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NOTICE 

• The following actions must be avoided without prior written permission from JEOL Ltd. or its subsidiary company 
responsible for the subject (hereinafter referred to as "JEOL"): modifying the instrument; attaching products other than 
those supplied by JEOL; repairing the instrument, components and parts that have failed, such as replacing pipes in the 
cooling water system, without consulting your JEOL service office; and adjusting the specified parts that only field 
service technicians employed or authorized by JEOL are allowed to adjust, such as bolts or regulators which need to be 
tightened with appropriate torque. Doing any of the above might result in instrument failure and/or a serious accident. If 
any such modification, attachment, replacement or adjustment is made, all the stipulated warranties and preventative 
maintenances and/or services contracted by JEOL or its affiliated company or authorized representative will be void. 

• Replacement parts for maintenance of the instrument functionality and performance are retained and available for seven 
years from the date of installation. Thereafter, some of those parts may be available for a certain period of time, and in 
this case, an extra service charge may be applied for servicing with those parts. Please contact your JEOL service office 
for details before the period of retention has passed. 

• In order to ensure safety in the use of this instrument, the customer is advised to attend to daily maintenance and 
inspection. In addition, JEOL strongly recommends that the customer have the instrument thoroughly checked up by 
field service technicians employed or authorized by JEOL, on the occasion of replacement of expendable parts, or at the 
proper time and interval for preventative maintenance of the instrument. Please note that JEOL will not be held 
responsible for any instrument failure and/or serious accident occurred with the instrument inappropriately controlled or 
managed for the maintenance. 

• After installation or delivery of the instrument, if the instrument is required for the relocation whether it is within the 
facility, transportation, resale whether it is involved with the relocation, or disposition, please be sure to contact your 
JEOL service office. If the instrument is disassembled, moved or transported without the supervision of the personnel 
authorized by JEOL, JEOL will not be held responsible for any loss, damage, accident or problem with the instrument. 
Operating the improperly installed instrument might cause accidents such as water leakage, fire, and electric shock. 

• The information described in this manual, and the specifications and contents of the software described in this manual 
are subject to change without prior notice due to the ongoing improvements made in the instrument. 

• Every effort has been made to ensure that the contents of this instruction manual provide all necessary information on 
the basic operation of the instrument and are correct. However, if you find any missing information or errors on the 
information described in this manual, please advise it to your JEOL service office. 

• In no event shall JEOL be liable for any direct, indirect, special, incidental or consequential damages, or any other 
damages of any kind, including but not limited to loss of use, loss of profits, or loss of data arising out of or in any way 
connected with the use of the information contained in this manual or the software described in this manual. Some 
countries do not allow the exclusion or limitation of incidental or consequential damages, so the above may not apply to you. 

• This manual and the software described in this manual are copyrighted, all rights reserved by JEOL and/or third-party 
licensors. Except as stated herein, none of the materials may be copied, reproduced, distributed, republished, displayed, 
posted or transmitted in any form or by any means, including, but not limited to, electronic, mechanical, photocopying, 
recording, or otherwise, without the prior written permission of JEOL or the respective copyright owner. 

• When this manual or the software described in this manual is furnished under a license agreement, it may only be used 
or copied in accordance with the terms of such license agreement. 

Copyright  2011 JEOL Ltd. 

• In some cases, this instrument, the software, and the instruction manual are controlled under the “Foreign Exchange and 
Foreign Trade Control Law” of Japan in compliance with international security export control. If you intend to export 
any of these items, please consult JEOL. Procedures are required to obtain the export license from Japan’s government. 

TRADEMARK 

• Windows is a trademark of Microsoft Corporation. 
• All other company and product names are trademarks or registered trademarks of their respective companies. 

MANUFACTURER 

JEOL Ltd. 1-2, Musashino 3-chome, Akishima, Tokyo 196-8558 Japan 
Telephone: 81-42-543-1111  Facsimile: 81-42-546-3353  URL: http://www.jeol.co.jp/  

Note: For servicing and inquiries, please contact your JEOL service office. 

http://www.jeol.co.jp/�


 

  

Please be sure to read carefully the following Software License Agreement before using the software supplied by JEOL Ltd. 
If you do not agree to the terms and conditions of the Agreement, please do not use the software and contact JEOL Ltd. 
 
 

Software License Agreement 
 
This Software License Agreement is made and entered into by and between you, the end-user customer, and JEOL Ltd. 
(hereinafter referred to as JEOL) in witness of agreement between both parties upon licensing of the right to use the 
software (which is hereinafter referred to as the Licensed Software) owned by JEOL. 
 
Article 1. (Right to Use Licensed Software) 

“Right to Use the Licensed Software” means your right to use the Licensed Software in the country where the JEOL 
product you purchased is installed (hereinafter referred to as Country of Installation). 

 
Article 2. (Grant of License) 

1. JEOL grants you the non-exclusive and non-assignable right to use the Licensed Software in the Country of 
Installation. 

2. You may install and use the Licensed Software on a single computer limiting the purpose to carrying out of your job. 
3. You may not cause any third party to use the Licensed Software by establishing a sublicense or other means, and shall 

not disclose the Licensed Software to any third party.  
4. You may not take the Licensed Software out of the Country of Installation under any circumstances. 

 
Article 3. (Prohibition of Assignment and Other Acts) 

1. You may not assign, rent or lease the right to use the Licensed Software, disclose the content of the right, or transfer 
possession of the Licensed Software to any third party.  

2. You may not modify, translate, carry out reverse engineering, decompile, and disassemble the Licensed Software in 
whole or in part. 

 
Article 4. (Prohibition of Reproduction) 

You may not reproduce the whole or any part of the Licensed Software. 
 
Article 5. (Rights to Licensed Software) 

All rights related to the Licensed Software including copyrights belong to JEOL. 
 
Article 6. (Warranty) 

1. JEOL does not guarantee proper performance of the Licensed Software if it is modified or translated.   
2. JEOL does not warrant that the Licensed Software is free from defects or fit and useful for your particular purpose. 

 
Article 7. (Exemption from Liability) 

JEOL shall not be liable for any damages or losses incurred by you or any third party or for any claim of a third party 
against you arising out of or in relation to the use of the Licensed Software. 

 
Article 8. (Confidentiality) 

You shall keep confidential the content of the Licensed Software supplied hereunder by JEOL and the terms and 
conditions of this Agreement, and shall not divulge or disclose them to any third party without the prior written consent 
of JEOL. 

 
Article 9. (Term of Validity) 

1. This Agreement shall become effective as of the day you accept the terms hereof and so remain unless it is 
terminated pursuant to the next Article. 

2. Notwithstanding the item above, the provisions set forth in the Article 8 (Confidentiality) shall remain effective even 
after the termination hereof. 

 
Article 10. (Termination) 

In any of the following event, JEOL may forthwith terminate this Agreement by so notifying you without any prior 
notification and may claim the damages incurred: 
(1) Any breach on your part of any of the provisions hereof, 
(2) Occurrence of seizure or provisional seizure or provisional injunction on your property; auctioning of your property; 

bankruptcy, corporate liquidation, and filing for corporate reorganization on your part; or proceedings taken against 
you for collection of tax delinquency. 

 
Article 11. (Steps to Be Taken after Termination) 

Upon the termination of this Agreement pursuant to the Item 1 of Article 9 and Article 10, you shall destroy the 
Licensed Software and notify JEOL of such destruction. 

 
Article 12. (Discussion in Good Faith) 

Matters not stipulated herein shall be discussed in good faith and settled between you and JEOL. 



     

 

     

  

WARRANTY INFORMATION 
1 Limited Warranty 

Products manufactured by JEOL Ltd. (hereafter “JEOL products”) that fail under normal use 
by the customer during the warranty period will be repaired or replaced, at JEOL’s discretion, 
without charge.  
The components, modules and devices that are provided as replacements will be new parts 
or refurbished parts that provide the same performance as new p arts. All components, 
modules and devices removed under this warranty become the property of JEOL. 

1.1 Applicable Products 
• This warranty applies only to hardware and software products manufactured by JEOL Ltd. 
• For components that are not JEOL products, such as the computer, HDD, memory device, 

and the like, the warranty provisions of the respective manufacturers shall apply.  

1.2 Warranty Period 
• In the case of products for which the warranty period is recorded in the contract 

documentation, the recorded warranty period shall take precedence. 
• If not specifically stated elsewhere, the warranty period is 12 m onths or a s eparately 

specified period from the date on which the acceptance test is completed after delivery to 
the customer.  

• For components that are not  JEOL products, like the computer, HDD, memory device, 
and the like, the warranty start date shall be the date on w hich the acceptance test is 
completed after delivery to the customer and t he warranty periods established by the 
respective makers shall apply.  

• In the event that parts are replaced or repaired free of charge during the warranty period, 
there is no change to the warranty start date or the warranty period for the product.  

1.3 Scope of the Warranty 
■ Failure diagnosis 

If a probl em occurs, contact your JEOL service office and des cribe the conditions and 
content of the problem. JEOL will assess the problem based on the situation and content of 
the problem. 

■ Repair method 
If it is determined that the problem is caused by a fault or defect of a JEOL product, repair or 
replacement will be performed free of charge. The choice of whether to repair or replace a 
component is entirely at the discretion of JEOL. 

■ Warranty exclusions 
This limited warranty does not extend to products for which any of the following situations 
apply. Even within the warranty period, in the situations listed below, a fee will be charged to 
repair the product. 

 
• Product is operated or stored in an environment or under conditions that do not satisfy the 

specified installation requirements. 
• The installation environment has changed (temperature, humidity, magnetic fields, etc.) 

since the time of installation. 
• There is significantly accelerated deterioration of components and/or corrosion of 

electrical circuitry as a result of exposure to extreme temperature, humidity, or an 
environment containing highly-corrosive gases or excessive dust.  

• The quality of the utilities (including electricity, water, gas, air quality) has worsened. 
• The customer has relocated an installed instrument. 



     

 

     

  

•  Even in the case of a p ortable or m ovable instrument designed to be t ransported to a 
remote location or moved around for use by the user, damage or failures caused during 
the instrument relocation by the customer. 

• Product has not been properly maintained. 
• Consumable items or parts with the specified replacement period have not been replaced 

as specified. 
• Corrupted operating system or application software, or damaged computer used with the 

instrument, caused by shutting down the main power to the computer without performing 
the proper shutdown sequence. 

• Products that have been disassembled, modified or rep aired by the customer in ways 
other than those specified in the instruction manuals provided with the instrument.  

• Products with damage or failure caused by using them in combination with hardware, 
software, peripheral devices, and accessories that have not been provided or approved 
by JEOL.  

• Damage or failure resulting from a situation caused by the customer, such as failing to 
properly manage the instrument, for which JEOL cannot be held responsible. 

• Corruption of the operating system or application software, or damage to a computer used 
with the instrument, caused by fluctuations in the electricity or power failure.  

• Product damaged as a result of fire, earthquake, flooding, lightning or other natural 
disaster, or due to local conflict or war.  

• Damage or malfunction of operating system, application software, or the instrument itself 
as a result of infection by a computer virus. 

• Instruments that have been res tored after being disposed of or re -sold without prior 
written notice to and agreement from JEOL.  

1.4 Items Not Covered by Warranty 
• Regardless of whether a product is still within the warranty period, this warranty does not 

cover losses or damage to devices made by any other manufacturer at the customer site 
even if they are damaged by a malfunction of the JEOL product.  

• JEOL is not responsible for any loss or damage to data recorded onto storage media, or 
to storage units. The customer is responsible for making back-up copies of their own data.  

• Replacement parts for maintenance of the instrument functionality and performance are 
retained and available for seven years from the date of installation. Thereafter, some of 
those parts may be a vailable for a c ertain period of time. Please contact your JEOL 
service office for details before the period of retention has passed. 

• For items that are frequently updated, remodeled, or disappear from the market, like the 
computers used with the JEOL products, it may not be possible to obtain an exact 
replacement.  

2 Repairs for a Fee 
Repairs of JEOL products are available with charges after the end of the warranty period, or 
at anytime a customer requests. The components, modules and devices that are provided 
as replacements during the paid repair work will be new p arts or ref urbished parts that 
provide the same performance as new parts. All components, modules and devices 
removed during such repairs will become the property of JEOL. 
• The warranty period for parts replaced and the service during paid repair work is a period 

of 3 months after the completion of the repairs; or, in the case of parts that must be 
periodically replaced, the warranty period is the length of the specified replacement period. 

• In the event that repairs are perf ormed again during the warranty period, there is no 
change to the warranty start date or the warranty period. 



  

Notes on Disposal for Business Users 
 
 
 

■ In the European Union 
 
This symbol means that electrical and electronic 
equipment, at the end of its life, should be disposed of 
correctly. 
 
In the European Union there is a separate collection 
system for used electrical and electronic products. 
Please help us to conserve the environment we live in! 
 
Electrical and electronic appliances and machines often 
contain materials which, if handled or disposed of 
incorrectly, are potentially hazardous to human health 
and to the environment. They are, however, essential for 
the correct functioning of your appliance or machine. 
Therefore, please do not dispose of your old machine or 
appliance together with your household waste. 
 
Your JEOL product is designed and manufactured with 
high-quality materials and components which can be 
recycled and reused. If the product is used for business 
purposes and you want to discard it, please contact your 
JEOL dealer, who will advise you about the end-of-life 
disposal arrangements.  
 
 

■ Outside the European Union 
 
If you wish to discard this product, please contact your 
local authorities and ask for the correct method of 
disposal. 

Attention:  
Your product is marked with 
this symbol. It means that 
used electrical and electronic 
products should not be mixed 
with general household waste. 
There is a separate collection 
system for these products. 

  



 

   

NOTATIONAL CONVENTIONS AND GLOSSARY 

■ Examples for general notations 

 
CAUTION : Important precautions for use, which, if not followed, may result in 

damage to or problems with the device itself. 

 

: Additional points to remember regarding the operation. 
 

: A reference to another section, chapter or manual. 
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SAFETY PRECAUTIONS 
 

Although this instrument is protected with a safety device which prevents the occurrence of 
accidents that could result in injury, harm, and damage to the users or the instrument itself, the 
safety feature may not work properly if you use the instrument for a purpose not intended or in an 
improper manner. For the proper use of the instrument, please be sure to carefully read all of the 
instructions, descriptions, notices, and precautions contained in this manual to understand them 
fully prior to the operation or maintenance. This section, “Safety Precautions,” contains important 
information related to safety for using of the instrument. 

 
The safety indications and their meanings are as follows: 

  DANGER: An imminently hazardous situation which, if not avoided, will result in death
or serious injury. 

 WARNING: A potentially hazardous situation which, if not avoided, could result in death 
or serious injury. 

 CAUTION: A potentially hazardous situation which, if not avoided, may result in minor 
or moderate injury, or a situation that could result in serious damage to fa-
cilities or acquired data. 

 

  
Labels bearing the following symbols are attached to dangerous locations on the instrument. Do not 
touch any of these locations with your hands or anything else. 

Pay extra attention when you work in the area that has “Beware of handling” label.  Make sure to 
refer to the relevant section in the Instruction Manual for more detail. 

 

 

     

Beware of 
electric shock 

Beware of 
laser 

Beware of
handling 

Beware of
getting caught

Beware of 
biohazard 

Do not
disassemble

Beware of
heat 

 

Examples of symbols  

  Use the instrument properly within the scope of the purpose and usage 
described in manuals. 

  Take the course provided by JEOL on the operation and maintenance of 
the instrument. 

  Use extracorporeal diagnostic agents as the regents for measurement. 

  Never open or remove protective parts (exterior panels) and parts that 
cannot be opened or removed without the use of a tool, or disconnect or 
connect the cables and connectors that are not described in this manual. 

  Never attempt to do any disassembling or assembling of the instrument 
other than what is described in this manual. 

  Never make modifications that include disassembling the instrument and 
installing substitute parts. 

  Never disconnect the grounding wire or move it from the prescribed 
position. Failure to follow this instruction could result in electric shock. 
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  The AC power cord provided with this system is supplied for the 
particular device so that never use it for any other equipment. 

  To avoid falling, do not climb onto the operation table and console during 
daily operation or during maintenance or inspection. 

  When you dispose the instrument, liquids, and other wastes, follow all 
applicable laws and regulations, and dispose them in a proper manner 
without polluting the environment. 

  Be sure to read the “Safety Precautions” section of the manuals for the 
accessories attached to or built into the instrument. 

  If anything is unclear, please contact your JEOL service office. 

 

 WARNING for Installation  
 

   Do not attempt to install the instruments by yourself. 
Installation work requires professional expertise and JEOL is responsible for the 
installation of the instruments and related attachments purchased from JEOL. 
Consult your JEOL service office.

 
 

 WARNING  

  Never use the equipment in an environment where there is an ignitable 
gas or an anesthetic gas. This equipment is not built to be explo-
sion-proof. 

  If you replace the unit with new one for maintenance or other operations, 
be sure to turn off the power or power breaker of the analyzer. 
If you continue working while the power is turned on or in the PC CONTROL status, 
you may get a shock, or the electrical devices or parts may get damaged. 

  Only operators who have received JEOL’s maintenance training can carry 
out dangerous maintenance work such as that performed with the top 
cover open and by turning on or off the main power of the instrument. Be 
sure to wear insulating gloves. 

  To protect yourself against infection, be sure to use protective gloves. If 
protective gloves are torn or if you injure yourself anyway, please receive 
a doctor’s diagnosis. 

  If any liquid, including reagents, wash solutions and Cuvette Conditioner 
EX and Reaction Bath Oil, or effluent solution gets in your eye, you risk a 
loss of eyesight or an infection. Wash your eyes immediately using pure 
water (tap water is also acceptable), and receive a doctor’s diagnosis. 

  If water or reagent enters the instrument, immediately turn off the power 
or the power breaker of the analyzer. Before replacing a unit having a 
power cable (for example, in order to carry out maintenance), turn the 
OPERATE/STANDBY switch OFF(



) or turn OFF  the MAIN power 
switch( ○) on the analyzer unit. If you work with the OPERATE/STANDBY 
switch ON(  ) or the MAIN power switch ON ( ｜), you may receive an 
electric shock or the printed circuit boards may be damaged. 
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  When you deal with corrosive reagents or infection samples, be sure to 
wear protective equipment or clothes. 
Your skin may get damaged or infected.

  Before you clean the outside panels, be sure to turn off (


) the 
operate/standby switch of the analyzer unit power panel. 
If you clean them while the operate/standby switch is turned on (  ), the gauze you are 
using may be caught in the cooling fan and you may get injured. 

  Before you clean the inside of the MIX wash port, be sure to turn off (


) 
the operate/standby switch of the analyzer unit power panel. 
If you continue operating the instrument while the power is turned on and you touch it, 
you may get injured, or you may get infected with a virus or a bacterium in the serum.

  Before you clean the filter of the cooling part, be sure to turn off (


) the 
operate/standby switch of the analyzer unit power panel. 
If you continue operating the instrument while the power is turned on and you touch it, 
you may get injured, or you may get infected with a virus or a bacterium in the serum.

  Before you clean the waste fluid lines of the probes and Mix wash ports，

be sure to turn off (


) the operate/standby switch of the analyzer unit 
power panel. 
If you continue operating the instrument while the power is turned on and you touch it, 
you may get injured, or you may get infected with a virus or a bacterium in the serum.

  If there is a possibility that the unit may start moving suddenly, be sure to 
turn off ( 


) the operate/standby switch of the analyzer unit power panel. 

If you continue operating the instrument while the power is turned on, the unit may 
move, and you may get injured, or it may get damaged.

  Before you clean the cooling fans, be sure to turn off ( 


) the oper-
ate/standby switch of the analyzer unit power panel. 
If you perform the task while the power is turned on, you may receive an electric shock 
or may injure yourself with the fans.

  While you operate the instrument, its probes and the Tray may move. Be 
careful not to touch these parts. 
If you touch the instrument while it is being operated, you may get injured or infected 
by a bacterium or a virus in the serum, or the probes or the Tray may be damaged.

  When you replace parts or perform maintenance in high places, stand on 
a step and ensure your safety before starting work. 

  If you turn off the power while performing any operations including 
maintenance, probes may droop under their own weight. 
If you turn on the power while the probes are drooping, they may move, and you may 
get injured, or the instrument may be damaged.

  Do not use the equipment in the event that an earthquake warning has 
been issued. In the event that an earthquake has occurred, be sure to 
carry out a safety check on the equipment and confirm that there is 
nothing wrong with it. 
If you fail to do this, the equipment may malfunction and you may be unable to obtain 
correct data. 

  When you replace the light source lamp, be sure to turn the power off for 
10 minutes before you replace it with a new one. 

 Right after you turn off the power, the lamp house is really hot and you 
may get burnt. 
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  Use the equipment while fixing the STT splashing cover with the screw 
except when performing maintenance. If you touch the moving parts in 
the STT splashing cover, you may be injured or infected. Close the STT 
splashing cover except when performing maintenance. Fasten the retainer 
screw of the STT splashing cover so it cannot be opened except for the 
person who received maintenance training from JEOL. 

  Be sure to open and close the top cover correctly. If opening and closing 
the top cover are not done correctly, the top cover could accidentally fall 
down. 

  Ethanol used for system cleaning is a combustible. Please do not use it if 
there is a possibility of igniting when using it in the high temperature part.
Also, be careful, do not pour ethanol into the instrument. 

  Probe Wash Solution 2 is a class 3,6,1 (Flammable, acute toxicity 
material) hazardous material. Do not use the material for a purpose other 
than for BM Chemistry operation/maintenance. 

  Risk of Biohazard.  Strictly follow the instructions by JEOL when 
transporting or disposing of the analyzer.   

 
 

 CAUTION  

  Dispose appropriately any parts, such as sample tubes and stirring rods 
that have directly touched the sample and parts or units to which the 
sample may have spread and adhered as medical waste. Also, dispose 
appropriately any cloth and paper used for cleaning as medical waste. 

  In maintenance work, if you directly touch the parts and units with your 
hands, the parts and units may rust or be stained by the dirt on your 
hands. Moreover, if you directly touch wash solutions, Cuvette Condition-
er EX or Reaction Bath Oil with your hands, they may cause a skin 
inflammation. In maintenance work, be sure to use protective gloves. 

  Please do not use replacement parts and that are not recommended by 
JEOL. 
The performance of the instrument will not be maintained. Also, it may result in the 
breakdown of the instrument.

  On holidays and at night when there is no user, make sure that you close 
the water tap. 
Water leakage from the connection due to pressure increases can damage the 
instrument or nearby equipment.

  Do not expose your eyes to the laser beam. 
The laser beam is not harmful to the skin. There is, therefore, no danger in exposing 
your arms or hands to the beam. The only possible health hazard is the exposure of 
your eyes to the laser beam. Damage to the eyes can occur if the operator stares 
directly into the beam. 

  Use of controls or adjustments or performance of procedures other than 
those specified herein may result in hazardous radiation exposure.  
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  Before operating the equipment, ensure that the top cover is properly 
closed. Also, be sure to close all the covers.  
If you operate the equipment with the top cover open, or with a cover removed, you 
may injure yourself, or the equipment may stop or become damaged.  

  If power fails, for example, due to lightning, or you reset the personal 
computer, restart the computer according to the procedure described in 
the instruction manual, as the normal start-up operation will result in the 
loss of the day’s data. 

  Please use the detergents recommended by JEOL.  
If you use detergent not recommended by JEOL, the instrument may be damaged, and 
you may not attain correct data.

  If you use your keyboard for a long time, your hands or arms may suffer 
from a nerve disorder. Operate the instrument following the labor safety 
and health standards established at each institution. 

  Install the equipment in a place that meets the following requirements: 
a) A dust-free, well-ventilated place. 
b) A place that is not exposed to direct sunlight. 
c) A place where there is no vibration. 
d) A place where the equipment can be installed on a level surface. 
e) A place that is free of electrical noise. 
f) Do not run the equipment with a power supply to which a machine that emits 

high-frequency electrical noise (such as a centrifugal separator or discharge equip-
ment) is connected. Also, do not install the equipment near such a machine.

  Do not put hands or objects on the trays or the conveying belts, and do 
not remove the rack-feeding tray forcefully, while performing the rack 
feeding. 
It is very dangerous, since you may get injured or the instrument may be damaged.

  Cuvette Wash Solution, Reagent Probe Wash 1 and Reagent Probe Wash 
3 are class 8 (Corrosive) hazardous materials. 

  Different kinds of screws are used in the materials and standards in this 
instrument depending on their purpose. When assembling the instrument, 
be sure to use the screws in their original positions. If you lose the 
screws, please ask for replacements from the JEOL service center. 

  When you set samples and reagents, make sure that the loader is 
properly set on STT/RTT and the samples and reagents are firmly set on 
the loader.  
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WARNING AND CAUTION LABELS 
 

The warning and caution labels attached to the instrument are explained. 
 

■ Rear panel 

①

②

③

④
⑤

  

   Laser beam 
Be careful with the laser beam that is inside the panel. 
Location: ①RTT1, RTT2 and STT/CTT at analyzer front  

 
 

   Electric shock 
Be careful so you do not receive an electric shock caused by the high voltage. Turn off 
the main breaker before you do any maintenance or repairs on the instrument. 
Locations: ③ rear panel 

   Infection 
Be careful so you do not receive an infection. The waste fluid might contain infec-
tiious agents. 
Locations: ② condensed effluent tube 
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  Caution: Outlet Rating 
This analyzer is rated at 100V 7.5A as stated on the label.   
Do not use the analyzer with the voltage more than 100V 7.5A.. 

 Location: ④ rear panel 
 

After turning off the power, wait for three minutes or longer before turning on 
the power again. 
Location: ⑤ rear panel
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■ Cover on top panel 

 

①

②

 
 

   Your fingers might be caught 
If the damper of the top cover malfunctions, your fingers might be caught by the 
cover and be injured. 
Location: ① cover on the top panel

  Caution: 
When opening or closing the top cover, be aware that some unit or part may be in 
operation and may suddenly move.  
Location: ② Analyzer Top Cover
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■ Sample tray 

 

①

②

 
 

   Infection 
The instrument might contain infectious agents inside of this cover. Handle the 
samples with care so that you are not infected. 
Location: ① sample tray

   Laser beam 
Be careful with the laser beam that is inside the cover. 
Location: ② Sample Tray 
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■ Reagent tray cover 

 

①②

 
 

   Laser beam 
Be careful with the laser beam that is inside the cover. 

Locations: ① Reagent Tray 1 

 

Locations: ② Reagent Tray 2 
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■ SPP, RPP 1, RPP 2 

 

①
②

③

 
 

  

 

 Risk of injury 
Do not touch the probes, sample tubes or cuvettes while the Sample Tray or Reaction 
Carousel is in operation. 

   Infection caution; unit containing infectious agents moves 
The unit that might contain infectious agents moves. Refer to the instruction manual 
when you do any maintenance such as replacement and cleaning. 
Locations: ① SPP probe, ② RPP probe 1, ③ RPP probe 2 
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■ RRV, MIX 1, MIX 2 

 

①

②
③

 

 

 

 

 

 

 Risk of Electric Shock 
Do not touch the centre of RRV (③) and Mixing Rods (① and ②) when the analyzer 
power is on.  You may receive an electric shock.   
 

 Risk of Electric Shock 
Do not touch the metal part under the RRV（③） top cover. You may receive an electric 
shock. 

 

 

 

 Caution: Some Unit may be in operation 
Do not touch the Reaction Carousel while the analyzer is in operation 

 

  

 

 Infection caution; unit containing infectious agents moves 
The unit that might contain infectious agents moves. Refer to the instruction manual 
when you do any maintenance such as replacement and cleaning. 
Locations: ① MIX 1, ② MIX 2, ③ RRV 
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■ Lamp 

 

①

②

 
 

  Caution 
A lamp inside of this cover might be damaged if a strong shock is applied on it. Refer 
to the instruction manual when you do any maintenance such as replacement of the 
lamp. 
Location: ① lamp housing

   High temperature 
Be careful not to touch the lamp inside of this cover while it is hot, If you touch, you 
might get burned. 
Location: ② optical unit
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PRECAUTIONS FOR USE 
 
 

Parameters for assays must be entered in this system. Use those values of the parameters, 
such as sample volumes, reagent volumes, measurement wavelengths, and calibrator that 
accompany reagents and reference samples. Enter these values correctly according to the 
procedures in the instruction manual. 
Should a failure that is not described in this instruction manual occur, turn off the power 
immediately and contact JEOL.  
 

 
■ Precautions for handling samples  

 Do not leave samples uncovered for a long time because evaporation could take place. 
Handling samples improperly may change the composition of samples due to 
evaporation.  

 
 Confirm that there are no fibrins or dirt in the sample. 

If the sample contains them, the diluting pipettes (SPP) or dilution tubes will 
become clogged, preventing correct data from being obtained. 

 
 The SPP or dilution system tubes can become clogged with samples having high 

viscosity, preventing the acquisition of correct data.  
 

 When blood-collecting tubes containing serum separators are used, the SPP or dilution 
system tubes can become clogged with separation agents, preventing the acquisition of 
correct data.  

 If you use bar codes on blood-collecting tubes, correctly stick the bar codes that can be 
read clearly on them. To prevent the bar codes from being read incorrectly, it is 
recommended that you use barcodes with check digits. 

 
 This system is designed to analyze serum, urine, and spinal fluid. However, some 

samples cannot be analyzed depending on the assay items or reagents. Consult the 
reagent manufacturer on this matter. 

 
■ Precautions to be observed when handling measurement reagents 

 Use or keep measurement reagents, reference solution, samples used for management 
correctly according to the instructions of the reagent manufacturers. 

 
 Do not add or replace a measurement reagent during operation. 

 
 When adding or replacing a measurement reagent, make sure to perform calibration 

again. 
 

 When refilling a measurement reagent, use a clean container exclusively for that 
reagent. 

 
 When replacing a major component in the sample or reaction system, such as a dilution 

pump, sampling pump, reagent pump, or light-source lamp, make sure to perform 
calibration. 

 
 One reagent may interfere with another one depending on the combination of assay 

items, influencing measurement values, or causing a malfunction of the equipment due 
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to deposition produced by mixing with the waste liquid. Consult the reagent maker on 
the interfering items. 

 
 Install the measurement reagents in the correct positions. 

The wrong position produces incorrect data and can cause a malfunction of the 
equipment. 
 

 
 Store opened or unopened measurement reagents according to the instructions of 

reagent makers. If reagents are not stored properly, correct data may not be obtained 
even within the effective period. 

 
■ Caution for handling solutions 

Cuvette Wash Solution 7 For in vitro diagnostic use as a cleaning agent on 
BioMajesty systems. 
Composition and ingredients: Sodium Hydroxide, 4.0% 
Wear proper protective equipment to avoid contact with 
skin or inhalation of the vapor. 
Disposal consideration 
Residual disposal: Dilute the chemical with a large 
amount of water and flush in a drain after neutralizing 
with diluted acid.  Or entrust approved waste disposal 
companies with the disposal. 
Containers : In case of disposal of empty bottles, dispose 
bottles after removing the content thoroughly. 

 
Cuvette Conditioner EX For in vitro diagnostic use as a cleaning agent on 

BioMajesty systems. 
Composition and ingredients: Surfactant 
Wear proper protection equipment. 
Avoid contact with skin and eye. 
This product may discolor or cause rust on metal. 
Disposal consideration 
Dispose residual product with plenty of water.  If 
substantial volume needs to be disposed, entrust 
approved waste disposal companies with the disposal . 

 
Lamp Coolant C For in vitro diagnostic use as a lamp coolant on 

BioMajesty systems. 
Composition and ingredients: Organic acid, Organic 
nitrogen compound, Alcoholic compound 
Do not inhale mist or spray. 
Wear proper protection equipment. 
Avoid contact with skin and eye. 
Disposal consideration 
Dispose of residual product with plenty of water.  If 
substantial volume needs to be disposed, entrust 
approved waste disposal companies with the disposal  . 

 
Reagent Probe Wash  K For in vitro diagnostic use as a cleaning agent on 

BioMajesty systems. 
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Composition and ingredients: Sodium Hydroxide, 2% 
Wear proper protective equipment to avoid contact with 
skin or inhale the vapor. 
Disposal consideration 
Residual disposal : Dilute the chemical with a large 
amount of water and flush in a drain after neutralizing 
with diluted acid.  Or entrust approved waste disposal 
companies with the disposal. 
Containers : In case of disposal of empty bottles, dispose 
bottles after removing the content thoroughly. 

 
Reagent Probe Wash  S For in vitro diagnostic use as a cleaning agent on 

BioMajesty systems. 
Composition and ingredients: Potassium hydroxide 
4.5%, Sodium polyacrylic acid 4.0%, Sodium 
hypochlorite 4.7%, Surfactant 
Do not inhale mist or spray. 
When handling in a room, make sure that there is 
adequate ventilation in the room and maintain the 
concentration under indicative concentration. 
Wear proper protection equipment.  

 Avoid contact with skin and eye. 
For normal use, only adequate general ventilation is 
required. 
Handle the product with care.  

 Do not drop the product. 
Disposal consideration 
This product is chlorite alkaline solution.  Dispose the 
product with plenty of water or neutralize it with acid 
after dechlorination with sodium thiosulphate (Hypo), 
then dispose it with plenty of water.  If substantial 
volume needs to be disposed, entrust approved waste 
disposal companies with the disposal 

 
Reagent Probe Wash 1 For in vitro diagnostic use as a cleaning agent on 

BioMajesty systems. 
Composition and ingredients: Sodium Hydroxide, 3.6% 
Wear proper protection equipment. 
Do not inhale mist or spray. 
Avoid contact with skin and eye. 
For normal use, only adequate general ventilation is 
required. 
Handle the product with care. 
Do not drop the product. 
Disposal consideration 
This product is alkaline. Dispose residual product with 
plenty of water or antalkaline with acid substance, then 
dispose of it with plenty of water. If substantial volume 
needs to be disposed, entrust approved waste disposal 
companies with the disposal. 
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Reagent Probe Wash 2 For in vitro diagnostic use as a cleaning agent on 

BioMajesty systems. 
Composition and ingredients: Oxalic acid 3.0%, 
Hydroxyacetic acid 20.0%, Methyl alcohol 4.8%, 
PEG-400 3.0% 
Do not inhale mist or spray. 
Wear proper protection equipment.  
Avoid contact with skin and eye. 
For normal use, only adequate general ventilation is 
required. 
Handle the product with care. 
Do not drop the product. 
Disposal consideration 
This product is acid.  Dispose the product with plenty of 
water or neutralize it with alkaline substance, then 
dispose it with plenty of water.  If substantial volume 
needs to be disposed, entrust approved waste disposal 
companies with the disposal. 

 
ISE Detergent Solusion For in vitro diagnostic use in the quantitative 

determination of certain electrolytes in human serum, 
plasma and urine on BioMajesty system. 
Composition and ingredients: Sodium hypochlorite 
6.0% 
Wear appropriate protection equipment. 
Avoid contact with eye and skin.  Avoid inhalation of 
vapor. 
Ensure that the work area has adequate local 
ventilation/general ventilation. 
Avoid spillage. 

 Do not eat and drink or smoke while handling this 
product.  

 Avoid contact with skin/eye, inhalation or ingestion. 
Wash hands after handling the product. 
Disposal consideration 
Dispose residual product in an appropriate method in 
accordance with the relevant law, rules and regulation. 

 
ISE Buffer（IS） For in vitro diagnostic use in the quantitative 

determination of certain electrolytes in human serum, 
plasma and urine on BioMajesty system. 
Composition and ingredients: Formaldehyde < 1.0%, 
Phosphate < 1.0%,  Triethanolamine < 2.0% 
Wear appropriate protection equipment. 
Avoid contact with eye/skin and inhalation of gas. 
Ensure that the work area has adequate local 
ventilation/general ventilation. 
Avoid spillage.  
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 Avoid contact with skin/eye, inhalation or ingestion. 
Wash hands after handling the product. 
Disposal consideration 
Disposal of residual product : Dispose residual product in 
an appropriate method in accordance with the relevant 
law, rules and regulation. 
Contaminated container and wrapping: Dispose any 
contaminated container and wrapping in accordance with 
the relevant law and the regulations by local authorities. 

 
Internal Standard Solution For in vitro diagnostic use in the quantitative 

determination of certain electrolytes in human serum, 
plasma and urine on BioMajesty system. 
Composition and ingredients: Formaldehyde < 0.1% 
Wear appropriate protection equipment. 
Avoid contact with eye/skin and inhalation of gas. 
Ensure that the work area has adequate local 
ventilation/general ventilation. 
Avoid spillage. 

 Avoid contact with skin/eye, inhalation or ingestion. 
Wash hands after handling the product. 
Disposal consideration 
Disposal of residual product : Dispose residual product in 
an appropriate method in accordance with the relevant 
law, rules and regulation. 
Contaminated container and wrapping : Dispose any 
contaminated container and wrapping in accordance with 
the relevant law and the regulations by local authorities. 

 
ISE Serum Standard Solutions For in vitro diagnostic use in the quantitative 

determination of certain electrolytes in human serum and 
plasma on BioMajesty system. 
ISE Serum High Standard 
Composition and ingredients: Formaldehyde 0.1%, 
Na+ 160mmol/L, K+ 6mmol/L, Cl- 120mmol/L,  
Preservative 
ISE Serum Low Standard 
Composition and ingredients: Formaldehyde 0.1%, 
Na+ 130mmol/L, K+ 3.5mmol/L, Cl- 85mmol/L,  
Preservative 
Wear appropriate protection equipment. 
Avoid contact with eye/skin and inhalation of vapor. 
Ensure that the work area has adequate local 
ventilation/general ventilation. 
Avoid spillage. 
Do not eat and drink or smoke while handling this 
product. 
Avoid contact with skin/eye, inhalation or ingestion.  
Wash hands after handling the product. 
Disposal consideration 
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Residual disposal : Dispose residual product in an 
appropriate method in accordance with the relevant law, 
rules and regulation. 
Contaminated container and wrapping : Dispose any 
contaminated container and wrapping in accordance with 
the relevant law and the regulations by local authorities. 

 
ISE Urine Standard Solutions For in vitro diagnostic use in the quantitative 

determination of certain electrolytes in human urine on 
BioMajesty system. 
ISE Urine High Standard 
Composition and ingredients: Formaldehyde 0.1%, 
Na+ 200mmol/L, K+ 100mmol/L, Cl- 180mmol/L,  
Preservative 
ISE Urine Low Standard 
Composition and ingredients: Formaldehyde 0.1%, 
Na+ 50mmol/L, K+ 10mmol/L, Cl- 50mmol/L,  
Preservative 
Wear appropriate protection equipment. 
Avoid contact with eye/skin and inhalation of vapor. 
Ensure that the work area has adequate local 
ventilation/general ventilation. 
Avoid spillage.  

 Do not eat and drink or smoke while handling this 
product.  

 Avoid contact with skin/eye, inhalation or ingestion. 
Wash hands after handling the product. 
Disposal consideration 
Residual disposal : Dispose residual product in an 
appropriate method in accordance with the relevant law, 
rules and regulation. 
Contaminated container and wrapping : Dispose any 
contaminated container and wrapping in accordance with 
the relevant law and the regulations by local authorities. 

 
■ Precautions concerning data 

In order to measure a sample with this equipment, measurement reagents, reference 
solution, samples used for management are required.  Make inquiries concerning the use 
of these reagents and samples to the respective reagent makers. 

 
 Use reagents and reference solutions made exclusively for electrolyte (Na, K, Cl) 

measurements. 
 

 Follow the instructions of the reagent makers for the timing and frequency of 
calibration, and the use of reference solutions. 

 
 When measuring a sample, use a management sample to monitor the condition of the 

equipment in real time at suitable intervals. 
 

 If abnormal color appears during sample testing, pay attention to the possibility of 
interference or influence on the measurement data. 
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 Data of a patient who is taking certain medications may show a higher or lower value 
than the actual value. Access the information from the maker beforehand. If the patient 
is treated based on the higher or lower value falsely measured, the treatment may result 
in a critical condition. 

 
 When cleaning the equipment, use the specified detergents. 

 
 If an abnormal value appears in the measurement data, confirm the reaction process 

and repeat the measurement. 
 

  Samples with abnormal values that are extremely high may have carryover. Please 
pay attention to the values of the next sample and the one in the dilution container. 

 
 Do not change (delete) the contents of your requests during analysis. It may result in 

inconsistency between sample numbers. 

 
■ Precautions concerning water supply and drain 

 Handle the demineralizer correctly according to the instruction manual. 
If the purity of the water supplied from the demineralizer to the Analyzer Unit 
deteriorates, data can be influenced. 

 
 Process waste liquid suitably according to water-pollution prevention ordinances and 

all related regulations.  
Treat reagents containing substances regulated by pollution-prevention ordinances 
and drainage standards after consulting the makers. 

 
■ Precautions concerning loss of data and parameters 

 Especially when starting the system, be sure to operate the system correctly. 
Mistakes can cause loss of data. 

 
 Be sure to back up the setting parameters. 

Various types of setting parameters may be lost or irrecoverable due to misoperation 
or breakdown of the equipment. 

 
 Do not load software on the hard drive other than the software specified by JEOL. 

To do so can cause a malfunction, resulting in loss of data. 
 

■ Notes on storing the instrument 

 If you have not operated the instrument for a long time, wash the lines and reaction 
tubes well enough. Also, pay attention to any liquid leakage from each part. 

 
 If there is a possibility of frost, drain the water from instrument, and inspect it before 

operation.  
 

 Be aware of biohazard risk.  Wear appropriate protection and operate the analyzer 
with care.  

 
 If the analyzer is used in a manner not specified by JEOL, the protection provided by 

the analyzer may be impaired.  
 
 
 
 



 
 
PRECAUTIONS FOR USE 

S-8  ICABM6010/C-4 

■ Precautions concerning the cleaning of the panels 
 If a large amount of serum, hazardous materials or water is splashed on the system, 

stop it and turn off the power at the main breaker. You must use ethanol to remove the 
contaminant from the system. 

 
 For the purpose of cleaning the analytical console’s panels and safety covers, use water 

or ethanol. Other solutions might peel off the paint, corrode and dissolve some part of 
the system’s panels and safety covers. Contact your service office authorized by JEOL 
whenever you are unclear about any operation or maintenance. 

 
■ Decontamination and Cleaning 

 Appropriate decontamination is carried out if hazardous material is spilt onto or into 
the equipment. 

 Decontamination is described in the following procedures. To perform decon-
tamination, be sure to wear gloves. First, wipe the dirty surface of a sample 
well. Next, use a lint free cloth, and wipe the surface where the sample is ad-
hering. Lastly, wipe the same surface well with another lint free cloth impreg-
nated with 5% sodium hypochlorite solution. 

 
 Do not use decontamination or cleaning agents which could cause a HAZARD as a 

result of a reaction with parts of the equipment or with material contained in it. 
 Should you wish to use any solution other than solutions specified by JEOL for wash 

or decontamination, please contact JEOL.  
 
■ Notes to transport and/or store the system. 

 If you transport or store the system by a method other than that recommended by JEOL, 
then JEOL will not bear any responsibility for erroneous results reported by the system 
or problems with the units on the system. 

 
 If you have further questions, please contact local service center. 

 
 If the system will be stopped for long period of time, take the necessary actions, like 

removing water from the system. 
 
■ Correspondence for a breakdown and an abnormality 

 If an equipment breakdown or abnormality occurs, please turn off the MAIN power 
supply. And, contact your service office authorized by JEOL. 

 
■ Precautions concerning the disposal of the device 

 Please process it according to the guidelines of the laws, ordinances, and so forth ｗ

hen you dispose the device.  
 Contact your service office authorized by JEOL whenever you are unclear about any 

operation or maintenance. 
 
■ Emergency Procedures 

To stop the operation after the analyzer has started 
To avoid possible injury and damage to the analyzer, make sure that all probes and mixers 
can move without any obstruction and that all analyzer covers are in place. 

 
1. At the bottom of the power panel, press the System Stop button. 
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2. Click INITIALIZE  
 

3. If reagents were dispensed, you must perform a Weekly Wash2 before resuming 
operation. Load Reagent Probe Wash-S (5% solution) into, RTT1-49 ,RTT2-49. 

 
To manage an expected power outage 

If you know in advance of an upcoming power outage: 
 

1. Turn off the workstation and analyzer power by performing the normal shutdown. 
 

2. If you expect the power supply to be off for a long period of time, remove the 
reagents in RTT1 and RTT2 and refrigerate them. 

 
3. When the power returns, perform the normal startup operation.  

 
To respond during a power failure-power is still off 

While the electrical power is still off: 
 

1. Turn OFF the workstation power switch. 
 

2. At the power panel, set the OPERATE/STANDBY switch to STANDBY. 
 
 
 
When the electrical power returns: 

 
1. Turn ON the workstation power switch. 

 
2. When the Startup window appears, turn the OPERATE/STANDBY switch to 

OPERATE. 
 

3. On the Startup window, click Re-Start, enter user name and password, then click 
OK. 

 
4. Repeat the task prior to the power failure and verify that the data were stored. 

 
5. If reagents were dispensed, you must perform a Weekly Wash2 before resuming 

operation. Load Reagent Probe Wash-S (5% solution) into, ,RTT1-49 ,RTT2-49. 
 

To resume after a power failure-power is restored 
 

1. If the Startup window is open, click Shutdown. 
 

2. When prompted by “It is now safe to turn off your computer,” turn off the worksta-
tion power and turn the OPERATE/STANDBY switch to STANDBY. 

 
3. After approximately 20 seconds, turn on the workstation power. 

 
4. Perform the normal startup operation. 

 
5. If reagents were dispensed, you must perform a Weekly Wash2 before resuming 

operation. Load Reagent Probe Wash-S (5% solution) into, RTT1-49 ,RTT2-49. 
 

6. If possible, repeat the last task prior to the power failure, and verify that any data 
generated were stored properly. 
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■ Notes on Electromagnetic waves 

This instrument complies with the emission and immunity requirements 
described in the IEC61326-2-6：2005. 

 
Warning 
This equipment has been designed and tested to CISPR 11 Class A. In a domestic 
environment it may cause radio interference, in which case, you may need to take 
measures to mitigate the interference. 

 
Caution 
The electromagnetic environment should be evaluated prior to operation of the 
equipment. 

 
Caution:  
Do not use this equipment in close proximity to sources of strong electromagnetic 
radiation, as these may interfere with the proper operation. 
 

■ When the analyzer remains unused for a long period  

When the analyzer remains unused for a long period (more than 3 days), there is a risk 
that the detergent lines for WUD become dry and may cause clogging.   
In order to avoid such damage on the analyzer, please follow the steps before and after 
leaving the analyzer unused. 
 

 
 Before turning off the analyzer for a long period 

a. Perform WASH2 to complete washing when the routine operations are over.   
b. Remove the aspiration line from the cuvette conditioner bottle and the 

cuvette wash solution bottle in the detergent compartment.  Rinse the lines 
with pure water and then put them in a beaker filled with 500ml of pure water.  
Cover the bottles if there is some solution left in them.    

Note:  IMPROTANT: Do not drain the Reaction Bath Oil. 
c. Perform WASH3 (washing only with water). 
d. When WASH3 is completed, fix the aspiration lines back to the bottles where 

they were originally installed.   
e. Cover the top of detergent and reagent bottles set on the reagent trays with 

some plastic film.  (Make sure to remove the plastic film when you restart 
the analyzer.)  

f. Perform Shutdown. 
Note:  Do not perform Auto-Startup. 

  
 Before starting up the analyzer again  

a. Check that there are no crystals on the tip of WUD nozzles.   
Check the second port/red 2 (cuvette wash solution), and the fourth port/red 
4 (cuvette conditioner).      

Note:  If there are any crystals or clogging, remove the WUD unit 
(with one Allen screw) and feed a wire through the nozzle tips 
from the bottom of the nozzles to remove any crystals or clot.  
(Do not remove the connection joint.) 

b. Startup the analyzer. 
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c. Remove the plastic film that has covered the top of the detergent and 
reagent bottles on RTTs. 

d. Perform PRIME1. 
e. Perform WASH3.  When WASH is started, observe the WUD movement to 

ensure that no line comes off from WUD and there is no leak from there.  
f. Run a routine analysis. 

 
 
■ Air Bubbles in the Reaction Bath 

The analyzer uses dedicated Reaction Bath Oil (inert oil) so that no air bubbles are 
generated in the Reaction Bath. 
However, it is important for the analyzer to have adequate supply of the Reaction Bath 
Oil to stablize the test result. 
Please check the Reaction Bath Oil status in the [System Monitor] window when you start 
up the analyzer. 
 

Note:   Refer to Chapter 1 in ‘Basic Operations’ for the startup operations. 
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IMPORTANT INFORMATION RELATED TO USE 
AND MANAGEMENT 

 
 

 The customer is responsible for maintaining and managing the delivered equipment. 
 

 Be sure to store important data in a clinical chart, notebook or external memory device. 
 

 Only doctors and legally qualified persons are allowed to use this equipment. 
 

 This equipment is intended to provide doctors with data required for diagnosis. 
 

 Do not modify or change this product (including software). 
 

 The useful life span of this product is seven years from the date when you started to 
use it (when it was installed). 

 
 Subsequent to the explanation of the warranty period, after-sale service is available for 

a fee. 
For after-sales service, consult your nearest service center. 

 
 If it is necessary to move or transport this equipment after delivery to your site, we can 

do this for a fee. 
In order to prevent any problems from occurring when the equipment is being 
moved or transported, be sure to consult your nearest service center. 

 
 This instruction manual contains warnings concerning dangers that JEOL considers 

could conceivably arise. However, be very careful of any other dangers that may arise 
as well. 

 Maintenance and operation of the system must be performed by the personnel who 
have completed JEOL’s official training and have sufficient knowledge of the system’s 
dangers. 

 
 Contents of the safety precautions must be observed strictly. 

 
 Do not use any parts other than those recommended by JEOL. 

 
 If the analyzer is used in a manner not specified by JEOL, the protection provided by 

the analyzer may be impaired.  
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EXEMPTION CLAUSES 
 
 

 It is important to maintain the equipment in a very safe and reliable condition. 
From manufacturing to installation, JEOL puts every effort into implementing 
integrated quality control, to ensure that the equipment can be delivered to the 
customer in as safe and reliable a condition as possible. 
However, once the equipment has been delivered to the customer, the customer is 
responsible for maintaining and managing the equipment. 
JEOL can carry out maintenance and inspection of the equipment for a fee subse-
quent to the expiration of the warranty period. 

 
 When using this equipment for clinical examinations, use it under the supervision of a 

doctor or clinical technician. 
This instrument aims to provide a doctor with data to be used for diagnosis. JEOL 
will not bear responsibility for secondary damage due to diagnosis results or data 
obtained when the equipment is used. 

 
 JEOL will not bear responsibility for any breakdown or damage due to installation, 

moving, maintenance, or repair carried out by a person other than JEOL's service 
engineer or designated engineer. 

 
 JEOL will not bear responsibility for loss of data stored in the equipment as a result of 

misoperation or an unforeseen accident. Store your important data on recording media 
such as medical records, notes, or floppy disks. 

 
 JEOL will not bear responsibility for any injury or infectious disease caused by 

transportation or disposal without supervision by a JEOL representative. 
 

 JEOL will not bear responsibility for the equipment breaking down or becoming 
damaged due to another company's equipment not delivered by JEOL. 

 
 JEOL will not bear responsibility for any breakdown or damage caused by mainten-

ance or repair carried out using spare parts not specified by JEOL. 
 

 JEOL will not bear responsibility for any breakdown or damage caused by use of the 
equipment in a country not specified by JEOL. 

 
 JEOL will not bear responsibility for any breakdown or loss of data due to failure of 

the user to observe the safety precautions and operation instructions described in this 
instruction manual. 

  Be careful about receiving an infection with a computer virus via your recording 
media including USB memory. 

The PC that comes with this instrument has been checked for viruses, and it is not 
infected with a virus. However, if you use recording media including USB memory, 
check your PC for viruses using antivirus software or other software, and using it is 
your responsibility. JEOL will not bear responsibility for the instrument that stopped 
operating due to the use of recording media infected with a virus. 
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1.1 Overview 
The analyzer system JCA-BM6010/C is a compact and high-performance analyzer of 
chemistry and electrolyte components of human blood and urine samples. The system 
comprises two units:  the analyzer (left) and the workstation (right).  The analyzer 
can be used standalone or in combination with a third-party laboratory automation 
system. 

 

 

 

Analyzer 

Workstation 

Note: Workstation configuration may 
vary per laboratory.   

BM6010/C System 

 Main Features 

 Reagent pickup type 

• Single line, full random access 

 Throughput 

• 1200 tests/hour for chemistry and ISE analysis combined.    
(Chemistry tests only: 800 tests/hour, ISE tests only: 600 tests/hour) 

  Ultra micro reagent volume 

• Minimum reagent volume needed for measurement: 80 µl 

 Flexible capability for analyses 

• Up to three-part reagent analysis is possible 

• Specialized diluent can be used (i.e. for immunoassay tests) 
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 Data credibility assured 

• Number of measurement points: 63 (with reaction time of 15 minutes) 

• Mixing by rotation and repeated left-right movement of the rod 

• Reaction process monitoring with 14 wavelengths 

• Three dimensional reaction monitoring 

 Enhanced usability 

• Automatic calibration 

• Automatic startup/shutdown 

• Automatic rerun 

• Automatic avoidance of using cuvettes with cuvette blank error 

• STAT port 

 High productivity 

• Reflex test 

• Reagent probe/cuvette contamination avoidance 

• Reaction Check Logic function 

• Sample carryover avoidance 
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1.2 Components 
The standard BM6010/C system includes the following components. 

 Standard components 

Analyzer  

• Analyzer main unit (1) 

• Reaction tray (RTT) cover (1) 

• Sample tray (STT) and cooling tray (CTT) covers  

• Bottles for cuvette detergent, cuvette conditioner, and reaction bath oil.   

• Sample tray loader (STT) (1) 

• Cooling tray loader (CTT) (1) 

• Reagent tray 1 loader (RTT1) (1) 

• Reagent tray 2 loader (RTT2) (1) 

• Splash cover (1) 

• Ion selective electrode (ISE) unit (1) 
  

1 set of Accessories 
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1.3 Operation Principle 
The operation principle of the BM6010/C system is as follows: 

 

Reagent 
tray 1 

Sampling 
pump 

Reagent 
pump 1 

 

A/D 
Converter 

 

CPU 
Controller 

Data 
processing 

CPU 

Reagent barcode readers 

Reagent 
tray 2 

Reagent probe unit 2 

Mixer 1 
Mixier 2 

Sample probe unit 

Sample tray 

Reaction bath 

Spectrophotometer 

Reatent probe unit1 

Reaction carousel 

Reagent 
pump 2 

 

Sample barcode 
reader 

 

Operational schema of BM6010/C 

The reagent probe (RPP) dispenses reagent 1 (R1) from reagent tray 1 (RTT1) to a 
clean reaction cuvette on the reaction carousel (RRV). 

The sample probe (SPP) dispenses the sample in the quantity required for the test from 
the sample tray (STT) into the RRV now containing R1.  

Sample dilution is possible if necessary. The diluent is placed in the RTT and 
dispensed into the reaction cuvette. Next, the sample is dispensed into the same cuvette 
by the SPP and mixed with the mixing rod. Now the diluted sample is in the reaction 
cuvette. The SPP dispenses the diluted sample in the reaction cuvette in which R1 
required for the test has already been dispensed. 

The dispensed sample and R1 are mixed in the reaction cuvette. Next, reagent 2/2e 
(R2/R2e, see ‘1.4.2: Three-part Reagents’ for details on reagents) is dispensed from the 
RTT as required. The contents are then mixed for the length of time required by the 
test.  Photometric measurement data is collected by the spectrophotometer every 13.5 
minutes to calculate concentration at each measurement point, which are posted to the 
workstation. 

The reaction cuvettes are washed with detergent and tepid water and blank 
measurement is performed for each wavelength.  
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1.4 Functional Features 
1.4.1 Simultaneous measurement of blood cell components (HbA1c) 

and plasma components 

Hemolysis of the sample is required to measure HbA1c in an automatic chemistry 
analyzer. 

BM6010/C has automatic on-board hemolysis function to enable high-throughput 
simultaneous measurements of plasma components (glucose, 1.5 AG, etc.) and blood 
cell components (HbA1c) of the blood sampled from a single tube. This procedure is 
called "simultaneous measurement" which is a special characteristic of the BM6010/C 
automatic analyzer. 

The blood sample, which is collected in a tube with anti-coagulant, needs to be 
centrifuged first, then decapped to be loaded on the analyzer.  The sample probe (SPP) 
aspirates the sample in accordance with the settings for the sample and assays to start 
the tests. The sampling order for simultaneous measurement is illustrated in the 
following diagram:  

 Sampling order during simultaneous measurement 

 

 
 

Centri-
fuge 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Aspirate plasma components 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dispense in a reaction cuvette 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Measure Glu, 1.5AG  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Measure HbA1c  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Aspirate 
blood cell 

components 

 

 
 
 
 
 
 
 
 
 

Dispense in a reaction 
cuvette. 

 
 
 
 
 
 
 
 
 
 
 
 

Dilute and hemolyse using 
pure water or dedicated 

diluent 

 
 
 
 
 
 
 
 
 
 

Dispense in a 
reaction cuvette 
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1 Serum / plasma component measurement: sampling of the upper phase of the sample 
tube.   
The sample probe (SPP) descends toward the sample surface. When the sensor 
detects the sample surface, SPP stops descending and aspirates the sample from the 
surface. 

2 Washing the SPP.   
The SPP returns to the wash port and descends by 15mm. The outer surface of SP is 
washed with wash solution in the wash port. 

3 Dispensing of the sample into the reaction cuvette  
The SPP dispenses the sample in the reaction cuvette, in which reagent 1 (R1) has 
already been dispensed. The analyzer starts running general chemistry analysis 

4 Washing the SPP. 
The SPP returns to the wash port and descends by 15mm. The outer surface of SPP 
is washed with wash solution in the wash port. 

5 Blood cell component measurement: sampling of the lower phase of the sample tube.  
The SPP descends near the bottom of the tube to aspirate the blood cell component 
sample. 

6 Washing the SPP.  
The SPP returns to the wash port and descends by 60mm. The outer surface of SPP 
is washed with wash solution in the wash port. 

7 Hemolysis of the sample.  
The SPP dispenses the sample in the reaction cuvette, in which the lysis solution has 
already been dispensed. 

8 Washing the SPP.  
The SPP returns to the wash port and descends by 15 mm. The outer surface of SPP 
is washed with wash solution in the wash port. 

9 The hemolysed sample is dispensed into another reaction cuvette to measure HbA1c.  
The SPP aspirates the hemolysed sample and dispenses it into a reaction cuvette, in 
which R1 has already been dispensed.  The analyzer starts running HbA1c analysis.   

 Throughput 

Maximum 800 tests / hour 

The HbA1c test involves hemolysis of the sample in a reaction cuvette prior to the 
measurement. The hemolysis procedure requires the time equivalent to that of a serum 
test (4.5 sec.). Therefore, one HbA1c analysis requires time equivalent to that for 2 
tests (4.5 sec. for hemolysis and 4.5 sec. for the actual HbA1c analysis = 9.0 sec.), 
making the throughput for HbA1c is 400 tests per hour.. When running a combination 
of a general chemistry test and HbA1c measurement, the throughput becomes 600 test 
per hour, running 2 tests in the time required for 3 tests.     
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1.4.2 Three-part reagents 

The analyzer can run tests with up to thr ee-part reagents.  The reagents are dispensed 
at the timing of measurement points shown below.  

Reagent Probe 1 ( RPP1) dispenses Reagent 1 in a reaction carousel (RRV) cuvette 
from the Reagent Tray 1 (RTT1).  Reagent Probe 2 (RPP2) dispenses Reagents 2e and 
2 from the Reagent Tray 2 (RTT2) in the RRV cuvette.  R eagent 1 is required for any 
reaction; reagents 2e and 2 are configured as required by each assay.   

In order to se up R2e and R2, log on as ‘manager’ and select [Setup] > [Analytical 
Parameters (Chemistry)].  (‘Manager’ can edit user-defined tests.) Enter the required 
volume for both [R2e Volume], [R2 volume], [R2e diluent volume] and [R2 diluent 
volume] in the [Analytical conditions] column.  

For two-part reagent tests, enter "0" for [R2e volume] and [R2e diluent volume]. 

 

The graph below shows an example of a test time course. 
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1.4.3 Diluting the sample  

 Dilution Steps: 

Fill the reagent bottle with diluent and set it on the reagent tray 1 (RTT1). 

If the sample does not need to be diluted, the reagent probe 1 (RPP1) 
dispenses the reagent 1 (R1) in a cuvette in the reaction carousel (RRV); then 
the sample probe (SPP) dispenses the sample into the cuvette. 

If the sample needs to be diluted, diluent, instead of R1, is first dispensed in 
the cuvette.  Then, the sample is added to the cuvette to make a diluted 
sample.  The mixing rod 1 (MIX1) mixes the diluted sample and the cuvette 
comes again to the sample dispensing position. SPP aspirates the diluted 
sample and dispenses it in another cuvette, into which R1 has already been 
dispensed. 

Then, MIX1 mixes the mixture again. If the assay requires R2e and R2, they 
are dispensed and mixed in accordance with the settings. 

 Setting up sample dilution 

Open [Setup] > [Analytical Parameters (Chemistry)] to set up the parameters. 

Click the [Analysis item condition setting (M)] button or [Rerun conditions] button and 
select "With dilution" for the [Dilution method] field. 

The sample is diluted according to the values set in the [Undiluted sample volume], 
[Diluent volume], and [Diluent volume from RPP] fields. 

 

Examples of sampling for sample dilution are shown below: 
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 [No dilution] 
[Sample volume]  SV=1-25µl 
[Dilution]  No 
[Undiluted sample volume]  ― 
[Diluent volume]  ― 
[Diluent position] (on RTT)  ― 
[Diluent volume from RPP] ― 

 
[With dilution] (Diluent) 

[Sample volume]  SV=1-25µl 
[Dilution]  Yes 
[Undiluted sample volume] DSV=1-25µl 
[Diluent volume]  DV=1-25µl 
[Diluent position ] (on RTT)  ≠0  1 -50  
[Diluent volume for diluent] 0 

 DSV＋DV－（SV＋3） ≧ 35 µl 
 
[With dilution] (Diluted diluents) 

[Sample volume]  SV=1-25µl 
[Dilution method]  Yes 
[Undiluted sample volume] DSV=1-25µl 
[Diluent volume]  DV=5-200µl 
[Diluent position] (on RTT)  ≠0  1 -50 
[Diluent volume for diluent] DDV =5-200µl 

 DV＋DDV＝25-200 µl 
 DSV＋DV＋DDV－（SV＋3） ≧ 35 µl 

Air 3µl 

SV＋3µl 

SP 

SPP 

Air 5µl Air 3µl 

17/16×DV＋10µl 
 of diluent on 
RTT1 

DSV＋sample 
3µl 

Dispense diluent Dispense sample 

RPP1 

Air 3µl 

DSV＋
Sample 3µl 

Dispense diluent 
and water 

Dispense 
sample 

Air 5μL 

DV 
RTT-1(diluents 
on RTT1 RPP1 SPP 

Water 
DDV 

SV: sample volume 
DV: diluent volume 
DSV: diluted sample volume 
DDV: diluted diluent volume 

 

  [With dilution] (Water dilution) 
[Reaction sample volume] SV=1-25µl 
[Dilution]  Yes 
[Undiluted sample volume] DSV=1-25 µl 
[Diluent volume]  DV= 25-200 µl 
[Diluent position]  0 
[Diluent volume for diluent] ― 

 DSV＋DV－（SV＋3） ≧ 35 µl 

Air 3µl 

DV 
(water) 

DSV＋
sample 3µl 
  

Dispense 
water 

Dispense 
sample 

 
Various sample dispensing patterns 

 Dilution conditions (M, D1, D2, D3, D4) 

 Setting "No sample dilution" 

The samples are not diluted in most of routine tests.  To set "no sample dilution" for a 
test, select [Analytical Parameters (Chemistry)] > [Analysis test condition setting (M)] 
button, and select “No dilution” for [Dilution method].  When registering tests for a 
sample in the [Request] > [Order Entry] window, select “1: M Cond.” for [System 
Dilution Mode]. 

 Setting "with Dilution" for a test 

If a test requires sample dilution for all samples, select [Analytical Parameters 
(Chemistry)] > [Analysis test condition setting (M)] button, and select "With dilution" 
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for [Dilution method].  Set appropriate values for [Undiluted sample volume], 
[Diluent volume], [Diluent position], and [Diluent volume]. 

When registering this type of test for a sample, select [Request] > [Order Entry], and 
select “1:M Cond.” for [System Dilution Mode]. 

 Setting "with Dilution" only for the samples with high result value for 
some test 

For the samples that are already known to have high values for certain tests, sample 
dilution can be set up for initial run.    

Select [Request] > [Order Entry], then select [With dilution] for [System Dilution 
Mode] and select an option from [D1 Cond.]-[D4 Cond.]. 

To set multiple dilution conditions for a sample, click [Multi. Dil.] button in the [Order 
Entry] window and set the required dilution conditions by clicking [M], [D1], [D2], 
[D3], and [D4] buttons.  When you set multiple dilution conditions for a sample, the 
sample volume and reagent volume are dispensed for each condition as configured in 
the setting..  
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1.5 Specifications 
 

1.5.1 Specifications of the analyzer 

The specifications of the analyzer are summarized in the following table. 

The installation conditions will be presented separately in section 1.6. 

 

Item BM6010/C 

Size 1220（W）×850（D）×1108（H）cm 
Weight 450 kg 
Power source AC200，220，230 or 240V±10％，50/60Hz，A  gr ound 

must be installed near the breaker．  
2.6 kVA 

Water Consumption  20 L/hour 
Measurement method  
Chemistry Open discrete 

Single-line, simultaneous, multi-item measurement 
ISE Na, K, Cl ion selective electrolyte assay  

Dilution measurement method 
Simultaneous measurement of serum and urine samples 

Test throughput  
 Simultaneous 

chemistry and ISE 
measurement 

Maximum 1200 tests / hour 

 Chemistry alone Maximum 800 tests / hour 
 ISE alone Maximum 600 tests / hour 
Sample throughput   
 Simultaneous 

chemistry and ISE 
measurement 

Maximum 800 samples / hour 

 Chemistry alone Maximum 800 samples / hour 
 ISE alone Maximum 200 samples / hour 
Number of test items    
 Simultaneous 

chemistry and ISE 
measurement 

Maximum 103 test items 
Routine  45 chemistry test items＋3 ISE test items 

Sample parameter / 
processing unit 

 

 Sample types 
measured 

Serum and urine 

 Tray Sample tray (STT): 2 rows (42 samples each = 84 total 
samples) 
      Barcode reader for sample ID 
Cooling tray (CTT)  used for calibrators, controls, and 
diluents with 61 total available positions. 
Point-in-space sampling for laboratory automation 
system (optional) 
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Item BM6010/C 

 Barcode reader Class 2 laser product 
Maximum output 1.0mW, pulse duration 112μs, emitted 
wavelength 650-660nm  

 Dispensed sample 
volume 

1 - 25μl (0.1 μl increments) 

 Sample dilution Reaction cuvette is used for sample dilution 
   Dilution ratio 1 - 200X 
   Dilution patterns Maximum 5 p atterns of dilution available for the initial  

run and rerun 
Different diluents and di fferent dilution ratio can be used 
for a primary sample 

 Rerun Primary sample in the STT is used for rerun 
 Liquid level sensor Incorporated 
Reagent parameter / 
processing unit 

 

 Dispensing system 3-part reagent capability, 2 probes  
 Trays Two trays, 45 positions each 
 Container capacity 20, 40, and 70 mL 
 Refrigerator All reagents 
 Reagent volume per 

test 
5 - 300 μL 

 Dispensing 
increments 

0.1μL 

 Reagent remaining 
volume  

Calculated based on the liquid level sensor detection 
result 

 Reagent barcode Standard barcode system for reagent containers of 
automatic analyzers specified by the Japan Analytical 
Instrument Manufacturers' Association  

 Barcode reader Class 2 laser product 
Maximum output: 1.0 mW, Pulse duration: 112 μs,       
Emitted wavelength: 660 nm, Class 2 laser product 
or 
Maximum output: 1.5 mW, Pulse duration: 65 μs ,         
Emitted wavelength: 650 nm, Class 2 laser product 

Reaction parameter / 
processing unit 

 

 Reaction tray Turntable style 
 Reaction cuvette 

material 
Plastic 

 Cuvette light path 
length 

10 mm 

 Reagent volume 80 - 430 µl 
 Stirring system Rotation and reciprocation with vibration cleaning 

Stirring immediately after additions of samples and 
reagents (R2e、R2) 

 Reaction time 3, 4, 5, 10, or 15 minutes 
 Reaction 

temperature 
37

 

o 

Reaction bath Inert liquid circulation method 
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Item BM6010/C 

 Reagent drain A drain line available for concentrated waste fluid with the 
optional dedicated bottle  

Measurement 
parameter / processing 
unit 

 

 Measurement 
method 

Reaction point measurement  

 Measurement point 63 measurement points, 1point per 13.5 seconds in 15 
minute reaction 

 Photometer Concave diffraction grating, rear spectroscopy system 
 Measurement 

wavelength 
14 fixed wavelengths between 340 - 884 nm; 1 or 2 
wavelengths are used for calculation 

 Light source Halogen lamp with cooling system   
 Assay method Photometric assays 

  • Endpoint assay (EPA) 
  • Reaction rate assay (RRA) 
  • 2-point rate assay (2PA) 
  • Constant rate assay (CRA) 
  • Immunoassay (IMA) 
  • 3-test simultaneous measurement (parameter 
independent) 
  • Prozone detection 
  • Point forwarding in rate assay 
  • Sample blank correction 

 Rerun system Automatic or manual (selectable) 
 Automatic correction Blood serum blank, cell blank, measurement point 

change, sample volume change in rerun 
Maintenance (including 
ISE unit) 

 

 Automatic 
maintenance 

Auto startup and shutdown scheduled by weekly timer  

ISE  Na, K, Cl ion selective electrolyte assay  
Dilution measurement method 
Simultaneous measurement of serum and urine samples 

Analysis   
 ISE  Simultaneous measurement of 3 test items 
 Mode 2 modes, either serum or urine 
 Data processing Correction available for serum and urine modes 

respectively. 
Other types of result processing are available including 
“ratio” parameters, flag display, and statistical calculation. 

Electrode  
 Na: Crown ether membrane 
 K Crown ether membrane 
 Cl Super-layer solid molecule orientation membrane 
 reference Sealed silver/silver chloride electrode 
Sample  

 Measurable samples Serum, Urine 
 Sample volume 22 μL 
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Item BM6010/C 

Calibration method  
 Upon measurement Internal standard measurement 
 Calibration 2-point calibration using low and high concentration 

calibrators (L-STD and H-STD respectively)  
 Standard substance 

for calibration 
NIST Standard salt #2201 and #2202 used as reference 

Sensitivity  
 Standard solution Changes in potential with L-STD for serum and urine for 

each measurement are: 
L-STD for serum L-STD for urine 
  Na 270 to 430 -15 to 385 
  K 160 to 330 75 to 825 
  Cl -160 to -40 270 to 400 

 Accuracy within ± 5% deviation  
 Measurement range               Serum                     Urine 

  Na:  100-200                  10-400 
   K:  2.5-200                     2-400 
  Cl:  50-200                  15-400 

Reference range for each test: 

The reference range for each test is as follows: 

Na: Serum 
Urine  

136 to 145 mEq/L 
40 to 220 mEq/day 

K Serum 
Plasma (male)  
Plasma (female) 
Urine  

3.5 to 5.1 mEq/L  
3.5 to 4.5 mEq/L 
3.4 to 4.4 mEq/L 
25 to 125 mEq/day (varies with diet) 

Cl Serum  
Urine 

98 to 107 mEq/L 
110 to 250 mEq/day 

Reference ranges based on Tietz NW, Clinical Guide for Laboratory Tests 3rd 
edition. WB Saunders Company, Philadelphia, PA, pp 610-611 (1995)  
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1.5.2 Reproducibility and Accuracy  

 Chemistry Tests Examples (when using reagents approved in 
Japan)  

Test Name/Method  Abbrev.  Reproducibility  Accuracy  

Aspartate aminotransferase / JSCC  AST  CV < 5%  CV < 10% 
Gamma glutamyl transpeptidase / 
JSCC  γ-GTP CV < 5% CV < 10% 

Total protein / Biuret  TP CV < 5% CV < 10% 
Triglyceride / GPO  TG CV < 5% CV < 10% 
Calcium / o-CPC  Ca  CV < 5% CV < 10% 

 ISE Tests 

Test Name/Method  Abbrev. Reproducibility Accuracy 

Sodium Na CV < 3% CV < 5% 
Potassium  K CV < 3% CV < 5% 
Chloride Cl CV < 3% CV < 5% 
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1.6 Installation 
 Environment 

 

Item Condition 

Power source AC200，220，230 or 240V±10％，50/60Hz  
Power consumption Maximum 2.6 kVA 
Ambient temperature 18 - 30°C (Variation: ±2°C / 1 hour or less) 
Change in 
temperature after 
calibration 

±5°C 

Humidity 40% - 70% with no condensation 
Ambiance Free of corrosive gas and significant vibration 

Free of electrical disturbances such as electromagnetic 
and electrostatic induction 

Altitude Up to 2000 meters above sea level  
Floor The system should be placed on a level floor (1/200 

gradient or less) that is capable of supporting a load of 450 
kg (990 lb) 

Pure Water 
Requirements 

Water temperature: 10 o

Dissolved oxygen: 8mg O
C - 30°C   

2/

Purity of pure water: 1µS/cm or less 
L or less (DO value) 

Overvoltage Category  II 
Pollution degree 2 
Drain outlet Height: up to 200 mm, opening diameter: 50 mm or over 
Water supply 
capacity 

40L/ hour or more 
Direct plumbing deionized water pressure: 1.4-14.2 psi (9.8 
– 98 kPa)  

Transportation and 
storage condition 

Temperature: -18 o

Fragile. Handle with care. Keep dry. Do not stack, do not 
overturn. 

C to +55 °C  

 

 Precautions for Installation 

• The system is for indoor use only.  An appropriate ventilation system is required in 
the installation room. 

• Sufficient ventilation space is required around the ventilation grids in the rear side 
of the system. The system should be installed at least 50 cm (20 inches) from the wall 
with nothing placed between the system and the wall that might block ventilation. 
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 Examples of installation room 
 

 

   

500 

1,220 740 

730 
850 Analyzer 

Unit: mm 

Workstation 

Pure water supply unit 

Power 
outlet 

Tap water 
supply Switch 

box 

Drain 

 
 

 Power supply specifications 

 Supply wiring requirements:  

USA or Canada UL listed cord for external wiring 
Must be CSA certified cord in Canada. 
Rated 600V, 105°C. 
Size AWG#14. 

EU Electric wire that is approved to a harmonized (HAR) 
standard  
Rated 300V or greater, 60°C or greater 
Size 2mm2

Other countries Electric wire that is approved to the national standard 
of the installation site.  
Rated 300V or greater, 60°C or greater 
Size 2mm

 or more, outside diameter 13 to 18 mm 
Circuit breaker - 15 or 20 amps. 

2 or greater, outside diameter 13 - 18 mm 
Circuit breaker: 15 or 20 amps. 
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 Connection specification (US / Canada) 

Customer
institution side

Instrument
side

Plug
NEMA 6-20P

Receptacle
NEMA 6-20R

Power supply
AC200V±10％,13A,50/60Hz
AC220V±10％,12A,50/60Hz
AC230V±10％,11A,50/60Hz
AC240V±10％,11A,50/60Hz

Switch Box

 
Disconnecting means in US and Canada: Plug. 

Make sure to connect the ground wire of power supply to the protective conductor 
terminal in the switch box. The system should be placed so that the operator can easily 
access the plug.  

Power supply wiring specifications: 

USA or Canada: Power is supplied to the system via plug connection. 
A NEMA 6-20R receptacle is required in the 
installation room.  

 N L 

 
NEMA 6-20R Receptacle  

 3-wire configuration with a protective ground wire 
covered with green and yellow striped material.  
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 Connection specification (EU and other countries) 

Power supply
AC200V±10％,13A,50/60Hz
AC220V±10％,12A,50/60Hz
AC230V±10％,11A,50/60Hz
AC240V±10％,11A,50/60Hz

Switch Box

Customer
institution side

Instrument side

 
Disconnecting means in EU and other countries: breaker installed in the switch box  

The system should be placed so that the operator can easily access the connection 
device.  

Make sure to connect the ground wire of the power supply to the protective conductor 
terminal in the switch box. 

An appropriate external circuit breaker should be available as a connection device at 
the installation site.  

Switch type should be either circuit breaker or knife switch.   
The operation room should have sufficient space to accommodate a switch box. 

The switch box should be located within 5 meters (15 feet) of the system for good 
accessibility. Mark the analyzer's particular breaker or knife switch in the switch box 
to avoid confusion. 
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 Wiring inside the analyzer 

 Front side 

ISE Buffer Bottle(ISE)
Incubation Bath Oil Bottle(IBO)

Cuvette Conditioner Bottle(CW)
Cuvette Wash Solution Bottle(CCon)

Label Information
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 Rear side 

To PC SLEEP INTERFACE CONNECTOR
【SLEEP】

①

To LAS(Laboratory Automatic System)
/URH(Universal Rack Handler)
【URH/LABCELL】

To LAS/URH Barcode Reader
【BCR】

To PC Power Supply
【PC】

To PC ETHERNET CONNECTOR

②

③
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 Connector 

①  

 

To LAS/URH Barcode Reader 

【BCR】 

 

To LAS(Laboratory Automatic System) 

/URH(Universal Rack Handler) 

【URH/LABCELL】 

 

 

②  

 

Outlet rating information 

 

Power supply to the 

workstation 

【PC】  

③  

 
To PC ETHERNET 

CONNECTOR 

 

To PC SLEEP INTERFACE 

CONNECTOR 

【SLEEP】 
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Pin No. Signal 

1 N/A 
2 RD 
3 SD 
4 N/A 
5 Signal Ground 
6 N/A 
7 N/A 
8 N/A 
9 N/A 

 

• Connection specification of LAS/URH barcode reader 

 
 

Pin No. Signal 

1 TIM  
2 RD 
3 SD 
4 N/A 
5 Signal Ground 
6 NG 
7 RS 
8 CS 
9 +5V 

  

Connector pin layout 

Connector pin layout 
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1.7 Descriptions of Units and 
Components 
The analyzer system BM6010/C comprises two main units: the analyzer and 
workstation. 

 

 

Analyzer Workstation 
 

BM6010/C System - whole view 
 

This section describes the names of units and components of the analyzer and 
workstation. 

The details and functions of the units and components used for routine analysis will be 
described in the section 1.8. 



 

 

ICABM6010/C-4  1-25 

C
hapter 1 

O
verview

 and M
ain Features of BM

6010/C
  

1.7.1 Workstation  

 

LCD Monitor 

Keyboard 

PC main unit 

Mouse 

Printer 

 
 

 The PC, LCD monitor, and printer delivered may be different from those 
shown in the picture above. 

 

 For the details of the PC, monitor, and printer, please refer to the instruction 
manual attached to each. 
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1.7.2 Analyzer  

The units and components of the analyzer are shown in front, top, and rear views. 

1.7.2a Front view 

 

Reaction bath 
oil bottle 

Sampling pump 

Cuvette Wash 
Solution-7 bottle 

Cuvette conditioner 
bottle 

Power panel 

Washing water supply pump 

Reagent pump 1 

Reagent pump 2 

LWP* pressure gauge LWP line filter 

圧力計 

Top cover 

Button panel 

 
*LWP stands for large water supply pump 
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1.7.2b Top view 

 

Sample tray 

Sample probe unit 

Mixer 2 
Mixer 1 

Reagent tray 2 

ISE unit 

Reagent 
probe unit 1 

Reaction 
carousel 

Reagent tray 1 Reagent probe unit 2 

STAT port 

 
 

 

 

Sample probe 
(SPP) unit 

Mixer 2 

Mixer 1 ISE Unit 

Reaction 
carousel 

Sample tray 
(STT) 

Reagent 
tray 2 

 

Reagent probe 
(RPP1) unit 1 Reagent probe 

(RPP2) unit 2 

Reagent 
tray 1 

STAT port 
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1.7.2c Rear view 

 

Water 

supply and 

drainage lines 

Main power switch (for whole instrument)  
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1.8 Functions of the Units and 
Components of the Analyzer 

 

1.8.1 Units and components on the front side 

The only unit on the front side required for routine analysis is the power panel. 

1.8.1a Power panel 

 1) READY light 

2) START light 

4) ALARM light 

7) SYSTEM STOP button 

3) Operate/standby switch 

5) Power light 

6) Refrigerator light 

 
 

1) READY light 

The READY light is lit when the analyzer is ready to begin analysis.  
 

2) START light 

The Start light is lit when the analyzer is in operation. 
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3) Operate/Standby switch 

This switch is used for selecting whether the PC will control the ON/OFF status of the 
analyzer.  Normally the [PC CONTROL] position is selected. 

PC CONTROL: The analyzer is turned on/off automatically with the workstation's 
startup and shutdown.  

   ON: The analyzer is turned on.  

 
  OFF: The analyzer is turned off. (Even in the OFF status, the refrigerated reagent 

compartment is electrically connected.) 

4) ALARM light 

This light is lit when some error is detected in the analyzer. 

5) Power light 

This light is lit when the analyzer is turned on. 

6) Refrigerator light 

When green, this light indicates refrigeration is at normal temperature; a continuous 
yellow light indicates low temperature while a blinking yellow light indicates high 
temperature. 

7) SYSTEM STOP button 

This button is used for an emergency suspension of the analyzer's operation. 
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1.8.1b Button panel 

 STT rotate button 

RTT1 rotate button 

STAT light 

RTT2 rotate button 

 
 

The [STAT] button displays the status of the STAT sample measurement. You can 
rotate the position of the sample or reagent by pushing the [STT] or [RTT] buttons.  

 STAT light  

Status of the STAT port is indicated by the LED lamp color.  

Green: Analysis using the STAT port is available. You may place a new sample in the 
STAT port.  

Orange: STAT sample measurement is in operation. You may not remove the sample 
placed in the STAT port.  

 RTT1 rotation button 

Pressing this button rotates the reagent tray 1 (RTT1). The button is active when the 
system is in the READY or Reagent-PAUSE mode.  

 RTT2 rotation button 

Pressing this button rotates the reagent tray 2 (RTT2). The button is active when the 
system is in the READY or Reagent-PAUSE mode.  

 STT rotation button 

Pressing this button rotates the sample tray (STT). The button is active when the 
system is in the READY, Processing, or PAUSE mode.  

If the STT operation has been specified as the “TT Continuous Mode” in the [Setting 
System Parameters] window, the STT rotation button is only available in the [READY] 
mode.  
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1.8.2 Units and components on the top side 

The units accessed from the top of the analyzer which are required for routine 
measurement are the sample tray (STT) / refrigerated tray (CTT), the reagent tray 
(RTT), and the sampling probe (SPP). 

1.8.2a Units for sampling operation 

 

Sample 
barcode reader 

Sample tray 
(STT) 

Refrigerated tray 
(CTT) 

 
 

STT/CTT 

 Functions 

The sampling operation units are used for inserting patient and control samples and 
calibrators for measurement. 

Samples are moved to the aspiration position by the tray rotation. 

 Specifications 

STT Used for routine samples and multipoint calibrators 
Comprises two rows to accommodate a total of 84 samples (42 samples in 
each of the inner and outer rows)  
Includes a built-in barcode reader for sample identification 

CTT Used for calibrators and control samples 
Comprises two rows to accommodate a total of 61 samples (34 samples in 
the outer row and 27 in the inner row)  
Includes a refrigeration control system 

 Operation 

In the [INITIALIZE] mode (see next section for various system modes)     
The tray turns clockwise and stops when the STT position 1 comes to the 
aspiration position. 

The analyzer performs "initializing operation" at the start of measurement.  Next, the 
STT rotates clockwise or counter-clockwise so that the next sample moves 
more quickly to the aspiration position.   
When the sample barcode is used, STT makes a full turn clockwise for 
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each barcode reading.   
In the STT continuous mode, STT rotates clockwise at the shortest 
possible interval for a sample (4.5 seconds). 

 
    

1.8.2b Sample probe (SPP) unit  

 
Sample 
probe unit 

Wash port 

Sample 
probe 

 
SPP unit 

 

 

Sampling pump 

Washing solution pump 

 
Sampling pump (SP) 

 Functions 

The SPP aspirates a volume of sample from STT and discharges it into a cuvette in the 
reaction carousel in accordance with the specified test conditions.  The SPP unit has a 
built-in liquid level sensor. 

 Specifications 

Dispensed sample volume: 1 - 25μL (at a 0.1μL increment) 
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 Operation 

In the [INITIALIZE] mode (see next section for operation modes)  
The sample probe (SPP) moves to it s highest position, rotates over the 
reaction carousel, and stops above the SPP wash port.  The pumps are in 
stand-by status, which is the same status after the SPP discharged the 
sample. 

 

During measurement, after the above initialization operation, the SPP p erforms the 
next three steps in the following order. 

 Discharge of 
sample in reaction 

cuvette 

Sample aspiration 
(Sample tray) 

Probe wash 

 
SPP sequence 

When the liquid level sensor detects a sample shortage before aspiration, SPP does not 
aspirate the sample but goes directly to the wash port. 

 Flow diagram 

 

Sample probe 

Sampling pump 

Washing solution pump 

Solenoid valve 

Degassing 
device 

Pure water 
bottle 

Sample 
container 

 
Sampling flow diagram 
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1.8.2c Reagent tray (RTT) 
 

 
 

RTT 
 

 Reagent barcode reader 

 
 

Reagent barcode reader 

 Functions 

Used for setting reagents for the test  Reagent 1 is set in the reagent tray 1 (RTT1) and 
Reagents 2 and 2e are in the reagent tray 2 (RTT2).  Also used for loading sample 
diluent, routine detergents, and reagent probe washes. 

The reagent trays rotate to the reagent aspiration position in accordance with the test 
condition. 
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 Specifications 

Number of reagent bottles loaded: 45 each  

20 mL, 40 mL, or 70 mL bottles can be loaded 

One bottle can be used for multiple tests; likewise, multiple bottles can be used for a 
single test. 

Includes a built-in barcode reader for reagent identification 

Includes a refrigeration control system 

 

 Operation 

In the [INITIALIZE] mode, the reagent tray turns clockwise and stops when the first 
bottle comes to the aspiration position. 

During measurement, the reagent tray (RTT) rotates so that the next reagent quickly to 
the aspiration position.  
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1.8.2d Reagent probe (RPP) unit 
 

 

Wash port Wash port 

Reagent probe unit 2 Reagent probe unit 1 
Reagent probe 1 Reagent probe 2 

 
 

RPP unit 

 Functions 

The RPP aspirates a volume of reagent on the RTT and discharges it into the cuvette in 
the reaction carousel in accordance with the specified test condition.  The RPP unit 
includes a liquid level sensor. 

 Specifications 

Capable of dispensing up to three reagents 

Dispensed volume of Reagent 1: 25 - 300 μL (in 0.1μl increments) 

Dispensed volume of Reagents 2 and 2e: 5 - 300 μL (in 0.1μl increments) 

Dilution of condensed reagent with pure water is available. The reagent is diluted upon 
dispensing. 

Dispensed volume of diluted reagent 1: 5 - 300 μL (in 0.1μl increments) 

The maximum volume that a reaction cuvette can accommodate is 430µl  w hich 
includes the sample volume. 
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 Operation 

In the [INITIALIZE] mode, the reagent probe (RPP) moves to its highest position, 
rotates over the reaction carousel, and stops above the 
RPP wash port. The pumps are in stand-by status, 
which is the same status after the RPP discharged the 
sample   

During measurement, after the above initialization operation, the RPP performs the 
next three steps in the following order. 

 Dispensing reagent in 
reaction cuvette 

Aspiration of reagent 
(from reagent bottle) 

Probe wash  

 
RPP sequence 

 

 Flow diagram 

 

RPP 

Reagent pump 

Washing solution pump 

Solenoid valve 

Degasser 

Reagent bottle Pure water 
bottle 

 
RPP-related flow diagram 



 

 

ICABM6010/C-4  1-39 

C
hapter 1 

O
verview

 and M
ain Features of BM

6010/C
  

1.8.2e Reaction carousel (RRV) 
 

 

Reaction 
carousel 

Reaction 
cuvette 

 
RRV 

 Functions 

Holds reaction cuvettes and provides a temperature controlled environment for the 
reaction. Temperature is maintained by a reaction bath which is kept at 37o

Each reaction cuvette passes in front of the spectrophotometer by the RRV rotation.  
As the reaction cuvette is suitable for both the reaction and optical measurement, the 
absorbance of the reaction solution in the cuvette can be directly measured.  

C.  

 Specifications 

Number of cuvettes: 231 (11 cuvette holders with 21 cuvettes per holder)  

Cuvette light path length: 10 mm 

 Operation 

In the [INITIALIZE} mode, RRV rotates counterclockwise up to two rotations until the 
reaction cuvette #1 comes to the reagent 1 dispensing 
position. 

During measurement, the analyzer does not perform the initialization operation when it 
starts measurement.  
The carousel rotates as follows: 

1. Clockwise rotation for 42 cuvettes. 

2. Clockwise rotation for 37 cuvettes. 

3. Counterclockwise for 3 cuvettes. 

 It takes 4.5 seconds to complete all three steps; each 
movement of 4.5 seconds is called 1 motion which 
corresponds to a rotation of 76 cuvettes. 

 This rotation pattern supports sample dilution. 
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1.8.2f Reaction bath 
 

 

Reaction 
bath 

2 reaction bath oil level sensors 

 
 

Reaction bath 

 Function 

Maintains a constant temperature for the reaction solution in the reaction cuvette. 

 Specifications 

Temperature  37oC (Analyzer ambient temperature 18-30o

Reaction temperature deviation  ±0.1

C) 
o

An inert oil is used as the reaction bath oil. 

C 

Reaction bath oil bottle contains two sensors:  
One for triggering replenishment of the reaction bath 
oil  
One for alerting for the reaction bath oil shortage     

Integrated automatic oil replenishing function  

Integrated oil shortage alarm function 
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 Flow diagram 

 

Filter Circulation 
pump 

Check valve 

Reaction bath oil 
 

Heater 
Pressure 
gauge 

Solenoid valve 

Drain cock 

Drain Oil replenishing pump 

Reaction bath 

Sensors 
A and B 

A:  Sensor for triggering replenishment of the reaction bath  
B:  Sensor for alarming for reaction bath shortage 

 
Bath oil temperature controlling diagram 

 Operation 

If the oil surface level becomes lower than the sensor A, the oil replenishing pump is 
activated for a certain period of time to replenish the reaction bath oil.  If the oil 
surface level is lower than sensor B level, an “Empty” error occurs. 
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1.8.2g Mixing units 

 Mixer 1 Mixer 2 

Wash port Wash port 
 

Mixing units 

 Function 

The mixing units stir the reaction solution dispensed in the reaction cuvette. 

 Specifications 

Mixing Back-and-forth / rotation mixing the reaction solution 
directly with a rod 
Strong and weak mixing options are available. 

Mixer 1 (MIX1): Stirs Reagent 1 and diluted sample 

Mixer 2 (MIX2): Stirs Reagent 2e and 2 
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 Operation 

In the [INITIALIZE] mode, the mixers move to their wash ports.  It a mixer is already 
at the wash port position, it is raised, then lowered.   
Finally, both MIX1 and MIX2 are raised from the wash 
ports. 

 

During measurement The analyzer performs "initializing operation" at the 
start of measurement.  However, they are not raised 
from the wash ports.  The sequence that follows is as 
below: 

 

 Reaction cuvette 
(to mix reaction solution) 

Mixer wash port 
(to wash mixer) 

 
Mixer sequence 

1.8.2h Reaction cuvette wash unit (WUD) 

 Reaction cuvette 
wash unit 

 
WUD 

 Function 

The WUD washes the reaction cuvettes after measurement and drains the wash solution. 
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 Specifications 

Washing nozzles used are as follows: 

 
第7ポート 第6ポート 第5ポート 第4ポート 第3ポート 第2ポート 第１ポート

 Ｉ     Ｃ3  Ｂ3Ｈ5Ｇ  Ｆ Ｈ4Ｃ2  Ｂ２Ｈ3Ｅ  Ｄ Ｈ2Ｃ1  Ｂ1Ｈ1Ａ

Nozzle1 Nozzle 2 Nozzle 3 Nozzle 4 Nozzle 7 Nozzle 6 Nozzle 5 

 

Wash Nozzle layout 

A for draining reaction solution 

B1-B3

C

 for discharging wash solution  

1-C3

D for discharging detergent 

 for draining wash solution 

E for draining detergent 

F for discharging Cuvette Conditioner-EX 

F for draining Cuvette Conditioner-EX 

H1-H5

I for vacuuming remaining liquid from cuvette 

 for aspirating overflow liquid 

 

The cuvette detergent and JEOL provided “Conditioner-EX” are first diluted with pure 
water from the pure water bottle located in the lower front compartment of the analyzer. 
(  See Section 1.7.2 of this chapter) before dispensed in the cuvette. The dilution rate 
is as follows: 

Cuvette wash solution 7     x 10 

Cuvette Conditioner-EX     x 40 
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 Operation 

In the [INITIALIZE] mode, the wash nozzles are raised to the highest position and 
then suspended.  When a nozzle is already in t he top 
position, it is lowered first and then is raised again. 

During measurement, the cuvette is washed and dried via ports 1 to 7 as follows: 
 

Step Wash solution Port 

1 Pure water 1 
2 Cuvette wash solution 7 (10%) 2 
3 Tepid pure water 3 
4 Cuvette conditioner EX (2.5%) 4 
5 Tepid pure water 5 
6         -        (Draining) 6 
7         -        (Drying) 7 
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1.8.2i Spectrophotometer 
 

 

Lamp Lamp coolant tank 

Spectrophotometer 

 
 

Spectrophotometer 

 Function 

The spectrophotometer measures the light absorption of the liquid contained in the 
reaction cuvette. 

 Specifications 

Spectrophotometer:    Concave diffraction grating, rear spectroscopy system 

Spectra available:  One or two wavelengths can be used per test 

340, 410, 451, 478, 505, 545, 571, 596, 658, 694, 751, 805, 845, 
or 884 nm. 

Lamp: 12V, 50W halogen lamp with forced cooling system  
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1.8.2j Top cover 
The top cover remains locked during operation; it must be unlocked to be opened for 
routine maintenance services. Steps for unlocking are as follows: 

 Steps to unlock the top cover 

1. Prepare a ball-point pen or mechanical pencil. 
2. The locking device is located as shown below. 

 

Pushing hole 

Guide Lane Lever 

 
3. Push out the pen point and insert the tip in the pushing hole of the lever. 
4. Raise the lever toward upper right along the guide lane. 

 

 
5. Keeping the lever in the raised position, insert your hand under the top 

cover to raise it up. 
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Lift up 

Keep the pen 
tip in the 
pushing hole 

 
 

 Steps to close the top cover 

1. Lower the top cover slowly until the locking device locks. 

2. Make sure that the cover will not come open even when you try to. 
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1.9 System mode and operation 
buttons 
In the [Startup] window of BM6010/C displayed on the workstation screen, click the 
[OK] button in the lower middle of the window to display the following Operation 
Panel which will appear in the upper right. The system mode is shown in the upper 
right box in the Operation Panel. 

 

 Operation buttons 

 

 

Buttons in the Operation Panel
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 Analyzer Modes 

The table below summarizes each mode and the operation button(s) available in the 
mode. The [System Stop] button in the lower part of the power panel shown in the 
section 1.8.1a can be used to immediately stop the operation of the system in any mode. 

System Mode Status of the Analyzer Available Button 

[WAIT] The analyzer has not been initialized yet. [INITIALIZE] 
 

[INITIALIZE] The analyzer is being initialized.  
[READY] The analyzer has finished initialization. Any operation can 

be started. 
[START] The analyzer is in operation. [PAUSE] 

[R-PAUSE] 
[STOP] 

[PAUSE] The analyzer is in operation but has 
temporarily suspended dispensing the 
sample.  

[START] 
[STOP] 

[Smart PAUSE] The analyzer is in operation but has 
temporarily suspended dispensing the 
sample. Opening the sample tray cover 
triggers this mode. 

[START] 
[STOP] 

 

[Reagent PAUSE] The analyzer is in operation but has 
temporarily suspended dispensing the 
sample. The reagents are already 
dispensed. 

 

[PROCESSING] The analyzer is in operation and the 
sample has already been dispensed. 

[START] 

[PAUSE SHIFT] The system is shifting to [PAUSE] mode. [START] 
[STOP] 

[R-PAUSE SHIFT] The system is shifting to [Reagent 
PAUSE] mode. 

[START] 
[STOP] 

[Proces.SHIFT] The system is shifting to the 
[PROCESSING] mode. 

[START] 
[PAUSE] 

[R-PAUSE] 
[END] The analyzer is still in operation but is 

ready to stop because all samples have 
been processed.  

 

[WASH] Washing is in progress. [STOP] 
[PRIME] Priming is in progress. [STOP] 

[STAT START] The analyzer is running a STAT 
(emergency) sample. 

[STOP] 
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 Function of each operation button and the system mode 

The functions of the SYSTEM STOP (emergency stop) button on the Power Panel and 
the six buttons in the left side of Operation Panel are summarized in the table below 
together with the system mode after using the button. 

Button 
Modes in which 

the button is 
used 

Function 
Mode after 

the button is 
used 

[SYSTEM 
STOP] All modes 

All operations are immediately 
stopped. 

[WAIT] 

[INITIALIZE] 
[WAIT] 

[READY] 
The units of the analyzer are 
initialized. 

[INITIALIZE] 

[START] 

[READY] 

The analyzer starts operation in 
accordance with the settings 
configured in the [Start Condition] 
window. 

[START] 

[PAUSE] 

The analyzer releases the 
temporary pause of sample 
dispensing in accordance with the 
settings configured in the [Start 
Condition] window. 

[PROCESSING] 

The analyzer starts sample 
dispensing in accordance with the 
settings configured in the [Start 
Condition] window. 

[PAUSE SHIFT] 
The analyzer returns to the system 
mode before the [PAUSE] button 
was pressed. 

[R-PAUSE 
SHIFT] 

The analyzer returns to the system 
mode before the [R-PAUSE] 
button was pressed. 

[Proces.SHIFT] 
The analyzer returns to the system 
mode before the [PROCESSING] 
button was pressed. 

[PRIME] 
[START] 

[Proces.SHIFT] 

The analyzer shifts to the 
temporary suspension of the 
sample dispensing. 

[PAUSE 
SHIFT] 

[R-PAUSE] 
[START] 

[Proces.SHIFT] 

The analyzer starts to shift to 
temporary suspension of sample 
dispensing, but completes reagent 
dispensing.  

[R-PAUSE 
SHIFT] 

[PROCESSING] 

[START] 
[PAUSE] 

[PAUSE SHIFT] 
[R-PAUSE 

SHIFT] 

The analyzer shifts to the system 
mode for sampling completion. 

[Proces.SHI
FT] 

[WASH] [READY] The analyzer begins washing. [WASH] 
[INITIALIZE] [READY] The analyzer begins priming. [PRIME] 
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1.10 ISE (ion-selective electrode 
analyzer) unit 
This section describes the ISE unit integrated in the system for sodium (Na), potassium 
(K), and chloride (Cl) measurement.  

 Components of the ISE unit 

 

 

Electrodes: 
Ref, Na, K, and 
Cl 

ISE dilution bowl 
(nozzles are located 
inside) 

BPEV 

Degassing 
device 

DPEV 

Wash bottle 
(WB) 

ISPEV 

Syringes for buffer and 
internal standard solution
（DP, ISP, BP） 

 

Side view of the ISE unit 
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 Flow diagram 

 
Flow diagram 

 Measurement 

• An ISE measurement is selected in the same way as a chemistry measurement.  
Ordering measurement of Na, K, or Cl will activate the analyzer to perform only the 
test ordered. 

• Undiluted sample is required for ISE measurements, therefore sampling for an ISE 
measurement must always come before that of chemistry measurement.  When 
selecting an ISE measurement only, the results are displayed in the [RealTime 
Monitor] window after the measurement is finished.  The results can also be printed 
in batch. 

 Calibration 

• Calibration should be performed at least once a day. 

• Calibration is available in two modes: serum and urine. Both modes can utilize 
either type of calibrator, the high-density calibrator (H-STD) or the low-density 
calibrator (L-STD), for measurement. 

• When a buffer, electrode, or consumable (except printing paper) is exchanged or 
maintenance service is performed, be sure to perform calibration before subsequent 
operation. 

• After measurement, the slope value and dilution factor are displayed in t he 
[Realtime Monitor] window. These values are also displayed in the [ISE Monitor] 
window. 

• Calibration can be selected from the [ISE Operation] window accessed from 
[Maint.] button or from the [Start Conditions] window accessed from [START] 
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button in the Operation Panel.  
When calibration is executed from the [ISE Operation] window, the ISE unit is 
independently activated for calibration. When calibration is selected from the [Start 
Conditions] window, the analyzer as a whole starts its preparatory movement; 
calibration is performed at the same time. The settings for calibration started from the 
[Start Conditions] window are defined in the [ISE Parameters Settings], [CTT Set], 
[CTT/STT set], [Test Select], and [Sample Select] windows.   
The settings for calibration are not linked between those activated from [ISE 
Operation] window and those from [Start Conditions] window. Therefore the 
parameters, including calibrator position, should be defined separately. 

 Reagent 

The reagents used in the ISE unit are as follows: 

• Buffer 

• Internal Standard (IS) solution 

• Standard (Calibrator) Set (Serum, Urine) 
 

 Warning 
If the buffer, IS solution, or calibrator comes in contact with skin, wash thoroughly with 
soap and water.  In case of accidental eye contact, wash the eye with running water and 
seek medical assistance. In case of accidental ingestion, seek medical assistance 
immediately. 

 

 

• When serum, plasma, or urine is measured in the unit, be sure to use the buffer, IS 
solution, and calibrator specified by JEOL.  If a reagent or calibrator not specified by 
JEOL is used, the measurement result may be incorrect, the analyzer's interior flow 
system may become deteriorated, and the life of the electrode may be shortened 
significantly. 

• Preservatives are added to the buffer, IS solution, and calibrator to prevent 
deteriorated. However, it is advised to use the liquid reagents as soon as possible 
after opening. 

• The opened buffer and calibrator can be stored in a sealed bottle at the room 
temperature. 

• Improper storage of the buffer and calibrator (eg. left unsealed) may cause 
performance degradation which will result in inaccurate measurements even before 
the expiration date.  

• Please make sure that the calibrator does not become concentrated when using a cup 
as container.  The degradation degree may depend on the cup type, temperature, and 
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humidity, but generally do not use the calibratort that has been left for over 20 
minutes after dispensed in the cup.  

• Be sure to set the buffer in the specified position.  If loaded in a wrong position, it 
can result in incorrect measurements and damage to the analyzer. 
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2.1 Basic Settings 
This section describes the settings to be made prior to measurement. 

2.1.1 System specification settings 
Configure the settings for system operation. 

Select [Setup] > [System Specification Settings]. The [System Specification Set] 
window is displayed. 

 
 

If you change settings in the [System Basic Configuration], [Rerun Settings], [Serum 
Indices Measurement], [Smart PAUSE], and [Auto Reagent PAUSE] columns in this 
window, the new settings will be effective after shutting down the system and 
restarting with "New Start" selected in the “Bio Majesty” starting window. The new 
settings selected in the other columns will be effective after starting the analyzer from 
the [READY] mode. 

 Setting items in the [System Basic Configuration] column 

[ISE Module] This item selects whether the system includes the Ion 
Selective Electrode (ISE) unit. The default value is 
“Avail. (ISE09-)”. 

[Sample delivery] Select "N.A." when you use the sample tray.  
Select "RACK Handler" when you use an optional rack 
handler.  
Select "LAS" when you use an optional laboratory 
automation system. 

[Number of rack] Indicate the number of samples placed on a rack when 
you selected "RACK Handler" for [Sample delivery]. 
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[On-line] This item selects whether the system is connected to 
LIS or not. 

[Sample barcode] Select "Avail." when you use the barcode pasted on the 
sample container for sample identification. 

[Reagent barcode] Select "Avail" when the barcode label is pasted on the 
reagent bottle. When using a reagent barcode, the 
barcode reader reads the label on the bottle anywhere 
on the RTT, eliminating the need to select the bottle 
position on the display of the workstation. 

[STAT port barcode] Select "Avail." when you use the barcode pasted on the 
sample container placed in the STAT port for sample 
identification. 

[External sample barcode] Select "Avail." when you selected “LAS” for above 
[Sample delivery] and use the barcode pasted on the 
sample container for sample identification. 

Barcode identification serves to confirm the sample arrival at the analyzer. 
This is an optional function. 

[Conc. Waste Bottle] This item selects the availability of the optional 
concentrated waste bottle. 

 Setting items in the [Rerun Settings] column 

[Auto rerun] Select whether to use the automatic rerun function or 
not. 

[OFF] Select this option if you do not use the automatic rerun 

 function. 

[ON (from STT)] Select this option to use the sample from the sample 
tray (STT) for rerun.  When you have selected "On 
(from STT)", you cannot remove the sample from the 
tray until sampling is completed for the rerun. 

[Manual Rerun] 

[Flagged Tests and Untested Tests]  
Select this option to run the tests not completed in the 
previous run and those that were completed but should 
be rerun. 

[Untested Tests Only] Select this option to run the tests that were not 
completed the last time. 

[All Tests] Select this option to run all the tests again at rerun. 

 Setting items in the [Serum Indices Measurement] column 

Select how the serum index is measured. 



 

 

ICABM6010/C-4  2-3 

C
hapter 2 

M
easurem

ent Settings 
 

[Run only when defined test is run]  
Select this option to perform the serum index 
measurement when the tests ordered in the [Order 
Entry] window for the sample include the serum index 
measurement. 

[Run for all samples] If the tests ordered in the [Order Entry] window for the 
sample do not include the serum index measurement, 
select this option. The top-priority test selected as test 
#1 in the [Analytical Parameter (Serum)] is 
automatically run. 

[Not required] Select this option when you do not wish to perform the 
serum index measurement. 

 Setting [Smart PAUSE] 

[STT Cover] Opening the sample tray (STT) cover triggers the 
[Smart PAUSE] function in which the analyzer enters 
[PAUSE] mode; closing the STT cover returns the 
analyzer to the [START] mode and resumes operation.  
Select "Avail." to use this function. 

 Setting for [Auto Reagent PAUSE] 

[Auto Reagent PAUSE] This function allows the replacement of reagent bottles 
during measurement.  
With this function, the analyzer pauses automatically 
when a reagent shortage is detected during 
measurement.  
Select "Avail." to use this function. 

Additional settings are required for the "Auto Reagent PAUSE" option. 
 Refer to “Section 4.12 R-PAUSE” as required. 

 

 Setting the values in the [Sample Container Specifications] 
column 

The analyzer controls the probe movement and judges the sample volume based on the 
sample container type indicated here.  The sample probe may be damaged if the values 
entered are incorrect. 
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[Type] Select a container number (Container 1 – Container 9).  
Enter the following values for the selected container 
number. 

[Container name] Enter a name for the container. 

[D1][D2][D3] Enter the diameter of each dimension as indicated 
below (unit: mm). 

[h1][h2][h3] Enter the height of each dimension as indicated below 
(unit: mm).  
Remove the sample tray and measure the height of the 
container from the aluminum plate beneath the tray. 

 

h1 

h2 

h3 

D1 

D2 

D3 

Upper surface of the aluminum 
plate under the STT 

Sample 
container 

 
 

[Height Correction] Adjust the aspiration height in 0.1 mm increments when 
the rack handler or LAS is used for sample delivery. 

[LLS.sensitivity] Select the sensitivity of the liquid level sensor.  The 
default value is "Med." 

[Liq.volume judge] Select whether to judge the liquid level with the liquid 
level sensor. "Avail" is the default value.  Select "N.A." 
for a small quantity sample such as a pediatric sample 
whose liquid level might be low and undetectable. 
When you select "N.A.", be sure that the container has 
sufficient volume of sample so that the measurement 
data will be correct. 
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 Setting the values in the [Reagent Bottle Specifications] column 

The analyzer controls the movement of the reagent bottle and judges the reagent 
volume on the basis of the reagent bottle type selected here. An incorrect setting will 
cause erroneous measurement results. 

[Type] Select a container number (Container1 to Container 9).  
Enter the following values for the selected container 
number. 

[Container Name] Enter a name for the container. 

[Bottle Section Area] Enter the capacity of the bottle.  Four options are 
available:  
7mL  －  80mm2 
20mL － 300mm2 
40mL － 470mm2 
70mL － 850mm

[LLS. sensitivity] Define the sensitivity of the liquid level sensor.  "Med." 
is the default value. 

2  
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2.1.2 Settings for [System Monitor] 
The [System Monitor] window is used to view the status of analyzer and also to select 
some functional options. 

Select [Maint.] > [System Monitor]. The [System Monitor] window is displayed. 

 
 

 [During-operation system set] column 

The options changed in this column are immediately effective even when the analyzer 
is operating. 

 

[Realtime monitor] Indicates the display type of the [Realtime monitor] 
window. 

[Routine analysis] Selects how data is displayed in the [Realtime monitor] 
window after completion of sample measurement. 

[STAT analysis] Selects how data is displayed in the [Realtime monitor] 
window after completion of STAT sample measurement. 

[Variance value display] Selects whether to display the variance value on the 
[Realtime monitor] which allows continuous 
monitoring for abnormalities in the reaction process. 

[Not Do] Hides the variance value. 

[Display when there is flag]   
Displays the variance value only when a flag is posted 
(See Section 11.1 for further information about flags). 
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[Do] Displays the variance value regardless of the flag status. 
 

<Example of display> 

Test Name Conc. flag ABS-RB ABS E1 E2   ・・・  
Fe     98.65                    0.0132      -0.0148   0.0228   -0.0062 ・・・  
  0.12670      0.14629     0.00399  0.09974    
Ca     8.85                     0.1908        0.3906   ・・・・・・・・・・・・  

 

The second line of each test shows the following values: (in order, left to right) main 
wavelength for reagent 1, sub wavelength for the reagent 1, main, sub for the reagent 
2e, main and sub for the reagent 2. 

In the above example, the main wavelength for reagent 1 is 0.12670, the sub-
wavelength for reagent 1 is 0.14629, the main wavelength for reagent 2 is 0.0039, and 
the sub-wavelength for reagent 2 is 0.09974.  

[On-line] Selects whether to activate communication between the 
analyzer and a laboratory information system (LIS) if 
one is connected. When "Not do" is selected, the 
analyzer will be used as a stand-alone device. A 
laboratory automation system (LAS) can be used with 
the analyzer even when "Not do" is selected. 

[Error judge rate (vs. previous data)]  This is a function which determines whether an 
error has occurred on the basis of the difference 
between the present and previous result values. The 
options are "Do" and "Not do". When "Do" is selected, 
the values entered in the [Error judge rate (vs. previous 
data)] are used for the error judgment. Select 
[Analytical Parameters (Chemistry)] > [Error judge rate 
(vs. previous data)] button to open the window. 

 [Pre-operation set] column 

Selections made in this column are immediately effective. 

[Chemistry] Selects whether chemistry tests are performed.  

[ISE] Selects whether ISE tests are performed.  

[Rack Handler/LAS] Selects whether to connect to the optional external rack 
handler or the LAS. 

 [Clot Detect] 

[Clot Detect] Selects whether to use the clot detection function.  

[Clot Sensitivity] Selects the sensitivity of the clot sensor. 
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2.2 Registering New Tests 
This section describes the steps to register a new test to the analyzer. 

Following steps can be also performed in [Setup] > [New Test Registration] window. 
Sub-windows for the test registration can be opened directly from the [New Test 
Registration] window.  

2.2.1 Setting analytical conditions 
New parameter settings must be entered for each test.   

2.2.1a Basic settings 

Select [Setup] > [Analytical Parameters (Chemistry)] to display the window below. 

If 1 - 90 is selected for [Analy.cond.no.], some parameters are grayed out and 
unchangeable as they have been automatically selected. If 91 - 100 is selected, the 
[Analytical Parameters (Chemistry)] window is displayed as below and all the 
parameters can be changed. 

 
 

  [Analy.cond.no.] field 

Enter a number (1 - 100) for the analytical condition you wish to define. 

Use the [Up] and [Down] buttons to change the number.  Alternatively, select a test 
name from the drop-down menu of the field below the [Up] and [Down] buttons.  
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  [Analytical conditions] column 

[R1 Volume]  Enter a value between 25 -300 μL in 0.1 μL increments. 

If the volume of reagent 1 + the volume of diluent for reagent 1 is > 25 μL, a 
value between 5 and 300μL can be entered for [R1 volume]. 

[R2e volume][R2 volume]  Enter a value between 0.5 -300 μL in 0.1 μL increments.  
The value "0" means that no reagent is used. 

[R1 Extra vol][R2e Extra vol][R2 Extra vol]  Enter a value only when you want to 
change the supplementary reagent volume that the 
reagent probe (RPP) aspirates.  Normally, no value is 
entered. 

[R1 diluent vol][R2e diluent vol][R2 diluent vol]  Enter a value between 0.5 and 300 
(μL) in 0.1 μL increments. 

The total reaction solution volume (sample volume + reagent volume + 
reagent diluent volume) should be between 80 and 430 (μL). 

The total volume of the reagent and reagent diluent should be between 25 
and 300 μL. 

[Sample vol (S)][Sample vol (U)] Enter the sample volume to be used for 
measurement.  
Enter a value between 1 and 25 (μL) in 0.1 μL 
increments.  
This value will be automatically shown in the [Reaction 
sample volume] of serum and urine in the [Analysis test 
condition setting (M)] window. 

[Reagent 1 mix][Reagent 2e mix] [Reagent 2 mix] Select "Weak" or "Strong" to define 
the force of the mixer that stirs the respective reagent. 

[Reaction Time] Select "3 min.", "4 min.", "5 min.", "10 min.", "15 
min.", "21 min." or "31 min." 
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 [Analysis Test condition setting (M)] button 

Click this button to display the window below. 

 
 

[Sample type] Select a sample type. Options are "Serum", "Urine", 
"STAT/Priority", "Control (A-M)", "Control (N-Z)", 
"BLK" and "STD". 

[Dilution specification]   Options are "Do" and "Not do".  
If "Not do" is selected, the analytical condition for 
serum or urine is automatically applied to run the 
sample selected in the above [Sample type].  
If "Do" is selected, you can define a new analytical 
condition in this window to run the sample selected in 
the above [Sample type]. Define the new condition by 
filling the following fields. However, defining a new 
analytical condition in this window is not available 
when “Serum” or “Urine” is selected for the above 
[Sample type].    

[Dilution correction]，[Liquid volume correction] "Do" or "Not do" can be selected 
depending on the selected sample type and dilution 
method. The default value is "Do".  If "Not do" is 
selected, no corrective calculation is applied to the 
analysis result based on the dilution factor and reaction 
solution volume. 

[Reaction sample volume] Enter 1 - 25 (μL) in 0.1 increments for the sample 
volume used in analysis.  
The values entered here will be automatically displayed 
in the [Sample Vol (S/U)] field in the [Analytical 
Parameters (Chemistry)] window. 
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[Dilution method] Select either "No dilution" or "With Dilution".  
"With Dilution" is a setting to dilute a sample in a 
reaction cuvette. Following fields also need to be filled 
when “With Dilution” is selected; [Undiluted sample 
volume], [Diluent volume], [Diluent position], and 
[Diluent volume from RPP]. 

[Undiluted sample volume] Enter a value between 1 and 25 (μL) in 0.1 increments 
for the volume of undiluted sample before being 
dispensed in the cuvette. 

[Diluent volume] Enter a value between 25 and 200 (μL) in 0.1 
increments for the volume of diluent dispensed in the 
cuvette for sample dilution. 

Enter a value between 5 and 200 (μL) in 0.1 increments if the diluent is to be 
diluted.  
However, the total volume of the diluent volume plus the diluent (pure 
water) volume from RPP should be between 25 and 200 (μL). 

The total of [Undiluted sample volume] + [Diluent volume] - ([Reaction 
sample volume] + 3μL) should be > 35μL. 

[Diluent position] Enter the position number on the reaction tray 1 
(RTT1) in which the diluent is placed.  Enter "0" when 
the pure water is dispensed from the RPP directly 
through the RPP line as diluent.  
Two or more diluent bottles can be placed on RTT1.  
For example, when you have placed the bottles in 
positions #43, 44, and 45, enter "43-45". 

[Diluent volume from RPP]  This field is available only when a value is entered in the 
[Diluent position] field.  The aspirated diluent is 
dispensed with the pure water by the pump.  

[Diluent volume]+[Diluent volume from RPP]＝25 - 200μL 
[Undiluted sample volume]+ [Diluent volume]+[Diluent volume from RPP]-
([Reaction sample volume] + 3μL) should be > 35 μL. 

 See Section 1.4.3 Diluting the Sample for more details on the steps for 
sample dilution. 

 [Multiple Dil. Conditions] option 

When this option is selected, multiple dilution conditions are applied to the test. 
Therefore, when the test is ordered, two or more dilution conditions can be selected in 
the [MultiDil.] column in the [Order Entry] window. When "Sub-analy. Conditions" 
are selected for a sample, different dilution conditions can be set for each condition. 
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When this option is not selected, multiple dilution conditions cannot be applied to the 
test. Even if the sub-analysis conditions have been defined for that test, the test is 
always run under the same dilution condition. 

Deselect this option for a "Ratio" test where a ratio is calculated between the values of 
tests with same analytical conditions but with different sub-analysis conditions. In this 
case, the dilution condition should be the same for all tests. By deselecting this option, 
the same dilution condition is automatically applied for all tests.  

 [Sub Param.#] field 

The sub-parameter number is the number of measurement values obtained from the 
reaction in one cuvette. Click the [UP] or [DOWN] button to choose from one, two, or 
three results per reaction. 

  [Sub-analy.conditions] column 

[Name] Enter a name in up to 6 alphanumeric characters. 

[Digits] Enter 0 - 4 to define the number of decimal places. 

[M-wave.L.], [S-wave.L.] Select a wavelength from 14 options: "340nm", 
"410nm", "451nm", "478nm", "505nm", "545nm", 
"571nm", "596nm" "658nm", "694nm", "751nm", 
"805nm", "845nm", and "884nm".   Select " *****" if 
you do not wish to select a sub-wavelength. 

[Analy. mthd] Select an analysis method from the options: "EPA (end 
point assay)", "RRA (reaction rate assay)","2PA (2-
point assay)", “CRA (constant rate assay)”, and “IMA 
(immunoassay)". 

[Calc.mthd] Select a calculation method for calibration: "ABS 
(absolute)", "STD (standard)", and "MSTD (multi-
standard). 

[Qualit.judge] Options are "Do" and "Not do".  When "Do" is selected, 
click the [Qualit. judgment set] button to enter the 
values necessary to perform the qualitative judgment. 
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 [Qualitative Judgment Set] button 

Click this button to display the window below. 

 
 

[Smp.type] Select "Serum/Urine", "Serum" or "Urine". 

[Qual.judg.type] Select "Qualitative" or "Critical". 

 When “Critical” is selected, upper and lower limit values are used for 
defining a target range. Measurement values between limit values are 
displayed as a numerical value; measurement values above and below the 
limits are displayed as less than or greater than the limit, i.e. "<0.3" will be 
displayed for all the values below 0.3.  Enter a very large value for the 
upper limit value if you do not wish to judge the upper limit.  

 

[Ranges] Enter the value ranges for qualitative and critical 
judgment. 

For qualitative judgment Define the threshold value for displaying flags such as 
"-" and "+". 

For critical judgment  Only the left-most and right-most values are valid. 

[Disp. Characters] Enter a mark or character to indicate the value is within 
the limits defined in the [Ranges] field.  In critical 
judgment, only the left-most and right-most marks or 
characters are valid. 
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 [Real-Time Correction Formula] button 

Click this button to display the window below. 

Use this window to enter the correction formula for serum and urine samples. 

The correction formula is applied to all the measurement values then the results are 
displayed.  

 
 

[Formula] Enter the correction formula for serum and urine 
respectively.  
Use the following symbols in entering the formula (e.g. 
"x*10/a^b".)  
x: raw measurement data (concentration) 
a, b, c, d: factors (defined in the "Factors" fields)                
*, /,  +, -: four arithmetic operations                      
1～9，“．(a period)” : Fixed value 
R(  ) : root 
L(  ):  log 
^( ）: power 
( , ): parentheses 

[Factors a-d] Factors used in the formula 

[Verify formula] button Click this button to display the [Realtime correction] 
window below. 

 
 

 Enter a tentative value in the [Test Data] field and click 
[Execute] to display the result value in the [Results] 
field. From the value displayed, the validity of the 
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formula can be judged.  Click [Save] to save the factors 
entered in this window. 

 [Rerun conditions] button 

Click this button to display the [Rerun conditions] window below. 

Four rerun conditions from [Dilute 1 (D1)] to [Dilute 4 (D4)] can be defined as "Rerun 
conditions" in this window 

 
 

 See “Section [Analysis Test Condition Setting (M)]” in “Section 2.2.1a: 
Basic Settings” in this chapter. 

 Conditions for [Dilute 2] and [Dilute 3] in the [Rerun conditions] window are 
automatically set to the conditions entered for [Dilute 1], but they can be 
edited. 

 [Rerun Conditions Set] button 

Click this button to display the [Rerun Conditions Set] window below. 

 
 

Select whether to rerun the tests for the items listed in this window. When selecting a 
rerun, one condition can be chosen from the conditions [M], [D1], D2], [D3], and [D4].  
The rerun conditions [M], [D1], [D2], [D3], and [D4] are defined as follows: 
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[M] The conditions as defined in the [Analysis test 
condition setting (M)] window. 

[D1]，[D2]，[D3]，[D4] The conditions defined respectively in the [Rerun 
conditions] window for [Dilute 1], [Dilute 2], [Dilute 3], 
and [Dilute 4]. . 

 

 
ATTENTION  

 

To perform a ratio calculation between the results of a test with three different sub-
analytical parameters (sub-parameter #1, 2, or 3), a same dilution condition must be set 
for the three sub-parameters in [Rerun Conditions Set] window. If different dilution 
conditions are set for the three sub-parameters, the result of a ratio calculation may be 
an abnormal value.   

 [Flag Setting] button 

Click this button to display the [Flag Setting] window below. 

 
 

Select "Yes" to post a flag with the abnormal result of the relevant item, or "No" to not 
to post a flag, when displaying or printing the result. 
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 [Normal value setting] button 

Click this button to display the [Normal Value Set] window below. 

 
 

[Infant/Adult Range] Enter the age limit respectively for [Male], [Female], 
and [Unknown].  The patient is regarded as adult if 
his/her age is the same or older than the entered age. 

[Serum h]，[Serum l] Enter the upper limit of the normal serum value in the 
[Serum h] fields and the lower limit in the [Serum l] 
fields. 

 [Abnormal value setting] button 

Click this button to display the [Abnormal value setting] window below. 

 
 

[Sample type] Select "Serum" or "Urine". 

[Report data select] column 

[Abnormal value (L) or (H)] Enter the values beyond which a measurement is 
considered outside the normal range (abnormal). 
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[Borderline data rate] If all the measurement values are abnormal and the 
value with low dilution is judged "H" and that with 
high dilution "L", a “difference rate” is calculated. The 
“difference rate” is defined as the difference between 
the two values divided by the value obtained with the 
higher dilution. If this difference rate is lower than the 
value set here, the above two values are judged to be 
borderline measurements. "Data (X)" indicates the 
measurement value with the dilution condition "X". 
"x1" indicates the difference between the "Data(M)" 
and "Data(D1)", "x2" indicates the difference between 
"Data(D1)" and "Data(D2)", etc.  

[Data selection for Data Comment] Flag "f", "q" or "a" is posted for the selected item 
of the following.  

[f: Plural normal data] When two or more normal values are obtained, select 
which value to report: [Low dilute data] or [High dilute 
data]. 

[q：Borderline data] When no normal value is obtained, yet both "L" and 
"H" values exist and borderline data exist, select which 
value to report, [Low dilute data] or [High dilute data]. 

 In the [Abnormal value] fields, enter the values that satisfy the following 
conditions.  
L1<H1, L2<H2, L3<H3, L4<H4, L5<H5 

[a: No normal data] When no normal value is obtained, select which value 
to report: the [Lowest dilute data] or the [Highest dilute 
data] for all the measured values. 

 See Section 6.1.3e and Section 11.2 for details. 

 [Standard setting] column 

Select the standard to be used in the [Standard setting] column located in the upper 
right section of the [Analytical Parameters (Chemistry)] window. The parameters are 
as follows: 

[FV] Define the concentration of the calibrator when "STD 
(standard)" calculation method is selected, or the factor 
value when "ABS (absolute)" calculation method is 
selected. 

[BLK H], [BLK L], [STD H], [STD L] 
Define the ranges of absorbance for the blank and the 
standard calibration. 
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 [Multi-STD Setting] button 

Click this button to display the [Multi-Standards Set] window below. 

 
 

Use this window when "MSTD" is selected for [Calc. mthd] in the [Sub-
analy.conditions] column. 

You can prepare a series of calibrators with several concentrations automatically by 
diluting a calibrator using various dilution factors. This series of diluted calibrator is 
then used to generate the calibration curve for multi-point calibration. 

Use this window to define the dilution condition for each point of the calibration curve. 

[Formula] Select an approximation formula to generate the 
calibration curve.  Select either [BLANK: passes] or 
[BLANK: not pass.] when defining the formula.  
Selecting [BLANK: not pass.], you can enter a value in 
the [FV] field for BLK. 

[Axis. conv.] Select an axis conversion method to use in generating 
the calibration curve after measurement. 

[Points] Define the number of data points used to generate the 
calibration curve (up to ten points are possible 
including the blank).  

[FV] Define the concentration of each calibrator. 

[Reaction sample volume] Enter a value between 1 and 25 (μL) in 0.1 increments 
for the sample volume used in calibration. 

To set conditions for [Dilution method], [Undiluted sample volume], [Diluent volume], 
[Diluent position], and [Diluent volume from RPP]:  
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 See [Analysis Test Condition Setting (M)]

[STD-H], [STD-L] Define the upper and lower allowance limits of 
absorbance measured. 

 in “Section 2.2.1a: Basic Settings” 
in this chapter. 

 When the volume and dilution condition of the calibrator is different from 
those for serum measurement, the "FV" value should be edited. 

 See “Section 2.3.2 Multi-standard” as required.  

 [Error judge rate (vs. previous data)] button 

Click this button to display the [Error judge rate (vs. previous data)] window below. 

 
 

Enter the allowance in this window to judge if the difference in absorbance between 
the current and previous measurements is within the allowable range. 

The difference rate is calculated using the following formula: 

( )%100
 n valuecalibratio previous

n valuecalibratiocurrent   - n valuecalibratio previous
×  

If this rate is higher than the allowance range, the value is judged as abnormal and flag 
"z" is posted to the result. The new calibration result will not be used and the previous 
calibration result is maintained.  

  The "Error judge rate (vs.previous data)" function is not available unless 
"Do" is selected for [Error judge rate (vs.previous data)] in the [System 
Monitor] window. 

 

[BLK], [STD], [MSTD0-9]  Enter the allowance rate (%) for each field.   

 [Calculation method setting] column 

The parameters in the [Calculation method setting] column are different depending on 
the analytical method. 

 See “Chapter 6 Data Processing” 
 

for details. 
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2.2.1b Settings for measuring urine samples 

 Serum and urine 

When selecting tests to perform on a sample, specify the sample type "serum" or 
"urine".  The tests are performed on the sample according to the analytical conditions 
specified for each type. See the "[Analytical test condition setting (M)] window section 
below for instructions for defining the sample type. 

You can enter different values depending on the serum or urine sample type for the 
following analytical parameters; the [Sample Vol.] fields in the [Analytical conditions] 
column and for the [Analysis test condition setting (M)] and [Rerun conditions] 
windows. Common parameters include reagents, mixer force, detected wavelength, 
calculation-related settings, and calibration-related settings. 

Parameters concerning the measurement results can also be defined by sample type in 
the [Qualitative Setting], [Real-time Correction Formula], [Normal value setting] and 
[Abnormal value settings] windows which are accessed by using the respective buttons 
in the [Analytical Parameters (Chemistry)] window. 

(The basic settings for the serum sample were described in Section 2.2.1a; therefore, 
the settings for the urine are described here.) 

 Setting the analytical conditions 

Select [Setup] > [Analytical Parameters (Chemistry)]. The [Analytical Parameter 
(Chemistry)] window is displayed. 
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 [Analytical conditions] column 

[Sample Vol (U)] Enter the urine sample volume to be dispensed into the 
reaction carousel (RVV) cuvette. Enter a value between 
1 and 25 μL in 0.1μL increments. 

 [Analysis test condition setting (M)] window 

Click the [Analysis test condition setting (M)] button located in the lower left of the 
[Analytical Parameters (Chemistry] window to display the [Analysis test condition 
setting (M)] window. Select "Urine" for the [Sample type] field on top of the page. 

Set the other parameters in the same way as described in “Section 2.2.1a: Basic 
Settings.” 

 [Rerun conditions] window 

Click [Rerun conditions] button in the [Sub-analy.conditions] column to display the 
[Rerun conditions] window. 

Select "Urine" for the [Sample type] field. 

Set the other parameters in the same way as described in “Section 2.2.1a: Basic 
Settings.” 

 Defining the data processing and flag conditions 

Click the [Qualit. judgment set], [Real-time correct.form.], [Normal value setting], and 
[Abnormal value setting] buttons respectively to display the corresponding window. 
Define the parameters separately for serum and urine sample type in these windows. 

Set the other parameters as described in “Section 2.2.1a: Basic Settings.” 

 Defining the ratio parameters 

Select [Setup] > [Ratio Parameters]. The [Ratio Parameters] window is displayed. 

See Section 2.3.4 for details. 

 Defining QC samples 

Select [QC] > [QC Sample Definition]. The [QC Sample Definition] window is 
displayed. 

Select "Urine" for the [samp. type] field in the [Control Sample Definition] column. 

 This defines the control sample to be run using the analytical conditions for urine and 
used exclusively for urine measurement. 

 



 

 

ICABM6010/C-4  2-23 

C
hapter 2 

M
easurem

ent Settings 
 

 

2.2.1c Settings for measuring HbA1c 

The following settings are required for measuring HbA1c. 

 [Sampling Position Setting] window 

Select [Setup] > [Analytical Parameters (Chemistry)]. The [Analytical Parameter 
(Chemistry)] window is displayed. Click the [Sampling Position Setting] button to 
display the [Sampling Position Setting] window. 

Select the sample aspiration position. You can define the position by both test and 
sample category such as patient sample, control sample, calibrators, etc.   

Click the arrow in each field to select either "Top" or "Bottom" from the drop-down 
menu.  
[Top]    The sample probe (SPP) aspirates the sample from the liquid surface.  
[Bottom]  SPP aspirates the sample near the bottom of the sample container. 

 
[Sampling Position Setting] window 

[No. Name1 Name2 Name3] The test # and names defined in the [Process Sequence] 
window are displayed. 

[Patient/STAT/Pri.] In this column, the sampling positions of the patient, 
STAT, and priority samples are selected. The upper 
field selects the sampling position of the patient and 
STAT samples.  
The lower field selects the sampling position of the 
priority samples. 

[Control （A-M/N-Z）] In this column, the sampling positions of control 
samples are selected. The upper field selects the 
sampling positions of the control samples A - M.  
The lower field selects the sampling positions of the 
control samples N - Z. 
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[Calibrator] In this column, the sampling positions of calibrators are 
selected. The upper field selects the sampling position 
for the reagent blank.  
The lower field defines the sampling position of the 
standards. 

[Multi-Standard] In this column, the sampling positions of standards 
used for multi-standard measurement are defined. The 
sampling position of the reagent blank and calibrators 
(STD1 – STD9) are defined respectively. 

[Next Page]/[Prev Page] buttons  Click [Next Page] to proceed to the next page and 
[Prev Page] to go back to the previous page. 

[Height Setting] button Click this button to display the window below. This 
window is used to specify the height of the sampling 
position from the bottom when "Bottom" is selected. 
Enter "1" mm for measuring HbA1c. The default value 
is "1". 

 
[Sampling Height Setting] window 

Buttons in [Sampling Height Setting] window 

[OK] button in  Click this button to save the current setting values and 
close the [Sampling Height Setting] window. 

[Cancel] button Click this button to close the window without saving 
the entered settings. 

 

Buttons in [Sampling Position Setting] window 

[Clear] button Click this button to reset all sampling positions to 
"Top". 

[Print] button Click this button to print all the sampling position and 
height settings. 

[Cancel] button Click this button to quit the [Sample Position Setting] 
window without saving the entered settings. 

[OK] button Click this button to save the current settings and close 
the [Sampling Position Setting] window. 
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2.2.1d Settings for ion selective electrode (ISE) measurement 

Select [Setup] > [ISE Parameter Settings] to display the [ISE Parameter Settings] 
window. Use this window to set parameters for the data acquisition and processing of 
ISE measurements. 

 
[ISE Parameter Settings] window 

 Data processing settings for Na, K, and Cl measurements 

This window is used to enter settings for processing measurement values for Na, K, 
and Cl respectively. 

Setting items are the test name, number of decimal places, real-time data correction 
formula, display of flags for abnormal values, rerun, range of abnormal values, range 
of normal values, concentration of calibrators (H-STD/L-STD), limit value of the slope, 
and the upper limit value of selectivity check. 

 [Analy.cond. no.] column 

In each [Analy.cond.no.] field, the number corresponding to Na, K, and Cl is 
automatically displayed. 
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 [Analysis condition] column 

 
The following table gives an explanation of the analytical condition parameters.  

 

Parameter Explanation 

Test  nam e Enter up to 6 one-byte characters (alphanumerical) or 3 
two-byte characters (Japanese, Chinese, etc.)  
However, the test name will be automatically entered as 
Na, K, or Cl when the CV check, interval check, 
calibration, or selectivity check is performed. 

Digits Enter 0 - 2 to define the number of decimal places used 
when displaying the measurement data. 
However, the number of decimal places is always "1" for 
Na and Cl, and "2" for K when displaying/printing the 
values from the CV check, Interval check, and 
Selectivity check. 

Real-time correct. Click this button to select a formula for correcting the 
measured concentration. 
Enter a separate formula for serum and urine. See 
“Section 2.2.1a: Basic Settings”
• The formulas are not applied to the values from CV 

check, interval check, and selectivity check because 
they are values for maintenance.  

 for details. 

Rerun cond., Flag Print 
Setting 

Select "To be rerun" or "No rerun" for each rerun 
condition. When "To be rerun" is selected, an automatic 
rerun is performed for a patient sample with flagged 
data.  Flags for rerun can be defined for each test. 

 

 [Standard value set] column 

The following table summarizes the parameters in the [Standard value set] column in 
the [ISE Parameters Setting] window. 
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Parameter Explanation 

Abnormal v. (serum) The threshold of abnormal values for serum 
measurement.  The upper limit is indicated with "H" and 
the lower with "L".  The default value is the limit 
concentration with which the measured potential of each 
test and the concentration value keeps the linearity (limit 
of linearity). 
• If "No flag" is selected for [Limit of abnormal value], 

the flag "H" or "L" will not be posted even when the 
measurement value is out of the normal range. 

Abnormal v. (urine) The threshold of abnormal values for urine measurement.  
The upper limit is indicated with "H" and the lower with 
"L".  The default value is the limit of linearity value for 
each test. 
• If "No flag" is selected for [Limit of abnormal value], 

the flag "H" or "L" will not be posted even when the 
measurement value is out of the range. 

[Normal value set] 
button 

Click this button to display the [Normal Value Set] window 
where the age ranges and threshold values are entered 
respectively for serum and urine. The upper limit is 
indicated with "h" and the lower with "l". 
• If "No flag" is selected for [Limit of abnormal value], 

the flag "h" or "l" will not be posted even when the 
measurement value is out of the range. 

Slope upper limit (h), 
Slope lower limit (l) 

The slope of the calibration curve is out of the range set 
by the upper and lower limits, the flag "h" or "l" is posted 
as an alert. Analysis can continue in either "h" or "l" 
status. 
The slope value for Cl will be negative, however, it is 
converted to positive value when judging slope validity. 
Therefore, enter positive values for Cl in this window as 
for Na and K. 
The upper limit (h) and lower limit (l) are common with 
serum and urine. 
The default values are 63 for the upper limit and 45 for 
the lower limit, which are common with Na, K, and Cl 
• The threshold slope values are 65 for the upper limit 

and 38 for the lower limit. They are default values and 
automatically entered in [ISE Parameter Settings] 
window. When the value reaches these thresholds, it 
is posted with "H" or "L" flag and judged to be a slope 
error.  When this error occurs, the ISE calibration data 
for both serum and urine samples are deleted.  

Therefore, repeat the calibration and obtain a new 
normal calibration values; alternatively, transfer 
existing values by selecting [ISE Monitor] > [Data 
transf.] 
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 Measurement settings common to all Na, K, and Cl measurements 

Some settings are common for all Na, K, and Cl measurements. These settings include 
the sampling volume, the number of calibration curve data points, whether to combine 
priming and washing of the ISE unit with those of the chemistry unit, the number of 
priming times, positions on the refrigerated sample tray (CTT) of calibrators and the 
pure water for washing electrodes.  

The table below summarizes the contents of the [Electrolyte Set] column located at the 
right side of the [ISE Parameter Settings] window. 

 
 

Item Description 

Calibration The calibration setting is used when the calibration 
is started by clicking the [START] button in the 
Operation Panel. 

CTT positions of 
calibrators 

The CTT positions of the high concentration 
calibrator (H) and the low concentration calibrator 
(L) are defined separately for serum and urine.  
Default positions are C-12 for Serum (H), C-11 for 
Serum (L), C-14 for Urine (H) and C-13 for Urine 
(L). 
When you change the CTT position or container 
type, click the [CTT Set] button in the top bar to 
open the [CTT Setting] window for confirmation. 

[Serum/Urine] field Select a calibration mode from "Serum", "Urine", 
or "Serum/Urine".  The default value is 
"Serum/Urine". 
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Item Description 

Selectivity check Enter a value to evaluate electrodes when they 
are checked with the selectivity check solution.  If 
the concentration is greater than the set value, the 
reading is flagged with "u". 

• Na upper limit Enter the upper limit of normal electrode sensitivity 
for Na.  The default value is "160". 

• K upper limit Enter the upper limit of normal electrode sensitivity 
for K.  The default value is "6.0". 

Prime/Electrode Wash Enter values when performing the "priming" and 
"electrode wash" of the ISE unit in combination 
with [PRIME], [WASH1], [WASH2], and [WASH3] 
of the Chemistry unit. 
When you change the CTT position or container 
type of the detergents, click the [CTT Set] button 
in the top bar to open the [CTT Setting] window for 
confirmation. 

• PRIME Select "with prime" to prime the ISE unit 
simultaneously with the chemistry unit. When 
"none" is selected, priming of the ISE unit must be 
started independently. 

• WASH1, WASH2, 
WASH3 

Select "with prime" to prime the ISE unit when 
one of the WASH is being performed at the 
chemistry unit.  
Select “with e. wash” to wash the ISE unit when 
one of the WASH is being performed at the 
chemistry unit.  
When "none" is selected, washing and/or priming 
of the ISE unit must be started independently. 

• Prime times Enter the number of priming sequences in the 
[INITIALIZE], [PRIME], and [WASH] procedures 
respectively. The default value is "2".  The value 
range is 0 - 3. 

• Detergent position Enter the CTT position number of the ISE 
detergent solution used for electrode washing 
during the [WASH] procedure. The default value is 
"C-15". 
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 Command buttons 

The table below summarizes the functions of buttons on the top bar in the [ISE 
Parameters Setting] window. 

 

 
 

Item Description 

Save Click this button to save the changes made in the [ISE 
Parameters Setting] window. 

CTT Set Click this button to display the [CTT Setting] window. 
Check that the CTT positions of the calibrators for the 
current test and the ISE detergent solution do not 
overlap with those of the calibrators and control 
solutions for other tests. 

Cup/Tube Type Click the arrow to select the container type to place on 
the CTT.  The container types and names must be 
entered in the [System Specifications Set] window 
beforehand.  Be sure to select an appropriate container. 

Print Click this button to print the settings entered in the [ISE 
Parameters Setting] window with the current date. 
Be sure to print the window for record of the defined 
settings in case of power outage or system failure. 

Clear Click this button to reset the values in the [ISE 
Parameter Setting] window to default. 

Exit Click this button to close the [ISE Parameter Setting] 
window. 
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2.2.2 [System Test List] window 
Select [Setup] > [System Test List] to display the [System Test List] window. Select 
the reagent bottle positions for each test in this window. 

 

 Items in the window 

The system test list is organized by the [System test #] on the basis of which the 
corresponding [Anal.cond. #] and reagent tray (RTT) position number of each reagent 
are defined. Use the [Anal.cond. #] that has already been selected in the [Analytical 
Parameters] window. 

When you use the barcode of the reagent bottle, enter a 5-digit code (manufacturer 
code for the first 3 digits and test code for the last 2 digits) in the field to the right of 
the [R1], [R2e], or [R2] button. 
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 Select the test order 

Click the [Analysis Order] button on the top bar to display the window below. 

 
 

Select the order of tests that use the reagent specified by the [System Test #].  
However, when two or more tests are performed on one sample, the following priority 
rules dictate the order of the tests:   

Priority 1: Test that requires long reaction time 

Priority 2: Contamination avoidance 



 

 

ICABM6010/C-4  2-33 

C
hapter 2 

M
easurem

ent Settings 
 

 

2.2.3 [Process Sequence] window 
Select [Setup] > [Process Sequence] to display the [Process Sequence] window. Select 
the order of tests by [Cond. No.] for data processing. 

 
 

 Select the data processing order 

After the data processing order is selected in the [Process Sequence] window, the tests 
are displayed in the processing order in the [Test Table] in the [Order Entry] window 
(accessed from the [Request] button).  The [Process Sequence #] is used as a test code 
in the laboratory information system (LIS). 

  The test code used when the analyzer is connected to the LIS can also be 
defined in the [Online Settings] window. 

The "Cond. no" are listed in the left column for the tests with the measurement order 
defined in the [System Test List] window.  Enter the "Cond. nos." of the tests you want 
to define under the [Cond. no.] column to the right of the [Seq. no.] column. After 
entering the [Cond. no.], the test name is automatically displayed in the [Test name] 
column.  This "Test name" in the [Process Sequence] window can be edited if desired. 

 After the "Test name" is changed, the new name is displayed.  However, 
note that the test name defined in the [Analytical Parameters (Chemistry)] 
window does not change. 
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 Insert or delete a test 

Click the [<-SP] button where you want to insert a test.  Note that a field will be added 
and the “Seq. nos.” below the inserted test will adjust automatically.  

Click the [DEL] button to delete a test. Note that a field will be deleted and the “Seq. 
nos.” below the deleted test will adjust automatically. 

In order to delete a test without changing the “Seq. nos.”, use the [Clear] button on the 
top bar to display the [Clear] window in which the specified test entry can be deleted. 
Enter the Seq. no. of the test you want to delete in the [Clear no.] field and then click 
[OK]. The fields of the deleted test in [Process Sequence] window will be blank and 
the “Seq. nos.” of the tests below the deleted one do not change.    

Test insertions and deletions are immediately reflected in the [Processing Test Order] 
and [Print Monitor Order] columns. 

 

 Selecting the display order of the tests on the monitor 

Select and highlight a test in the [Print Monitor Order] column and click the [Up] 
button to move the test upward or the [Down] button to move it downward. 
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2.2.4 [Reagent Container Set] window 
This window is used to define the container type placed in each position on the reagent 
tray (RTT). 

Select [Reagent] > [Reagent Container Settings] to display [Reagent Container Set] 
window. 

 
 

Select a container type in the [Container] column. Comments can be entered in the 
[Comment] column for each RTT position. 

If "Avail." is selected for [Reagent barcode] in the [System Specification Settings] 
window (accessed from the [Setup] button), the analyzer reads the reagent barcode and 
the relevant data are displayed in the [Barcode], [Lot#], [Exp.Date (expiration date)] 
columns respectively. 

 Entering the reagent expiration date and recording the reagent 
opening date 

The [Reagent Container Set] window is also used for entering the expiration date and 
recording the opening date of the reagents without a barcode or that have an 8-digit 
barcode. Enter the expiration date in the field under the [Exp.Date] header and then 
click the button under the [Open] header to record the reagent was opened. 

An 18-digit barcode on the reagent allows automatic entry of the lot number and 
expiration date when the analyzer reads the barcode. The analyzer assumes that the 
reagent bottle is opened when it reads the barcode. For reagent bottles with 18-digit 
barcode, just click the [Barcode Scan] button in [Reagent Test Monitor] window. 
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2.2.5 [Calibration Setup] window 
Select [Calib.] > [Calibration Setup] to display the [Calibration Setup] window in order 
to enter the positions of the calibrators.  

 
 

 Defining [BLK posi.], [STD posi.], and [Coeff (FV)] values 

Enter the position (1-61) on the refrigerated sample tray (CTT) of the blank sample and 
the calibrator in the [BLK posi.] and [STD posi.] respectively for each test.  

The field under the [FV] header automatically displays the value defined in the 
[Analytical Parameters (Chemistry)] window. You can edit the value here if desired; 
the edited value is reflected in the corresponding value in the [Analytical Parameters 
(Chemistry)] window. 

 [CTT Setting] window 

Click the [CTT Set] button on the top bar to display the window below. 

Following are the items to be defined in this window. 

 
 

[Cup/Tube Type] Select the container type for the calibrator. 
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[Reps] Indicate the number of measurement replicates for the 
calibrator. For example, if "5" is entered, the 
measurement is repeated 5 times. The final calibration 
value is obtained by averaging 3 measurement values 
excluding the highest and lowest values.  If "2" is 
entered, the mean value of the two measurements will 
be the final result. 

[Comment] Enter a description of the calibrator.  The description 
will carry forward to other relevant windows to assist 
in identifying the calibrator. This is a required field; a 
comment must be entered.  

 [Multi-Standard Setup] window 

See Section 2.3.2 for setting up multi-standard measurement. 
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2.2.6 [QC Sample Definition] window 
Select [QC] > [QC Sample Definition] to display the [QC Sample Definition] window 
below. 

 
 

 Settings for control samples 

Up to 26 control samples (A-Z) can be utilized for quality control (QC). 
 

① Enter the following items for each control sample. 

• [CTT Posi.no.]:  position on the refrigerated tray. 

• [Comment 1]:  relevant comment for identifying control samples 

• [Dil.Factor]:    dilution factor 

• [Samp.Type]:    sample type 

• [Container]:    type of container 

• [Replicates]:    number of measurement times 

• [Test table]:   tests selected to run 

② Entering the position on the CTT 

Click the [CTT Set] button on the top bar to display the [CTT Setting] window. 

Enter the values in the same way as described in the “Defining CTT settings” sub-
section of “Section 2.2.5 [Calibration Setup] window.” 

Click the [Auto Control (TOTAL TEST)] or [Auto Control (TEST)] button in the [QC 
Sample Definition] window to display the window below. 
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Enter the number of replicates in the field in the [# of Tests] column for each control 
sample. Click the [Reset] button to clear the value in the [Remain times] column for 
that row. Click the [All reset] button in the bottom of the window to clear all the values 
in the [Remain times] column.  The number in the [Remain times] column is reset 
when the analyzer starts in the "New start" mode; they are not reset in the "Re-start" 
mode. 

To select tests for which the control measurement is automatically performed, select 
[QC] > [Test Select], then select "3. Auto control samp. meas." in the [Test select] 
column and select the appropriate tests in the [Test table]. The control measurement is 
automatically performed for the selected tests only. 

 

 The method by which the number of automatic control sample 
measurement replicates is calculated and the tests on which the control 
measurement is performed depend on the [System Parameters] setting. For 
details, see “Section 5.4.2. Automatic control measurement” in “Chapter 5 
Optional Functions.” 



  

 

2-40  ICABM6010/C-4 

C
hapter 2 

M
easurem

ent Settings 
 

 

2.2.7 [Ctrl/Cal Sample Setup] window 
 

This window is used to indicate the container type and number of replicates for 
calibrators and control samples. 

Select [Setup] > [Ctrl/Cal Sample Setup] to display the window below: 

 
 

① Select a tray. 

Select "CTT", "STT-98", or "STT-99" in the field at the upper left corner. 

"CTT" is used for calibrator, special diluents, detergents, and control samples. 

"STT-98" and "STT-99" are used for standards with multiple data points. 

② When "CTT" is selected, define the following parameters. 

[Usage] This field is automatically filled with the predefined 
value. 

[Meas.times] Enter the number of replicates. 

[Container type] Select a container type. 

[Comment] Enter a comment if desired. 

[Contents] This field is automatically filled with the predefined 
value. 

③ When "STT-98" or "STT-99 is selected, define the following parameters. 

[Meas.times] Enter the number of replicates. 

[Container type] Select a container type. 

[Comment] Enter a comment if desired. 
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2.2.8 [Test Select] window 
This window is used to define the tests to perform by measurement type. 

Any test not selected in this window will not be run, even if an order is placed.  

Select [Request] > [Test Select] to display the window below. 

 
 
 

① Select a measurement category in the [Test select] column. 

The measurement types are classified into ten categories in the [Test select] column. 

[Routine/Interrp./STAT samp.meas.]  Select when patient samples are measured. 

[Ordinary control samp.meas.]   Select when ordinary control samples are 
measured. 

[Auto control samp.meas.]   Select when control samples are 
automatically measured. 

[Auto control meas. after calib.]   Select when control samples are measured 
after automatic calibration. 

[Ordinary calibration meas. (BLK)]  Select when ordinary blank calibrators are 
measured. 

[Ordinary calibration meas. (STD)]  Select when ordinary calibrators are 
measured. 

[Auto calibration meas. (BLK)]  Select when ordinary blank calibrators are 
automatically measured. 

[Auto calibration meas. (STD)]  Select when ordinary calibrators are 
automatically measured. 

[Special calibration meas. (BLK)] Select when an alternative blank calibrator 
is measured.  This option is useful if you 
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change the tests for calibration depending on 
the day of the week. 

[Special calibration meas. (STD)] Select when an alternative calibrator is 
measured.  This option is useful if you 
change the tests for calibration depending on 
the day of the week. 

② Select the tests desired in each measurement category. 

Click the button with the test name on the [Test table] to select it. 

The selected test button will appear depressed and the test name will be displayed in 
the [Test list] column on the right. 

If a test is not selected in the [Test Select] window, any order to execute the test will 
be disregarded by the analyzer.   
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2.2.9 [Sample Select] window 
This window is used to select calibrators and control samples on which measurement is 
performed. 

The samples not selected in this window are not measured even if an order is placed.  

Select [Calib.] > [Sample Select] to display the window below. 

 
 

① Select a tray. 

Select "CTT", "STT-98", or "STT-99" in the drop-down box at the upper left corner of 
the window. 

② Select the samples to measure 

Click the appropriate buttons to select the desired sample positions on each tray. 

The selected buttons will appear depressed. 

If a sample is not selected in the [Sample Select] window, any test ordered for the 
sample will be ignored. 
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2.3 Other Settings 
This section describes optional and advanced settings. 

2.3.1 Rerun 

 What is a rerun? 

Measurement values are sometimes displayed with one or more flags. 

Flags are posted under the following circumstances: 

 When an abnormality is detected while processing the measurement data 

 When the measurement data are out of the limit of linearity for the test 

 When the measurement data are out of the normal range. 

 When the reaction time course is abnormal 

 When the reagent was short during measurement 
 

An automatic rerun can be selected in advance based on flagged data.  The rerun 
conditions such as sample dilution or changed sample volume in measurement can also 
be selected in advance. 

See Appendix 3

 

 for further details on flags. 

 Selecting the type of rerun 

When the system orders a rerun for the flagged value, you can choose whether to rerun 
the sample immediately or start the rerun later manually. 

Select [Setup] > [System Specification Settings] to display the window below. Select 
automatic or manual rerun in the [Rerun Settings] column located in the upper section 
of the middle column of the window. 
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 [Auto rerun] 

[OFF] The rerun is not performed immediately but the rerun 
order is retained.  You can perform a rerun of the 
ordered test later manually. 

[ON (from STT)] The rerun is performed immediately when a rerun is 
ordered. When you select this option, you cannot 
remove the sample from the sample tray (STT) until the 
sampling is completed for rerun. 

 [Manual Rerun] 

Three options are available: [Flagged tests and untested tests], [Untested tests only], 
and [All tests]. 

When you have selected "ON (from STT)" for [Auto rerun], you have to select [All 
tests]. 

 

[Flagged tests and untested tests] Only the flagged test and the tests that were 
not completed in the initial run are to be 
performed on the same sample when a rerun 
is ordered. 

[Untested tests only] Only the tests that were not completed in the initial run 
are to be performed on the same sample when a rerun is 
ordered. 

[All tests]  All tests are to be performed on the same sample when 
a rerun is ordered. 

 Setting the analytical conditions for rerun 

Select [Setup] > [Analytical Parameters (Chemistry)] to display the window below. 

 
 

Define the "Rerun conditions" and "Rerun conditions set" as follows; 
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 [Rerun conditions] window 

Click the [Rerun conditions] button to display the window below. 

 
 

Define the sample volume and dilution conditions for the rerun. 

[Sample type] Select "Serum" or "Urine" as the sample type. 

[Dilute 1] - [Dilute 4] Four different dilution conditions ([Dilute 1] to [Dilute 
4]) can be defined.  

 Depending on the user interface, it may be displayed as 
[D1] - [D4] instead of [Dilute 1] - [Dilute 4]. 

[Reaction sample volume] Enter the sample volume to be dispensed in the reaction 
carousel (RVV) cuvette. Enter a value between 1 and 
25 μL in 0.1μL increments.  
When "No dilution" is selected for [Dilution method], 
the specified volume of undiluted sample is dispensed 
directly from the sample on the sample tray (STT).  
When "A dilution" is selected, the specified volume of 
diluted sample is dispensed from the diluted sample in 
the reaction cuvette on the reaction carousel (RVV). 

[Dilution method] Define whether to dilute the sample.  
When "No dilution" is selected, the undiluted sample is 
dispensed directly from the sample on the STT into the 
cuvette on the RVV.  
When "A dilution" is selected, the sample is diluted and 
then dispensed into the cuvette on the RVV. 

[Undiluted sample volume] Enter volume of a sample before dilution between 1 and 
25μL in 0.1 increments. The specified volume of the 
sample is dispensed into the reaction cuvette. 

[Diluent volume] Enter a value between 25 and 200 (μL) in 0.1 
increments.  
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[Diluent position] Enter the position number of the diluent to be placed on 
the reaction tray 1 (RTT1). Values can range from 0 to 
50.  
When "0" is entered, no diluent is placed on the RTT1; 
pure water from reagent probe 1 (RPP1) is dispensed 
into the cuvette according to the value entered for 
[Diluent volume].  
When a number from 1 to 50 is entered, the diluent 
must be placed in the specified position on the RTT1.  
The RPP1 will dispense the diluent into the cuvette 
according to the volume entered for [Diluent volume]. 

[Diluent volume from RPP] Enter the volume of pure water dispensed from the RPP 
via the RPP tube. Enter a value between 5 and 200 (μL) 
in 0.1 increments. The pure water is used for diluting 
the diluent.  
First, the RPP1 aspirates the diluent located on the 
RVV at the position specified for [Diluent position]. 
The amount aspirated is the volume entered for 
[Diluent volume].  Then, the aspirated diluent is 
dispensed together with pure water supplied from the 
RPP1 tube into the cuvette. The volume of pure water 
is the amount entered for [Diluent volume from RPP].  
This function is practical when a condensed diluent is 
used. 

The following is a description of the example settings illustrated on the above 
screenshot of the window.  

 

 The setting in the above window is an example.  During actual operation, 
set the optimal values after taking into account of your own sample status 
and reagent performance. 

[Dilute 1] The sample is not diluted, but a smaller volume of 
sample is used for measurement.  
The sample volume is 1.0 μL.  
This is an example of a rerun with a reduced sample 
volume. 

[Dilute 2] The primary sample of 10.0 μL is diluted with 90.0 μL 
of diluent dispensed from the RTT1. This results in a 
10-fold dilution of the sample to be used for 
measurement.  The sample volume used for the rerun is 
2.0 μL. This is an example of a rerun with diluted 
sample. 



  

 

2-48  ICABM6010/C-4 

C
hapter 2 

M
easurem

ent Settings 
 

[Dilute 3] 9.5μL of the diluent aspirated from the container on the 
RTT1 is further diluted with 85.5 μL of pure water 
supplied from the RPP1 tube. The resulting 95.0 μL of 
diluted diluent is used to dilute 5.0 μL of the primary 
sample. This results in a 20-fold dilution of the sample. 
The sample volume used for the rerun is 2.0 μL. This is 
an example of a rerun with the sample diluted with a 
diluent diluted with pure water. 

[Dilute 4] 1.0 μL of the primary sample is diluted with 99.0 μL of 
pure water supplied from the RPP1 tube. This results in 
a 100-fold dilution of the sample. The sample volume 
used for the rerun is 2.0 μL. This is an example of rerun 
with a pure water-diluted sample. 

  [Rerun conditions set] window 

Click the [Rerun conditions set] button to display the window below. 

 
 

In this window, the rerun conditions can be defined by flags. 

 

The descriptions indicate the type of abnormality with the flag notation in parentheses.  

Only one rerun condition can be selected from M, D1, D2, D3, or D4 for each flag.  

[M (Main)] means the condition applied in the initial run; [D1] - [D4] stand for [Dilute 
1] - [Dilute 4]. 

If no rerun conditions are selected for a flag, a rerun will not be performed even if the 
flag is posted to the result data.  

The following is an explanation of the example settings illustrated on the above 
screenshot of the window.  
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 The setting in the above window is an example.  During actual operation, set the 
optimal values after taking into account your own sample status, reagent performance 
and the meaning of the flag. 

In the example above, when a test result of the initial run is flagged with an "h" 
(normal value limit) only, the [D1] or [Dilute 1] defined in the [Rerun conditions] 
window is applied for rerun. 

 When two or more flags are posted to the result data of a sample and 
the rerun conditions of those flags are different, a condition of the flag 
with the highest priority is applied in accordance with the hierarchy 
below.  

• Order of priority of the flags in rerun conditions: 
Z>f>*>U>D>u>d>N>P>H>L>h>l>/>n>v>V>w>W>x>X>O>J  

In the example above, when the flags "h" and "n" are posted to a test result, the 
condition [D1] is applied for rerun because "h" has the priority. 

 

 
ATTENTION  

 

When a ratio parameter is calculated between the results obtained from a test with sub-
analysis conditions #1-3, the calculated parameter can be abnormal if the rerun dilution 
conditions of the sub-analysis conditions #1-3 are not the same. 
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2.3.2 Multi-Standard 

 Features of multi-standard calibration 

The BM6010/C supports tests that require multi-standard calibration. The following 
features are available. 

• Calibration with up to 10 data points. 

• The following approximation formulas are available to generate a calibration curve: 
linear, quadratic, and cubic corrections, logit-log conversion, spline correction, etc. 
Logarithmic conversion can be applied to the axes as well. 

• The calibration curve can be generated from measurement values alone without 
using blank sample. 

• The calibration curve can be prepared with a series of dilutions for use in multi-
point calibration by diluting a calibrator with different dilution factors.    

• Simplified calibration is available using a blank sample and a single calibrator. 

• The concentration of the sample in both serum and urine can be calculated using the 
calibration curve generated above.  

 Setting the analytical parameters 

Select [Setup] > [Analytical Parameters (Chemistry)]. Select "MSTD" for [Calc.mthd] 
in the [Sub-analy.conditions] column located slightly to the left in the [Analytical 
Parameters (Chemistry)] window. 
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Then, click the [Multi-STD setting] button in the [Standard setting] column located in 
the upper right of the window. The [Multi-Standards Set] window is displayed. 

 

Attention to the values for 
reaction sample volume 

 
 

Select the type of approximation formula, the use or omission of a blank solution, the 
axis conversion type, the number of data points, the measurement conditions including 
concentration and dilution, and the absorbance limit. 

Select "BLANK is 0" when a calibration blank is available.  The approximation 
formula will be generated so that the calibration curve will pass through point "0".  In 
this case, the Y axis represents "ABS-RB" values. 

Select "BLANK-Any Value" when the calibration blank is not available.  All the data 
points from the calibrators will be used to generate the calibration curve which will 
therefore not necessarily pass through point "0".  The Y axis represents "ABS" values. 

The BM6010/C is capable of preparing a series of calibrator dilutions for multi-point 
calibration. This practical function will be described later. 

[Formula] Select a type of approximation formula to generate the 
calibration curve after measurement.  
Also, select "BLANK is 0" when the blank sample is 
used or "BLANK: Any value" when it is not used. 

[Axis conv.] Select whether to apply logarithmic conversion to the 
axis of the calibration curve.  
[No convert.]: No conversion is applied to either the X 
or the Y axis.  
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[Log.-linear]: Logarithmic conversion is applied to the 
X axis (concentration), but not to the Y axis.  
[Log.-Log.]: Logarithmic conversion is applied to both 
the X and the Y axes.  

[Points] Enter the number of data points to be used to generate 
the calibration curve.  
Up to ten data points including the blank sample can be 
selected. 

[BLK] or [0] - [9] The number that represents each standard.   [BLK] is 
displayed when "BLANK is 0" is selected in the drop-
down menu to the right of the [Formula] drop-down 
menu; [0] is displayed when "BLANK: Any value" is 
selected.  
As many data points as defined in the [Points] field are 
measured. 

[FV] Enter the corresponding concentration for each data 
point in the dilution series.  
When the sample is diluted or when the value entered 
in this window is different from that entered in the 
[Sample Vol (S)] field in the [Analytical Parameters 
(Chemistry)] window, calculate the value to enter in 
[FV] using the following formula:  

 [FV] = C * (O/P) * (SV/SVo) * (TVo/TV) 
C:  Concentration of the calibrator 

O: Serum dilution rate as specificed in the [Analysis 
test condition setting (M)] window 

P: Dilution rate defined in this window 
SVo: Value entered for [Sample Vol (S)] in the [Analytical 

Parameters (Chemistry)] window 
SV: Value entered for [Reac.sam.volume] in this window 
TVo: Total volume of the reaction sample entered in the 

[Analytical Parameters (Chemistry)] window 
TV: Total volume of the reaction sample entered in this 

window and the [Analytical Parameters (Chemistry)] 
window 

[Reac. smp. volume] Enter the sample volume to be dispensed into the 
reaction carousel (RVV) cuvette. Enter a value between 
1 and 25 μL in 0.1μL increments.  
When "No dilution" is selected for [Dilution method], 
the indicated volume of undiluted sample is dispensed.  
When "A dilution" is selected, the indicated volume of 
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diluted sample is dispensed from the diluted sample 
into the reaction cuvette on the RVV. 

 The default value for the [Reac.smp.volume] is 25.0 μL. Be aware that the 
appropriate value will depend on the condition. 

[Dilution Method]  Select whether to dilute the sample.  
When "No dilution" is selected, the undiluted sample is 
dispensed directly by the sample probe (SPP) into the 
reaction cuvette on the RVV.  
When "A dilution" is selected, the sample is first 
diluted and then dispensed into the cuvette on the RVV. 

[Dil. smp volume] Enter a value between 1 and 25 (μL) in 0.1 increments 
as the volume of undiluted sample.  
The specified volume of the undiluted sample is 
dispensed by the SPP into a cuvette that already 
contains the diluents.  

[Diluent volume] Enter a value between 25 and 200 (μL) in 0.1 
increments.  

[Diluent position] Enter the position number (1 – 50) on the reaction tray 
1 (RTT1) in which the diluent will be placed.  

 When "0" is entered, no diluent is placed on RTT1.  
Pure water in the reagent probe 1 (RPP1) is dispensed 
into the cuvette according to the volume entered for 
[Diluent volume].  
When a number from "1" to "50" is entered, place the 
diluent in the specified position on RTT1.  The RPP1 
dispenses the diluent into the cuvette according to the 
volume entered for [Diluent volume]. 

[Dil. vol. from RPP] Enter the volume of pure water dispensed from the RPP 
via the RPP tube. Enter a value between 5 and 200 μＬ 
in 0.1 increments. The pure water is used for diluting 
the diluent.  
First, the RPP1 aspirates the diluent located on the 
specified RVV position according to the volume 
entered for [Diluent volume].  Then, it dispenses the 
diluent together with the pure water supplied from the 
RPP1 tube according to the volume specified for the 
[Diluent volume for diluent] into the cuvette.  
This function is practical when a condensed diluent is 
used. 
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[STD-H] Enter the upper limit for the absorbance.  If the 
measurement value is greater than this limit, it is 
flagged with an "H". 

[STD-L] Enter the lower limit for the absorbance.  If the 
measurement value is less than this limit, it is flagged 
with an "L". 

 Select conditions for measurement of the calibrators  

Be sure to enter the same values for [Reac.smp.volume], [Dilution Method], [Dil.smp 
volume], [Diluent volume], [Diluent position], and [Dil.vol. from RPP] for calibration 
as were entered for sample analysis under sample type "serum" (when using this 
calibration data for serum tests) in the [Analysis test condition setting (M)].  In this 
way, the analytical conditions (sample dilution, sample volume, etc.) will be the same 
for both calibration and serum sample measurement. 

 The default value for the [Reac.Smp.Volume] is 25.0 μL. Be sure to enter 
the same value that was entered for [Reaction sample volume] in the 
[Analysis test condition setting (M)] window. 

Enter the concentration value of each calibrator as is in the field in the [FV] column. 
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 Preparation of dilution series for a calibrator  

Define values for [Reac.samp.volume], [Dil.smp. volume], [Diluent volume], [Diluent 
postion], and [Dil.col. from RPP] to prepare dilution series of from a calibrator 
automatically.  

The window below shows an example of settings used to dilute a high-concentration 
calibrator for the preparation of dilution series.   In the [FV] column, be sure to enter 
the values obtained with the formula presented in the "FV" section above. 
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 Entering the calibrator positions  

Select [Calib.] > [Calibration Setup]. A [Setting] button is displayed under the [MSTD] 
header for multi-standard tests. 

 
 

 [Multi Standard Setup] 

Click the [Setting] button to display the [Multi Standard Setup] window. 

 
 

[TT No.] Select a STT number to set the calibrator.  
Multi-standard calibrators should be placed on the 
sample tray (STT) instead of the refrigerated sample 
tray (CTT). Select either "98" or "99". 
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[Posi.] Enter the STT position numbers to set the calibrators. 
You can enter a same position number for two or more 
standards when you prepare dilution series from a 
calibrator.  

[Coeff (FV)] Enter the concentration values of the series.  
The meaning is the same as that of [FV] in the [Multi-
Standards Set] window accessed from the [Analytical 
Parameters (Chemistry)] window.  You can edit the 
concentration value here. 

[Return] button Click this button to save the values entered in this 
window before closing. 

[Cancel] button Click this button to close the window without saving 
the changes that have been made. 

 [STT Set] 

Click the [STT Set] button on the top bar to display the [STT Setting] window. 

 
 

[Posi.no.] The number to the left of the dash represents the STT 
number and the number to the right of the dash 
represents the container position number. 

[Container] Select the container type for each position.  

[Meas.times] Enter a value between 0 and 5 to signify the number of 
replicates for each calibrator. 
Enter "0" if the calibrator should not be measured. 

[Comment] Enter a description of the calibrator.   Be sure to enter a 
comment since it will be used to identify the calibrator 
in other windows.  
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 Simplified calibration 

After the multi-standard calibration is performed, a simplified calibration can be used 
using only two solutions: a blank sample and a single calibrator.  

The simplified calibration is generated by correcting the Y-intercept and slope of the 
multi-standard calibration curve. 

Multi-standard calibration is suggested when using a new lot of a reagent and 
simplified calibration may be used for daily analysis.  
The simplified calibration is performed in the same way as a one-point calibration 
using a blank sample and a single calibrator. 

① Select [Calib.] > [Calibration Setup] and enter the [BLK posi.], [STD 
posi.], and [Coeff (FV)] for tests that require multi-standard calibration. 

Set the blank sample and a calibrator on the refrigerated sample tray (CTT).  
Click the [CTT Set] button to specify the positions in the [CTT Setting] window. 

② Perform the ordinary calibration steps using a blank sample and a 
single calibrator for the tests that require multi-standard calibration. 

Click the [START] button on the Operation Panel to display the [Start Conditions] 
window. Select "Analyze" for [one-pnt.smp.] in the [Calib.] column.  
After calibration, the corrections are applied to the calibration curve. 
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2.3.3 Setting analytical conditions for serum indices 
Select [Setup] > [Analytical Parameters (Serum)] to display the [Analytical Parameters 
(Serum)] window below. 

 
 

 Defining chemistry tests for serum index measurement 

Define chemistry tests for serum indices measurement with the order of priority.  At 
this time, define [Factor a] - [Factor f].  These factors are required for processing the 
serum index measurement values.  Following is the referential information. 

 Reference information: formulas for calculating serum index values 

The serum index values are calculated with the formulas below: 

Lipemia＝a*ABS (A) 

Hemolysis＝b*{ABS (B)－d*ABS (A)} 

Icterus＝c*{ABS (C)－e*{ABS (B)－d*ABS (A)}－f*ABS (A)} 

ABS (A): Absorbance in lipemia measurement  
ABS (B): Absorbance in hemolysis measurement 
ABS (C): Absorbance in icterus measurement 

where the factors a, b, c, d, e, and f are constants.  

Following is the explanation on these factors. 
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 Factor for serum index analysis 

The table below summarizes the constants for factors obtained in an experiment under 
the serum index measurement conditions described in the next section. 

 

Factor Value 

a 1128.90 
b 167.54 
c 39.08 
d 0.8987 
e 0.1488 
f 1.3289 

 

 Samples and measurement condition used to obtain the factors 

Measured sample: Interference-Check A plus (Sysmex Corp,), Item #79370 

Reagent used: Saline, Production#9351 

Measurement condition R1: 100 
Sample volume: 2 
Dilution rate: 1 

 

Item Wavelength 
(λ) 

Sample  Indicated 
value 

Serum index  
Concentration 

Icterus 478-505 Water    
Bilirubin C T-BIL 224 mg/dL 5 mg/dL 
Bilirubin F T-BIL 184 mg/dL 5 mg/dL 
Hemoglobin Hb 4500 

mg/dL 
 

Lipemia Formazin 
Turbidity  

21800  

Hemolysis 571-596 Water    
Bilirubin C T-BIL 224 mg/dL  
Bilirubin F T-BIL 184 mg/dL  
Hemoglobin Hb 4500 

mg/dL 
50 mg/dL 

Lipemia Formazin 
Turbidity 

21800  

Lipemia 658-694 Water    
Bilirubin C T-BIL 224 mg/dL  
Bilirubin F T-BIL 184 mg/dL  
Hemoglobin Hb 4500 

mg/dL 
 

Lipemia Formazin 
Turbidity 

21800 500 

 

 Factor correction  
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If the measurement conditions (values of R1, SV, and dilution factor) are different 
from those listed above, correct the factors a, b, and c using the formula below: 

 (a', b', c') ＝ {(R1+SV) / 102}× (2／SV) × dilution factor × (a, b, c) 

a', b', c'：corrected factors 

R1: [volume of Reagent 1] + [volume of diluent used to dilute Reagent 1] 

SV: [Serum reaction sample volume] 

Dilution factor: ([undiluted serum sample volume]+[diluent volume for 
serum])/[undiluted serum sample volume] 

Correct the factors a, b, and c according to the actual serum index tests. 
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2.3.4 [Ratio Parameters] window 
The measurement results from different tests can be used to calculate a ratio between 
those values; this ratio is regarded as a test result. The calculation used to obtain this 
ratio is called a "ratio test". This window is used to set parameters for the ratio test. 

Select [Setup] > [Ratio parameters].  

 
Enter the values in the following columns in the window. 

[Analysis conditions] Enter the same way as in the [Analytical Parameters 
(Chemistry)] window. 

[Standard value set] Enter the same way as in the [Analytical Parameters 
(Chemistry)] window. 

[Real-time Calculation Ratio Parameters]   

[Test #S-Z] Enter the "Process Sequence nos." of the tests whose 
results are used for ratio calculation. 

[Factor a-f] Enter the values of the constants (factors) used in the 
calculation formula. 

[Formula] Enter the formula. Use the following characters to 
define the formula. (e.g. x / (y-x))  
[S]-[Z]:  Measurement result (concentration) of 
 the test used for ratio calculation  
[a]-[f]:  Factor (as defined in the [Factor] 
 fields)  
[*], [/], [+], [-]: Arithmetic operator 
[1]-[9], [.]: Constants 
[R()]： Root 
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[L()]： Log 
[( )，[ ]]，[＾]: Operator 

[Simulation] Click the [Simulation] button to see the result of the 
ratio calculation formula using the “test results”. 

 

 
ATTENTION  

 

When you perform a "ratio test” using results from tests with the same 
"Analy.Cond.no" but different "Sub Param. #", the result of ratio test may be abnormal. 
Be sure that the same dilution conditions are selected in the [Rerun Conditions Set] 
window. 
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2.3.5 Settings for quality control (QC) 
This section describes the purpose and use of the quality control (QC) windows.  

 Types of QC 

Three types of QC are available with the BM6010/C: 

Real-Time QC Uses twin plot graphs representing the values of the 
control samples measured up to the current time of the 
current day.  The purpose is to review the quality of the 
current measurement. 

Daily Precision Control Uses X-charts representing the all the measurement 
data of the control samples completed in the day.  The 
purpose is to review the quality of the current day's 
measurement. 

QC Cumulative Uses X-R charts of the daily control sample 
measurement values.  The purpose is to review the 
quality of data measured over multiple dates. 

 [Real-Time QC] window 

① Display the X-chart. 

Select [QC] > [Real-Time QC] to display the window below. 

 
 

The X-chart displays measurement values of two defined control samples; a separate 
chart is used for each test. For correct X-chart display, the control samples and the 
chart-display settings should be properly defined as explained respectively in Steps 2 
and 3 below. 

② Define the control samples used for real-time QC. 
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Follow the steps below to specify the types of control samples. 

a. Define the types of control sample. 

Click the [Registration list edit] button located in the upper middle part of the [Real－
Time QC] window to display the [Real-Time QC Registration List] window. 

 
 

Select the types of control samples for each test.  Two types of the control sample 
should be selected for twin-plot graph representation. Select one type for both [Control 
1] and [Control 2].  

 When setting the defaults, delete all entries in the [Regist Test] column. 
Select and highlight all entries in the [Regist Test] column, and then click 
the [Delete] button. 

b. Select the tests. 
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Click and highlight the tests in the [Test List (I)].  Click the test names while pressing 
the [Shift] or [Ctrl] key to select multiple tests simultaneously. Click [Regist (R)] 
button to select the highlighted tests. Their names will be displayed in the [Regist Test 
(T)] column. Select all the tests required. 

c. Define the chart display order on the monitor.  

The charts of the tests are displayed in the monitor in the order shown in the [Regist 
Test (T)] column. 

To change the order, select and highlight a test and move it upward or downward by 
clicking the [UP] and [DOWN] buttons respectively. 

d. Save the settings 

Click [OK] to save.  The layout in the [Real-Time QC] window will change 
accordingly. 

③ Choose the layout of X-charts in the [Real-Time QC] window. 

a. Display the [Graph setting] window. 

Click the [Setting (S)] command in the top bar of the [Real-Time QC] window and 
click the [Chart setting] option. The [Graph setting] window is displayed. 

 

b. Choose the [Number of Displays] 

Enter the number of charts to display vertically and horizontally respectively. 

c. Select a [Drawing] type 

Select the type of graphical display. 

d. Select an [X-axis scale] type 

[Automatic calculation]   The chart is displayed with the optimal scale calculated on 
the basis of the number of measurement data.  This is the 
default option. 
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[Number of data]  The chart is displayed in the maximum size with all the 
measurement values. If the number of the values is small, 
the distant between plots will be too wide. 

e. Save the settings. 

Click [OK] to save the setting and close the window. The layout in the [Real-Time QC] 
window will change accordingly. 

 Quality control of the daily measurement 

① Display the [Daily Precision Control] window. 

Select [QC] > [Daily Precision Control] to open the [Daily Precision Control] window. 

 
 

This window lists all the control sample measurement data since the analyzer started in 
the "New Start" mode in chronological order. The data are displayed by control sample 
type and by test. The instructions for selecting the tests and display order are described 
below in Step 3.  

 

The charts are generated based on the reference values defined for each test (MEAN 
and SD) in the [Daily QC] column in the [QC] > [Control Data Registration] window. 
The scale is SD and the display range is up to +3SD to -3SD. 

To display the data correctly, the display settings should be properly defined as 
explained below in Steps 2 and 3. 
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② Select the layout of the X-charts in the [Daily Precision Control] 
window. 

Select options for the X-chart in the [Daily Precision Control] window in the same 
manner as in the [Real-Time QC] window. 

③ Select the chart display order in the [Daily Precision Control] window. 

a. Display the [Setting of the order of displaying test] window. 

Click the [Setting] command in the top bar in the [Daily Precision Control] window 
and select [Setting of the order of display]. The window below is displayed. 

 

b. Select the order in which the X-charts will be displayed.  

Select and highlight the tests in the [Meas. Test] column, and then click the [>>] 
button to move them to the [Select Test] column.  The X-charts of the tests are 
displayed in the order they appear in this column in the [Daily Precision Control] 
window. 

Select a test and then use the [UP] or [DOWN] buttons to change the display order. 

c. Save the settings. 

Click [OK] to save the settings and close the window. The X-chart display order in the 
[Daily Precision Control] window will be updated accordingly. 
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 Quality control of measurement data over multiple dates 

① Display the [QC Cumulative] window. 

Select [QC] > [QC Cumulative] to open the [QC Cumulative] window. 

 
 

The data collection period is displayed next to the [QC Cumulative] window name on 
the blue title bar. The default period is the past 30 days. X-R charts representing the 
average and range of the daily control sample measurement values during this period 
are displayed. The charts are displayed by control sample type and by test. The 
instructions for selecting the tests and display order are described below in Step 3.  

 

The charts are generated based on the reference values defined for each test (MEAN 
and SD) in the [QC Cumulative] column in the [QC] > [Control Data Registration] 
window. The scale is SD and the display range is up to +3SD to -3SD. 

To display the data correctly, the display settings should be properly defined as explained 
below in Steps 2 and 3. Select the layout of X-charts in the [QC Cumulative] window 

 

② Select options for the X-R chart in the [QC Cumulative] window in the 
same manner as in the [Real-Time QC] window. 

 
③ Select the chart display order in the [QC Cumulative] window 

Select the order of charts in the [QC Cumulative] window in the same manner as in the 
[Daily Precision Control] window.  
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2.3.6 Defining profiles 

 What is a profile? 

A profile is a set of tests defined as a group. When selecting tests for each sample in 
the [Request] > [Order Entry] window, you can select multiple tests simultaneously by 
using a profile.  It is efficient to define profiles depending on the purpose of analysis. 

 Defining a profile 

Follow the steps below to define a profile. 

① Display the [Profile Definition] window 

Select [Request] > [Order Entry]. Click the [Create Profile] button located nearly in the 
center of the top bar in the [Order Entry] window. The [Profile Definition] window is 
displayed. 

② Define a profile 

Up to 150 profiles can be defined. 

[Profile set no.] Enter the profile number. 

[Comment] Enter a description of the profile that will be displayed 
in the [Order Entry] window. 

[Test number] Click the [Test Table] button located to the right of the 
field to display the [Test Table] window. Select tests 
for the profile by checking the appropriate box. Click 
[Return] to close the [Test Table] window. Click 
[Execute] in the [Profile Definition] window to save the 
profile of selected tests under the number indicated for 
[Profile set.no.] Click [Cancel] to return to the [Profile 
Definition] window without saving the settings. 
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 Using a profile 

① Display the [Order Entry] window 

Select [Request] > [Order Entry] to display the [Order Entry] window. 

② Click a profile name in the [Profiles] column 

When selecting tests to run on a sample, click a profile name in the [Profiles] column 
instead of clicking test names individually in the [Test table] column. The tests that 
comprise the profile will be displayed in the [Test table] column. 
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2.3.7 Setting automatic startup/shutdown 

Startup settings 

"Startup" indicates the preparatory operations including "PRIME", "WASH", and 
"Cuvette blank" of the analyzer that is already in the [READY] mode. 

 Default "Startup" settings 

Choose the desired series of "startup" operations when the system is successfully 
initialized.  

The default setting values are as follows: 

[PRIME] "PRIME1" 

[WASH1] Deselected (no check in the box) 

[WASH2] Deselected (no check in the box) 

[WASH3] Selected (check  in the box) 

[Cuvette blank] Deselected (no check in the box) 

 Steps for routine startup 

 Visually check that the volumes of detergents and pure water are sufficient. 
If any volume is short, the defined operation may not be successfully 
performed. 

 Select [Maint.] > [System Startup/Shutdown Setting] to display the [System 
Startup/Shutdown Setting] window. 

 
 

 Select "Startup" for [Mode set] drop-down menu located at the top of the 
[System Startup/Shutdown Setting] window. 
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 Check the set values. 

If you change any value in the window, be sure to click the [Save] button after making 
the change. 

 Select "Startup" in the [Select wash routine] column on the left side of the 
window; select "Set1", "Set2" or "Set 3" in the [Proc.set] drop-down menu. 

 Click [Yes] in the [Select wash routine] column. 

If the system mode is [READY], the selected start-up operation(s) will begin. 

If the system mode is not [READY], the [Time remaining] field will read "Start"and the 
selected operation will start as soon as the mode becomes [READY]. 

 
 

Once the start-up operation has begun, it proceeds automatically until the end. The 
current system mode and time remaining until the end of operation are indicated in the 
upper left field of the window. When [Cuvette blank] is selected, a pop-up window is 
displayed to register the cuvette blank result just before the cuvette blank measurement 
is completed. Select [save] or [no save]. When the selected start-up operations are all 
completed, the system mode returns to [READY]. 

 If you want to stop the start-up procedure after it has started, perform one 
of the following measures: 

• Click the [Stop] button in the [System Startup/Shutdown Setting] window. 

• Click the [Cancel] button in the [Select wash routine] column of the [System 
Startup/Shutdown Setting] window. 

• Click the [STOP] button in the Operation Panel 

 Shutdown settings 

Select [Maint.] > [System Startup/Shutdown Setting] to choose settings for shutdown. 

 Default "Shutdown" settings 

Choose a series of "shutdown" operations to engage after the system finishes its normal 
operation. You can define the "shutdown" operations independently or to be combined 
with the automatic startup of the next day. 

The default settings are as follows: 
 

 The Operate/standby switch in the power panel should be in the [PC 
CONTROL] position. 
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 Shutdown both the workstation and the analyzer 

[System p.s.] Select "Power OFF" (check  in the box) 

[System end] "Shutdown" 

[PRIME] "Nothing" 

[WASH1] Deselected (no check in the box) 

[WASH2] Selected (check  in the box) 

[WASH3] Deselected (no check in the box) 

[End ISE Operation] Selected (check  in the box) 

 Put the workstation in sleep mode and shutdown the analyzer to permit 
automatic startup  

[System p.s.] Select "Power OFF" (check  in the box) 

[System end] "System End" (This is the status where the workstation 
is closed but the power is maintained.) 

[PRIME] "Nothing" 

[WASH1] Deselected (no check in the box) 

[WASH2] Selected (check  in the box) 

[WASH3] Deselected (no check in the box) 

[End ISE Operation] Selected (check  in the box) 

 Put the analyzer in sleep mode (maintain the power of the analyzer to 
permit automatic startup) 

[System p.s.] Deselect "Power OFF" (no check in the box) 

[System end] "Nothing" 

[PRIME] "Nothing" 

[WASH1] Deselected (no check in the box) 

[WASH2] Selected (check  in the box) 

[WASH3] Deselected (no check in the box) 

[End ISE Operation] Selected (check  in the box) 
 

 When "Nothing" is selected for [System end], the workstation must be 
shutdown manually before the time indicated for automatic startup. 
Automatic startup is not available when the workstation is not shutdown. 

 

If "Shutdown" is selected for [System end], the analyzer’s power will also be turned 
off in order to shutdown the workstation regardless of the [System p.s.] selection.  
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 Steps for routine shutdown 

 Visually check the volumes of detergents and pure water to be sure the 
quantities are sufficient for the shutdown procedures.  If any volume is 
short, the defined operation may not be successfully performed. 

 Select [Maint.] > [System Startup/Shutdown Setting] to display the [System 
Startup/Shutdown Setting] window. 

 

 Select "Shutdown" in the [Mode set] dropdown menu located in the upper 
part in the [System Startup/Shutdown Setting] window. 

 Check the set values. 

If you change any value in the window, be sure to click the [Save] button after making 
the change. 

 Select the wash routine. 

Select "shutdown" in the [Select wash routine] column in the left side of the window, 
and select "Set1", "Set2" or "Set 3" in the [Proc.set] drop-down menu.  

 Save the shutdown setting 

Click [Yes] in the [Select Wash Routine] column. If the system mode is [READY], the 
selected shutdown procedure begins. 

If the system mode is not [READY], the [Time remaining] field reads "Start" and the 
defined shutdown procedure will begin as soon as the mode becomes [READY]. 

 
Once the shutdown operation has begun, it proceeds automatically until the end.  The 
current system mode and remaining time to the end of operation are indicated in the 
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upper left field in the window. When the selected shutdown operation is completed, the 
analyzer and workstation enter the status indicated for [System end] in the [System 
Startup/Shutdown Setting] window. 

 If you want to stop the shutdown procedure after it has started, perform one 
of the following measures. 

• Click the [Stop] button in the [System Startup/Shutdown Setting] window. 

• Click the [Cancel] button in the [Select wash routine] column of the [System 
Startup/Shutdown Setting] window. 

• Click the [STOP] button in the Operation Panel 

 The main valve and power supply for the pure water supply unit should be 
shut off separately from the above procedure. 

 Do not exit the system on the workstation during the shutdown procedure.  
Otherwise, the analyzer will enter in the [WAIT] mode and the selected 
shutdown procedure will not be completed. 

Setting the automatic startup 

Select [Maint.] > [System Startup/Shutdown Setting] to define settings for automatic 
startup. Select "Auto Startup" in the [Mode Set] dropdown menu. 

 For ordinary use 

Choose the operations for automatic startup for each day of the week and the days on 
which to activate automatic startup (i.e. not on weekends).  Set the values as follows: 

[Activate Auto Startup] Check the box next to the days of the week to use 
"Auto Startup". (Check in the box) 

[Start year/month/day] Do not enter a value (except for [Auto startup by 
appointment] which is explained below) 

[Start time] Enter the time to start up (e.g. 0730 for seven thirty in 
the morning) 

[Allow reaction bath to warm] "Do" (check  in the box) 

[System start] Select "New start" 

[PRIME] Select "PRIME1" 

[WASH1] Deselected (no check in the box) 

[WASH2] Deselected (no check in the box) 

[WASH3] Selected (check  in the box) 

[Cuvette blank] Deselected (no check in the box) 
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 Scheduling an automatic startup more than 7 days in the future  

Use the [Auto Startup by Appointment] column to schedule an automatic startup in 
more than 7 days. 

 Check the box next to "Active Auto startup" (check  in the box) 

 Enter the starting date [year/month/day] 

(e.g. 20110530 for May 30, 2011) 

 Enter values for the fields from [Start time] to [Cuvette blank]. 

 Deselect all the days of the week for [Activate Auto Startup]. 

 Steps for routine automatic start-up 

The automatic startup feature starts-up the system automatically at a precise time (i.e. 
by the time you start working next morning or in the morning after the holiday). 
Usually, the automatic startup of the next working day is linked with the system 
shutdown of the current day. 

 Steps for automatic startup alone 

 Visually check the volumes of detergents and pure water required for 
automatic startup. 

If any volume is short, the selected operation may not be successfully performed. 

 Select [Maint.] > [System Startup/Shutdown Setting] to display the [System 
Startup/Shutdown Setting] window. 

 Select "Auto Startup" in the [Mode set] drop-down menu located in the 
upper part in the [System Startup/Shutdown Setting] window. 

 Check the set values. If you change any value in the window, be sure to 
click the [Save] button after making the change. 
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 Click the [On] button in the [Enable auto start] column in the lower left hand 
corner of the window to activate "Auto startup". The [State] field will read 
"On". 

 
 

 Exit the system on the workstation as usual. 

After the workstation is shut down, the window below is displayed and the system enters 
in “SLEEP” mode.  

[SLEEP] mode will continue until automatic startup the next morning. The workstation 
is not powered off. 

 The Operate/standby switch in the power panel should be in the [PC 
CONTROL] position.  If you want to turn off power of the analyzer. 

 
The system will start-up automatically at the designated time and date.  During 
automatic start-up, the [System Startup/Shutdown Setting] window is displayed and the 
current system mode and the time remaining until the end of automatic startup are 
displayed in the upper left fields.  When [Cuvette blank] has been selected in the 
[System Startup/Shutdown Setting] window, a pop-up window is displayed to register 
the cuvette blank result just before the cuvette blank measurement is completed. When 
the automatic start-up procedures are completed, the system mode returns to [READY]. 
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Linking shutdown with automatic start-up 

In order to perform the linked operation properly, the Operate/standby switch must be 
turned to [PC CONTROL], "System End" must be selected in the [System End], and 
"Shutdown" must be selected in the [Mode Set] drop-down menu in the [System 
Startup/Shutdown Setting] window.  

 Visually check the volumes of detergents and pure water required for 
shutdown and automatic startup. If any volume is short, the defined 
operation may not be successfully performed. 

 Select [Maint.] > [System Startup/Shutdown Setting] to display the [System 
Startup/Shutdown Setting] window. 

 Select "Auto Startup" from the [Mode set] drop-down menu located at the 
top of the [System Startup/Shutdown Setting] window. 

 Check the set values. 

If you change any value in the window, be sure to click the [Save] button after making 
the change. 

 

 Click the [On] button in the [Enable auto start] column in the lower left hand 
corner of the window to activate "Auto startup". The [State] field reads "On". 

 

 Select the wash routine. Select "Shutdown" in the [Select wash routine] 
column located in the left hand side of the window, and select "Set1", 
"Set2", or "Set3" from the [Proc.set] drop-down menu. 

 Ensure that "Power OFF" is selected (check  in the box) for [System p.s.] 
and "Shutdown" is selected for [System end]. 

 Click [Yes] in the [Select wash routine] column. A pop-up window will 
prompt you: "Start the shutdown process?”. Click [Yes]. 

If the system mode is [READY], the shutdown procedure will begin immediately. 

If the system mode is not [READY], the [Time remaining] field reads "Start" and the 
shutdown procedure will begin as soon as the mode becomes [READY]. 

 
 

  From here, the procedure will be automatically carried out until the 
completion of the automatic startup the next morning. The current system 
mode and time remaining until the end of shutdown procedure are indicated 
in the upper left hand corner of the window. When the shutdown procedure 
is complete, the analyzer's power will be in the status selected in the 
[System p.s.] or [System end] fields in the [System Startup/Shutdown 
Setting] window. The message "Standing by for auto-startup." is displayed 
in the [Auto Startup] window.  
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The system will startup automatically as designated at the defined time and 
date. During automatic startup, the [System Startup/Shutdown Setting] 
window is displayed and the current system mode and the remaining time 
until the end of automatic startup are displayed in the upper left hand field.  
When [Cuvette blank] is selected, a pop-up window is displayed to register 
the cuvette blank result just before the cuvette blank measurement is 
completed. Select [save] or [no save].  
When all the setting values have been entered, the [Password] window is 
displayed.  
Enter a [Username] and [Password] and click [OK]. 

 

 See the above sections “ Steps for routine shutdown” and“ Setting the 
automatic startup.” 

. 

Miscellaneous settings for automatic start-up and shutdown 

• The table below summarizes the status of the analyzer's Operate/standby switch and 
the automatic start-up function. 

 
 

Analyzer's power Automatic startup 

ON Startup successfully 
OFF Startup the workstation only 

PC CONTROL Startup successfully 
 

• To release the “standby” mode of the system waiting for automatic start-up, perform 
one of the following steps: 

• Click the [Off] button in the [Enable auto start] column of the [System 
Startup/Shutdown Setting] window. 

• If the [Auto startup] window is displayed, click the [Cancel] button in the window. 

• To stop the automatic start-up operation of the system, perform one of the following 
steps: 

• Click the [Stop] button in the [System Startup/Shutdown Setting] window. 

• Click the [Cancel] button in the [Select wash routine] column of the [System 
Startup/Shutdown Setting] window. 

• Click the [STOP] button in the Operation Panel 

• When [Cuvette blank] is selected and "Do" for [Allow reaction bath to warm], the 
analyzer will be in the [CB WATCH] mode (displayed in the Operation Panel) for 30 
minutes after startup.    

• The automatic start-up is canceled if the analyzer is in the status from which it 
cannot start (e.g. the analyzer is already in operation).  
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• When both [Week] and [Auto startup by appointment] are selected in the [System 
Startup/Shutdown Setting] window, the system will start-up at the earlier time. The 
automatic startup can be scheduled only once per day. 

• Follow the steps below to wake the analyzer from the “sleep” mode to return it ready 
for start-up:  

• Click the [Cancel] button in the [Auto Startup] window, and then click the [OK] 
button in the [BioMajesty] Startup window. 

• The startup procedure for the pure water supply unit (opening the main valve and 
turning on the unit) is not included in this automatic startup procedure. 

Time required for start-up / shutdown 

The approximate time required for each process is as follows. 

 Time required for individual process 
 

Process Values Time 

PRIME1 5 times for all steps 1 min 
WASH1 5 times 14 min 
WASH2 2 times 39 min 
WASH3 Once 27 min 

Cuvette blank ― 17 min 
 

 Time required for each procedure 

Following is the approximate time required for each of the procedures 

 Startup 

• PRIME1 + WASH3 ＝ 28 min 

• PRIME1 + WASH3 + Cuvette blank ＝ 45 min 

 Shutdown 

• WASH2 + System end + Shutdown the analyzer ＝ 40 min 

 Automatic startup 

• PRIME1 + WASH3 ＝ 28 min 

• PRIME1 + WASH3 + Cuvette blank (including warming up) ＝ 45 min 
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3.1 Preparing the Sample Containers 
3.1.1 Sample containers 

 Acceptable sample containers 

 Specifications 

The sample tray (STT) accepts containers conforming to the following specifications: 

 Height: 75 - 100 mm 
Note the following: 

 Sample tube shorter than 75mm may become stuck in the tray 

Sample tube higher than 100mm will contact the cover of the sample try and may be 
broken during analyzer operation.  

 Outer diameter: 12.0 - 15.5 mm (including the label thickness) 
If sample tube with an outer diameter smaller than 12.0 mm is used, it can become 
unstable on the STT and may cause probe crash.   
If a sample tube with an outer diameter larger than 15.5 mm is used, the label may 
become dislodged or the sample tube itself may be damaged. 

 If the small container, the "JCUP" (name shown in the application window) is used, 
use the JEOL-provided adapter with the JCUP. 

 If you use a ‘off the shelf’ sample tube or container as an adapter, make sure that the 
JCUP does not contact the cover of the sample tray.  Also, be sure that the JCUP 
does not fall into or get stuck in the sample tube or container before use.  

 Settings for sample container 

Each combination of an adapter and sample container must be registered on the 
workstation. The following default values are set for the JEOL authorized products. 

Container name Description 

10 ml tube Sample tube with capacity of approx. 10 
mL 
 

Jcup/Adp. 
 

A JEOL-provided cup to use in 
combination with the dedicated adapter. 

 

 The consumables that JEOL provides are listed in Section 7.2: “Consumables and 
Spare Parts for Maintenance". 

 If you want to use a new, unregistered sample container, register it in the [System 
Specifications Set] window.  (Login level: “manager” or above.) 

 See the section 2.1.1 “System Specification Setting” for the registration 
steps. 
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3.1.2 Sample barcode 

 Barcode specifications 

The table below summarizes the specifications of barcode systems that the system 

accepts.  

Item Specifications Figure 

Width of narrow bar 
(narrower bar) 

0.19 - 1.0 mm  

Width of quiet zone 
(blank spaces on both 
ends of the bar) 

At least 5 mm and at least 10 times the 
width of narrow bar. 

(1) 

Narrow bar / wide bar ratio 
(narrow bar / wide bar) 

1: 2.5 - 1: 3.0 (recommended ratio: 2.5)  

Bar width 15 - 60 mm (2) 
Bar height 12 mm or greater (3) 
Space between bar and 
character 

1 mm or greater (A space less than 1mm 
may cause a reading error) 

(4) 

Supported code types CODE128, CODE39＊1, ITF＊1, NW-7＊1, 
JAN 
Check digit (CD) is recommended 

 
 

Number of digits for 
sample ID  

CODE128:1-13digits 
Others:4- 13 digits 

 

Print quality 
PCS (reflection rate) 
ANSI X3.182 (quality 
standard) 

 
0.6 or more (75% or greater for white) 
Grade A or B (ANSI X3.182 guideline)  

 

Label Black bar on white background  
Placing angle allowance ± 2 degrees  

 

  Use of check digit (CD) is recommended to avoid erroneous readings.  
Although CD is an effective preventive method for erroneous readings, it 
does not guarantee 100% correct reading.  

 

 Acceptable barcode standards 

Barcode standards acceptable for the BM6010/C are summarized in the table below 

with availability of the CD and start/stop character functions. 

The following points must be taken into account when setting the barcode 

specifications: 

 When the CD function is used, CD should appear in the end of the barcode 

number. 

 The CD and start/stop characters are included within the bar, but not necessarily 

printed in the section for visual identification. Check the barcode specification 

with an expert in your software engineering group. 
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 The sample ID number is limited to between 4 and 13 digits. Note that when 

using CD and start/stop characters, they are included in the number of digits in 

the sample ID. (CD requires 1 digit and start/stop characters requires 2 digits.) . 

 Up to four barcode types can be setup (Default settings are shown below).  

However, different settings for one barcode type (e.g. CODE128 with CD and 

without CD) cannot be set up.   

 If you want to operate NW7 or ITF, the fixed digits is recommended to avoid 

erroneous readings. 

  If you want to operate the system with a barcode setting that is not included 
in the default factory setting, please contact your local distributor. 

 

Barcode 

Type 
 

Function 
Mandatory / 

Recommended 

 

Default
CD 

CD 
Transmission 

Start/stop 
Character 

Transmission 

CODE128 
 

Available N/A － Mandatory 
○ 

ITF 
 

Available N/A － Recommended ○ 
Available － Recommended  

N/A － － －  
JAN 
(13 digits) 

Available Available － Recommended 
○ 

JAN 
(8 digits) 

Available Available － Recommended  

NW7 
 

Available 
(Modulas16) 

N/A N/A Recommended 
○ 

Available 
(another 
method) 

Available or 
N/A 

Available or 
N/A 

Recommended  

N/A － Available or 
N/A 

－  

CODE39 
 

Available Available or 
N/A 

Available or 
N/A 

Recommended  

N/A － Available or 
N/A 

－  

Barcode standards acceptable for system 
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  Labeling position 

Place the sample barcode label properly on the sample container as shown below: 

(1) 

(1) 

(2) 

(3) 

(4) 

 

Correct Sample Barcode position 
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3.2 Preparing the Sample 
  

3.2.1 Dispensing the sample into the sample container 
 Check that the volume is sufficient for measurement.  

Required volume = (sample volume to be used in measurement) + (dead volume for 
the container) 

 Because several tests are performed in one measurement, the required sample 
volume is the total sample volume for tests plus dead volume for the container. The 
required volume for one chemistry test is the sample volume plus 3 μl. However, for 
an ISE test (i.e. Na, K, or Cl), the required volume is 24μl regardless of the number 
of tests. 

 The dead volume varies depending on the container size, 

Container name Dead volume 

10 ml tube 200 μl 
JCUP 50 μl 

Dead volume for most commonly used containers 

 If the container used for centrifugation is also used in the sample tray, ensure that 
the container has sufficient volume for the serum measurement as well as for the 
sample liquid level sensor. If the volume of serum is insufficient, the probe will 
aspirate the blood cell components underneath which may affect the measurement or 
cause probe clogging by the serum separator.  

 If the serum volume is insufficient after centrifuge separation, transfer the serum to 
a new, smaller container such as the JCUP to increase the liquid depth for the sample 
probe. Ensure that no blood cell components are transferred to the new tube. 
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3.2.2 Notes for handling the sample 
 Always ensure adequate sample storage. If left at room temperature too long, it can 

deteriorate the sample due to evaporation or alteration of components, therefore, 
may result in erroneous measurement results. 

 Ensure that no fibrin or other foreign matter is present in the sample. Fibrin in the 
sample may result in clot formation in the sample probe (SPP) or SPP line resulting 
in erroneous measurements. 

 Samples with high viscosity may clog the sample probe, resulting in erroneous 
measurements. 

 If serum separator is added in the tube, ensure that the serum separator is properly 
centrifuged and is not floating in the serum sample.  Serum separator in the serum 
can clog the sample probe and may cause erroneous measurement results. 

 When using anticoagulant, follow the instruction of the reagent manufacturer. 
Improper use of anticoagulant can also cause erroneous measurement results. 

 Ensure that no air bubbles are present in the sample. Air bubbles can cause 
aspiration error by the sample probe. 

 Some coexisting substance in the sample may affect the reagent.  Read the reagent 
manufacturer’s package insert carefully for information. 

 Please be sure to follow the manufacturer’s instructions regarding the appropriate 
reagent for each test and sample type.  

3.2.3 Notes for handling the sample for ISE measurement 

 Acceptable sample types 

Serum, plasma, and urine are all acceptable samples for ISE measurement. Whole blood 
is not acceptable. 

 

 Effects from coexisting chemical substances 

 Anticoagulation agents 

Lithium heparin contains lithium which is an ion that interferes with the measurement 
of sodium. Anticoagulant such as sodium heparin, EDTA-1K or EDTA-2K has sodium 
and potassium added to plasma. Therefore, the result value may be elevated if such 
anticoagulant is used.  

Oxalic acid, citric acid and other similar substances can interfere with the measurement 
of chlorine. 
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 Drug metabolites in serum 

(a) Halogen-containing drugs:  
Halogen metabolites are negative free ions that may elevate the Cl-

(b) Bromisol (bromvalerylurea)  
Sedatives, analgesics, and cold remedies may contain Br

 values.  

- ions which can elevate 
Cl-

(c) Vitamins  
Vitamin preparations often contain additional salts such as hydrochloride, bromide, 
and nitrate. When these salts become free negative ions, Cl

 values. 

- values may appear to 
be elevated.  

 Substances (principally ions) that may affect ISE measurement values  

The table below shows the ion selective factors for coexistent ions for the Na+, K+, and 
Cl-

 

 electrodes. The ion selective factor indicates the degree of sensitively to the 
coexistent ion in comparison with that to the target ion.  The sensitivity to the target 
ion is defined as "1.0". 

Ion selective factors for the Na, K, and Cl electrodes   

Na electrode (membrane: crown ether) 
Coexistent ion Km,x 

Potassium ion  (K＋ 1.5×10) 
Rubidium ion  (Rb

－2 
＋ 1.1×10) 

Cesium ion  (Cs

－2 
＋ 9.0×10) 

Ammonium ion  (NH

-3 
4
＋ 1.2×10) 

Lithium ion  (Li

-3 
＋ 5.0×10) 

Calcium ion   (Ca

-4 
2＋ 9.9×10) 

Magnesium ion  (Mg

-5 
2＋ 8.1×10) 

 

-5 

K electrode (membrane: crown ether) 
Rubidium ion  (Rb＋ 1.4×10) 
Cesium ion  (Cs

－1 
＋ 4.2×10) 

Ammonium ion  (NH

-3 
4
＋ 7.4×10) 

Lithium ion  (Li

-3 
＋ 1.6×10) 

Sodium ion  (Na

-4 
＋ 3.6×10) 

Calcium ion  (Ca

-4 
2＋ 1.1×10) 

Magnesium ion  (Mg

-5 
2＋ 6.5×10) 

 

-6 
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Cl electrode (Membrane: Super-layer 
solid molecule orientation membrane 
MO) 

 

Salicylate ion  (C6H4（OH）COO－ 3.3 ) 
Azide ion  ( N3

－ 2.6 ) 
Thiocyanic ion  (SCN－ 7.0 ) 
Perchloric ion  (ClO4

－ 4.4 ) 
Iodine ion  (I－ 4.7 ) 
Nitrate ion (NO3

－ 2.5 ) 
Bromine ion  (Br－ 2.1 ) 
Bicarbonate ion  (HCO3

－ 1.1×10) 
Acetate ion  (CH

-1 
3COO－ 3.8×10) 

Monovalent phosphoric ion (H

-2 
2PO4

－ 6.0×10) 
Bivalent phosphoric ion (HPO

-3 
4

2－ 1.3×10) 
Acetate ion  (sulfate ion) 

-2 
7.0×10

 

-3 
 
 

3.2.4 Sample for simultaneous measurement of blood cell 
components (HbA1c) and plasma components 
This section describes the conditions for simultaneous measurement of blood cell and 
plasma targets. 

 Conditions for centrifugation  

Follow the reagent manufacturer instructions when preparing the centrifuged blood cell 
component sample.  

The centrifugal force (CF) is calculated with the following formula. 

CF (g) ＝ 1.118×10-5 × rotor radius (cm) × rpm２  

 Setting analytical conditions for blood cell component 

Set the analytical conditions for measuring blood cell component (HbA1c) as follows: 

When setting diluent on the reagent tray 1 (RTT1), select [Setup] > [Analytical 
Parameters (Chemistry)] > [Analytic test condition setting (M)], and define the values 
as follows: 

Item Value 

[Dilution condition] "Do" 
[Undiluted sample volume] 2.0 µl 
[Diluent volume] 200.0 µl  
[Diluent position] RTT1 position where the diluent is loaded. 

 

 Be sure to read the package insert of the reagent used. If the insert 
indicates setting values other than described above, follow those described 
in the package insert. 
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 Setting analytical conditions for plasma components 

Set the analytical conditions for measuring tests such as glucose or 1.5-Anhydro-D-
glucitol

 Select [Setup] > [Analytical Parameters (Chemistry)] > [Analysis test condition 
setting (M)].  Select “Not do" in [Dilution specification] in the [Analysis Test 
Condition Setting (M)] window.  

 as follows: 

 Click the [Sampling Position Setting] button in the top bar of the [Analytical 
Parameters (Chemistry)] window to open the [Sampling Position Setting] window.  
Select "Top" for the sampling position there. 

 Be sure to read the package insert of the reagent.  If the insert indicates 
different settings, follow the indication of the package insert. 

 Sample surface level  

For the sample that is aspirated from the “Bottom” position of the container, the 
sample surface level in the container must be 60 mm or lower (See Section 1.4.1: 
“Simultaneous measurement of blood cell components (HbA1c) and plasma 
components” in Chapter 1.) Any part of sample probe (SPP) higher than 60 mm cannot 
be washed; therefore, sample may be carried over to the next samples, resulting in 
incorrect measurement data. Insufficient washing of the sample probe can cause LLS 
errors and unsanitary conditions within the analyzer.  

  Settings for hemolysed sample 

Set the dedicated diluent (lysis solution) on RTT1 for tests requiring hemolysed 
sample. 
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3.3 Setting the Sample on the Tray 
Place the sample in the position designated by the settings or order and check the 
position, container, and type again to make sure if the sample is correctly loaded on the 
tray.   

 Placing the sample. 

 Push the sample container down to the bottom of the sample tray or STAT port. 

 Remove the cover (e.g. cap) of the sample container before placing the container in 
position. Otherwise, the container may contact the Sample tray (STT) cover, and the 
cover and/or container may be damaged. 

 Using a barcoded sample  

 The barcode reader is located in the outer edge of the sample tray space and reads 
the barcode from the outside. Therefore, be sure to place the container so that the 
barcode label faces the outside of the tray. 

 Ensure that the barcode label is securely attached to the container (i.e. no parts of 
the label are peeling off) when placing the container into the sample tray. 

 Using an adapter 

 Set an appropriate adapter in a STT loading slot and place a JCUP inside. 

 Place the adapter so that the side of the adapter with the narrower diameter faces 
upwards 

 

Adapter 

JCUP 

 
 

 Place the adapter in the STT hole. Be sure that the adapter is securely set in position.    

 Visually check that the JCUP placed in the adapter is not tilted or shifted in order to 
prevent oscillation within the machine. 
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3.4 Preparing the Reagents 
Set reagents in the position designated by the settings, and check the position, bottle 
and type for each reagent to make sure if they are correctly loaded on the tray. 

 Reagent handling 

 Handle and store the reagent properly in accordance with the manufacturer's 
instructions. 

 Do not use expired reagents. 

 Do not use reagents that contain layers of liquid paraffin. Paraffin layers may cause 
the reagent to be aspirated improperly. 

 Reagent filling 

 Use a clean, dedicated bottle (provided by JEOL) to fill reagent. 

 Do not add new reagent to a bottle containing remaining reagent. 

 Reagents containing surfactants may form bubbles when refilled into the bottle.  
Bubbles can cause reagent aspiration error.  Remove the bubbles if there are any.  

 Reagent bottle 

 When using a bottle with barcode, check that the label is still intact and not soiled. 

 Setting the reagent bottle on the reagent tray (RTT) 

 Set the reagent bottle firmly on the reagent tray so that the bottom is securely set in 
position. Check that it does not rattle. 

 Use the dedicated reagent bottle adapter, provided by JEOL, when setting a smaller 
bottle.  

 How to use the bottle adapter 

Following bottle adapters are available: 
 

Type Bottle size to 
support 

Setting position on RTT 

20 ml -> 40 ml 20 ml Positions for 40 ml bottles 
20 ml -> 70 ml 20 ml Positions for 70 ml bottles 
40 ml -> 70ml 40 ml Positions for 70 ml bottles 
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1. Set the reagent bottle in the adapter as shown below. 
 

20 ml - 40 ml 20 ml - 70 ml 40 ml - 70ml 

   

 The barcode label must be securely attached. 

 Ensure that the barcode visible at all times.  

 

2. Place the bottle adapter with the bottle in the appropriate RTT position. 
 

20 mL - 40 mL 20 mL - 70 mL 40 mL - 70mL 

   
 

 Check that the bottle adapter and bottle are securely placed.  

 Ensure that the barcode is sufficiently visible to the barcode reader.   
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4.1 Routine Workflow 
The following diagram shows the general workflow of the measurement with the 
analyzer BM6010/C. 

 
Turn on the main power switch of the system

 

Prepare the pure water supply unit 

[Startup] 

Turn on the power switch on the workstation rack 

Turn on the printer 

Start up the system 

Get the analyzer “READY” 

[Preparation] 
Prepare the analyzer 

Perform [PRIME] 

Perform the startup washing 

Perform the cuvette blank measurement (as required) 

[Measurement] 
Perform the calibration and control measurement 

Patient sample 
measurement 

Urgent sample 
measurement 

Confirm the data and transfer them to LIS
 

Perform maintenance 

[Shutdown] 
Perform the washing after the day's operation 

Shut down the system 

Check the power supply to the workstation is off
 

Shut down and turn off the workstation 

Shut down the pure water supply unit
 

Clean the environment of the analyzer 

[Maintenance] 

Set the Operate/Standby switch to "PC CONTROL" 

Turn on the computer 

※ When the main power switch is kept on, skip 
this step.  
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4.2 Getting Started 
 

 Warning 
Once the analyzer has been started, the probes and trays move before entering into the 
READY mode. Never touch the probes and trays while they are moving. This may lead to 
injury or infection of the operator, or damage to the analyzer. 

 

 Turn on the main power switch of the system. 

 Turn on the main power switch of the system on the back panel of the 
analyzer. 

 

Back side of the analyzer 

With the main power turned on, the electric current goes through the Reagent Tray 
(RTT), Refrigerated Sample Tray (CTT), and ISE Unit. 

 

 Prepare the Pure Water Supply Unit. 

Follow the instructions for your pure water supply unit to start it up and prepare a pure 
water supply to the analyzer. 
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 Set the Operate/Standby switch to “PC CONTROL”. 

Set the Operate/Standby switch to the “PC CONTROL” position to synchronize the 
startup and shutdown of the analyzer with the workstation. 

 

 Although you may set the Operate/Standby switch to    “ON” position, the 
analyzer does not synchronize with the workstation for startup and shutdown. 

 

 Set the Operate/Standby switch of the power panel to “PC CONTROL”. 

 

Power panel 
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 Start up the workstation. 

1) Turn on the power switch on the workstation rack. 

 

Workstation 

The LCD monitor and printer included in the workstation get turned on. 

 When they are not automatically turned on, manually turn them on. 
 

2) Turn on the computer. 

 
 

3) Check that the printer's “ready to print” switch is ON. 

When this switch is OFF, you may not be able to print. 

In approximately 1 minute after Step 2, “BioMajesty” startup window opens. 



 

 

ICABM6010/C-4  4-5 

C
hapter 4 

R
outine M

easurem
ent  

 Start up the system 

1) Select the starting mode of BioMajesty. 

Select the starting mode according to the following features.  
[New Start]: All the data and requests associated with the current “System Date” will 
be deleted.  
[Re-Start]: The requests and data associated with the “System Date” will be 
retained and available for use. 

 

BioMajesty Startup Window 

2) Click the [OK] button on the BioMajesty Startup Window. 

The system starts, and the Menu Panel and Operation Panel are displayed on the top of 
the screen as shown below.  The analyzer is turned on automatically with the 
workstation, and the indication lamp on the status display/power panel lights on.  
The system mode displayed on the Operation Panel changes from “SYSTEM INIT” to 
“WAIT.” 

 

 

 

Operation Panel  Menu Panel 

System Mode display 
 

The Menu Panel and Operation Panel in the upper section of the monitor 
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 Get the analyzer [READY] 

 If the system mode displayed on the Operation Panel is “WAIT,” click 
the [INITIALIZE] button on the panel to change the system mode to 
“READY”. 

 

 

 

System Mode display INITIALIZE button 

 

Operation Panel  

The initialization finishes approximately in one minute, and then the “READY” lamp 
on the status display/power panel of the analyzer lights on in green indicating the 
analyzer is now ready. During “initialization” of the analyzer, the system mode is 
displayed as “INITIALIZE.” When the initialization is completed and the analyzer is 
ready, the mode shown changes to “READY.” 

 

If the startup fails, the red ALARM lamp on the status display/power panel lights with 
an alarm and the analyzer stops automatically.  After solving the problem, click the 
[INITIALIZE] button in the Operation Panel to restart the system. 

Click the [ALARM] button to display the error report for identification of the problem. 
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4.3 Preparing the Analyzer 
 

 Warning 
When performing “Lamp energy check,” “WASH3,” or “Cuvette blank measurement,” the 
probes and trays move. Never touch the probes and trays while they are moving. This may 
lead to injury or infection of the operator, or damage to the analyzer. 

 

4.3.1 Preparation before test run 

The maintenance of the system must be performed as necessary besides the routine 
checks required before every operation. Refer to “Chapter 7 Maintenance” for details. 

 Points to be checked for the workstation before measurement 

i. Clean the LCD display and keyboard as required. 

ii. Ensure that there is sufficient quantity of paper in the paper tray of the printer. 
 See your printer manual for loading the paper. 

iii. Ensure that there is sufficient amount of ink / toner. If not, replace the 
cartridge. 

If the printing shade is becoming light, replace the cartridge with a new one.  

 See your printer manual for cartridge replacement. 

 Points to be checked for the analyzer before measurement 
 

i. Clean the nozzles of the sample probe (SPP) and the reagent probes (RPP1/ 
RPP2) as required and ensure the positions are correct. 

 

ii. Clean the nozzles of the reaction carousel wash unit (WUD) as required. 
 

iii. Clean the mixing rods (MIX1/MIX2) as required. 

iv. Visually check the reagent trays (RTT), refrigerated sample tray (CTT) and 
the remaining volumes of detergents in the bottles, and replenish them as 
required. 

The following table summarizes the types of detergents and other solutions and their 
locations. 

 See the following “Section 3) Replenish reagents” for replenishing the 
reagents. 
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Detergents and other solutions and their locations 

Purpose Location Name of Detergent 

Prevent contamination 
(alkaline) 

Position #47 on 
RTT1 and RTT2 

Reagent probe wash -1 

Prevent contamination 
(acid) 

Position #48 on 
RTT1 and RTT2 

Reagent probe wash -2 

WASH2 (daily) Position #49 on 
RTT1 and RTT2 

Reagent probe wash K 
(20%) 

WASH2 (weekly) Position #49 on 
RTT1 and RTT2 

Reagent Probe Wash S (5%) 

WASH 1-3 (daily and 
weekly) 

Position #50 on 
RTT1 and RTT2 

Pure Water 

WASH1 (daily) Position #50 on 
RTT1 and RTT2 

Pure Water 

#50 on CTT Pure water 
Cuvette detergent 
(alkaline) 

Detergent 
container 

Cuvette wash solution 

Cuvette blank 
measurement 

Detergent 
container 

Cuvette Conditioner EX 

Sample dilution Detergent 
container 

Saline 

Reaction bath oil Detergent 
container 

ACUR20 

 

v. Check for any liquid leak from the pumps. If any, replace the entire pump 
head or the sealing materials. 

 Points to be checked for the ISE unit before measurement 

i. Check the remaining volumes of ISE buffer and internal standard are 
sufficient. 

ii. If the amount is insufficient, replace the bottle with a new one. 

After changing the ISE buffer bottle, set “15” times for the number of buffer priming. 

Close the panel above the bottle compartment during measurement. The vibration via 
bottles may influence the ISE test values. 

iii. When using the concentrated waste fluid tank, check if the room is sufficient. 
When replacing the buffer bottle, discard the waste fluid. 

iv. Check there is no excess amount of crystalline substance formed around the 
ISE dilution bowl and waste fluid outlet. For any abnormal findings around 
this area, perform maintenance on the dilution bowl tray. 
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 Settings and replenishments 

1) Check the temperature 

Select [Maint.] > [System Monitor] to check if the temperatures of the reaction 
carousel (RRV) and reaction tray (RTT) are acceptable and if the flow rate of the 
reaction bath oil is in the normal range. 

 
 

2) Define the analysis conditions 
 See “Chapter 2 Measurement Settings” for details. 
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3) Replenish reagents 

i. Select [Reagent] > [Reagent Test Monitor] to open the window below. 

 

ii. Check the remaining volume of each reagent. 

Write down the names of the tests for which reagents are insufficient. 

iii. Click the [Reagent Position] button in the [Reagent Test Monitor] window 

The window below is displayed. 

 
 

iv. Check the RTT positions of the reagent bottles on the [Reagent Position] 
window. 
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v. Replenish the reagent bottle. 
 The reagent contains surfactant.  Pour it carefully into the bottle to avoid 
foaming. 

 When the reagent bottle has a barcode label on, ensure that it is legible 
and not peeled off. 

vi. To check the reagent volume, select [Reagent] > [Reagent Test Monitor] > 
[Reagent Monitor] button. 

The remaining reagent volume is displayed in the [Reagent Position Monitor] window.  

 
 

vii. Click the [Cancel] button underneath the reagent tray (RTT) position number 
as required. 

This button is used to avoid using the reagent placed in the position. 

 If this button is pressed, the corresponding check box is checked in the 
[Reagent Container Set] window. 

 

 To see the volume of the sample set on the refrigerated sample tray 
(CTT), select [Reagent] > [CTT Monitor]. Note that the volume indicated 
in this window is the value detected by the liquid level sensor. 
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4) Check the lamp energy. 

Check the lamp energy weekly in the [Lam Energy Monitor] window. 

i. Select [Maint.] > [Lamp Energy] 

The [Lamp Energy Monitor] window is displayed. 

 

ii. Click the [Check Energy] button. 

The reaction cuvette containing water moves to the detection position. 

iii. Click the [Meas Energy] button. 

Spectrophotometry is performed. 

iv. Click the [Collect Data] button. 

The measurement data is displayed. 
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If a value < 80% is shown in the [Attenu] field, replace the lamp. Follow the steps 
described in “Chapter 7  Maintenance.”  

If a value < 4V or > 

 

9V is shown in the [Volt] field, the optical system including 
spectrophotometer and lamp might have problems. Contact your local distributor for the 
problem related to [Volt]. Solve the problems before proceeding to the next step. 

4.3.2 Priming 

Priming has to be performed when the cuvette detergent (alkaline), cuvette blank 
sample or saline is replenished. Steps are as follows: 

 

1) Click the [PRIME] button in the Operation Panel. 

The [Prime Set] window is displayed. 

 
 

2) Select [PRIME1] and click the [Execute] button. 

The priming [PRIME1] starts and finishes in approximately 5 minutes. 

 The numbers shown in the white boxes in the [PRIME Set] window indicate 
the number of priming to be performed. The figure shown above indicates 
that priming is performed for 5 times per line when “PRIME1” is selected. If 
you want to change the number of priming, change the number in the white 
box. 
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4.3.3 Washing at startup 
 

1) Click the [WASH] button in the Operation Panel. 

The [WASH Set] window is displayed. 

 
 

2) Select [WASH3] and click the [Execute] button. 

The [WASH3] begins and the startup washing finishes in approximately 27 minutes. 
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4.3.4 Cuvette blank measurement 

Follow the steps below to measure the cuvette blank. Perform the cuvette blank 
measurement approximately once a week. 

 

1) Click the [User Maintenance] button in the [Maint.] window. 

The window below is displayed. 

 
 

2) Click the [Start CB] button in the [Cell blank meas. check] field. 

The cell blank measurement starts and finishes in approximately 17 minutes. The 
measurement data and summary are displayed on the workstation monitor. 

3) When the measurement has been successfully completed, click the [Save] 
button. 

The data are saved in the hard disk of the workstation. 
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After the completion of measurement, the statistical results of the cuvette blank 
measurement are displayed on the [Realtime Monitor] window. You can print the 
results if necessary from the [User Maintenance] window. The position numbers of the 
flagged cuvettes are listed in the last part. 

The measured value of a cuvette with flag “H” is higher and that with flag “L” is lower 
than the average by more than the absorbance ± 0.04. These cuvettes are not used for 
measurement. 

When a significant number of cuvettes are flagged with H or L, perform one of the 
followings: 

• Replace the reaction cuvettes with new ones. 

• Perform [WASH] to clean the cuvettes. 
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4.4 Measurement 
 

 Warning 
When performing calibration or patient sample analysis, the probes and trays move. Never 
touch the probes and trays while they are moving. This may lead to injury or infection of 
the operator, or damage to the analyzer. 

 

4.4.1 Measurements of calibrators and control samples 

Calibration must be performed before measurement.  

For the ISE unit, calibration is required respectively for serum and urine.  If the calibrator for 
urine is used for serum calibration, or vice versa, the precision and accuracy will be reduced. 
Also, note that the previous calibration values are cleared when calibration starts. 

These measurements can be performed for chemistry tests and ISE tests either separately or 
simultaneously. In order to perform them simultaneously, preparation must be completed for 
both the chemistry and ISE tests. Following are the steps for the calibration (reagent blank 
and calibrator measurement) and the serum control measurement for quality control (QC) for 
chemistry tests. 

 Calibration (reagent blank and calibrator measurement) and 
control sample measurement for chemistry tests 

1) Prepare the samples. 

Dispense the sample in the container specified in [QC] > [QC Sample Definition] 
window and set in the position defined in [Calibration] > [Calibration Setup] window. 

2) Start measurement. 

Click the [START] button in the Operation Panel. The [Start Conditions] window is 
displayed. 
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When there is a test which uses the multipoint calibrator, check the “Analyze” check 
box for [Multipnt.smp.] in the [Calibration] column. 

Select either “98” or “99” for [TTNo]. 

Select “Analyze” for [Singlepnt.smp]. 

Select either “Calibration” or “ Special calib.” 

Select “Analyze” for [Control smp.] in the [Control] column. 

Click the [Start] button in the [Start Conditions] window. 

The measurement starts and the results are generated. 

 By clicking the [Start] button, the calibration and control measurement 
begin, and the countdown for automatic calibration and the test time count 
for automatic control (item) are reset. 
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 Calibration and control measurement for ISE test 

1) Set calibrators. 

Dispense the calibrators in the containers defined in the [CTT Setting] window 
accessed via [Setup] > [ISE Parameter Settings] > [CTT Set], and set the containers in 
the positions C-11 to C-14 defined in the [CTT Setting] window. For serum, set 
“Serum H-STD” and “Serum L-STD,” and for urine, set “Urine H-STD” and “Urine L-
STD.” The measurement begins with “Serum” and “H-STD.” 

 The default values are: C-11 to C-14.  To change the position on the 
refrigerated sample tray (CTT), select [ISE Parameter Settings] > [CTT 
Setting] window. 

 Set calibrator 

 

2) Select the sample type and refrigerated sample tray (CTT) position. 

For the sample type in the [ISE Parameter Settings] window, select “Serum/Urine” for 
[Serum/Urine] under [Calibration] in the [Electrolyte set] column. To select the CTT 
positions, open [QC] > [Sample Select], and click [C-11] to [C-14] buttons. 

 

3) Select the type of calibration. 

Click the [START] button in the Operation Panel to display the [Start Conditions] 
window. Select “Analyze” for [Singlepnt.smp] in the [Calibration] column. 

 
 

Select either [Calibration] or [Special calib.]. 

 These options are not displayed here if “Analyze” was not selected in Step 
1. 

4) Start calibration. 

Click the [Start] button in the [Start Conditions] window. Measurement of ISE 
calibrators begins first. The measurement is repeated 3 - 8 times until the difference in 
the calibration value (the sample potential minus the buffer potential) between the 
current value and the previous value falls within the allowance.  
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When calibration of the ISE test is achieved, the calibration for chemistry measurement 
begins. The ISE calibration values are displayed in the [ISE Monitor] window for 
comparison with the previous values. 

 

 The calibration for the ISE test can also be performed independently from 
the [ISE Operation] window. 

 Measurement of control samples 

1) Define the control samples in the [QC Sample Definition] window 

Select [QC] > [QC Sample Definition] to define the control samples. (  See Section 
2.2.6.) 

2) Set the control samples. 

Dispense the control samples in the respective containers specified in the [QC Sample 
Definition] window, and set the containers in the refrigerated sample tray (CTT) 
positions specified in the same window. 

 

3) Select the control samples in the [Sample Select] window. 

Select [QC] > [Sample Select] to select the control samples defined in Step 1. 
 

4) Click the [START] button in the Operation Panel. 

The [Start Conditions] window is displayed. 

 
 

5) Select “Analyze” for [Control smp.]. 
6) Click the [Start] button in the [Start Conditions] window. 

 

 If you do not intend to perform the control measurement, do not select 
“Analyze” for [Control smp.]. 
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 Changing tests for calibration and control measurement 

You can temporarily change the test selection and sample selection respectively in the 
[Temp.test select] and [Temp.sample select] windows accessed via the [Start 
Conditions] window. Since this is only a temporary change, the original settings of 
[Test Select] and [Sample Select] remain the same. 

This function is useful when you want to temporarily change the test or sample 
selection to perform another calibration and control measurement because the result of 
the calibration or control measurement was not valid. 

 [Temp.test select] window 

Select [Start Conditions] > [Temp.test select] to open the [Temp.test select] window 
shown below. 

 
 

Select tests for either [Calibration] or [Special calib.] depending on your selection in 
the [Start Conditions] window.  Note that the changes made in this window are 
temporary. 

[Test Table] Select tests respectively for [BLK], [STD] and 
[Control] in this table. 

[Select] In this column, select either [BLK], [STD], or [Control], 
and click the [Select All] button to chose all the tests 
selected above. Or, click [Clear All] to clear them all. 

 [Temp.sample select] window 

Click the [Temp.sample select] button in the [Start Conditions] window to open the 
[Temp.sample select] window shown below. (If you have selected the [Temp.sample 
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select] button in the [Control] column in the [Start Conditions] window, the “TT98” 
and “TT99” options in the figure below are not shown.) 

 
 

Change the samples selected in the [Sample Select] window temporarily here. The 
changes can be made respectively for [CTT], [STT98], and [STT99]. 

[Cancel] button  Click this button to cancel the temporary sample 
selection and return to the [Start Conditions] window. 

[Clear] button  Click this button to clear all the selected items. 
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4.4.2 Patient sample measurement 

1) Select [Request] > [Order Entry] to display the [Order Entry] window. 
Define tests for each sample here. 

Tests to be performed on a sample are designated with the “Sequence numbers” and 
“Test name” defined in the [Process Sequence] window. If any one of the ions “Na,” 
“K,” and Cl” is designated, The ISE test is performed for all three ions.  However, the 
result will be reported only for the ordered ion. 

 

 Measuring samples with no barcode label 

Defining the sample individually by position numbers (sample tray (STT) and cup 
position numbers) 

1. Click the [New] button in the [Order Entry (Sequential)] column on the left side of 
the [Order Entry] window. 

2. For [Posi.no], enter the STT number in the first field and the cup position number 
in the second field. 

The analyzer has only one sample tray (STT), but more than 84 samples can be 
efficiently defined at one time by using virtual STTs in this manner. The STTs numbered 2 
and upwards are those virtual trays. In actual operation, the measured samples are 
removed and new samples are added manually. 

 

3. Select tests to perform on the sample in the [Test table]. 

4. From the drop-down menu of [System Dilution Mode], select one of the options 
explained below. You can set the mode for each test. 
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[M Cond]  The system measures the sample using the sample 
dilution condition specified in [Analytical conditions] 
in the [Analytical Parameters (Chemistry)] window. 

[D1-D4 Cond.]  The system measures the sample using the sample 
dilution condition for rerun specified in the [Rerun 
Conditions Set] in the [Analytical Parameters 
(Chemistry)] window. 

5. For [Container type], select the type of the container to be used for the sample. 

6. For [Samp.type], select “1:Serum” for the serum measurement or “2:Urine” for the 
urine measurement. 

7. For [Dil.factor], enter the dilution factor when using a diluted sample. 

8. For [Comment], [Sex], [Age] and [Blood collection date], enter information as 
necessary. 

9. Click the [Enter] button. 

Defining a same measurement condition simultaneously for multiple samples by 
position numbers (the sample tray (STT) and cup position numbers) 

Follow the same steps up to Step 8 described above (before clicking the [Enter] button). 

9. Instead of clicking the [Enter] button, click the [Batch Entry] button on the 
command bar at the upper side of the [Order Entry] window. The [Batch Entry] 
window opens. 

 
 

10. For [Last no. entry format], select “Posi. no.” 

11. For [Last position number], enter the last STT position number. 

Enter the tray number in the first field and the position number in the second field. 

When two or more STT numbers are used, the samples are automatically defined up to the 
position 84, and then the remaining samples are defined from the position 1 of the next 
STT number.  

12. Click the [Execute] button. 

 Measuring samples with barcode 

Defining the samples individually by entering sample ID manually 
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1. Click the [New] button. 

2. Enter the number on the barcode label manually in the [Samp.no.] field. The 
barcode number should comprise up to 13 alphanumeric characters (A-Z, a-z, and 
0-9). 

3. Click the tests to perform in the [Test table] column in the central part of the 
window. 

4. From the drop-down menu of [System Dilution Mode], select one of the options 
explained below. You can set a mode for each test. 

[M Cond]  The system measures the sample using the sample 
dilution condition specified in [Analytical conditions] 
in the [Analytical Parameters (Chemistry)] window. 

[D1-D4 Cond.]  The system measures the sample using the sample 
dilution condition specified in the [Rerun Conditions 
Set] in the [Analytical Parameters (Chemistry)] window. 

5. For [Container type], select the type of the container to be used for the sample. 

6. For [Samp.type], select “1: Serum” for the serum measurement or “2: Urine” for 
the urine measurement. 

7. For [Dil.factor], enter the dilution factor when using a diluted sample. 

8. Fill in the [Comment], [Sex], [Age] and [Blood collection date] fields as required. 

9. Click the [Enter] button. 
 

Follow the same steps up to Step 8 described above (before clicking the [Enter] button). 

Defining a same measurement condition simultaneously for multiple samples using 
sample ID 

9. Instead of clicking the [Enter] button, click the [Batch Entry] button on the top bar 
in the [Order Entry] window. The [Batch Entry] window opens. 

 
 

10. For [Last no. entry format], select “Samp.no.” 

11. For [Last sample number], enter the last sample number. 

The same test is registered for the successively numbered samples from the number you 
entered in the [Order Entry] window up to this number. 
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12. Click the [Execute] button. 
 

2) Dispense the sample in the container and set on the sample tray. 

When you set a sample in a container, confirm no air is trapped in the container, 
especially near the bottom. If any air bubbles are formed when dispensing the serum in 
the sample container, be sure to remove them. Otherwise, the air bubbles will be 
aspirated to cause an abnormally low measurement value. 

3) Select [Request] > [Test Select]. Select “Routine/Priority/STAT 
samp.meas.” in the [Test select] column, and confirm that the target tests 
are shown selected in the [Test table] column. 

Here you can deselect tests as required. However, this deselection is applied to all the 
samples. 

4) Start measurement. 

Click the [START] button in the Operation Panel. The [Start Conditions] window 
opens. 

 

 

1. In the [Patient sample] column, select “Barcode” or “Cup posi.” for [Analyze 
mode]. 

Select “Barcode” when the sample containers have barcode labels and you select to use 
them. 

Select “Cup posi.” when you use the sample tray (STT) and cup position numbers. 

If you have chosen “Cup posi”, enter the number in [Tray No.]. 

Skip this step if you have chosen [Barcode]. 
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2. Check “Analyze” for [Routine smp.] in the [Patient sample] column. In the fields 
next to it, enter the STT position numbers used for measurement to define the 
range. 

3. Enter the STT number in the first field and the cup position number in the second field. 
Skip this step if you have chosen [Barcode]. 

4. Click the [Temp.cup/tube select] button. The [Temp.cup/tube select] window 
opens. 

 
 

If you use a type of the sample container that is different from the one already specified in 
the [Order Entry] window, you can change the value for each position by selecting a 
container type from the drop-down menu under the [Status/Container] header.  Also, if you 
want to measure specific samples sooner than others samples, check the box under the “I” 
header for those specific samples. To return to the [Start Conditions] window, click the 
[Return] button. Note that the [Execution] button is used when you have made a change in 
the [Container set] setting to the left of the button. 

5. Click the [Start] button in the [Start Conditions] window. If you have selected 
“Barcode,” the analyzer reads the barcode labels and then the [Sample 
Confirmation] window is displayed on the workstation monitor. 
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In the [Sample Confirmation] window, confirm that the correct barcode number is 
shown for each cup position on the STT. If the correct barcode number is not shown, 
you can manually enter the correct number in this window.  

If the analyzer cannot read some of the barcodes of the samples for which tests have 
been registered in the [Order Entry] window (due to stains, etc.), you can re-register 
them by manually entering the barcode numbers in the fields that correspond to the 
container positions. 

Here, you can also specify the priority of the samples to be measured by checking the 
corresponding boxes. 
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4.5 Checking the Calibration Results 
Select [Calib.] > [View Calibration Curve] to view the calibration results in the [View 
Calibration Curve] window. 

1) Display the calibration result of the test to check. 

Select [Calib.] > [View Calibration Curve], and select the test from the [Test name] 
drop-down menu.  

The calibration result is displayed for the selected test. 

 
 

2) View the calibration summary with the detailed information. 

Click the [Calib. Summary] button in the [View Calibration Curve] window. The 
[Calibration Summary] window opens as below. 
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3) View the calibration history. 

Click the [Calibration History] button in the [View Calibration Curve] window. The 
[Calibration History] window opens. The calibration results of the past 60 calibrations 
can be checked here. 

 
 

4) Perform calibration again if necessary. 

If one or more tests show invalid calibration results, perform calibration again after 
eliminating the possible cause. Use the [Temp.test select] and [Temp.sample select] 
windows accessed from the [Start Conditions] window to select the test to be measured 
again. 
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4.6 Checking the Control Sample 
Measurement Results 

 Types of quality control (QC) 

Three types of QC are available as follows. 
 

Real-Time QC  Features a twin-plot chart using the data from the 
control samples collected from the start of the system 
by the [New Start] mode.  It is used to check the 
precision of the current measurement data. 

 

Daily Precision Control Uses X-charts representing all the measurement data 
from the control samples completed in one day.  The 
purpose is to review the quality of the current day's 
measurement. 

 

QC Cumulative Features X-R charts of the data from control sample 
measurements collected daily. It is used to compare 
precision amongst plural measurement days. 

 

 [Real-Time QC] window 

1) Select [QC] > [Real-Time QC]. 

The window below is displayed. 

 
 

The measurement data from two control samples are displayed in line plot respectively 
for the selected tests.  
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2) Check the range of the result values. 

The chart display scale of each test is determined on the basis of the mean and standard 
deviation (SD) values for [Daily QC] in the [Control Data Registration] window 
accessed via the [QC] window. Check the range of the control measurement values so 
far in the day in relation to the Daily QC values. 

Also, when the results of control sample measurement fall within the following 
conditions, flags are displayed with the results. 

• 2SD < | (Result)－［Mean Value (X)］ | < 3SD.  When the result value falls within 
this range, the flag “l” or “h” is posted with the value in the report. 

• 3SD < | (Result)－[Mean Value (X)] |.  When the result value falls within this 
range, the flag “L” or “H” is posted with the value in the report. 

A posted flag indicates that the value is largely deviated in relation to the “Daily QC” 
values. 

3) [Twin-Plot] display 

Select “Twin-Plot” from the [View] drop-down menu on the top command bar in the 
[Real-Time QC] window. You can also select it in the display option drop-down menu 
on the upper-left side of the window. 

 

 

Test name combo box Display option combo box 

Measurement 
data 

 
 

The twin plot chart representing the measurement values of the two selected control 
samples is displayed. To see the chart for another test, select that test in the second left 
drop-down menu under the top bar. 
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4) Check the range of the result values in the [Twin-Plot] display. 

The values of the samples highlighted in the list on the left side of the window are 
plotted as blue dot in the graph on the left.  The graph on the right shows the enlarged 
view of ｔｈｅ area in the red frame. 

You can move the red frame on the left graph by clicking anywhere on the graph with a 
mouse. The new red-framed area is now shown magnified on the right graph. 
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 Daily precision control ([Daily Precision Control] window) 

1) Select [QC] > [Daily Precision Control]. 

The window below is displayed. 

 
 

The results from the measurements of the control samples from the time the system 
started with [New Start] from the “BioMajesty” start-up window are shown in 
chronological order of measurement. The graphs are displayed by control sample and 
by test. The display scale for each test depends on the [Daily QC] values set in the 
[Control Data Registration] window. 

2) Check the range of the result values. 

Check the range of the control measurement values in comparison with that of the 
[Daily QC] values for each test. When the range is within ±2SD, the background of the 
chart is shown in green. When the range is greater than ±2SD, the background of the 
chart is shown in reddish brown. 

 



 

 

ICABM6010/C-4  4-35 

C
hapter 4 

R
outine M

easurem
ent  

3) Display the control sample data. 

Select “Control Data” from the [View] drop-down menu on the top command tool of 
the [Daily Precision Control] window. You can also select it in the display option 
drop-down menu on the upper-left side of the window. 

 
 

The control sample number, measurement values, statistical data and line-plot (X-
chart) for the selected test are displayed by control sample. The test can be selected in 
the [Test] drop-down menu. 

Up to 200 control samples can be displayed in the [Daily Precision Control] window.  
When more than 200 samples have been measured, only the most recent 200 samples 
are displayed in the reverse chronological order and the control sample number moves 
forward. The statistical processing takes into account only these 200 samples. The data 
from the samples preceding these 200 samples are deleted and cannot be retrieved. 

 

4) Check the data. 

After selecting a control sample, select a test in the [Test] drop-down menu located in 
the mid-level of the window. The measurement data of the control sample for the 
selected test are displayed. 

5) Exclude an arbitrary measurement value from statistical processing. 

Click the [Omit] button to the right of the relevant measurement value shown in the 
lower half section in the [Daily Precision Control] window. 

The measurement value is deleted. When a measurement value is excluded from 
statistical processing by clicking the [Omit] button, the comment field to the right is 
activated.  You may enter the reason for exclusion. 

Be sure to click [Save] after deleting a value.  

The window below is displayed after the [Save] button is clicked. 
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Click [Yes] to save the deletion of the value. The measurement value is excluded from 
the statistical processing to obtain the cumulative QC value.  
Do not click [Save] if you do not want to exclude the measurement value from the 
processing. 

 The [Print], [Save], [Delete], [Save Control Data] and [Display order test］
buttons are only effective for the type of control sample that is currently 
displayed. One button click does not affect all the sample types 
simultaneously. 

 Once the measurement value is deleted, it is deleted even when the [Save] 
button is not clicked. However, when the [QC Cumulative Calculation] 
button is clicked to calculate the cumulative QC value, the deleted value is 
retained.  

 

6) Display the QC value list. 

Select “QC list” from the [View] drop-down menu on the top command tool of the 
[Daily Precision Control] window. You can also select it in the display option drop-
down menu on the upper-left side of the window. The following QC list is displayed. 

 

The statistical results are displayed by test for each control sample type.  

7) Check the data. 

Follow Step 5 above if exclusion of some data is required. 
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8) Register the data for cumulative QC calculation. 

Click the [QC Cumulative Calculation] button. 

The window below is displayed. 

 
 

Click the [Yes] button to display the [QC Cumulative Calculation] window. 

 
 

Click and highlight the control sample types to use and click [OK]. The mean value 
and range are registered as of the current system date to be used for cumulative QC 
calculation. 
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 Quality control of the measurement data over multiple dates 

1) Select [QC] > [QC Cumulative]. 

The window below is displayed. 

 
 

The data collection period is displayed on the left side in the blue upper border of the 
window.  The default period is the last one month. The X-R charts represent the 
average and range of the daily control sample measurement values during this period.  
The graphs are displayed by control sample type and by test. Each graph is displayed 
in the scale defined in the [QC Cumulative] column in the [QC] > [Control Data 
Registration] window. 

 

2) Check the range of the result values. 

Check the range of the control values in comparison with the [Daily QC] values for 
each test.  When the range is within ±2SD, the background of the chart is shown in 
white. When the range is out of this range, it is shown in green. 
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3) Display the control sample data. 

Select “Control Data” from the [View] drop-down menu on the top command tool of 
the [QC Cumulative] window. You can also select it in the display option drop-down 
menu on the upper-left side of the window. The data is now displayed as below. 

 
 

The date, mean value, value range, and other statistical results of the selected test are 
displayed in an X-R chart for the selected control sample type.  

 

4) Check the data. 

Select a test in the [Test] drop-down menu located in the mid-level of the window. The 
cumulative QC values for the selected test are displayed. 

5) Exclude the cumulative QC value of an arbitrary date from the statistical 
processing. 

Click the [Omit] button to the right of the relevant cumulative QC value in the data 
display section in the lower part of the window to delete the value. When a 
measurement value is excluded from statistical processing by clicking the [Omit] 
button, the comment field on the right side is activated.  You may enter the reason for 
exclusion, for example. 

Be sure to click [Save] after deleting a value. The value is excluded from the statistical 
processing to obtain the QC values. The window below is displayed after the [Save] 
button is clicked. 
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Click [Yes] to save the deletion of the value. The relevant value is excluded from the 
statistical processing to obtain the cumulative QC value. 

Do not click [Save] if you do not exclude the measurement value from the processing. 

 The [Print], [Save], [Delete], [Save Control Data] and [Display order test］
buttons are only effective for the type of control sample that is currently 
displayed. One button click does not affect all the sample types 
simultaneously. 

6) Display the QC value list. 

Select “QC list” from the [View] drop-down menu on the top command tool of the [QC 
Cumulative window. You can also select it in the display option drop-down menu on 
the upper-left side of the window. The following QC list is displayed. 

 

The cumulative QC values (statistical data of daily QC values) are displayed by test for 
each control sample type. 

 

7) Check the data. 

Follow Step 5 above if some data exclusion is required. 
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4.7 Urgent Sample Measurement 
Two methods are available for urgent sample measurement: “Priority” and “STAT 
port.” “Priority” is a method by which the relevant sample defined as “Priority” is 
placed in the sample tray (STT) to be measured sooner than the other samples, while 
“STAT port” is used instead of STT to set an urgent sample to be measured ahead of 
other samples. The STAT port can accept only one sample at a time.  Either method 
may be used, depending on the case. 

4.7.1 “Priority” measurement 

The samples are defined as “priority” in the [Order Entry] window. 

The [Temp.cup/tube select] and [Sample Confirmation] windows are also used for 
defining the “priority” samples. 

 [Order Entry] window 

Select [Request] > [Order Entry]. Select “Priority” for [Type] in the Order Entry 
(Sequential] column in the left side of the [Order Entry] window when defining tests 
on the sample. The sample will be measured sooner than the other samples. 

 

 

Select Priority Button 

 



  

 

4-42  ICABM6010/C-4 

C
hapter 4 

R
outine M

easurem
ent  

 

 [Cup/Tube Assign] window 

Select [Request] > [Cup/Tube Assign] to display the window below. 

 
 

This window is used to define the priority, status and container type for each STT 
position. Check the box under the [Pri.] header corresponding to the relevant STT 
number to measure the samples sooner than non-priority samples. Setting in this 
window has priority over that in the [Order Entry] window. 

Also, a container type different from the one already specified in the [Order Entry] 
window can be defined here. 
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4.7.2 STAT port 

Measurement from the STAT port is available when the system mode is [START], 
[READY], [Processing], or [PAUSE].  Only one sample can be set in the STAT port at 
a time. After sampling of the current sample is completed, the next sample can be 
placed in the STAT port. 

 

1) Set the sample 

Set a sample in the port and push the lever in when the system mode is either [START], 
[READY], [Processing], or [PAUSE]. 

 

Place the sample in the STAT port. 

Push in the lever. 
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2) Define values in the [STAT port] window 

When the sample is pushed in, the [STAT port] window is displayed.  However, the 
window is not displayed in the [WAIT] mode or [Processing] mode, from which the 
measurement cannot be resumed. 

The following [STAT port] setting is not required when the on-line order is received 
automatically. This automatic setting is defined in the [System Basic Configuration] 
column in the [System Specifications Set] window accessed from the [Setup] button in 
the Menu Panel. “Avail.” should be selected respectively for [On-line] and [STAT port 
barcode] there. 

 

[STAT Set Specification] Select “0” - “9” for the test set to perform. As 
described above, there is no need to select if the on-line 
order is received automatically.  In this case, when the 
[STAT Set Specification] button is clicked after the 
barcode is read, the STAT sample is numbered 
automatically from S01 and successively up to S100.  
To define the STAT test set, select [Setup] > [Setting 
System Parameter]. For [STAT Port Request Reflex 
Setting], select “0” - “9” to always use the same set or 
“99” to use the set selected for the previous STAT 
measurement. See “Section 5.9 [Setting System 
Parameters] window” in “Chapter 5 Optional 
Functions” as required. 

 The test set to use is defined in the [Request] > [STAT Order Setup] window. 

[Sample No.] This field displays the sample ID automatically when 
the sample barcode is read.  If the barcode is not 
readable or if you want to change the sample ID, enter 
a number manually using the keyboard.  
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However, when “N.A.” is selected for [STAT port 
barcode] in the [System Basic Configuration] column in 
the [System Specification Settings] window accessed 
from the [Setup] button in the Menu Panel, the STAT 
sample will be numbered automatically from S01 
successively up to S100.  
When the number exceeds S100, it returns to S01.  In 
this case, the measurement value previously at S01 is 
overwritten, and cannot be retrieved.  
Also, the STAT sample ID will be reset when the 
analyzer starts in the [New Start] mode. 

[Comment1 and 2] Two fields are available to enter your comments in the 
[Comment 1] and [Comment 2].  
You can define whether to display the comments with 
result or which comment to display as the [STAT 
Screen Comment Display Setting] option in the [Setting 
System Parameters] window. 

[Barcode re-reading] This button is to be displayed under the [Comment2] 
field. When the barcode reading was unsuccessful, 
click this button for re-reading.  
When it fails repeatedly, the barcode may not be 
readable.  Attach a new barcode label on the sample 
container, or enter the code manually using keyboard. 

Status box In this space under [Comment2], the status of the 
current STAT port measurement is displayed (e.g. 
barcode reading error). 

[Temporary Change] button Use this button to change the content of the test set 
content temporarily.  

 See the following “Section 3) Temporary change of 
the STAT port measurement setting.” 

[Selection Release] button  Use this button to deselect the selected “STAT Set 
Specification.” 

[Timer OFF] button Use this button to deactivate the timer. The timer will 
not automatically start when a sample is placed in the 
STAT port.  
When “0” is selected for the [STAT Port Request 
Screen Timer] option in the [Setting System 
Parameters] window, the timer is defined to be always 
“off”, therefore, this button is not activated. 

[Start] button Use this button to start the measurement of the sample 
set in the STAT port.  
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Click when you want to start the measurement before 
the counter beside the [Timer OFF] button finishes 
counting the remaining time down to “0”. 

[Cancel] button Measurement from the STAT port is canceled and the 
window is closed. 

3) Temporary change of the STAT port measurement setting. 

Display the [Temporary change] window 

If you need to change the settings temporarily, click the [Temporary Change] button in the 
[STAT port] window to display the [Temporary Change] window below. Enter the 
following values for temporary changes. 

 

“Test group to display” buttons  
 

[Samp.no.] This field displays the sample ID. 

[Sample Information] column  

[Container type] You can temporarily change the container type. 

[Samp. type] You can temporarily change the sample type. 

[Comment] Enter a comment. 

[Sex] You can temporarily change the gender of the patient. 

[Age] Enter the age of the patient. 
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[Dil.factor] Enter a dilution factor when you use diluted sample. 
The result values are calculated automatically. 

[Collec.date] Enter the sample collection date. 

[Test Table] You can temporarily change the test selection. 

[Dilution condition] button Click this button to display the window below.  You 
can define the dilution condition by test.  Two or more 
dilution condition can be defined.  Click [Add] to add 
the selected dilution condition. Click [Cancel] to return 
to the previous window without adding the condition. 

 

“Test group to display” buttons A group of 45 tests can be selected for display by 
clicking the button indicating the range of numbers. 

[Profiles Page] field You can temporarily change the tests defined as a set.  
Click the buttons to select a set. Up to 150 sets of tests 
can be registered. The first 30 sets are represented by 
the buttons respectively. To display the next 30 sets of 
tests, select “2” in the [Profile Page] drop-down menu. 
For additional test sets, select an appropriate number in 
the box.   

[Save] button Click this button to save and effectuate the temporary 
change.  

[Cancel] button Click this button to close the window without saving 
the change to return to the previous window. 

Start measurement after the temporary change. 

After clicking the [Save] button, the [STAT port] window is displayed again.  Click the 
[Start] button to start measurement under the modified conditions. 

 

4) Dispensing the STAT sample 

When the analyzer finished sampling from the STAT port, the [STAT port] window is 
aromatically closed. 

 If the [STAT port] window remains, some kind of error is suspected. Check 
the message in the status box in the [STAT port] window and act 
accordingly.  
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4.8 PAUSE / Smart PAUSE 
“PAUSE” and “Smart PAUSE” are the functions that allow temporary suspension of 
measurement to add samples. The steps are as follows: 

  PAUSE 

1) Set the analyzer to show “PAUSE” in the system mode box of the 
Operation Panel. 

When the system mode is “START”, click the [PAUSE] button and wait until 
“PAUSE” is displayed in the system mode box. 

 When the “Smart PAUSE” function is selected, the system mode shifts to 
“Smart PAUSE” by opening the cover of the sample tray (STT). The steps 
for setting “Smart PAUSE” are described on the next page. 

 When the system mode is already in “Processing” or “PAUSE”, you do not 
need to change the mode to add samples and continue measurement. 

2) Add samples when the Operation Panel displays “SMP LOAD OK” or 
“Append.” 

3) Click the [START] button in the Operation Panel to re-start the 
measurement. (If you set the samples defined with a different tray number 
in Step 2, you have to enter the tray number in the [Start condition] 
window before starting.) 

 

 

System mode 

Displays if the tray exchange or 
sample addition is possible. 

 

 Warning 
When you change the tray or samples after clicking the [PAUSE] or [STOP] button during 
operation, be sure to follow the instructions displayed in the system mode box. When 
“SMP LOAD NG” or “No append” is displayed, the probes and trays move. Never touch 
the probes and trays while they are moving. This may lead to injury or infection of the 
operator from the contact with serum, or damage to the analyzer. 

 

[PAUSE] button Click to suspend the on-going sampling during 
operation.  This button is used for the operation such as 
adding samples. 
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[STOP] button Click to stop sampling during operation. Do not use 
this button in the ordinary situation. 

 Smart PAUSE 

Smart PAUSE is the function that enables the analyzer to pause when the sample tray 
(STT) cover is opened and to resume measurement when it is closed. The setup steps 
are as follows: 

 Setup steps 

1. Select [Setup] > [System Specification Settings] to display the [System 
Specifications Set] window.  

2. In the [System Basic Configuration] column, select “Avail.” for [Sample barcode].  

3. In the [Rerun Settings] column, select “Flagged tests and untested tests” or 
“Untested tests only” for [Manual Rerun].  

4. In the [Smart PAUSE] column, select “Avail.” for [STT Cover]. 

 Workflow 

1) Open the sample tray (STT) cover 

The window below is displayed and the system mode shifts to “PAUSE”. 

 
 

 
ＣＡＵＴＩＯＮ  

 

While the mode is shifting, the tray and probe move. It is dangerous to touch the 
moving trays or probes, ensure that the mode has certainly shifted to “PAUSE” before 
adding the samples. 

2) The “Smart PAUSE” function is now applied 
3) Add the samples 
4) Close the STT cover 

The system mode turns to “START”. (Smart START) 

5) The analyzer reads the sample barcode labels. 
6) The [Sample Confirmation] window is displayed. 

When the timer counts down to “0” or when you click [OK], the measurement starts. 

 Conditions for application of the “Smart” functions 

The “Smart” functions are performed when all of the following conditions are met. 
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Smart PAUSE 

• When the STT cover is opened. 

• The system mode is either “START”, “Proces.SHIFT”, “HOLD”, “HOLD SHIFT” 
or “WAIT”. 

• “Avail.” is selected for the [Smart PAUSE] option in the [System Specification 
Settings] window. 

• Analyze” is not selected for [Multipnt.smp.] in the [Calibration] column and “Cup 
posi.” is not selected for [Analysis mode] in the [Patient sample] column of the 
[Start Conditions] window.  

• No pop-up window to be displayed by clicking a button in the Operation Panel is not 
being displayed. 

Smart START 

• When the STT cover is closed. 

• The system mode is “Smart PAUSE”. 
 

 When you shifted the system mode to [PAUSE] by clicking the [PAUSE] 
button, you have to click the [START] button to resume the operation. In the 
“PAUSE” mode triggered by “Smart PAUSE,” you can click the [START] 
button to resume the operation after closing the cover. (Operation can be 
resumed only by closing the cover, too.) 

 The term “Smart PAUSE” is shown only in the Operation Panel. The term 
“PAUSE” is used for all the windows including “Error Report” window 
instead of “Smart PAUSE” even if the pause was the result of “Smart 
PAUSE”.  



 

 

ICABM6010/C-4  4-51 

C
hapter 4 

R
outine M

easurem
ent  

4.9 Checking the Measurement Data 
4.9.1 Checking the chemistry analysis measurement results  

Select [Setup] > [Test Result Monitor] to display the window below. 

 

The measurement status and the most recent analysis data are displayed for each 
sample. The status and results are updated as the measurement proceeds. When the 
sampling is completed in the range of positions designated in the [Starting Conditions] 
window, the system mode shifts to “Processing”. 

1) Check the values in the Realtime Monitor 

Select [Request] > [Reatime Monitor] to open the window below. The displayed items 
vary depending on the setting defined in [Maint.] > [System Monitor] window. 

Following is the description of the items. 

 

Example of displayed results of calibration  
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Example of displayed results of control sample measurement 

 

Example of displayed results of patient sample 
 

 See “Chapter 6 Data Processing” for the detailed data processing. 
 

Test Name The name of the test 

Conc. Concentration. The value “0” is displayed for all the 
reagent blank measurements.  
The factor value is displayed for calibrators.  
The concentration is displayed for control and patient 
samples. 

Flag The space to post flags for value judged as abnormal. 
For the types and details concerning the flags, see 
Appendix 3. 

ABS-RB For reagent blank measurement, the value obtained by 
subtracting the previously measured value from the 
current measurement value is displayed in order to 
determine the discrepancy between the two values.  
For calibrator, control, and patient sample measurement, 
the reaction absorbance (Reaction ABS value) obtained 
by subtracting the reagent blank from the measurement 
value is displayed.  The ABS range is displayed for 
reaction rate assays (RRA), and the ABS value is 
displayed for end-point assays. 

ABS The absorbance calculated from the measurement value 
(including reagent blank) is displayed. The ABS range 
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is displayed for reaction rate assay (RRA), and ABS 
value for end-point assay. 

E1 When the check detection point (Check D.P.) is defined, 
the ABS value for the main wavelength is displayed. If 
not, the ABS value for the main wavelength at the main 
detection point .m (DET.P.m) is displayed. 

E2 The median of the ABS values for the main wavelength 
at detection point (DET.P) 4 to 6 is displayed. 

ABS1 The calculated absorbance at the main detection points 
(M-DET.P) is displayed.  ABS is obtained by 
subtracting ABS2 from ABS1. ABS2 is the value 
corrected with regard to the liquid volume. 

ABS2 Calculated absorbance at sub detection points (S-
DET.P) is displayed. 

N The number of the main detection points (M-DET.P) 
used for calculation.  

S Variance shown in %  

P Calculated prozone value 

RRV The position number of the reaction cuvette used for 
measurement. 

 Confirm the data and transfer them to the laboratory information 
system (LIS) 

2) Confirm the data on the display monitor 

1. Select [Request] > [Review/Edit] to display the [Review/Edit] window below. 
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2. Select a sample in the box on the left side to display the relevant data in the 
columns on the right side. 

3. Check the data and act accordingly when some flag(s) is posted. 
 



 

 

ICABM6010/C-4  4-55 

C
hapter 4 

R
outine M

easurem
ent  

3) Transfer the data 

1. Click the [Host Transfer] button on the top bar of the window to open the window 
below. 

 
 

2. Define the [Specif.range], [Number entry format], and [Last no. entry format] 
respectively. 

3. Enter the [Start no.] and [Last no.], and then click the [Execute] button. The data 
in the define range will be transferred to LIS. 

 

4) Check the data by the time course 

1. Select [Request] > [Reaction Monitor] to display the window below: 

 
 

2. Enter the [Posi.no] or [Samp.no] in the [Sample list] column to designate the 
sample. 

3. Click and select a test name displayed in the [Test name list] box. 

4. Check the time course of each test by sample. 
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5) Print the data for checking 

1. Select [Request] > [Statistics] to display the [Statistics] window below. 

 
 

2. Select “Details of test data” for [Print type] in the [Setting tests to print] column. 

3. Select the tests to print in the [Profile] or [Test Select] column. 

4. Define the printing details and print the data. 

5. Click the [Print] button to display the window below: 

 
 

i. Define the detailed printing content. 

Enter the [Specif.range], [ID entry format], and [Last no. entry format] respectively. 

ii. Define the printing range. 

Enter the [Start no.] and [Last.no.]. 

iii. Print the data 

Click the [Execute]. The designated range of data is printed.  
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4.9.2 Checking the ISE test results 

 Display the [ISE Monitor] window 

Select [Maint.] > [ISE Monitor] to display the window below. 

This window is used to check the result of calibration and the time course.  

 

[ISE Monitor] window 

 Features 

This window is used for: 

• Checking calibration results for the last 30 days.  The latest data is transferred to the 
ISE unit during the [INITIALIZE] mode. 

• Checking the chronologic changes of calibration results efficiently in the graphic 
display. Printing the calibration measurement data and results of the current data in 
the standard printing format and the calibration results only of past dates by using 
the [Monitor print] button. 

• Selecting a set of calibration values from the sets retained in the past 30 days by 
using the [Monitor search] button to transfer the set with the [Data transf.] button. 
The system recognizes the transferred set to be the latest one. 

• Checking the ion selectivity using the results of the latest ion selectivity check, 
because the time and the result values of the check are stored. Please note that the 
samples for the selectivity check (checking solutions for Na and K) are not included 
in the standard accessory set. 

• Printing the results of up to 100 patient samples in the standard printing format 
using [Chronologic.print] button.  The results are printed in reverse chronological 
order. 
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 Command buttons 

The table below summarizes the functions of the command buttons used for the above 
features. 

 Command buttons 

Name of the button Function 

Monitor print Used for printing calibration results of the last 30 days. 
When you have selected “Latest data”, you can define how many 
latest data to print if the calibration was repeated several times. The 
measurement values and result values are printed in reverse 
chronological order. 

Monitor search Used for selecting a date from the last 30 days to show the data in 
the [Calib.monitor:..] columns  

Chronologic.print Used for printing the data from up to 100 patient samples in the 
standard printing format. 

Serum <-> Urine Used for toggling the calibration history graph between serum and 
urine. 

Scale change Used for changing the scale of the Y axis in the calibration history 
graph. 
When the ISE Monitor window is displayed, the Y axis is optimally 
adjusted. 
To edit the scale of the Y axis, enter appropriate values in the [Scale 
change] window and click [Execute]. The graphs are now displayed 
with the entered values. 
Click the [Default] button in the [Scale change] window to display 
the graph in the normal range of each test.  The measurement value 
which was not displayed within the screen will be treated as range 
or slope error. 
To return to the automatically adjusted scale of the history graph, 
click the [serum <-> urine] or close and then re-open the window.  

Delete All ISE Data Used to clear all the calibration data stored in the system.  
This button is used on limited occasions such as when some error 
occurred in the calibration history graph due to a software upgrade.  
Do not use [Delete All ISE Date] under ordinary circumstances. 
Otherwise, the system will lose valid calibration values to use  
when an abnormality occurs in calibration. Be sure to backup the 
calibration data before clicking this button. 
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Name of the button Function 

Data transfer Used for sending the data displayed in the [Calibration monitor] 
window to the ISE unit to overwrite the existing calibration values. 
When there is an error in the calibration data, the message “No 
calibration data” is displayed and no measurement is performed.  
This indicates that the calibration has not been successfully 
completed. When the maintenance related measurement such as 
interval check or CV check is performed, select the correct data 
using the [Monitor Search] button and display the valid values in the 
window. Then use this [Transfer data] button to transfer the 
displayed values to the ISE unit. 
 
Note) 
1. When you click the [Transfer data] button during the [INITIALIZE] 
mode, the message “An error occurred during transmission” may 
be displayed. 

2. The transferred data is recognized to be the latest data. 
3. When you try to transfer the data with the flag “H” or “L” for 
“slope”, or “d” for “dilution factor”, the transfer will fail. 

Exit Close the [ISE Monitor] window 
 

 Columns in the window 

 [Calib.monitor] column 

The latest calibration values are displayed in this column.  Use the [Monitor search] 
button to show past values. This column is for display purposes only. No entry is 
allowed. The following table summarizes the contents of the items in the column. They 
are shared by “Serum” and “Urine”. 
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Item Description 

Ｄａｔｅ Shows the date and time when the calibration values were acquired. 
C- Indicates the position number of the refrigerated sample tray (CTT) 

defined respectively for L-STD and H-STD measurements. 
Low The fields under this header show the potential (sample potential 

minus buffer potential) of Na, K, and Cl electrodes obtained by L-
STD measurement and the potentials of thermistors 1 and 2 (TH1 
and TH2) when the L-STD sample potential is measured. 

High The fields under this header show the potential (sample potential 
minus buffer potential) of Na, K, and Cl electrodes obtained by H-
STD measurement and the potentials of the thermistors 1 and 2 
(TH1 and TH2) when the H-STD sample potential is measured. 

Base Indicates the buffer potentials of Na, K, and Cl electrodes and the 
potentials of TH1 and TH2. The values for L-STD and H-STD 
measurements are displayed accordingly. 

Slope Indicates the sensitivity of electrodes Na, K, and Cl.  The flag [h] is 
posted when the measurement value is greater than the value 
defined for [Slope upper limit h] in the [ISE Parameter Settings] 
window, and the flag [l] is posted when the value is lower than the 
value defined for [Slope lower limit l].  When the value is out of the 
existing abnormal slope threshold, “L” or “H” is displayed.  Use 
these flags to judge the timing of electrode replacement. 
When the slope is out of the abnormal threshold, the value will be 
“0” and the correct values cannot be calculated.  

Dil.factor The calculated dilution factors for Na, K, and Cl samples are 
displayed.  The flag “d” is posted to alert to user to the dilution factor 
error when it is out of the dilution factor range.  The calibration 
values cannot be correctly calculated. 

Ref.Electrode The flag “d” is posted when the value is 350 or lower. This signifies 
that it is time to use a new electrode. 

 

 [Selectivity check] column 

 

This column shows the latest data but allows no entry. It is for display purposes only.  

The selectivity of each electrode is measured three times and the mean value of the 
second and third results are displayed in the fields under the [Conc.], [Sample], and 
[Buffer] header respectively. 

Please note that the samples used for the selectivity checks (checking solutions for Na 
and K) are not included in the standard accessory set, and must be purchased separately. 
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The following table summarizes the contents of the items in the column. 
 

Item Description 

Date Shows the selectivity check date of the Na and K electrodes, 
respectively. 

Conc. Shows Na and K concentration values measured at the selectivity 
check, respectively.  
When the concentration value is above the upper limit defined for 
selectivity, a “u” character is flagged in the box to the right of the 
concentration field.  This means that there is inference by some other 
ion. These flags can be used to judge the timing of electrode 
replacement. 

Sample Shows the value obtained by subtracting the buffer potential from the 
sample potential regarding the selectivity check of the Na and K 
electrodes. 

Buffer Shows the buffer potential at the selectivity check measurement of 
the Na and K electrodes, respectively. 

 

 [Calibration history] column 

 

For both serum and urine, the calibration values measured for the last 30 days are 
graphically displayed in this column. The latest value is shown on the left-most side. 

The data is stored by date. Only the latest values of the date are stored. 

The value obtained by subtracting the buffer potential from the sample potential is 
plotted by electrode (Na, K, and Cl) and by calibrator (H-STD and L-STD). The slope 
value in the bottom graph is plotted by all three electrodes Na, K, and Cl values. (Cl 
values with inverse plus and minus sign) Use this graph to judge the timing of 
electrode replacement. 
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• Click the [Serum <-> Urine] button in the top bar to toggle the display between 
serum and urine. 

• The Y axis is scaled automatically when the window is displayed. 

 Realtime monitor 

As already described in the section 4.9.1, the realtime monitor allows you to check the 
ISE calibration and measurement values, too. Select [Request] > [Realtine Monitor] to 
display the [Realtime Monitor] window below. The ISE-related area is as follows: 

 Calibration data 

Following is an example of serum calibration results. 
 
 
 
 
 
 
 
 
 
 
 
 

   
         
ELASTDSH011 S-B  Flag Sample       

Base  
TH１  Sample Base  TH2  S ample Base  

Na         442.3  341.0 -101.3 493.7 498.1 487.4 491.2 
K       374.4  611.8 237.3     
Cl        -174.1  993.8 1167.9     
         
ELASTDSH012 S-B  Flag  Sample       

Base  
TH１  Sample Base  TH2  S ample Base  

Na         441.8  341.6 -100.1 486.7 488.6 480.9 482.5 
K        374.4  612.3 237.8     
Cl       -173.6  994.3 1167.9     
         
    ・     
    ・     
    ・     
LASTDSL011 S-B  Flag  Sample Base TH１  Sample Base  TH2  S ample Base  
Na:       398.0  298.2 -99.9 485.1 485.7 480.6 480.8 
K       276.4  513.1 236.8     
Cl       -144.2  1027.0 1171.2     
         
ELASTDSL012 S-B  Flag  Sample Base  TH１  Sample Base  TH2  S ample Base  
Na       397.8  300.3 -97.5 483.3 484.0 478.5 478.8 
K       277.0  515.0 238.1     
Cl       -143.7  1027.0 1170.8     
         
    ・     
    ・     
    ・     
ISE Calibration:Serum  Meas.Date:2009/10/ 5   0: 3 ISE serial number: 

93CK**** 
 

Test Name Flag H-STD Base L-STD Base Slope Dilute  
Na        441.9 -100.6 397.3 -96.7 62.4 38.7  
K        374.7 236.9 276.7 238.8 56.6 33.2  
Cl        -173.8 1168.6 -143.7 1170.9 -53.6 34.5  
TH1        486.2 487.3 482.1 482.9    
TH2  480.6 481.4 477.5 478.1    
Ref.electrode  1170.9       

 
 

 

 
Flagged: 
Slope alarm（h, l） 
Slope abnormal （H，L） 
Dilution ratio abnormal (d), Bias 
abnormal (NG) 

Control value of 
reference electrode. 
Flag “d” will be 
displayed when the 
value is lower than 
350 

The slope out of the 
normal range is 
judged abnormal. 

The dilution factor 
out of the normal 
range is judged 
abnormal. 

Thermistor1 potential when sample 
potential is measured 

Thermistor1 potential when buffer potential 
is measured 

Flag for data alarm 
Result (Sample potential-Buffer potential) 

Number of measurements of calibration 

H-STD（H） or L-STD（L） 
serum（S）or urine（U） 

Number of measurements of the day 
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• Under the [S-B] header, the mean values of the sample potential minus the buffer 
potential of the last two measurements are displayed. 

 

• The temperature of calibrators (diluted with buffer solution) is measured every time 
and displayed under the [TH] header.   

• The slope value and dilution factor are calculated from the measurement results of 
H-STD and L-STD calibrators and displayed respectively under the [Slope] and 
[Dilute] headers located in the lower right of the above chart. 

 

• Select ［Maint.］> [ISE Monitor] to compare the results with the previous results. 

• The slope value out of the 63 - 45* range indicates that it is time to replace the 
electrodes.  At that time, the flag “l” or “h” is posted for warning.  

 *The value range of the slope for flag display can be defined in the [ISE 
Parameter Settings] window. 

• A slope value outside of the 65 - 38 range is judged abnormal, and the flag “H” or 
“L” is posted. You cannot change this value range. 

• The dilution factor is the factor by which the calibrator is diluted with the buffer 
solution. It is calculated from the calibration data. If the calculated dilution factor is 
out of the 25 - 60 range, the flag “d” is posted and the data is treated as calibration 
error.  The possible cause of the error may be degradation of the calibrator or buffer 
solution, or improper washing. 

• When a calibration error occurs, the calibration data stored in the ISE unit is deleted.  
The previous data are retained in the [ISE Monitor] window and these data are 
transferred to the ISE unit as the latest data during the system [INITIATE] mode. 
These data will be used for calculating the measurement results. 

• When the slope or dilution fraction is abnormal, the values in the [ISE Monitor] will 
be updated but cannot be used for measurement. In this case, either repeat the 
calibration, or transfer normal data from the [ISE Monitor] window to set the normal 
calibration data for measurement.  
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 Patient sample measurement data 

The [Realtime Monitor] window displays the patient sample measurement data as well. 
 

Sample 
No. 

 Posi.No. comment1 comment2 Sex Age Sample 
type 

Dil.factor 

          
Test Name Conc. Flag SAMPLE BASE TH1.S TH1.B TH2.S TH2.B  
Na 144  -33.8 -442.9 79.9 82.6 82.4 88.0  
K 3.9  278.4 -8.7 79.9 82.6 82.4 88.0  
Cl 94  899.7 1050.2 79.9 82.6 82.4 88.0  

 
 
 
 
 
 
 
 
 
 

The displayed items are as follows: 

• In the [Sample No.] line, the sample attributes are displayed.  
For [Sample No.], a sample ID or arbitrary registration number (up to 13 bytes) is 
displayed (e.g. “1”).  
 [Posi.No.] is displayed in [TTNo.]－[Cup no.] or by the rack position (e.g. 1-1). For 
[Sex], “Ｍ” is displayed for male and “F” for female.  
For [Sample type], “S” is displayed for serum and “U” for urine.  
For [Dil.factor], the value entered in the [Order Entry] window is displayed for 
the sample diluted before measurement. 

• The test names specified in the [ISE Parameter Settings] window are displayed for 
[Test Name]. 

• The number of decimals of the value in the [Conc. (concentration)] field has been 
defined in the [ISE Parameter Settings] window. 

• The [Flag] field displays the flags selected for [Rerun cond.] in the [ISE Parameter 
Settings] window when the relevant abnormal values are obtained in measurement. 

 For details of flags, see “Appendix 3. Flags” 

Thermistor potential when buffer 
potential is measured 

Thermistor potential when sample 
potential is measured 
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4.10 Rerun 
When “ON (from STT)” is selected for [Auto.rerun] in the [Rerun Settings] column in 
the [System Specification Settings] window, the system automatically reruns the test 
which is judged the rerun is required. 

This section describes the steps necessary to define a rerun for a measured sample, and 
to perform it whether the automatic rerun is selected or not. 

1) Select in advance “Flagged tests and untested tests” for [Manual Rerun] 
in the [Rerun Settings] column of the [System Specification Settings] 
window. 

This allows the system to perform the “flagged tests and untested tests” in rerun. 

2) Define the sample and measurement conditions for rerun 

Select [Request] > [Review/Edit] to display the window below. 

  
 

In the list box on the left, click the number under the [Order #] header to select the 
sample to rerun. The selected sample is shown highlighted and the fields in the 
[Sample Information] column are automatically populated with the corresponding 
values. 

Check the tests to rerun in the box under the [R] header. 

Select one from “M” - “D4” for [[Dil.Cond] and click the [Save] button. The diluent 
conditions “Ｍ” - “D4” are as follows: 

“Ｍ” The sample volume defined either for [Sample Vol (S) 
or (U)] in the [Analytical conditions] columns in the 
[Analytical Parameters (Chemistry)] window is diluted 
in the condition defined in the [Analysis test condition 
setting (M)] window. 
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“D1” - “D4” Rerun condition and dilution condition defined in 
[Rerun conditions] window accessed from [Setup] > 
[Analytical Parameters (Chemistry)] window 

3) Rerun with the sample selected in Step 2 

There are two cases for rerunning. 

• When “N.A.” is selected for [Sample barcode] in the [Setup] > [ System 
Specification Settings] window, you do n ot have to change the sample 
position in the sample tray (STT), but rather enter the currently used 
“TrayNo.” in the [Start Conditions] window displayed by clicking the 
[START] button in the Operation Panel and then click the [Start] button in 
the [Start Conditions] window. 

• When “Avail.” is selected for [Sample barcode] in the [Setup] > [System 
Specification Settings] window, you do n ot have to change the sample 
position in the sample tray (STT) nor enter the “TrayNo.” in the [Start 
Conditions] window because the information is supplied by the barcode.  

The tests defined for rerun repeated. 

Apart from the defined tests, the following measurements may be performed 
simultaneously depending on the case. 

• The tests for which the system has defined auto rerun but have not been 
performed yet. 

• The tests that have been defined but have not been performed due to 
reagent shortage, etc. 

 

 When “N.A.” is selected for [Auto.rerun] in the [Rerun Settings] column 
in the [System Specification Settings] window, the tests that the system 
has defined to rerun will remain unperformed.  When “On (from STT)” is 
selected, usually the tests defined to rerun are automatically performed, 
except in select cases including some reagent shortages. In this latter 
case, the tests remain unperformed. 

 

 Define a dilution condition for the initial run of a test with a 
sample for which the value is expected to be high. 

When the test value of a sample is known in advance to be high, define a dilution 
condition to apply to the initial run. 

Select [Request] > [Order Entry]. In the window, select an option from [2: D1 cond.] to 
[5: D4 cond.] for [System Dilution Mode], or click the [Multi Dil.] button and select an 
option from “M” to “D4”  

Thus, the sample is measured with the dilution condition in the initial run. 
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4.11 Check the Remaining Reagent 
Volume 
Select [Reagent] > [Reagent Test Monitor] to check the current volume of the reagents 
by test. 

If you have replenished the reagents and want to check the remaining volume, follow 
the steps below. 

 Steps to scan the remaining reagent volume  

1) Display the [Reagent Bottle Scan] window 

Select [Reagent] > [Reagent Test Monitor], and click the [Reagent Scan] button. The 
window below is displayed. 

 
 

2) Select a reagent tray “RTT”. 

Select “RTT1” for [RTT select]. 

3) Select the positions of reagent bottles to check. 

Click the boxes under the [Check] header corresponding to the positions of the reagent 
bottles to check in RTT1.  

4) Change RTT 

Select “RTT2” for [RTT select]. 

5) Select the positions of reagent bottles to check. 

Click the boxes under the [Check] header corresponding to the positions of the reagent 
bottles to check in RTT2. 
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6) Scan the reagent bottles 

Click the [Start] button to start the reagent scan. 

The reagent probes check the remaining volume of reagents in the bottles in 
numerical order by position. This is accomplished by repeating aspiration/washing 
motions, although the reagents are not actually aspirated.  During this operation, 
the Operation Panel displays “REAGENT SCAN” as the system mode.  When the 
scan is completed, the mode returns to “READY”. 

7) Check the volume 

Check the remaining volume in the [Reagent Test Monitor] window. 
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4.12 R-PAUSE 
“R-PAUSE” or “Reagent-PAUSE” is a feature that allows the system to suspend 
measurement temporarily in order to replace empty reagent bottles. 

Click the [R-PAUSE] button in the Operation Panel. The system mode shifts to [R-
PAUSE SHIFT] and then to [R-PAUSE]. At this point you can replace an empty 
reagent bottle. 

During “R-PAUSE”, select [Request] > [Sample Log] window and confirm the event in 
the window. 

 Workflow 

1. Click the [R-PAUSE] button on the Operational Panel. 

2. The system mode shifts to “R-PAUSE SHIFT” and the sampling is suspended. 

3. The mode shifts to “R-PAUSE” 

The mode shifts to “R-PAUSE” when the reagent dispensing is completed for the sample 
that had already been dispensed in the cuvette when the “R-PAUSE” button was clicked. 

 

4. The [Reagent Scan] window is displayed. You can replenish the reagent or replace the 
reagent bottle as required 

 
 

5. Select “Barcode Scan/Bottle Scan” or “Bottle Scan” and click the [Start] button. The 
barcode reading or reagent volume check is performed. 

 When the reagent barcode is used for operation, ensure to select “Barcode 
Scan/Bottle Scan”. 
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6. The measurement will resume automatically. 

 Setting the “Auto R-PAUSE” feature 

“Auto R-PAUSE” is a feature that enables the system mode to shift to [R-PAUSE] 
automatically when a reagent shortage is detected during measurement. To use this 
feature, follow the steps below. 

1) Select “1: W+Selection” for [Processing mode in no reagent] in the 
[Setting System Parameters] window. 

Select [Setup] > [Setting System Parameters] to display the [Setting System 
Parameters] window. 

In the [Value] field for the parameter [Processing mode in no reagent], enter “1” that 
represents “1: W+Selection” in the [Comment] field. 

Click the [Exit] button in the upper left section. A pop-up window is displayed and ask 
“Save and Exit?” Click [Yes] to close the window. 

2) Select to use the “AUTO R-PAUSE” feature in the [System Specification 
Settings] window 

Select [Setup] > [System Specification Settings] to display the [System Specification 
Settings] window. Define the following values. 

 
 

[Auto Reagent PAUSE] Default value is “N.A.”  Select “Avail.” to use the 
“Auto Reagent PAUSE” function. 

Click the [Exit] button in the upper left section. A pop-up window is displayed and ask 
“Save and Exit?” Click [Yes] to close the window. 
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3) Enable the setting 

Follow the steps described in the section 4.13 to shut down the analyzer once, and then 
restart it up with the “PC CONTROL” mode by “New Start”. 

 NOTES 

• Reagent replacement is possible when the analyzer has finished dispensing all the 
scheduled reagents.  
When the [R-PAUSE] button is clicked, the sampling is suspended, but the reagents 
will be dispensed into the cuvettes that already contain samples.The dispensing of 
Reagent 2e and Reagent 2 should also be completed. Therefore, depending on when 
the [R-PAUSE] button is clicked and the number of tests scheduled for the samples, 
it may take more than 5 minutes for the system mode to shift to “R-PAUSE”. 

• The [R-PAUSE] button is activated in the following system modes in which a 
reagent pause is possible. 

• START 

• Proces.SHIFT 

• HOLD When the analyzer is connected to a laboratory automation 
    system (LAS) or a rack handler 

• HOLD SHIFT When the analyzer is connected to a LAS or a rack 
 handler 

• WAIT When the analyzer is connected to a LAS or a rack handler 

• In the [R-PAUSE] mode, samples cannot be replaced or added on the sample tray 
(STT) or the refrigerated sample tray (CTT).  
To replace or add samples, resume measurement from the “R-PAUSE” mode and 
click the [PAUSE] button. 

• Even if the system detects a detergent, water, or diluent shortage, it will not enter 
automatically in the “R-PAUSE” mode.   
When replenishment or replacement is required, click the [R-PAUSE] button to shift 
the system mode to “R-PAUSE”. 

• No automatic calibration is performed for the reagent replenished in the same bottle.  
If you want to perform calibration, follow the steps described in the section 4.4.1. 

• Measurement from the STAT port is not available in the “R-PAUSE SHIFT” and 
“R-PAUSE” modes. 

• When the reagent shortage is detected while “Auto Reagent PAUSE” function is 
selected and the [Sample confirmation], [Start Conditions], or [STAT Port] window 
displayed on the monitor, the system mode skips the “R-PAUSE SHIFT” mode to 
shift directly to “AUTO R-PAUSE.” 
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4.13 System End/Shutdown 
 

 Warning 
When performing “WASH”, the probes and trays move. Never touch the probes and trays 
while they are moving. This may lead to injury or infection of the operator, or damage to 
the analyzer. 

 

 Washing after the day's operation  

Perform the washing at the end of the day’s operation by following the steps below: 

1) Select [Setup] > [ISE Parameter Settings]. 
2) Select “with e.wash” for [WASH2] in the [Prime/Electrode Wash] section. 

This set up is carried out only once at the beginning of washing. It is not necessary to 
repeat Steps 1 and 2 for every end-of-the-day wash. 

3) Place Reagent probe wash -K (20%) in position 49 and pure water in 
position 50 of the reagent trays (RTT) 1 and 2, respectively.  

4) Set the ISE detergent solution and pure water in the respective containers 
defined in the [ISE Parameter Settings] window, and then place the 
containers in the positions defined in the same window. 

5) 1) Select the [WASH] button on the Operational Panel. 

[The WASH Set] window is displayed. 

 
 

6) Select [WASH2] and click the [Execute] button. 

WASH2 is performed, and the ISE unit is washed together with the chemistry analysis 
unit.  

This entire procedure lasts approximately 40 minutes. 

 When a large quantities of urine or dialysate samples were analyzed during 
the day, replace the electrodes with the dummy electrodes and perform the 
line wash after the ISE wash (  See Section 4.6). 
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 After the line wash, be sure to perform calibration before the next 
measurement, as the line wash changes the condition of the electrodes. 

 Shutdown the system 

1) Click the [System (S)] button in the upper left corner of the Menu Panel 
and select “Exit” in the drop-down menu. 

The pop-up window is displayed and asks “OK to exit?” 

2) Click the [Yes] button. 

The pop-up window is displayed again and asks “Are you sure?” 

3) Click the [Yes] button. 

Approximately 15 seconds later, “BioMajesty” startup window is displayed. 

 

“BioMajesty” startup window 

4) Click the [Shutdown] button. 

The workstation shuts down and the power gets off. If “PC CONTROL” is selected by 
the Operate/Standby switch of the Power Panel of the analyzer, the analyzer turns the 
power off automatically.  
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 Check the power supply status of the analyzer 

Check that “PC CONTROL” is selected by the Operate/Standby switch and the power 
light is off in the Power Panel of the analyzer. 

 If     (ON) is selected by the Operate/Standby switch, turn it to  
  (OFF) 

once and then select “PC CONTROL”.  If “PC CONTROL” is not selected, 
the analyzer does not turn on or off automatically with the workstation. 

 

Operate/Standby 
switch 

Power panel 

Power light 
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 Turn the power off the workstation. 

 

Workstation 

The display and printer turn off automatically if their power supply is synchronized 
with the computer. If not, turn the individual switch off. 

 Shutdown the pure water supply unit 

Follow the instruction of your pure water supply unit to end the unit.  Close the main 
cock for safety. 

 

 CAUTION 
Be sure to close the tap water supply cock during night hours when no users are present, 
as well as on holidays.  The water pressure may be elevated, resulting in water leaks at the 
connections, which may cause water damage on the system. 

 

 Clean the environment of the analyzer 

1) Clean the floor around the analyzer with a vacuum cleaner. 
2) Take care of the sample cups and other materials properly. 
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4.14 Maintenance 
Appropriate maintenance should be performed regularly as well as occasionally as 
required. Refer to “Chapter 7 Maintenance” for details. 
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5.1 Handling and Setting Reagent 
Bottles 

5.1.1 Using multiple bottles of a reagent for a test 

 Setting the analyzer to recognize multiple bottles of the same 
reagent 

Frequently performed tests require larger volumes of reagent than other less often used 
tests. Therefore, it is practical to have several bottles of the same reagent on the 
reagent tray (RTT). Follow the steps below to set the analyzer to recognize multiple 
bottles of the same reagent: 

1 Select [Setup] > [System Test List] to open the [System Test List] window. 

 
 

2 Enter multiple position numbers in the [Position] fields for [R1], [R2e], and 
[R2] reagent bottles. For instance, if you want to set 3 bottles in positions 5, 6, 
and 7, enter [5, 6, 7] or [5-7] in the [Position] field. 

3 Click the [Save] button in the upper left of the window to save the setting 

When you are using reagent bottles with barcode, please see Section 5.1.2. 
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 Bottle usage order 

When the analyzer starts operation after multiple reagent bottles are set, it begins by 
using the bottle located at the lowest position number first.  When the first bottle 
becomes empty, the analyzer uses the reagent bottle located at the next lowest position 
number. 

When you replace the reagent bottles, select [Reagent] > [Reagent Test Monitor] and 
click the [Reset] button then click the [START] button on the Operation Panel. 
Alternatively, click the [Reagent Scan] button instead of the [Reset] button; after the 
reagent scan is completed, click the [START] button on the Operation Panel. The 
analyzer restarts and again uses the reagent bottle located at the lowest position 
number. 

 

 When the [Reset] button is pressed, the analyzer assumes the reagent 
bottle was replaced. After reset, bottle status is displayed either as "bottle 
capacity" or "indefinite" according to the selections made in the [Setting 
System Parameters] > [Reagent Reset] window. 

 See the details regarding [Reagent Reset] in “Section 5.9 Parameters in the 
[Setting System Parameters] Window" of this chapter. 
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 Automatic calibration for a new bottle 

Automatic calibration can be selected for a new bottle of reagent when multiple 
reagent bottles are set for a test. 

Select [Calib.] > [Calibration Setup] > [Auto Calibration Setting] for setup. For details, 
see “Section 5.4 Automatic Calibration and Automatic Control Measurement"

To select tests for automatic calibration, select [Request] > [Test Select]. Select [Auto 
calibration meas.] in the [Test Select] column then click the test name buttons in the 
[Test table] column. Auto calibration will be performed on the reagent bottles for the 
selected tests when the bottle is replaced to a new one. 

 of this 
chapter. 
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5.1.2 Barcode on the reagent bottle  

 Functions of the reagent bottle barcode 

The barcode label placed on the reagent bottle contains information such as the name 
of manufacturer, test name, expiration date, and bottle capacity. 

The following features are available when a bottle is set on the reagent tray (RTT) and 
the barcode is read.   

 

• The expiration date can be checked on the workstation display. 

• Reagent bottles can be set in arbitrary RTT positions. 

• The bottle capacity is automatically recognized. 

 Selecting to use the barcode on the reagent bottle for 
identification 

1 Select [Setup] > [System Specification Settings] to display the window below: 
Select "Avail." for the [Reagent barcode] field in the [System Basic 
Configuration] column. 

  
 



 

 

ICABM6010/C-4  5-5 

C
hapter 5 

O
ptional Functions  

2 Define the following values in the [Reagent Bottle Specification] column in 
the lower right side of the window. 

 

[Type] 
[Container 

name] 
[Bottle section 

area] 

[LLS (liquid level 
sensor) 

sensitivity] 

[Bottle1] 7 mL 80 mm Med. 2 
[Bottle2] 20 mL 300 mm Med. 2 
[Bottle3] 70 mL 850 mm Med. 
[Bottle4] 40 mL 470 mm Med. 2 

 

3 Select [Setup] > [System Test List] to display the window below: 

   
 

4 Enter a 5-digit identification number in the [R-Code] field. 

Normally, the RTT position where the reagent bottle is placed is entered in the [Position] 
field of the test. However, when the reagent bottle barcode is used, leave the [Position] 
field blank but enter a 5-digit number in the [R-Code] field. The first 3 digits correspond 
to the manufacturer’s name and the last 2 digits refer to the test. The manufacturer number 
can be found on the reagent’s package insert.  Otherwise, contact the reagent 
manufacturer. 
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 Reading the barcode on the reagent bottle 

Follow the steps below for the analyzer to read the barcode on the reagent bottle. 

1 Check that the analyzer is at the halt in the [READY] mode. 

2 Set the reagent bottle on RTT. 

You can place reagent bottles with a barcode label in arbitrary positions. You can also set 
multiple bottles of a reagent used for a test. 

3 Select [Reagent] > [Reagent Test Monitor] and Click the [Reagent Scan] 
button. 

As the RTT rotates, each reagent bottle barcode is read. 
 

4 Select [Reagent] > [Reagent Container Set] to open the window below. 

 
 

When the reading is complete, the following data are shown for each RTT position. 

[Test Name] Name of the test to which the reagent is allocated after 
reading. 

[Barcode] Code readout (simple enumeration)  

[Container] Bottle capacity identified by barcode 

[Exp.Date] Expiration date of the reagent 

[R-Type] Type of the reagent (R1, R2e, or R2) 

Barcode reading enables automatic identification of the RTT position of the reagent bottle. 
After the barcodes have been read, measurement can begin as usual. 
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5.2 Checking the Data 
5.2.1 Checking the reaction time course 

Every 13.5 seconds, multiple spectrophotographic measurements are taken throughout 
a standard reaction process using all 14 wavelengths. In a standard reaction process, 
there are 63 total possible data points; if the reaction process is prolonged, there will 
be 134 data points. 

 Window to check the reaction time course 

1 Select [Request] > [Reaction Monitor] to display the window below: 

 
 

2 Enter values in the [Sample type] and [Sample list] columns. 

3 Click the test to check the reaction time course in the [Time name list] 
column. 

If a test is performed only on the initial run, the 
time course is displayed immediately in the 
right side of the window.  

If a test is performed on both the first run and 
the rerun, the dialog box on the left is displayed. 

Select either [First data] or [Rerun data] for 
display. 

4 Select [Calc.results], [M/S-WL], or [Approx.curve] as required. 
 

5 Press the [Data List] button on the top bar to show the measurement values. 
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6 Click the [Cuvette Blank] button to display the cuvette blank value used for 
the calculation.    

7 Click the [14WL monitor] button to open the [14WL monitor] window. The 
reaction time courses are displayed for the 14 wavelengths including the one 
used for the calculation.    

Change the value in the [Display conditions] column in the [14WL monitor] window, and 
then click the [Display switch] button to display the revised time course. 
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 Data point time course 

The following table lists each data point and the exact time obtained from the 
beginning of the reaction.  

 

Measurement 
point Time (s) Remarks Measurement 

point Time (s) Remarks 

   －4.94 seconds,  R1      
1 -1.765  6.77 seconds, sample, 

Mix1 72 1037.735   
2 11.768  Diluent aspiration 73 1051.268   
3 25.300   74 1064.800   
4 38.833   75 1078.333   
5 52.365   76 1091.865   
6 65.898   77 1105.398   
7 95.294  108.13 seconds,  R2  78 1134.794   
8 108.827  Mix2 79 1148.327   
9 122.359   80 1161.859   

10 135.892   81 1175.392   
11 149.424   82 1188.924   
12 162.957   83 1202.457   
13 176.489   84 1215.989   
14 190.022  3-min reaction 85 1229.522   
15 203.554   86 1243.054   
16 217.087   87 1256.587   
17 230.619   88 1270.119  21-min reaction 
18 244.152  4-min reaction 89 1283.652   
19 286.094  298.58 seconds,  R3  90 1325.594   
20 299.627  Mix3 91 1339.127   
21 313.159  5-min reaction 92 1352.659   
22 326.692   93 1366.192   
23 340.224   94 1379.724   
24 353.757   95 1393.257   
25 367.289   96 1406.789   
26 380.822   97 1420.322   
27 394.355   98 1433.855   
28 407.887   99 1447.387   
29 421.420   100 1460.920   
30 437.283   101 1476.783   
31 450.816   102 1490.316   
32 464.348   103 1503.848   
33 477.881   104 1517.381   
34 491.413   105 1530.913   
35 504.946   106 1544.446   
36 518.479   107 1557.979   
37 532.011   108 1571.511   
38 545.544   109 1585.044   
39 559.076   110 1598.576   
40 572.609   111 1612.109   
41 586.141   112 1625.641   
42 599.674  10-min reaction 113 1639.174   
43 628.083   114 1667.583   
44 641.616   115 1681.116   
45 655.148   116 1694.648   
46 668.681   117 1708.181   
47 682.214   118 1721.714   
48 695.746   119 1735.246   
49 709.279   120 1748.779   
50 722.811   121 1762.311   
51 736.344   122 1775.844   
52 749.876   123 1789.376   
53 763.409   124 1802.909   
54 779.273   125 1818.773   
55 792.805   126 1832.305   
56 806.338   127 1845.838   
57 819.870   128 1859.370   
58 833.403   129 1872.903   
59 846.935   130 1886.435   
60 860.468   131 1899.968   
61 874.000   132 1913.500   
62 887.533   133 1927.033   
63 901.065  15-min reaction 134 1940.565  31-min reaction 

   Washing    Washing 
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5.2.2 Reflex test 

 What is a reflex test? 

A reflex test is a test which was originally unordered but is automatically performed on 
the basis of the result of an ordered test (primary test). Follow the steps below to 
schedule a reflex test.  

 Setting the reflex test function 

Select [Setup] > [Reflex Test Settings] to open the [Reflex Testing Setup] window. 

 
 

The following values are defined regarding the primary and reflex tests. 

[Setup No.] Enter a setup no. (1 - 30) 

[Process Test No.] Enter the process sequence number of the primary test.  
Up to 3 process sequences can be defined for a “Setup 
No.” 

[Cut-off Value] Enter the reference value for judgment. 

[Check Logic] Select either "Below or equal to" or "Above or equal 
to." 

[Reflex Process Test Number(s)] 
Enter the process sequence no. of the reflex test(s). Up 
to 3 tests can be defined for a setup. 

When the primary test result meets all the conditions defined for a setup, the tests 
defined in the [Reflex Process Test Number(s)]] field are performed.  
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 Performing a reflex test  

A reflex test is automatically ordered when the primary test result meets the conditions 
for performing a reflex test.  When the test to be added as reflex was already 
performed on the sample, the test is automatically excluded. Select [Setup] > [System 
specification settings]. If “STT rerun” is selected for [Auto.rerun] in the [Basic System 
Operation Mode] column, the reflex tests are automatically performed at the rerun 
sequence. The result obtained by the reflex test is considered to be the initial run data 
because the result of the reflex test was obtained for the first time. However, in this 
case, the automatic re-rerun will not be performed. 

The reflex test results are sent to the LIS. However, in order to save the data in the 
LIS , a storage destination must be defined there.  

5.2.3 Setting reaction check logic 

 What is reaction check logic? 

In evaluating the result of a test (primary test), the measurement values of another test 
may be useful. This test method is called reaction check logic. If selected, another 
related tests are automatically ordered when the primary test is ordered.  When results 
(e.g. concentration, activity) of those tests are outside the reference range, they are 
taken into consideration for evaluation of the primary test result. Furthermore, an 
automatic rerun of the primary test can be set to be triggered by abnormal results from 
the reaction check logic. 

 Setting reaction check logic 

Select [Setup] > [Reaction Check Logic] window for settings. 
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[Setup No.] This number defines a set of tests (assays).  
Up to 30 sets can be defined. 

[Assay Number] Select another tests to be checked for reaction check 
logic (up to three) which will be ordered automatically 
when a primary test is ordered. To select a test, enter 
the “Process sequence number”.   

[Cut-off Value (Conc.)] Enter a threshold value (e.g. concentration, activity). 

[Check Logic] Select either [Above or equal to] or [Below or equal to] 
as judgment criteria. 

[Assay to be flagged] Enter the test number (“Process sequence” number) of 
the primary test(s).  Up to three primary tests can be 
defined. All the tests to be checked for reaction check 
logic will be automatically ordered if at least one of 
these tests is ordered.  
If the result of one or more tests is out of the range 
defined in the [Cut-off Value] and [Check Logic] fields, 
the results of all the corresponding primary tests are 
flagged with "J". 

 Setting up an automatic rerun order 

An automatic rerun can be selected for the primary test, triggered by abnormal values 
of the reaction check logic results. Select [Setup] > [Analytical Parameters 
(Chemistry)] > [Rerun conditions set] to open the [Rerun Conditions Set] window.  For 
[Reaction Check Logic (J)], select the dilution condition (s) from [M] to [D4] as 
required (Multiple conditions can be selected). 

When the results are marked with a "J" flag, a rerun is ordered for the primary test. 

 Example 

See "Setup no.1" in the [Reaction Check Logic] window above as an example of how 
this feature works. 

If the TG test result is a high value, the sample suggests the patient may have 
hyperlipidemia. The presence of hyperlipidemia may then affect the results of the 
HDL-C, AST, and ALT tests depending on reagent. 

In the example above, when at least one of the three tests HDL-C, AST, and ALT is 
ordered, the TG test is automatically ordered as well.  When the results of the TG test 
are > 800 (mg/dL), the results of the HDL-C, AST, and ALT tests are all flagged with a 
"J".  The "J" flag signifies that the TG test, the tests used for reaction check logic, 
shows a high value therefore the attention should be paid for the results of the HDL-C, 
AST, and ALT tests. 
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5.2.4 Generating correlation graph 

A graph can be generated showing data correlation between two tests performed with 
the BM6010/C.  In addition, a graph can be generated showing data correlation 
between a test performed with a BM6010/C system and a test performed with another 
analyzer.  Up to 100 correlation graphs can be generated; up to 1,000 data points can 
be integrated in the correlation graphs. 

Steps for generating a graph are as follows: 

1 Select [Request] > [Correlation] to display the window below. 

 
 

2 Click the [Enter Data Corr.] button to display the window below. 

 
 

The [Registration List] column shows the graphs already stored in the system. 
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3 Enter the values in the following fields: 

[Corr graph no.] Enter a number from 1 to 100 which is not listed in 
the [Registration List]. 

[Corr graph name] Enter the name of the correlation graph. 

[Date] Select a measurement date. 

[Samp.type] Designate a sample type. 

[Test X,Y] Enter a test number in each field to generate a 
correlation graph between them. When you manually 
enter the data obtained in another system as shown in 
Step 9, leave these fields blank. 

[Enter order numbers] Enter the range of data to show in the graph.  Use the 
number shown in the [Order no.] field in the [Order 
Entry] window. 

4 Click the [Execute] button to generate and save a new correlation graph. 
When using the external data, the graph is not generated at this step. Please 
refer to Step 9. 

5 Click the [Return] button in the [Correlation data] window to close it. 

6 Select the newly generated graph name in the [Data search] column in the 
[Correlation] window. 

The generated correlation graph is displayed. 

7 Click the [Display data] button to display the window below. 

 

The data used for the correlation graph are displayed. 

8 Enter the [Axis names]. 
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9 When using the data of another analyzer, enter the values in the [Xdate] and 
[Ydata] columns. 

You can also edit the data here if required. 

Click the [Save] button to close the window. The correlation graph and related data are 
displayed.  You can change the display scale using the [Scale change] column. 

5.2.5 Automatic cuvette skipping based on the cuvette blank value 

 Measurement and registration of the cuvette blank value 

Select [Maint.] > [User Maintenance] to perform measurement and registration of a 
cuvette blank value. Cuvette blank value of each cuvette is measured and registered. 
When the obtained cuvette blank value deviates significantly from the mean of all 
cuvette blank values, an "H" or "L" flag is shown with the value; this cuvette is not 
used for measurement which is called automatic cuvette skipping. The decision to skip 
the cuvette is made using data generated from all wavelengths. 

 Pre-measurement judgment of the cuvette blank value 

Before starting each sample measurement, the analyzer measures the cuvette blank 
value and compares it with the corresponding values already registered in the process 
described above. If a cuvette has a blank value that differs significantly from the 
registered value, it is not used for further measurements. Cuvette blank measurement 
made before analysis starts are analyzed using the wavelength specified in the [Setting 
System Parameters] window. 

 Setting limits for cuvette blank values 

The following parameters used for the deciding whether to skip a cuvette blank are 
selected in the [Setup] > [Setting System Parameters] window. 
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[Cuvette Skip Judge] Select whether to skip or retain a cuvette with an 
abnormal pre-measurement blank value.   Enter either 
“0” to retain the cuvette or “1” to skip the cuvette. “"1” 
is the default value.  

[Skip Judgment Wavelength] Select a wavelength (“1”-“14”) to obtain the pre-
measurement cuvette blank value for judgment. "10" 
(694 nm) is the default value. 

[Cuvette standard value] Cuvette blank values of all cuvettes are measured in 
sequence.  The median of the blank values of all 
cuvettes is calculated, and the deviation between the 
median and the blank value of each cuvette is evaluated.  
If a cuvette has a blank value that differs from the 
median by more than the value entered here, the cuvette 
is excluded from routine analysis. In other words, this 
value indicates the limit of the difference between a 
measured blank value and the median. "0.4" is the 
default value. 

[Forwarding absorbance value]The cuvette blank is measured after each sample 
measurement to calculate absorbance. This measured 
cuvette blank value is compared with the previously 
obtained value for the cuvette. If the difference is equal 
to or greater than the value entered here, the cuvette 
blank is skipped and the previously obtained value is 
used instead.  "0.04" is the default value. 

[Cuvette breakup limit value] The cuvette blank is re-measured after each sample 
measurement to calculate absorbance. The cuvette 
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blank value is the mean value of two replicate 
measurements obtained by the detector. If the 
difference between the two measurements is equal to or 
greater than the value entered here, the sample data is 
flagged with "N".  "0.1" is the default value. 

[Skip absorbance value] The cuvette blank value from a previously used (now 
washed) cuvette is evaluated for abnormality before it 
is used for measurement.  If the difference between the 
pre-measurement cuvette blank value and that entered 
in the [User Maintenance] window is equal to or greater 
than the value entered here, the cuvette is not used for 
measurement. "0.04" is the default value. 

 

5.2.6 Displaying statistical information 

The [Statistics] window provides statistical data including the mean, minimum, and 
maximum values. 

Select [Request] > [Statistics] to display the window below. Define the items below. 

 
 

 Items in the upper left fields 

[Smp.type] Select either [Routine sample] or [STAT sample]. 

[Filename] Select from the past seven measurement days including 
the current day. 
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 Items in the [Setting tests to print] column 

[Select test to print] Enter a number and a period (.) shown in the [Test 
table], or click a test shown in the [Test table] column. 
The selected tests are shown in the [Print tests] column 
in the right side of the window. 

 

 The tests can also be selected using the [Profile] column. 
 

[Print type] Select from [Statistics], [Test data], or [Details of test 
data]. 

[Statistics] Print the values of average, maximum, minimum, 
difference, standard deviation, and coefficient of 
variation for ABS-R, ABS, ABS1, ABS2, E1, and E2 
respectively. 

[Test data] Print the values of average, maximum, minimum, 
difference, standard deviation, and coefficient of 
variation of the concentration. 

[Details of test data] Print the measurement data and the values of average, 
maximum, minimum, difference, standard deviation, 
and coefficient of variation of the concentration. 

 [Print] button 

Click this button to display the window below. Use this window to specify the printing 
range and submit a printing order as below. 

 
 

[Specif.range] Select either [Input range] or [All]. 
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[ID entry format] Select a format to specify the printing range.  Options 
are [Samp.no.], [Posi.no.], or [Order no.].  If you select 
[Posi.no.], also select either [1:TT] or [2:RACK]. 

[Last no. entry format] Select a format to specify the end of the printing range.  
Options are [Last no.] and [Number of sample]. 

[Start no.]，[Last no.]  If you select "Last no." for [Last no. entry format] 
above, the [Last no.] field will appear. Enter a first data 
number in the [Start no.] field and the last data number 
in the [Last no.] field to specify the printing range.   

[Execute]  Click this button to submit the printing order. 
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5.3 Error Report 
In case of an error during analyzer operation, the following information is logged in the 
[Error Report] window: date, system mode, error code (Safe. no. in GUI), content, as 
well as the behavior and operation of the analyzer. Select [Maint.] > [Error Report] to 
display the window below. 

Display options and scope can be selected with the radio buttons in the [Disp.switch] 
and the [Scope] fields in the top bar of the window. The items included in the error 
reports are as follows: 

 
 

 [Disp.switch] 

Two display formats are available. 

[Standard] Items related to error incidence, system modes, and the 
operation order are displayed. 

[Extend] More detailed contents are displayed. 

 [Scope] 

Two options are available for the date range. 
 

[Today] Incidences on the current day are displayed. 

[All] Up to 10,000 past incidences are displayed. 

 Items included in the error report 

[No.] The previous incidences (up to 10,000) are numbered in 
reverse chronological order. 
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[Date] Time and date of occurrence 

[Section] Unit related to the error (e.g. analyzer, workstation) 

[Mode] System mode in which the error occurred 

[Samp.ID] ID of the sample under measurement when the error 
occurred. 

[Test name] Name of the test being performed when the error 
occurred. 

[Time] Error occurrence time counted from the start of the 
corresponding measurement. 

[FNO] Function number of operation of the unit related with 
the error. This information is just for JEOL service 
engineers. 

[INDEX] Internal number of the error processing.  
This information is only for JEOL service engineers. 

[Safe.No.]  Error code 

[Contents] Content of the error 

[Measures] Behavior of the system when the error occurred 
 

You can check the detailed contents of each error. Move your mouse over the error 
listed and double click the left button of the mouse to display the [Error Report 
Details] window as below. The countermeasure is indicated under “ACTION.” 
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5.4 Automatic Calibration and 
Automatic Control Measurement 

5.4.1 Automatic calibration 

 Types of automatic calibration 

Two types of automatic calibration are available on the BM6010/C analyzer. 

• Calibration after reagent bottle switch  
When multiple bottles of a reagent for a test are set to the reagent tray, calibration 
for the test is automatically performed whenever a bottle is switched to a new one. 
Automatic measurement of the control sample can also be set following calibration. 

• Scheduled calibration  
The calibrator placed in the refrigerated tray is automatically measured at pre-
defined intervals. Automatic measurement of the control sample can also be set 
following calibration. The system calculates the interval regardless of the operation 
status of the analyzer unless the power is turned off (the workstation is shut down). 
When the analyzer restarts after a system shutdown, calibration is automatically 
performed. 

 Setting automatic calibration 

1 Select [Calib,] > [Calibration Setup] to display the [Calibration Setup] window. 

2 Click the [Auto calib.set] button on the top bar to open the window below. 

 
 

3 Setup [Blank], [Standard], and [Control select] for each test. Enter a control 
name in the [Control select] field that is measured at the same time with the 
calibrator. 
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4 Setup the calibration after bottle switch. 

Click the box [] for [Bottle Switch] to perform an automatic calibration of the test when 
starting to use a new bottle. 

5 Set scheduled calibration. 

Enter a value for [Interval time (min.)] and check the box under the [Scheduled] header to 
start countdown of calibration time. 

6 Click the [Save] button to save the entered values and close the [Auto 
Calibration Setting] window. 

The positions of calibrators are the same as defined in the [Calibration Setup] window. 

 Activating automatic calibration 

1 Select [Request] > [Test Select]. Select tests for [Auto calibration 
meas.(BLK)], [Auto calibration meas.(STD)], and [Auto control meas. After 
calib.] respectively in the [Test Select] window.  

Automatic calibration and control measurement that follows will be performed only for the 
selected tests. 

2 Click the [Exit] button to save the settings and close the [Test Select] window. 
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 Scheduled calibration 

With scheduled calibration, calibration is automatically performed at the specified 
interval. Once a calibration is complete, a new countdown starts for the next 
calibration. 

When a scheduled time for calibration arrives but the analyzer is not in the analysis 
sequence, an automatic calibration is performed when the analyzer begins a new 
analysis sequence. 

If a routine calibration is performed before the scheduled automatic calibration, 
scheduled automatic calibration will not be performed for the tests that were covered 
by the routine calibration. After completion of the automatic calibration, a new 
countdown starts for the next calibration. 

5.4.2 Automatic control measurement 

 Test count for automatic control measurement 

The automatic control measurement function allows automatic measurement of the 
control samples set in the refrigerated tray (CTT) after a specified number of tests are 
completed. The test count is reset when the analyzer is started as a “New Start” from 
the BM6010/C startup window.  If “Re-start” is selected when starting up the system, 
the count is not reset. Calibrators and QC samples are excluded from the test count. 

 Setting the test count and tests for automatic control 
measurement  

Select [Setup] > [Setting System Parameters] > [Automatic Control] to set the 
following parameters for automatic control measurement. 

 

 [Automatic Control Counting method (0: Total tests, 1: Number of tests 
of each items)] 

The following two options are available as the subject test to count from the 
completion of a control measurement to the next automatic control measurement. 

"0: Total tests"    All the tests defined for the control sample are performed when the 
test count reaches the number defined in the [# of Tests] field in the 
[Auto Control] window. ([QC] > [QC Sample Definition] > [Auto 
Control]) The value for [# of Tests] ranges from 100 to 99999. 

"1: Number of tests of each items"  

 The number of test times is counted separately for each test, but the 
counting method varies according to the setting of [Auto Control 
Execution method in Each Assay (0: Each item 1:All items) as 
explained below.  



 

 

ICABM6010/C-4  5-25 

C
hapter 5 

O
ptional Functions  

 

 [Auto.Control Execution method in Each Assay (0: Each item, 1: All 
item)] 

This parameter becomes selectable when "1: Number of tests of each item" is selected 
for the above [Automatic Control Counting method] parameter. 

"0: Each item"    The number of times a particular test is performed is calculated; 
when the count reaches the number entered for [# of Tests], the 
control measurement is performed for that test alone.  Therefore, the 
same control sample is measured separately for each test, and only 
the test count for the test for which the QC sample is measured is 
reset.  

"1: All items" The number of times a particular test is performed is calculated; 
when the count reaches the number entered for [# of Tests], the 
control measurement registered for the test is performed 
simultaneously for all the tests using the same control sample type if 
they have been performed in the course of counting. The control 
sample is not re-measured for the tests that have not been performed 
in the course of counting.  The value for [# of Tests] can range from 
5 to 10000. 
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 Selecting the tests for automatic control measurement, and 
setting the test interval 

1 Tests subject to the auto control measurement are selected as follows. Select 
[QC] > [Test Select] to display the window below. 

 
Select "Auto control samp.meas." in the [Test select] column in the left column and then 
select the tests subject to the automatic control measurement in the [Test Table] column in 
the middle pane. The selected tests are shown in the [Test list] column in the right of the 
window. 

2 Click the [Save] button in the upper left of the window to save the setting. 
The automatic control measurement is performed only for the selected tests.  

3 Tests performed on the control sample used in the auto control measurement 
are selected as follows. Select [QC] > [QC Sample Definition] to display the 
window below. 

 
Select a control ID in the [Ctrl.ID] section, and select tests to perform for each control ID. 
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4 Click [Auto Control (TOTAL TEST)] button in the top bar to display the 
window below. 

 

For each control sample, enter the number of test times in the [# of Tests] column that 
indicates the measurement interval, and click the check box in the [Select] column to show 
[] in it.  Click the [Reset] button. Countdown starts in the [Remain times] column. 

5 Click the [Save] button in the bottom of the window to save the setting. 

 Test count for the automatic control measurement  

When an automatic control measurement time comes, the control samples are measured. 
Then, the test count is reset and a new count begins. 

Also, when a routine control measurement is performed before the automatic control 
measurement timing, automatic control measurement is not performed but the [# of 
tests] gets reset, and a new count starts as if the measurement was performed. 
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5.5 Checking for Sample Carryover 
5.5.1 Checking for sample carryover 

An abnormal measurement value for a sample may result from physical carryover of 
the previous sample into the reaction cuvette. 

 Method for the detection of sample carryover  

To guard against possible sample carryover, whenever two successive samples show 
abnormal values for a test, the measurement value of the second sample is flagged.  For 
the flagged sample, an automatic rerun for the test can be performed.  

 Parameters for carryover detection 

Select [Setup] > [Carryover Setting] to define the following parameters in the 
[Carryover Setting] window. 

 
 

[Setup No.] Number for a set of tests to check carryover.  Up to 10 
sets can be defined. 

[Carryover test] Specify the test to check for carryover. Enter the test 
number defined in the [Analy.Con. no] field of the 
[Analytical Parameters (Chemistry)] window. 

[Cut-off Value]  Enter a threshold value (e.g. concentration, activity) of 
carryover. When the measurement values of two 
successive samples meet the condition set by the “cut-
off value” and “check logic,” the carryover flag is 
posted to the second sample. 
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[Check Logic] Select either [Above or equal to] or [Below or equal to] 
as judgment criteria. 

 Carryover detecting function 

See the setting values in the [Carryover Setting] window above as an example of how 
the detecting function works. 

 Example 

Two successive samples are both measured for "μ-ALB" and the measurement values 
of both the samples are 3.00 mg/dL or above, the μ-ALB measurement value of the 
second sample is marked with an “O” flag.  Otherwise, no “O” flag is posted. 

 

 Setting up automatic rerun 

You can set up automatic rerun with the predefined dilution rate for the sample marked 
with the carryover flag “O” Define automatic rerun and dilution rate for rerun as 
follows: 

1 Select [Setup] > [Analytical Parameters (Chemistry)]. 

2 In the [Analytical Parameter (Chemistry)] window, click the [Rerun conditions 
set] button in the [Sub-analy.conditions] column.  

3 Select the dilution condition from [M] to [D4] as required for [Carryover (O)] in 
the [Rerun Conditions Set] window (multiple conditions can be selected). 

4 Click [OK] to close the [Rerun Conditions Set] window, and then click [Save] 
in the [Analytical Parameters (Chemistry)] window to exit. 
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5.5.2 Setting contamination avoidance 

This section describes various kinds of contamination and the corresponding 
preventive measures. 

 Contamination of reagent probes and avoidance method 

The BM6010/C analyzer features three-part reagent capability for a test.  Two reagent 
probes, RPP1 and RPP2, are used for dispensing reagents.  RPP1 dispenses reagent R1, 
and RPP2 dispenses R2e and R2.  The table below summarizes how each reagent probe 
can contribute to contamination.  

Actors in contamination 

#  Reagent probe Contaminating reagent Reagent to be 
contaminated 

1 RPP1 R1 R1 
2 RPP2 R2e R2e 
3 RPP2 R2e R2 
4 RPP2 R2 R2e 
5 RPP2 R2 R2 

 

All the contamination scenarios listed above can be avoided.  

 Method of contamination avoidance 
 

Contamination can be avoided by delaying a test that uses a reagent subject to 
contamination. Meanwhile, only alternate tests with no risk of reagent contamination 
are performed for a certain period of time.  

If the reagent to be dispensed is subject to contamination as shown in the above table 
and all the other reagents have already been dispensed, the reagent probe is simply 
washed with the designated washing solution (“Reagent probe wash”). 

In the combination of #3 in the above table, R2 is subject to contamination, R2 is 
dispensed before R2e. Thus, R2 contamination is avoided even if the probe is not 
washed. 

The [Influence Effect] entered in the [Setup] > [Contamination Set] window is also 
taken into consideration. 

 Example of preventing the reagent probe from contamination 

Condition: 

Test producing contamination (Affecting Test) / Test subject to contamination 
(Affected Test):  ALT > LDH 

Influence effect: 2 

Preventive detergent: reagent probe wash 1 
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Measurement orders and the result: 

ALT LDH TP ALP 

ALT 

1. 

LDH TP ALB ALP 2. 

ALT LDH TP ALB ALP 

ALT 

3. 

LDH ALB 4. Wash by 
detergent 

LDH is measured immediately 
following ALT measurement. The 
result is affected by contamination. 

LDH is measured after 1 cycle 
following ALT measurement. The 
result is affected by contamination.  

After 2 cylcles following ALT 
measurement, LDH is measured. 

Contaminated 

No contamination 2 cycles 

ALB 
Contaminated 

No contamination  
As shown in order #3, contamination can be avoided by changing the measurement 
order. 

When the order cannot be changed, the reagent probe is washed with wash solution 
after measurement of ALT, and then LDH is measured (see order #4). 

 Defining the conditions for avoiding contamination of the reagent 
probe 

1 Select [Setup] > [Contamination Settings] to display the window below. Place 
a checkmark next to [Probe] in the [Switch] field in the middle of the top bar. 
This activates the contamination avoidance function for probes. 

2 Select "Setting condition for avoiding reagent probe contamination" for [Set 
type], and define the parameters as follows. 

 

3 Click the [Detergent set] button on the top bar to define a wash solution. The 
[Detergent set] window is displayed. Enter "Pure water", "RPP Wash 1" or 
"RPP Wash 2" in the [Comment] column. 



  

 

5-32  ICABM6010/C-4 

C
hapter 5 

O
ptional Functions 

 

If the probe can be sufficiently cleaned with pure water, use "pure water".  Otherwise, if 
"RPP Wash 1" and "RPP Wash 2" are effective, use "RPP Wash 1".  If neither pure water 
nor "RPP Wash 1" is effective, use "RPP Wash 2". 

4 Define [Influence effect (factor)]. When the probe is sufficiently cleaned with 
pure water, the influence effect is "1", 

5 If the RPP Wash 1 or RPP Wash 2 is effective, calculate the influence effect 
as below: 

Influence effect ＝ (Measurement order number of affected test) - (Measurement order 
number of test using affecting reagent) - 1 
However, when the calculated influence effect is zero or lower, add the total number of 
tests.  Also, when the calculated influence effect is 20 or greater, enter "20".  However, if 
the reagent has a strong contamination effect, enter "999". 

6 Define the [Influence effect] of the reagent probe wash detergents. 

Enter the name of detergent in the [Substance contaminating] field. The effect of 
detergents can be nullified by wash with pure water.  Enter "1" for [Influence effect]. 

 

7 Define contamination avoidance setting separately for R1 and R2. 

Either the affecting test or affected test uses one-part reagent, set avoidance for R1 and R2.  
Both the affecting test and affected test use one-part reagent, set avoidance for R1 only. 

In the default setting of preventive detergent number, #901 and #906 indicate Reagent 
probe wash 1 (RPP Wash 1); #902 and #907 Reagent probe wash 2 (RPP Wash 2); and 
pure water  #903 and #908. 

The table below shows an example of set values. 
 

No. Probe Affecting 
test/detergent 

Re-
agent 

Affected 
test 

Reagent Influence 
effect 

Number 

1 RPP1 GPT R1 LDH R1 12 901(RPP Wash 1) 

2 RPP2 GPT R2 LDH R2 12 906(RPP Wash 1) 

3 RPP1 LAP R1 CRP R1 1 903(Pure water) 

4 RPP2 LAP R2 CRP R2 1 908(Pure water) 

5 RPP1 TCHO R1 FCHO R1 999 902(RPP Wash 2) 

6 RPP2 TCHO R2 FCHO R2 999 907(RPP Wash 2) 

7 RPP1 RPP WASH 2 R1 Fe R1 1 903(Pure water) 

8 RPP2 RPP WASH 2 R2 Fe R2 1 908(Pure water) 
 

 Avoiding reaction cuvette contamination 

A cuvette used for an "affecting test" is subsequently used preferentially for tests that 
are not designated “affected tests” in order to avoid the necessity of a cuvette wash 
procedure. If the remaining tests are all “affected tests”, the cuvette is washed with the 
designated solution before proceeding to the next test assay. When an “affected test” is 
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the last assay of the measurement, all cuvettes are washed to prevent contamination in 
the next measurement. 

 

 Example of Reaction Cuvette Contamination Avoidance 

Condition: Affecting test > affected test ALT > LDH 

Detergent for contamination avoidance: Reagent probe wash 1 
 

 

ALP TP 

Contaminated 

Previous run 

1. 

2. 

3. 

LDH measured in the cuvette used for ALT test 
in the previous run is influenced by the 
contamination. 

Use the cuvette used for ALT in the previous run 
for a test other than LDH this time and use 
another cuvette for LDH to avoid contamination. 

Wash the cuvette used for ALT in the previous run 
before using it for LDH to avoid contamination 

CRE ALT AST 

ALP TP This time CRE 

ALB LDH 

ALB LDH 

ALB LDH WASH 

No contamination 

No contamination 

Cuvettes 

 
 

In order #2, contamination is avoided by changing the measurement order. 

When the order cannot be changed, the cuvette is washed with detergent after the ALT 
test then LDH test is measured in the same cuvette. 

It is also possible to setup a forced wash for contamination avoidance without changing 
the test order. 

 Defining conditions for avoiding contamination of reaction cuvettes 

1 Select [Setup] > [Contamination Settings] to display the window below. Select 
[Cuvette] for [Switch] in the middle of the top bar. This activates the function 
of preventing the cuvettes from contamination. 

2 Select "Setting condition for avoiding RRV cuvette contamination" for [Set 
type], and define the parameters as follows.  
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3 Select detergents to be used for contamination avoidance. Click the 
[Detergent set] button. The [Detergent set] window is displayed. Enter "Pure 
water", "RPP Wash 1", or "RPP Wash 2" in the [Comment] column. 

If the probe can be sufficiently cleaned with pure water, use "pure water".  Otherwise, if 
"RPP Wash 1" and "RPP Wash 2" are equally effective, use "RPP Wash 1".  If neither pure 
water nor RPP Wash 1 is effective, use "RPP Wash 2". 

4 For a combination of tests for which contamination can be avoided with a 
pure water wash, enter the “affecting test” in the [Substance contaminating] 
field and the “affected test” in the [Substance contaminated] field.  When 
contamination cannot be avoided with a pure water wash, enter only the 
“affecting test” in the [Substance contaminating] field and enter "900 (All 
tests)" in the [Substance contaminated] field. 

5 When a test can contaminate multiple tests such as A >B and A >C, select 
"900 (All tests)” in the [Substance Contaminating] field.  Select a detergent 
which is effective for all tests. 

 Do not enter a test in two or more fields for [Substance contaminating]. 

Example: A > B  Detergent: Pure water 

    A > C   Detergent: Reagent probe wash 1 

    A > D   Detergent: Reagent probe wash 2 

For a combination containing all tests listed above, enter the tests as follows: 

 A > all tests Detergent: Reagent probe wash 2 

6 Enter the [Influence effect] of the reagent probe wash detergents. 

The effect of the detergents on test results can be nullified by another wash with pure 
water. Enter tests which can be affected by detergent contamination according to the 
procedure outlined in orders #4 and #5 in the example in the table below. 
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In the default setting of preventive detergent number, #901 and #906 indicate Reagent 
probe wash 1 (RPP Wash 1); #902 and #907 Reagent probe wash 2 (RPP Wash 2); and 
pure water  #903 and #908. 

 

The table below shows an example of set values. 
 

Number Affecting test Affected test 
Number 

RPP1 RPP2 

1 GPT All tests (900) 901 (RPP Wash 1) 906 (RPP Wash 1) 
2 LAP CRP 903 (Pure water) 908 (Pure water) 
3 TCHO All tests (900) 902 (RPP Wash 2) 907 (RPP Wash 2) 
4 Reagent probe 

wash 1 
Fe 903 (Pure water) 908 (Pure water) 

5 Reagent probe 
wash 2 

Fe 903 (Pure water) 908 (Pure water) 
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5.6 Defining Report Formats and 
Printing the Reports 

 Reports 

Reports can be printed from the workstation of the analyzer system BM6010/C.  

Select [Setup] > [Print Form Settings] to open the window for setup. 

To print a report, select [Request] > [Print Report], or [Request] > [Review/ Edit], and 
then click the [Print Report] button in the command bar in the window. 

 Setting up a reporting format 

You can create a new report format or edit an existing format. 

In either case, please note that if you click the [Exit] button without saving the created 
or edited format with the [Save] button, the format is not saved.  

 Creating a new report format 

① Setting up a reporting format 

1 Select [Setup] > [Print Form Setting] to display the window below. 

 
 

This window is used for setting up a format, checking printing performance, and saving 
the format: 
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2 To select the appropriate paper type, click the [Page Setup] button to display 
the window below: 

 
 

Set the paper type, printing margin, etc. in this window.  Click [OK] to display the format 
page that has just been set up.  

 Point of origin 

Printer’s printing range 

Printing range defined 
by the paper size 

grid 

 
 

Enter the margins so that the printing range of the paper size will be within the print range 
of the printer. 

Print a test page to confirm the paper size and range are correct. Also, adjust the 
vertical/horizontal positions of both the format and the paper. 
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3 Define the page division. Click the [Page Division] button to display the 
window below. 

 

Decide how many parts into which to divide the page vertically and horizontally.  Division 
into up to 10 parts is possible for each direction. 

Click [OK] to view the formatted page. 

The format setup is commonly applied to the all divisions. 

4 Setup the default font. Click the [Default font] button to display the window 
below. 

 
 

Select the default font. Designate the font type that is most frequently used to eliminate the 
need to modify the font type every time you generate a report.  

5 Setup a grid size. Click the [Grid Size] button to display the window below. 
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This window is used to select the grid size to use when setting up a format. Method of 
adjusting the position will be described later in the [Property] window. 

6 Select a temporary text format. Click the [Text Setting] button to display the 
[Temporary Text Setting] window. 

 

Use this window to enter temporary values that are displayed or printed during format 
setting instead of real data. Use the maximum length that actual data can be when a report 
is printed.  These values are commonly applied to all reports. 

You can use the field of [Item comment] to show a value specific to a test such as unit of 
concentration. 

② Setting up a detailed text format 

1 Click [View] in the top command bar in the [Print Form Set] window and 
select "Property" in the drop-down menu. The [Print Form Set Property] 
window is displayed. Use this window to setup the detailed text format for 
printing. 
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2 Select the tests to show in the report in the [Test Select] tab page and define 
the display order.    

 
 

Select the tests to show in the report in the left [Test List] column and move them to the 
right [Select List] column. First select and highlight a test in the left column and click the 
[Add] button in the middle to move it to the right column. With the [Shift] key kept 
pressed, you can select multiple tests simultaneously. 

The tests are printed in the order shown in the [Select List] column.  To change the order, 
select and highlight the test and click the [Up] or [Down] button to move the test in that 
direction. 

 The created printing format can be exported to / imported from another 
BM6010/C system. However, the [Select List] often varies by system, 
therefore the list should be re-selected, that is, delete it once and define 
a new list. Also, when a select list is not registered or deleted in the 
system, the report cannot be printed.  

3 Use the [Fixed Character String] tab page to setup the fixed character string 
and its location used in the report. 

 
 

You can select the font type and size by character string. The setting steps are as follows: 
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(1) Make a right click on the mouse to show the menu below. 

 
 

(2) Select [Add] to change the display as below. 

 
 

(3) In the narrower field below [List(L):], enter the a text that is always used in the 
report. Then, move the cursor to the upper field and click in it to move the 
entered text to the upper field and confirm it. 

(4) Set up [Print Position (mm)] and [Font] as checking them in the format page. 
[Print Position] accepts entry after the decimal point. The point of origin (the 
upper left corner) may look shifted depending on the font type selected. 

4 Use the [Sample Attribute] tab page to define the sample attributes to print in 
the report. 

 

 
 

The items selected in the [Text Setting] tab page are displayed in the format page.  
Highlight and select to show  for the item to be printed, and setup the printing position, 
font, and number of digits for each item. Click the mouse in an arbitrary position in the 
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format page to show the values in the defined positions. Adjust the positions by entering 
the values of “Print Position.” 

 

Use the [Test Cell] tab page to set up the fields to show the test results. Each of the fields 
will contain the value that is defined in the [Data format] tab page (to be described later). 
Only the tests selected in the [Test Select] tab page are displayed in the fields. The 
excessive fields are shown blank. 

 
 

5 Use the [Test Comment (Etc)] tab page to enter a fixed character string for 
each test. 
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Click a test name to highlight, and enter a comment in the lower field under the [Selected 
Test] field. 

Following items can be defined in the left side of the page. 

[Untest (T)]: Select "Pack" in the drop-down menu to eliminate the space for tests not 
performed or "Unpack" to keep the space for them. 

Use the [Normal Value flag (H/L)] fields and [Untest mark(U)] field if you want to change 
the flag from the default setting. Enter in the corresponding field the character that you 
want to use as flag. 

6 Use the [Data format] tab to setup the printing positions of the values such as 
"Text name" and "Result data" defined in the [Test Cell] tab page. 

 

The point of origin is the upper left corner of the first cell. The font type selected in the 
[Test Cuvette] tab page is used, but the position can be adjusted in this page.  The 
excessive characters over the value set as [Width] will be cut in the right side.  The 
characters defined in the [Text Setting] tab page are displayed in the format page. 

Click [X] in the upper right corner to close the [Print Form Set Property] window. 

③ Check the format on the monitor 

1 Click [File] in the top command bar in the [Print Form Set] window and select 
"Print Preview" to display the created format. 
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 Click the [Close] button to close the display. If you use the [Exit] button in 
the [Print Form Set] window to close the window, the format created so far 
will be gone without being saved. 

④ Print the page to check the format 

1 Click [File] in the top command bar in the [Print Form Set] window and select 
"Print".  
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The window below is displayed. 

 
 

2 Click [OK] to print the format and check the contents and positions. 
 

⑤ Save the printing format 

1 Click the [Save] button 

The window below is displayed. 

 
 

2 Click [OK]  

The window below is displayed. 
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For a new format, "Untitled" is displayed in the [File name] field.  Enter a name for the 
format in 8 alphanumeric characters (8 one-byte characters or 4 two-byte characters).  This 
name is displayed when a report is printed in the format. 

 Be sure to save the format in the folder "ETC" as shown above. Otherwise, 
you cannot print nor backup the report in this format. 

 Editing an existing printing format 

① Retreaving an existing printing format 

1 Select [Setup] > [Print Form Setting] to display the window below. 

 
 

2 Click the [Open] button to display the window below. 
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3 Select a file to edit and click [Open]. The selected format is displayed. 
 

② Edit the reporting format 

Follow the steps described in the section "Creating a new report format" to edit the 
contents and check the edited format. 

 

③ Save the edited format 

1 Click the [Save] button and click [OK] in the confirmation popup window. The 
following window is displayed. 

 
 

2 The name of the current file is displayed. Click [Save] to overwrite it. 

 Printing a report 

To print a report, select [Request] > [Print Report], or [Request] > [Review/Edit], and 
then click the [Print Report] button in the command bar in the window. 

The measurement data of the last 7 days including the current day can be printed. Also, 
the data saved in an external media such as CD-RW can be printed. The measurement 
data of the reported sample are usually reviewed in the [Review/Edit] window. 
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 Print a r eport of measurement data of the last 7 days including the 
current day. 

1 To print a report, select [Request] > [Print Report], or [Request] > [Review/ 
Edit], and then click the [Print Report] button in the command bar in the 
window. The window below is displayed. 

 
 

2 For [Sample Type (T)], select either "Routine Sample", "STAT Sample" or 
"Control Sample." 

3 Select the data range to print in the report in the [File Data] field. The option 
is "Archive" or a date.  

 When "Archive" is selected, refer to the next section "Printing the 
measurement results recorded in an external media". 

 

4 In the [Specification range] field, select "Input Range" to set the printing 
range or [All] not to. Once you select "All", you can enter a value only in the 
[Report Form File] window, and all the data in the media is printed. 

5 When "Input Range" is selected, select an entry format in the [Number entry 
format] field. The option is "Sample No.", "Position No. (Rack No.)", "Position 
No. (TT. No.), or "Order No."  

6 In the [Last no. entry format] field, select either "Last no." or "Number of 
samples" to define the end of the printing range. 

7 Define a report format to use for printing 
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(1) Click the [Open] button to the right of the [Report Form File] field to display the 
window below. 

 
 

(2) Click and select a format to use. 
(3) Click the [Open] button.  

The selected format is displayed as "C： ￥BIOM J ¥ETC￥xxxxxxx.Frm" where 

xxxxxxx. is the format name in the [Report Form File ()] field. 

8 Enter the starting number in the [Starting number] field. Use the format 
selected in the [Number entry format] field. 

9 Enter the last number to print or the total number of samples in the [Last 
number] field. 

10 Click [Print] to print the report. 
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 Print measurement data recorded in an external media (CD-RW) 

1 Select [Request] > [Print Report], or [Request] > [Review/ Edit], and then 
click the [Print Report] button in the command bar in the window to open the 
window below. 

2 Select a [Sample Type] to show in the report. 

3 Mount a CD-RW in the media drive. 

4 When "Archive" is chosen for [File Data (F)], the [Archive File Name (I)] 
becomes available. 

5 Click the [Open] button to the right of the [Archive File Name (I)] field to 
display the window below. 

 
 

6 Select a folder that stores the archive files to display the file names. Select a 
file and click [OK]. 
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The selected file name is shown as "D:¥BIOMJ¥DATA¥YYYYMMDD" in the [Archive 
File Name] field. 

7 Set the values in the fields including [Specification range] as described from 
Steps 4 onwards in the previous section "Print a report of measurement data 
of the last 7 days including the current day." Then, print the report. 

8 When printing is complete, remove the CD-RW from the driver. 
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5.7 Special analytical conditions 
5.7.1 Round prolongation 

In the default setting, 15 minutes will elapse from the time reagent 1 and the sample 
are dispensed into the cuvette to the final wash. If the test requires a longer reaction 
time, 21 minutes or 31 minutes can be selected as the [Reaction time] in the 
[Analytical Parameters (Chemistry)] window. 

 
 

A test for which a longer reaction time is required is called a "test of prolonged round."   
When measuring a test of extended round, the cuvette is not washed at the scheduled 
wash time and the reaction continues. Thus, the reaction carousel wash unit (WUD) 
does not lower.  At the next scheduled wash time after 15 minutes, the cuvette will be 
washed.  Nine cuvettes prior to and following the unwashed cuvette will also skip the 
scheduled wash (18 cuvettes in total). With “prolonged round tests”, the throughput of 
the analyzer is compromised. 
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5.7.2 Setting up a blank reagent 

The blank reagent is defined in the [Blank Reagent Set] window (accessed via [Setup] 
> [Blank Reagent Settings]). This section describes precautions for settings under three 
conditions below: 

 
 

 When there is no BIL-B and the standard value of T-BIL is used as 
D-BIL standard value 

• Do not define "T-BIL" for the [Blank CH test] column.  
Otherwise, "STD-OD" will be "0" for both of the tests, which will cause invalid 
results. 

• Set "STD" as test condition of D-BIL, but do not use STD sample for measurement. 

• "KV" is not used for calculation. 

• The formula is as follows. 

BIL(STD)‐T

BIL(Samp)‐D
FVance)BIL（Absorb‐D D ×=  

 

 D-BIL (Samp) and T-BIL (STD) are the values obtained by subtracting 
reagent blank value from measurement absorbance.  
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Test name 

D-BIL 4 1 

2 

3 

3 T-BIL 

No 

Blank CH test No KV BLK test STD test 

No Test name No Test name 

 
 The number shown before the test is the corresponding “Process sequence 
number”. 

 When BIL-B is used and T-BIL value is used as standard value 

• Do not define "STD test" for "T-BIL".  
Otherwise, "STD-OD" will be "0" for both of the tests, which will cause invalid 
results. 

• Set "STD" as test condition of D-BIL, but do not use STD sample for measurement. 

• Measure BLK and STD samples for BIL-B. 

• Do not define [BLK test] for BIL-B. 

• The analytical conditions for the tests (D-BIL and T-BIL) and BLK test should be 
the same except the conditions unique to each. Follow the instruction of the reagent 
manufacturer for the setting details for each test. When performing rerun, use the 
same conditions, 

• "KV" for BIL-B is not used for calculation. 

• The formula is as follows. 

B(STD)‐BIL-BIL(STD)‐TKV

B(Samp)‐BILBIL(Samp)‐TKV
FVance)BIL（absorb‐T

T

T
T ×

−×
×=  

B(STD)‐BIL-BIL(STD)‐TKV

B(Samp)‐BILBIL(Samp)‐DKV
FVance）BIL（absorb‐D

T

D
D ×

−×
×=  

B(STD)‐BIL-BIL(STD)‐TKV

B(Samp)‐BIL
FVce）B（absorban‐BIL

T

B ×
×=  

 

 D-BIL (Samp) and T-BIL(STD) are the values obtained by subtracting 
reagent blank value from measurement absorbance. 
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Test name 

T-BIL 23 1 

2 

3 

23 T-BIL 

No 

Blank CH test No KV BLK test STD test 

No Test name No Test name 

23 T-BIL 

BIL-B 25 

25 BIL-B 

1 

1 24 D-BIL 

25 BIL-B 

 
 

 

 When another BLK is used for the test (e.g. Fe/Fe-B) 

• Do not define "STD test" for Fe. 

• Measure BLK and STD samples for both Fe and Fe-B tests 

• Do not define [BLK test] for Fe-B. 

• The analytical conditions of Fe, Fe-B, BLK tests should be the same except the 
conditions unique to each. Follow the instruction of the reagent manufacturer for the 
setting details for each test. When performing rerun, use the same conditions, 

• "KV" for Fe-B is not used for calculation. 

• The formula is as follows. 

B(STD)‐Fe-Fe(STD)KV

B(Samp)‐FeFe(Samp)KV
FVnce）Fe（absorba

Fe

Fe
Fe ×

−×
×=  

B(STD)‐Fe-Fe(STD)KV

B(Samp)‐Fe
FVce）B（absorban‐Fe

Fe

FeB ×
×=  

 

 D-BIL (Samp) and T-BIL (STD) are the values obtained by subtracting 
reagent blank value from measurement absorbance. 

  

Test name 

Fe 16 1 

2 

3 

16 Fe 

No 

Blank CH test No KV BLK test STD test 

No Test name No Test name 

17 Fe-B 

1 17 Fe-B 

 



  

 

5-56  ICABM6010/C-4 

C
hapter 5 

O
ptional Functions 

 

5.8 Other Useful Features 
5.8.1 User code settings   

With a user code defined, the code is displayed in the [User] field when the user edited 
the measurement data in the [Review/Edit] or [View Calibration Curve] windows. This 
way, the editor is easily identified. 

Select [Setup] > [Use Code Settings] to display the window below: 

 
 

 Values 

[User Code] Use up to 3 (one-byte) alphanumeric characters. Up to 
50 user codes can be defined. 

[User Name] Enter a user name with up to 25 one-byte alphanumeric 
characters for the use code. 

[User Password] Use up to 6 (one-byte) alphanumeric characters as 
password 

 To log in the system using the user code, click the [System] command in 
the upper left side of the system menu and select "Change User" in the 
dropdown menu. Enter the user name and password in the [Password] 
window. 

 Another [Password] window is accessible by selecting [System] > 
[Password]. Use this window to select the access level (either "User" or 
"Manager"). Note this window does not allow user login with the user name 
and password defined in the [User Code Settings] window. 
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5.8.2 Online settings 

Select [Setup] > [Online Settings] to define various LIS parameters. 

 
 
 

 Parameters in the [Communication conditions] column 

[Baut rate] Select one from "4800bps", "9600bps", "14400bps", 
"19200bps", "38400bps", "57600bps" and "115200bps." 
Default value is "9600bps." 

[Parity] Select "NONE", "EVEN", or "ODD." Default value is 
"EVEN." 

[Stop bit] Select either "1bit" or "2bit." Default value is "2bit." 

[Data length] Select either "7bit" or "8bit." Default value is "8bit." 

[Serial port] Select either "COM1" or "COM2." Default value is 
"COM1." 

[Time-out: Auto test select] This parameter defines the transmission time-out 
duration for the order of an automatically selected test 
sent from the LIS to the BM6010/C workstation.  Enter 
a duration in second that is added to the default time-
out duration (42 seconds). Normally "18" is entered to 
make the total time-out to be 60 seconds. 

[Time-out: Realtime test select]  
The parameter defines the transmission time-out 
duration for the order of a test selected in real-time 
when the optional laboratory automation system (LAS) 
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is used. Enter a duration in second to be added to the 
default time-out duration. Default value is 10 seconds. 

[Time-out: Between frames] This parameter defines the time-out between the frames 
when a communication message from the LIS 
comprises two or more frames. Enter a duration in 
second that is added to the default time-out duration of 
5 seconds. 

[Error sample skip number (Request)] 
This parameter defines up to how many sample analysis 
orders are ignored if they are not properly received. 
Default value is "0" to avoid ignoring any order. 

[Error sample skip number (Result Trs.)] 
This parameter defines up to how many sample data are 
ignored if they are not properly sent. "0" is the default 
value. 

 Parameters in the [Automatic transfer] column 

[Automatic test select] This parameter selects whether the analyzer sends 
inquiry to the laboratory information system (LIS) 
whether there are on-line test orders or not when the 
sample is dispensed from the sample tray (STT) for 
measurement.  

[Real test select] This parameter selects whether the analyzer sends 
inquiry to the LIS whether there are tests ordered in 
real-time or not for a sample which is transported by 
the rack or laboratory automation system (LAS). 

[Routine smp.auto result transfer]  
This setting selects whether the results of routine 
sample measurements are transferred in real-time to the 
LIS. 

[Priority smp.auto result transfer]  
This parameter defines whether the results of priority 
sample measurements are transferred in realtime to the 
LIS or not. 

[Control smp.auto result transfer]  
This parameter defines whether the results of control 
sample measurements are transferred in realtime to the 
LIS or not. 

[STAT smp.auto result transfer]  
This parameter defines whether the results of STAT 
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sample measurements are transferred in realtime to the 
LIS or not. 

[STD. smp.auto result transfer]  
This parameter defines whether the results of calibrator 
measurements are transferred in realtime to the LIS or 
not. 

 Parameters in the lower right column of the window 

[Check sum] This parameter defines whether check sum is used to 
verify the validity of an online message. 

[Maximum frame size] Select "256byte" or "512byte" for the maximum size 
per frame of an online message. 

[Host transfer date] When the LIS is operated on a date setting different 
from the system startup date of the analyzer, enter a 
date to match the communication date between the LIS 
and analyzer system. Default value is blank. 

[Host transfer Using] Select "User Code Number" to use the user code 
number selected in the [Set Test] window or 
"Processing Test Number" when the user code number 
is not used. The parameters in the [Set Test] window 
are described below.  
Select [Setup] > [Process Sequence] to define 
"Processing Test Numbers." 

 [Set Test] button 

Click this button to display the window below. The following parameters are defined in 
this window. 

 
 

[BAT] Select this button to include the corresponding test in 
the batch data transfer. 
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[REAL] Select this button to include the corresponding test in 
the realtime data transfer. 

[Qual] Select the button to send the qualitative data of the test 
designated with qualitative judgment. 

[Code] Enter an arbitrary test code if "User Code Number" is 
selected for [Host transfer Using]. It is practical to 
coordinate the code with that used in the LIS. 
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 [Loop back test] button 

Click this button to display the window below. 

 
Loop back test is the dedicated application to check the function of online port of the 
BM6010/C system.  A special connector is required to perform the test.  This window 
is exclusively for JEOL service staff. 



  

 

5-62  ICABM6010/C-4 

C
hapter 5 

O
ptional Functions 

 

5.8.3 Alarm buzzer set 

Select [Setup] > [Alarm Buzzer Set] to display the window below: 

Use this window to setup the alarm goes off that the analyzer uses for notification. The 
default values are shown in the window. 

 
 

 Parameters in the [Safety Code] column 

Set up the sound type and duration for each code. 
 

[Safety Code] Enter the codes of errors that you want to use alarm 
sound. Use the error codes defined in the [Safe.No.] 
column in the [Maint.] > [Error Report] window. 

 

 [9903] is the code to indicate that the analyzer has entered in the [READY] 
mode.  
[9906] is the code to indicate that the analyzer has entered in the 
[Processing] mode.  
[1322] is the code to indicate that the analyzer has entered in the [START] 
mode for STT rerun from host (LIS). 

[Buzzer type] Select the alarm type from "Buzzer OFF", 
"Continuous", and "Interval."  

[Sound] This button is for use in future expansion. It is not used 
for the moment.  

[Time (sec)] Enter the duration of the sound in second. 

[Comment] Enter remarks such as the meaning of the code. 



 

 

ICABM6010/C-4  5-63 

C
hapter 5 

O
ptional Functions  

 Parameters in the [Sound profile] column  

Define the sound type and duration according to the status (buzzer level). 

[Buzzer Level] Buzzer type and duration can be defined according to 
the status when the error is detected. Select a status 
from "Blank", "WARNING", "Emergency STOP", 
"STOP", and "Error Report flag 11-50". 

[Buzzer type] Select an alarm type from "Buzzer OFF", "Continuous", 
and "Interval." 

[Sound] This button is for use in future expansion. It is not used 
for the moment.  

[Time (sec)] Enter the duration of the sound in second. 

 [Clear] button 

Click this button to display the window below. 

 
 

Use the [Clear] button to cancel the defined settings. Specify the range to clear with 
error (safety) code or processing flag. 
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5.9 Parameters in the [Setting System 
Parameters] Window 
Select [Setup] > [Setting System Parameters] to open a window where you can define 
various settings regarding operation and data processing. Attention may be required for 
setting because an inappropriate setting may adversely affect operation and 
measurement data. 

After setting the values, close the window, confirm the Operation Panel shows 
"READY" in the mode window, and press the [START] button. The defined settings 
are effective when the analyzer starts operation this way.  

 
 
 

 Columns 

[Parameter name] The setting content is displayed. 

[Value] Enter the value to define. 

[Comment] Options or range of values is displayed. 

5.9.1 [Probe Washing] 

[At start detergent No.1 nozzle cleaning setting (0: Not, 1: Execute)] 

[At start detergent No.2 nozzle cleaning setting (0: Not, 1: Execute)] 

[At start detergent No.3 nozzle cleaning setting (0: Not, 1: Execute)] 

[At start detergent No.4 nozzle cleaning setting (0: Not, 1: Execute)] 
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[At start detergent No.5 nozzle cleaning setting (0:Not, 1:Execute)] 

 These parameters define if the reagent probe is washed 
at the startup with the detergent defined in the 
[Detergent Set] window (Accessed by selecting [Setup] 
> [Contamination Settings] and clicking the [Detergent 
set] button). If the probes are not washed at the start of 
operation, the first measurement value may be incorrect 
due to the impurities remaining from the previous 
measurement. The default value is "1: Execute" to 
avoid contamination.   

 

5.9.2 [Abnormal Cuvette Blank] 

Refer to Section 5.2.5. 

5.9.3 [STT Operation] 

[TT Continuous analysis (0: Normal, 1:TT Continuous mode) ] 
Default value is "0" for routine measurement.  
When "1" (continuous mode) is selected, you can 
specify up to 3 sample tray numbers successively (e.g. 
1-3) in the [Tray No.] field in the [Patient sample] 
column of the [Start Conditions] windows.  In this case, 
the tests performed on each sample remain the same as 
specified in the [Request] > [Order Entry] window.  
Also, when "1" is selected, the samples cannot be 
changed at the tray exchange, because the system does 
not stop measurement. Therefore, this option is not 
used for measurement but for special occasions such as 
investigation of test conditions. When "1" is selected, 
select "Cup posi." for [Analysis mode] in the [Patient 
sample] column in the [Start Conditions] window. 

[STT Position Fix (0: Normal, 1-84: Fix Position)] 
Default value is "0" for routine measurement.  
When "1" - "84" is selected for a fixed position, the 
patient sample is aspirated at the sample tray (STT) 
position designated here. No matter what STT position 
is defined in the [Order Entry] window, all the samples 
are aspirated at this STT position,  In this case, the tests 
performed on each sample remain the same as  
specified in the [Request] > [Order Entry] window.  
This option is used only in special occasions such as 
investigation of test conditions. When "1"- "84" (fixed 
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position) is selected, select "Cup posi." for [Analysis 
mode] in the [Patient sample] column in the [Start 
Conditions] window.  If "Barcode" is selected, the 
analyzer will operate improperly. (This is a prohibited 
setting. Never select "Barcode" in this setting.) 

 

5.9.4 [Drain Tank Setting] 

[Concentrated Waste Tank Overflow Sensor] 
This parameter is used to set the function of sensor to 
detect that the optional concentrated waste tank comes 
full.  When "0" is selected, the function is not activated.  
When "1" is selected, an alarm goes off and a message 
is displayed on the Operation Panel when the tank 
becomes full.  When "2" is selected, the alarm goes off 
and the message is displayed in the same way as when 
"1" is selected. Further, the analyzer stops the operation 
and enters the [STOP] mode.  When "3" is selected, the 
alarm goes off and the message is displayed in the same 
way as when "1" is selected. Further, the analyzer stops 
the operation immediately and enters the [WAIT] mode. 
"0" is the default value because the tank is not included 
in the standard specification. 

[Waste Tank Overflow sensor] 
This parameter is used to set the function of sensor to 
detect that the optional waste tank comes full.  When 
"0" is selected, the function is not activated.  When "1" 
is selected, an alarm goes off and a message is 
displayed on the Operation Panel when the tank 
becomes full.  When "2" is selected, the alarm goes off 
and the message is displayed in the same way as when 
"1" is selected. Further, the analyzer stops the operation 
and enters the [STOP] mode.  When "3" is selected, the 
alarm goes off and the message is displayed in the same 
way as when "1" is selected. Further, the analyzer stops 
the operation immediately and enters the [WAIT] mode.  
"0" is the default value because the tank is not included 
in the standard specification. 

5.9.5 [RTT Insufficient Reagent Setting]  

[Processing mode in no reagent] 
When the liquid level in the reagent bottle set in the 
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reagent tray (RTT) becomes lower than the height (in 
mm) from the bottom of the bottle defined for [Reagent 
empty RPP height] below, the analyzer judges the 
reagent is short.  When "0" is selected, an alarm goes 
off and a message is displayed on the Operation Panel 
when the reagent bottle becomes empty.  When "1" is 
selected, the alarm goes off and the message is 
displayed in the same way as when "0" is selected. 
Further, subsequently, the analyzer does not perform 
the tests using that reagent.  When "2" is selected, the 
alarm goes off and the message is displayed in the same 
way as when "0" is selected. Further, the analyzer stops 
the operation and enters the [STOP] mode.  When "3" 
is selected, the alarm goes off and the message is 
displayed in the same way as when "0" is selected. 
Further, the analyzer stops the operation immediately 
and enters the [WAIT] mode.  "1" is the default value. 

 

[Bottle change RPP height] When multiple bottles of a reagent are set in multiple 
RTTs and the liquid level of the bottle in use becomes 
lower than the value (in mm) defined here, the analyzer 
stops aspirating reagent from the bottle and starts to 
aspirate from another bottle.  "1.5 mm" is the default 
value.  You can change the value in a value greater than 
that entered for [Reagent empty RPP height] below.  If 
a value smaller than that, the analyzer judges the 
reagent is empty before changing the bottles, and mark 
the data with the "r" flag to show the reagent bottle was 
empty. 

 Please refer to “Section 5.1.1 "Using multiple 
bottles of a reagent for a test" of this chapter. 

[Reagent empty RPP height] 
When the liquid level of the reagent bottle in RTT 
becomes lower than the height (in mm) from the bottom 
of the bottle defined here, the analyzer judges the 
reagent has run out.  Also the relevant data are flagged 
with "r" to indicate the reagent had run out.  "1.0 (mm)" 
is the default value. 

[Reagent Reset (0：Bottle Capacity , 1：I ndefinite)]  
This parameter selects the reagent volume after the 
[Reset] button is clicked in the [Reagent Test Monitor] 
window accessed via [Reagent]. When [0] (Bottle 
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Capacity) is selected, the analyzer assumes that the 
reagent bottle is full. (The reagent volume is assumed 
to be the value defined for each container in the 
[Reagent Bottle Specifications] column accessed via 
[Setup] > [System Specification Settings], the value 
defined in the [Container] column accessed via 
[Reagent] > [Reagent Container Settings].) When [1] 
(Indefinite) is selected, the analyzer assumes that the 
reagent volume is unknown. The [Vol.Left (ml)] field 
displays "- - -" and the [VOLUME DISPLAY] bar is 
shown in gray in the [Reagent Test Monitor] window. 

5.9.6 [STT Sample Barcode Setting] 

[Barcode digit limit (Lower)] 

[Barcode digit limit (Upper)]  The analyzer accepts a sample barcode with up to 13 
digits.  When using a fixed range of barcode digit 
number, enter the lower and upper limit respectively.   
When the barcode reader reads a sample barcode, if the 
digit number of the read barcode is not in the range 
defined here, the analyzer assumes it is a reading error.   
The value ranges between "0" and "13".  Enter the 
smaller number for [Barcode digit limit (Lower)] and 
the larger for [Barcode digit limit (Upper)]. When "0" 
is selected, there will be no limit in the digit number.  
Default value is "0". 

[Edit of STT Barcode Confirmation screen (0: Sample Setting Position, 1: All)] 
When the sample barcode reading is completed, the 
[STT Barcode confirmation] window is displayed. 
When "0: Sample Setting Position" is selected, ID 
fields are displayed only for the positions where the 
samples are placed. When "1: All" is selected, all the 
ID fields are displayed whether the sample is placed or 
not. 

[STT Barcode Error Process (0: Ignore, 1: Waiting+AutoStartoff)] 
The parameter defines the procedure when a barcode 
reading error occurs, When "1" (Waiting + 
AutoStartoff) is selected; an error message is displayed 
when a barcode reading error occurs for a patient or 
blank sample. The analyzer will not start no matter 
what value is entered for [Sample Barcode Confirm 
time] (to be described below), unless you click the [Re-
try] button in the [Sample confirmation] window. When 
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"0" (Ignore) is selected, no error message is displayed. 
However, when the sample barcode reading error may 
cause an erroneous sampling, the operation is stopped 
and a popup window is displayed to draw attention. In 
some cases when sample containers with and without 
barcode label are used together, "0" may be a better 
option. 

[Sample Barcode Confirm time (10 – 10000, 0: timer off)] 
This parameter defines the waiting time of the sample 
barcode confirmation window. When "0" is selected, 
sampling does not start until the [OK] button is clicked 
in the [Sample Barcode Confirm] window. When 
entering a number between 10 and 10,000, the sampling 
starts automatically after the defined time (in second) is 
elapsed. The numbers "1" - "9" are invalid. 

5.9.7 [Automatic Control] 

[Automatic Control Counting method (0: Total tests 1: Number of tests of each item)] 

 See "Section 5.4.2 Automatic control measurement" in this chapter. 

[Auto.Control Execution method in Each Assay (0: Individual 1: All items)] 

 See "Section 5.4.2 Automatic control measurement" in this chapter. 

5.9.8 [STAT Port] 

[STAT Port Request Screen Timer (0: Timer OFF, 1-999: Timer (sec))] 
This parameter selects the waiting time of the STAT 
port request window. When "0" is selected, sampling 
does not begin until the [OK] button is clicked in the 
[STAT Port] window. When entering a number between 
1 and 999, the measurement begins automatically after 
the defined time (in second) is elapsed.  

[STAT Port Request Reflex Setting (0-9: Specify.STAT Set, 99: Reflex of Last STAT Set)] 
This parameter selects the STAT set to display in the 
[STAT port] window when a sample is set in the STAT 
port. When a value from "0" to "9" is entered, the 
corresponding STAT set is displayed. When "99" is 
entered, the STAT set used last time is displayed. 

[STAT Screen Comment Display Setting (0: Not Display, 1:Comment1, 2:Comment2, 
3:Both)] 
This parameter selects the comment to display in the 
[STAT port] window. When "0" is selected, no 
comment is displayed; when "1" is selected, only 
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Comment 1 is displayed; when "2" is selected, only 
Comment 2 is displayed; when "3" is selected, both 
Comments 1 and 2 are displayed. 
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6.1 Chemistry Analysis (Measurement 
of Absorbance) 

6.1.1 Assay method 

6.1.1a Assay methods 

The table below summarizes the assay methods available with BM6010/C. Select 
[Setup] > [Analytical Parameters (Chemistry)] to setup the assay method. 

List of Assays Available withＢＭ6010/C 

Analy. 
mthd 

[Analytical Parameters 
(Chemistry)] 

Condition for setting 
points 

Minimum total 
volume required 

(μL) 
Calculated absorbance Remarks 

EPA  
m＜n, p＝r＝0  (S＋V)＞80  A  mn  

P＜r,  
m＜n (S＋Vp, m)＞80  Amn－kpm×A

Sample blank 
correction is possible ｐｒ + 

RRA  
0＜l＜m＜n, p＝r＝0  (S＋V)＞80 ⊿Amn(⊿Aｌn  )  

P＜r, 0＜ｌ＜m＜n  (S＋Vp, m)＞80 ⊿Amn(⊿Aｌn)－kpm×⊿A
Sample blank 
correction is possible ｐｒ  

2PA  

m+2＜n, 
p＝r＝0  

(S＋V)＞80 (Aｎ+Aｎ-1)－(Am+Am+1  ) 
2t  

P＜r, 
 0＜ｌ＜m＜n  

(S＋Vp, m)＞80 

(Aｎ+Aｎ-1)－(Am+Am+1) _ 
2t

k{(A
mｎ  

ｒ+Aｒ-1)－(Aｐ+Aｐ+1)} 
2 t

Sample blank 
correction is possible 

ｐｒ  

CRA  
0＜ｌ＜4, 
0＜m＜n  

p, r≠0,   
p≠r 

(S＋Vp, m)＞80 

A(ｔｒ)－A(tp) 
ｔtr －ｔp  

Rate assay 

p≠0（p＝r 
 or r＝0） ⊿A(tp)＝A×k×exp(-k×tp)  Rate method 

p＝0  A(ｔ∞ End-point assay  )－A(0)  

IMA  
0＜ｌ＜m＜n, p＝r＝0  (S＋Ｖ)＞80  ⊿Amn(⊿Aｌn  ) 

P＜r, 
 0＜ｌ＜m＜n  (S＋Vp, m)＞80 ⊿Amn(⊿Aｌn)－kpm×⊿A

Sample blank 
correction is possible ｐｒ   

In the above table, 

l, m, n, p, r: Data point. 

S: Sample volume 

V, Vp, m: Reagent volume (total volume at the points p and m) 

Amn: Mean absorbance between the points m and n. The highest and lowest values are 
excluded from calculation. 
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⊿Amn Variance per minute in absorbance between the points m and 
n, calculated by least squares. 

tmｎ Time (min) between the points m and n. 

Ａ(tp) Absorbance obtained from the approximation curve by 
assigning the time at the point p. 

⊿Ａ(tp) The slope of the tangent line of the approximation curve at 
the point p. 

ｋpm Liquid volume correction factor＝(S＋Vp）／(S＋Vm) 

 

 

6.1.1b End-point assay (EPA) 
In EPA, the concentration is calculated from the absorbance at the certain time point 
after the reagent addition. 

 

S+R1 

Time 

Absorbance 
DET.P 

 
p  r  m  n  

 

R2e~R2 

DET.P Points 
M DET.P.m Starting point of main detection 
M DET.P.n Ending point of main detection 
S DET.P.p Starting point of sub detection 
S DET.P.r Ending point of Sub detection 
S Sample 
R Reagent 
 

S DET.P M DET.P 

 

Typical reaction process in EPA and an example of setting the points 

 Enter the measurement conditions 

In the Menu Panel, select [Setup] > [Analytical Parameters (Chemistry)]. Select "EPA" 
from the drop-down menu of [Analy.mthd] in the [Sub-analy.conditions] column in the 
[Analytical Parameters (Chemistry)] window. 

Define the following parameters in the [Calculation method setting] column. 

M-DET.P l＝0  (One point is not used in EPA) 

 m < n or m ≠ 0 and n ＝0  (DET.P.m must be defined) 

S-DET.P If you do not use "S-DET.P", be sure to enter p＝r＝0 . 

 If you use it,  p < r  or  p ≠ 0 and R ＝ 0. 
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 Calculated absorbance 

 When "S-DET.P" is not used 

Calculate the mean absorbance in the range between the points m and n with the 
highest and lowest values excluded. Name this absorbance as "Abs1". With n = 0, take 
the median absorbance in the range of the points m, m+1, and m+2 as "Abs1". 

 Calculated absorbance Abs = Abs1 

 When "S-DET.P" is used 

Calculate the mean absorbance in the range between the points p and r with the highest 
and lowest values excluded. Name this absorbance as "Abs2". 

With r = 0, take the median absorbance in the range of the points p, p+1, and p+2 as 
"Abs2". 

 Calculated absorbance Abs = Abs1 - k x Abs2 

Abs2 of S-DET.P can be used for correcting the blank correction of the sample. "k" is 
the volume correction factor. 

 

6.1.1c Radio rate assay (RRA) 
In RRA, concentration or activity is calculated from the variance per minute in 
absorbance between 2 points obtained with least squares. 

 

Time 

A
bsorbance 

DET.P 

Check D.P. 

l        m                             n p              r  

R2e~R2 

S+R1 

S DET.P M DET.P 

 

Typical (decreasing) reaction process in RRA and an example of setting the points 
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 Enter the measurement conditions 

In the Menu Panel, select [Setup] > [Analytical Parameters (Chemistry)]. Select "RRA" 

from the drop-down menu of [Analy.mthd] in the [Sub-analy.conditions] column in the 

[Analytical Parameters (Chemistry)] window. 

Define the following parameters in the [Calculation method setting] column. 

M-DET.P With l＝0  or  l > m, points are not moved forward. (When the 

measurement values at some points are judged invalid by the method 

described later and excluded, and consequently the number of points 

becomes smaller than the defined number, the range for M-DET.P is 

expanded by moving the points consecutively forward from "1" to "n". )   

 With 1 < m, when the absorbance of the main wavelength is over the 

absorbance limit, for example in case of a sample producing abnormally 

high value, the over-the-limit absorbance values are automatically 

excluded from calculation. Also, when the number of the measurement 

values is 3 or smaller, the points are moved forward consecutively up to 

"l" so that the number will be 4. 

 With DET.P.m, n, be sure to set  m < (n－4) and  m ≠ 0. 

S-DET.P If you do not use "S-DET.P", be sure to enter p＝r＝0 . 

 If you use it, set p < r. 

E2 CORRECTION ([E2 CORRE]) 

Blank correction is applied to the sample measurement value outside the 

absorbance limit (d) [hereafter sample (d)] or [hereafter sample (u)]. Here, 

"d" stands for "lower" and "u" for "upper".  This correction is called "E2 

CORRECTION."  

Sample measurement value corrected for the lower limit [Hereafter, 

corrected value (d)] = the sample (d) ＋k× (E2 value－RBE2 value) 

However, the correction is not applied when (E2 value－RBE2 value) < 0.  

Here, E2 is the median of measurement values at the 3 E2 points for the 

main wavelength.  

RBE2 indicates the E2 value at the reagent blank measurement.  

"k" is the volume correction factor. 

 Calculated absorbance 

 When "S-DET.P" is not used 

Calculate the variance per minute in absorbance from the measurement values at the 

M-DET.P points by least squares and name it as ⊿Abs1. 

 Calculated absorbance variance ⊿Abs = Abs1 
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 When "S-DET.P" is used 

Calculate the variance per minute in absorbance from the measurement values in the range 

of the points "p" to "r" by least squares, and name it as ⊿Abs2. 

 Calculated absorbance variance ⊿Abs = ⊿Abs1－k×⊿Abs2 

"k" is the volume correction factor. 

 

6.1.1d 2-point assay (2PA) 

2PA is a reaction rate assay where the concentration or activity is calculated from the 

variance per minute in absorbance between 2 points.  "E2 CORRECTION" can be 

applied to the samples (u) and (d) as with RRA. 

 S+R1 

Time

A
bsorbance

DET.P

Check D.P.

l  m      n

R2e~R2

p              r

S DET.P M DET.P

 
Typical (decreasing) reaction process in 2PA and an example of setting the points 

 Enter the measurement conditions 

In the Menu Panel, select [Setup] > [Analytical Parameters (Chemistry)]. Select "2PA" 

from the drop-down menu of [Analy.mthd] in the [Sub-analy.conditions] column in the 

[Analytical Parameters (Chemistry)] window. 

Define the following parameters in the [Calculation method setting] column. 

M-DET.P With l＝0  or  l > m, points are not moved forward. 

 Also, with 1 < m, when the number of the measurement values is 3 or 

smaller (e.g. a sample has produced abnormally high values), the points 

are moved forward consecutively up to "l" so that the number will be 4. 

 With DET.P.m, n, be sure to set  m < (n－4) and  m ≠ 0. 

S-DET.P If you do not use "S-DET.P", be sure to enter p＝r＝0 . 

 If you use it, set p < r. 
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 Calculated absorbance 

 When "S-DET.P" is not used 

Variance in absorbance per minutes (⊿Abs1) is obtained by dividing the difference 

between the mean absorbance at the points "m" and "m+1" and that at the points "n", 

"n-1" by the time between the points. 

 Calculated absorbance variance ⊿Abs = ⊿Abs1 

 When "S-DET.P" is used 

The variance in absorbance per minute (⊿Abs2) is obtained by dividing the difference 

between the mean absorbance at the points "p" and "p+1" and that at the points "r", "r-

1" by the time between the points. 

 Calculated absorbance variance ⊿Abs = ⊿Abs1 - k×⊿Abs2 

"k" is the volume correction factor. 

 

6.1.1e CRA 

In CRA, the approximation curve is obtained by least squares for response where the 

absorbance becomes constant over time, and then absorbance is calculated from the 

approximation curve with setting either absorbance variation or reaction time as 

infinite to obtain concentration or activity. "E2 CORRECTION" can be applied to the 

samples (u) and (d). 

 

Time 

Absorbance 

DET.P 
Check D.P.

R2e~R2

S+R1 

M DET.P

m                                n 

 

Typical (increasing) reaction process with CRA and an example of setting the points 

 Enter the measurement conditions 

In the Menu Panel, select [Setup] > [Analytical Parameters (Chemistry)]. Select "CRA" 

from the drop-down menu of [Analy.mthd] in the [Sub-analy.conditions] column in the 

[Analytical Parameters (Chemistry)] window. 

Define the following parameters in the [Calculation method setting] column. 
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M-DET.P Be sure to set  1 < l < 4 for DET.P.l. Enter the trigger reagent number. 

Accurate reaction time is required for approximation in CRA.  The 

reaction is assumed to begin at the time when this trigger reagent is 

dispensed.  

With DET.P.m, n, be sure to set  m < n and  m ≠ 0. Calculate the 

approximation curve of the chemical kinetics by least squares from the 

absorbance values in the range of the points m to n. Set the range as large 

as possible to obtain the correct value. 

S-DET.P Used for calculating the absorbance from the obtained approximation 

curve. The absorbance calculation varies depending on the setting. 

 Calculated absorbance 

 When S-DET.P is set with p = r ≠ 0 or p ≠ 0 and r = 0  

Absorbance variance (⊿Abs) is calculated from the slope of the tangent line at the 

time "t(p)" on the approximation curve. 

 When S-DET.P is set with p < r  

Absorbance variance (⊿Abs) is calculated from the slope of the line connecting the 

calculated absorbance values at the time "t (p)" and "t (r)". 

 When S-DET.P is set with p = r = 0. 

Absorbance [Abs(t∞)] is calculated with setting infinite for time of the approximation 

curve. Then the [Abs(t∞)] is corrected for blank to obtain absorbance (Abs). 
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6.1.1f Immunoassay (IMA) 
In IMA, concentration or activity is calculated from the variance per minute in 
absorbance between 2 points obtained with least squares. This method is effective 
when E2 CORRECTION is not applicable because the volume of the reagent 1 is too 
small, or when you want to correct the measurement for the serum blank in the one-
part reagent  

The difference from RRA is as follows: 

 Check D.P. Correction 
When excluding the values using the absorbance limit of M-DET.P, absorbance at the 
Check D.P. is used for correction instead of the E2 point. This allows sample blank 
correction when the sample volume is small at the E2 point. 

 Automatic update of the limit values  
During calibration, the absorbance limit and prozone limit values are calculated from 
the calibration data to allow automatic updating of the values. 

 

A
bsorbance 

S+R1 

Check D.P. S DET.P M DET.P 

p r l m n 

R2e~R2 

DET.P 

Time  

Typical (increasing) reaction process with IMA and an example of setting the points 
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 Enter the measurement conditions 

In the Menu Panel, select [Setup] > [Analytical Parameters (Chemistry)]. Select "IMA" 
from the drop-down menu of [Analy.mthd] in the [Sub-analy.conditions] column in the 
[Analytical Parameters (Chemistry)] window. 

Define the following parameters in the [Calculation method setting] column. 
 

Check D.P. When the check D.P.＝0, no correction is applied to the absorbance limit.  
When the check D.P.>0, correction is applied to the sample (d) during the 
decreasing phase of reaction and to sample (u) in the increasing phase.  
This correction is called "Check D.P. Correction."  
Corrected absorbance limit = Absorbance of the sample (d or u) +k × 
value at the check D.P. 
Here, "k" is the volume correction factor. 

 

Sample 
(u) 

Absorbance 

              19 21               30 

 

 
Reaction process values 

              19 21               30 

 

Reaction process values with turbidity 

Sample 
(u) 
 

Exclude the values in this 
range from calculation 

Exclude the values in this 
range from calculation 
 

Limit absorbance for correction (LAC) ＝Sample（u）＋Absorbance ｌ 

Example of Check 
D.P. setting 

Check D.P. 19 
DET.P.m 21 
DET.P.n 30 

 

   Point 

Absor- 
bance l 

LAC 

 
 

M-DET.P With l＝0  or  l > m, points are not moved forward. 

 With 1 < m, when the absorbance with the main wavelength is over the 
absorbance limit, in the increasing phase of reaction (  see the figure in 
the previous page), for example in case of a sample producing an 
abnormally high value, the over-the-limit absorbance values are 
automatically excluded from calculation. Also, when the number of the 
measurement values is 3 or smaller, the points are moved forward 
consecutively up to "l" so that the number will be 4. 

 With DET.P.m, n, be sure to set m < (n－4) and  m ≠ 0.  

S-DET.P If you do not use "S-DET.P", be sure to enter p＝r＝0 . 

 If you use it, set p < r. 
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 Calculated absorbance 

The absorbance is calculated by the same formula as used in RRA (  See Section 
6.1.1c). 

 Automatic update of the limit values  

During multi-point calibration, the absorbance limit and prozone limit values are 
calculated from the calibration data to allow automatic updating of the values.  
Generally, the reagents for immunoassay tend to vary by lot, therefore, the assay may 
not succeed with fixed limit values. In such a case, use this function. 

 Defining calibrators for each limit value and point in the reaction 
process 

Select [Setup] > [Analytical Parameters (Chemistry)], and click the [Multi-STD 
setting] button to display the [Multi-Standards Set] window. 

 Define the calibrators  
Enter the appropriate values in each line. The line "0" is for reagent blank and the 
lines 1 to 9 are for STD1 to STD9 respectively. 

 Click the [IMA setting] button in the [Analytical Parameters (Chemistry)] window to 
display the [IMA Set] window. 

 Enter [D.P. set l] and [D.P. set m].  
Specify the range of points in t he reaction process for the main wave length of the 
selected calibrator to be used for automatic calculation 

 Define [Factor d].  
Define the factor so that the variance in absorbance between the specified points will 
be the corresponding limit value. The value range is from -9.999 to 9.9999. 

 Select whether or not to use the function of automatic update of the limit values in 
the respective [Auto. set] field.  
Select "Do." When "Not do" is selected, the limit values are not updated after 
calibration. If you do not want to update the values, select "Not do." 

 Calculation formula 

The limit value calculation formulas for the blank samples (u) and (d), samples (u) and 
(d), and the prozone sample is: 

 Limit Value＝Factor d  x (Am－A1

where, Am represents the absorbance with the main wavelength at the D.P. set m for 
the selected calibrator. When 0 is entered for [D.P. set m], Am equals 0. 

) 

where, A1 represents the absorbance with the main wavelength at the D.P. set l for the 
selected calibrator. When 0 is entered for [D.P. set l, A1 equals 0. 
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 Displaying the updated limit values 

 Click [OK]. When the calibration is completed, the limit values in the [Analytical 
Parameters (Chemistry)] window are updated. 

 When the calculation results is outside the effective range (from -9.9999 to 
99.9999), the limit values are not updated and the previous values are 
maintained. 

 Example of settings 

 

               21            27 

 

 

               21 

 

 

Absorbance 

Calibrator： 0 Calibrator： 5 

Blank (u)＝Absorbance m×1.3 

IMA 
Blank (u) 

Calibrator 0 
D.P.set l 0 
D.P.set m 21 
Factor d 1.3 

 

   Po int 

Absorb- 
ance m 

Absorbance l 

Absorbance m 

R1＋S 

Sample （u）＝（Absorbance m - Absorbance ｌ）
×1.3 

IMA 
Sample (u) 

Calibrator 5 
D.P.set l 21 
D.P.set m 27 
Factor d 1.3 

 

R2e~R2 R1＋S R2e~R2 
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6.1.2 Calibration 

Calibration is an operation for generating a calibration curve used for converting the 
absorbance or its variance of the reaction solution into a concentration or activity value. 

6.1.2a Methods of calibration 
Calibration methods are summarized in the table below. The parameters are defined in 
the [Analytical Parameters (Chemistry)] window. Note that the calibration data for a 
test can be used for another test. 

 See "Section 5.7.2 Setting up a blank reagent" in “Chapter 5. 

List of Calibration Methods 

Method 
Number and type of 

calibrators 
Conversion method for concentration 

Absorbance (ABS) calculation Reagent blank Reaction ABS x FV 

One-point calibration curve 
Reagent blank 1 
Standard 

Reaction ABS x FV/(ABS of standard) 

Multipoint  
calibration 
curve *1 
(MSTD 
calculation) 

• No conversion 
• Semi-log 

transformation  
(The 
concentration is 
log-transformed.)   

• Log 
transformation  
(Both the 
concentration and 
the reaction ABS 
are log-
transformed.) 

Linear 
function 

Reagent blank and 
one or two calibrators  

Calculate "a"  from the calibration 
function "Y＝aX＋d" by  l east  
squares approximation, and then 
convert it to concentration by false 
position method. 

Quad-
ratic 
function 

Reagent blank and 
two or three 
calibrators 

Calculate "a" and "b" from the 
calibration function "Y=aX２

Cubic 
function 

＋bX＋d" by  
least  squares approximation, and 
convert them to concentration by false 
position method. 

Reagent blank and 
three or four 
calibrators 

Calculate "a", "b" and "c" from the 
calibration function "Y=aX２＋bX２

Broken line approximation 

＋cX＋
d" by  lea st  s quares approximation, 
and convert them to concentration by 
false position method." 

Reagent blank and 
one or two calibrators 

Connect the points consecutively with 
the linear function Y = aX+d to obtain 
"a", and convert it to concentration by 
reverse calibration function of the 
corresponding absorbance. 

Spline interpolation 
Reagent blank and 
two or three 
calibrators 

Connect the points consecutively with 
the cubic function Y＝aX３＋bX２

LOGIT-LOG1 function 

＋cX＋d 
to obtain "a", "b", and "c", and convert 
them to concentration by reverse 
calibration function of the corresponding 
absorbance. 

Reagent blank and 
two or three 
calibrators 

Calculate "a" and "b" from the 
calibration function "Y＝(a-d)/(1+X/b)+d" 
by least squares approximation, and 
convert them to concentration by false 
position method. 
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Method Number and type of 

 

Conversion method for concentration 

LOGIT-LOG2 function 
Reagent blank and 
three or four 
calibrators 

Calculate "a", "b", and "c" from the 
calibration function "Y＝(a-d)/(1+(X/b)
ｃ

LOGIT-LOG3 function 

)+d" by least squares approximation, 
and convert them to concentration by 
false position method. 

Reagent blank and 
four or five calibrators 

Calculate "a", "b", "c", and "e" from the 
calibration function "Y＝(a-d)/(1+(X/b)
ｃ

Simplified calibration

exp(eX))+d" by least  s quares 
approximation, and convert them to 
concentration by false position method. 

Reagent blank 
1 calibrator 

*2 

Calibration function "Fx" is obtained 
from the multipoint calibration curve and 
corrected with the reagent blank and a 
calibration value to obtain the function 
"Y＝F(X)×u2＋u1" which is used for 
conversion to concentration for each 
calibration method. 

 

*1 Up to 9 calibrators can be measured in multipoint calibration except the reagent blank. If the 
reagent blank is not used, up to 10 calibrators can be measured.  
In the calculation formulas of multipoint calibration (MSTD), X corresponds to concentration 
and Y to calculated absorbance.  
In multipoint calibration curve with reagent blank, the X axis indicates concentration (reagent 
blank and FV1 to 9) and the Y axis shows reaction absorbance. In multipoint calibration curve 
without reagent blank, the X axis indicates concentration (FV0 to 9) and the Y axis shows 
calculated absorbance.  
  Calculated absorbance: Absorbance (ABS) of the calibrator  
  Reaction absorbance: Absorbance of the calibrator subtracted by reagent blank (ABS-RB) 

*2 Simplified calibration uses a 2-point calibration curve for daily correction of the reagent blank 
and slope of the multipoint calibration curve that requires more calibrators to obtain. The 
calibration function F(X) must be obtained in advance with the selected calibrators. 
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6.1.2b Calibration 
 See "Section 2.2.5 Calibration Setup window" in “Chapter 2 for details of 
calibration settings 

 Measurement of the reagent blank 

1 Select the tests for which the reagent blank will be m easured, in the 
[Calibration Setup] window.  

2 Define the CTT No. and the position to set the reagent blank. 
3 Define the replication number.  

Measurement can be repeated up to 5 times. 
4 Start the measurement. 

The mean measurement value of the values except the smallest and largest values is 
retained and displayed in the [Calibration Summary] in the [View Calibration Curve] 
window. 

 Measurement of the calibrators (STD) 

 One-point calibration (Calculation for STD and simplified calibration) 

1 Select the tests for which the calibrators will be measured, in the 
[Calibration Setup] window. 

2 Define the CTT No. and the position to set the calibrator 
3 Define the replication number.  

Measurement can be repeated up to 5 times. 
4 Start the measurement. 
The mean measurement value of the values except the smallest and largest values is 
retained and displayed in the [Calibration Summary] in the [View Calibration Curve] 
window. 

 [Multi-Standard Setup] window 

1 Select the tests for which the calibrators will be measured, in the  
[Calibration Setup] window. 

2 Define the STT No. and the position to set the calibrator from the window 
displayed by clicking the [Setting] button on the MSTD column. 

3 Define the replication number.  
Measurement can be repeated up to 5 times. 

4 Start the measurement. 

The mean measurement value of the values except the smallest and largest values is 
retained and displayed in the [Calibration Summary] in the [View Calibration Curve] 
window as reaction ABS which is the absorbance subtracted by the reagent blank. 
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6.1.2c Absorbance (ABS) calculation 
In calibration for the ABS calculation, only the reagent blank is measured. A constant 
FV is used for conversion to concentration. 

 

6.1.2d One-point calibration 
The concentration of reagent blank and a calibrator (STD) are measured for calibration. 

Concentration of the standard is used as FV for conversion to concentration.  

The following formula is used. 

)calibrator of ABSReaction (／FVABSReaction Cx ×=  

Cx: Concentration or a unit of the measurement sample (hereafter 
referred to as concentration) 

Reaction ABS: Reaction absorbance of the measurement sample 

FV: Constant for calibration concentration 

STD: Calibration value stored in the system 

 Calculated 
ABS 

BLK 

FV Cx 

Calibrator 

Calibration curve 

Concentr
-ation  

 

The following formula is used for calculating "F" (slope of the calibration curve). 

 F＝FV／(reaction ABS of STD) 
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6.1.2e Multipoint calibration (no conversion, linear, quadratic, and cubic 
functions) 
Concentrations of the reagent blank and calibrators (STD) are measured. One up to ten 
calibrators can be used.  

The calibration curve is calculated with the following formula. 

dCxcCxbCxa ABSCalculated 23 +×+×+×=   

Calculated ABS: Calculated absorbance of the measurement sample 

Cx: Concentration of the sample 

a, b, c, d: Factors automatically calculated by curve approximation in 
calibration. 

 

   STD5 
   STD4 

 
Cal. ABS 
   STD3 
 
   STD2 
 
 
   STD1 
 
    BLK 

Calculated ABS 

FV1    FV2   FV3   Cx        FV4       FV5 

Calibra-
tion 
curve 

Conc. 
 

 

Up to 10 calibrators are used to calculate factors a, b, c, and d by least squares. In the 
above figure, the reagent blank and 5 calibrators are used. In linear function, a = b = 0, 
and in quadratic function, a=0. The number of calibrators must be at least the number 
of exponentiation powers plus 1 including the reagent blank. False power method is 
used to calculate Cx from the calculated ABS. 

The calculation to obtain the factors a, b, c, and d varies as follows depending on the 
presence or absence of the reagent blank. 

In the presence of the reagent blank, the calibration curve is obtained from the 
measurement results of the reagent blank and calibrators so that it should pass the 
origin (0, 0, or the blank point). 

In the absence of the reagent blank, the curve does not necessarily pass the origin 
because it is obtained from the measurement results of calibrators only. 
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6.1.2f Multipoint calibration (semi-log transformation, linear, quadratic, 
and cubic approximations) 
Concentrations of the reagent blank and calibrators (STD) are measured. One up to ten 
calibrators can be used. 

The calibration curve is calculated with the following formula. 

)2(Cx/FVi)1log(Cx/FVif(Cx) ++=  

df(Cx)cf(Cx)bf(Cx)a ABSCal. 23 +×+×+×=  

F (Cx): Axis transformed concentration 

FVi: Concentration of the second highest calibrator 

Calculated ABS: Calculated absorbance of the measurement sample 

a, b, c, d: Factors automatically calculated by curve approximation in 
calibration 

 
 

   STD5 
   STD5 
 
Cal. ABS 
   STD3 
 
   STD2 
 
 
 
   STD1 
 
    BLK 

Cal. ABS 

FV1     FV2   FV3   Cx      FV4      FV5 
                         f(Cx) 

Calibration 
curve 

Conc. 

 
 

See the description under the graph in Section 6.1.2e for how to obtain the factors a, b, 
c, and d. 
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6.1.2g Multipoint calibration (log transformation, linear, quadratic, and 
cubic approximations) 
Concentrations of the reagent blank and calibrators (STD) are measured. One up to ten 
calibrators can be used. 

The calibration curve is calculated with the following formula. 

)(Cx/FVi)1log(Cx/FVif(Cx) 2++=  

)2i)(Cal.ABS/A1S/Ailog(Cal.ABg(Cal.ABS) ++=  

df(Cx)cf(Cx)bf(Cx)a ABS)g(Cal. 23 +×+×+×=  

f (Cx): Factor to convert absorbance to concentration 

g (Calculated ABS):  Axis transformed calculated ABS 

Cx: Concentration of the sample 

FVi: The second lowest concentration of the calibrator 

Calculated ABS: Calculated absorbance of the measurement sample 

Ai: The second lowest calculated ABS of the calibrator 

a, b, c, d: Factors automatically calculated by curve 
approximation in calibration 

 
 

   STD5 
   STD4 
 
Cal.ABS 
   STD3 
 
   STD2 
 
 
   STD1 
 
    BLK 

g(Cal.ABS) 

 FV1    FV2    FV3   Cx      FV4      FV5 
                          f(Cx) 

Calibration 
curve 

Conc. 

 
 

See the description under the graph in Section 6.1.2e for how to obtain the factors a, b, 
c, and d. 
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6.1.2h Multipoint calibration (Broken line approximation） 
Concentrations of the reagent blank and calibrators (STD) are measured. One up to ten 
calibrators can be used. 

The calibration curve is calculated with the following formula. 

ii dCxaCal.ABS +×=  

Calculated ABS: Calculated absorbance of the measurement sample 

Cx: Concentration of the sample 

a i , di

 

: Automatically obtained factors for each section of calibration (i＝1 
to 10) 

 
FV1  FV2        FV3   Cx  FV4      FV5 

 
 

Up to 10 calibrators can be used. In the above figure, the reagent blank and 5 
calibrators are used. A linear function is obtained for each section of the curve by 
connecting two measurement points in the section. The number of calibrators must be 
at least two including the reagent blank. Set the calibrator in such a way that the 
concentration will be higher as the number of FV is larger. (i.e, the reagent blank or 
FV0 < FV1 < FV2 < FV3 ....) Click the [MSTD setting] button in the [Analytical 
Conditions (Chemistry)] window and enter the values in the fields under the [FV] 
header. 

    STD5 
    STD4 
 Cal. ABS  
    STD3 
 
 
 
 
 
    STD2 
    STD1 
     BLK 

Cal. ABS 

Conc. 

calibration 
curve  
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6.1.2i Multipoint calibration (Cubic spline interpolation) 
Concentrations of the reagent blank and calibrators (STD) are measured. Two up to ten 
calibrators can be used. 

The calibration curve is calculated with the following formula. 

ii
2

i
3

i dCxcCxbCxa ABSCal. +×+×+×=  
 

Calculated ABS: Calculated absorbance of the measurement sample 

Cx: Concentration of the sample 

a i , bi , c i , d i

 

 

    STD5 
    STD4  
 Cal.ABS 
 
 
    STD3 
  
    STD2 
  
    STD1 
     BLK 

Cal.ABS 

 FV1   FV2  FV3    Cx    FV4    FV5 

Calibration 
curve 

Conc. 

: Automatically obtained factors for each section of calibration (i＝1 
to 10). 

 
Up to 10 calibrators can be used. In the above figure, the reagent blank and 5 
calibrators are used. A cubic function is obtained for each section of the curve by 
connecting three measurement points in the section. The number of calibrators must be 
at least three including the reagent blank. Set the calibrator in such a way that the 
concentration will be higher as the number of FV is larger. (i.e, the reagent blank or 
FV0 < FV1 < FV2 < FV3 ....) Click the [MSTD setting] button in the [Analytical 
Conditions (Chemistry)] window and enter the values in the fields under the [FV] 
header. 
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6.1.2j Multipoint calibration (LOGIT-LOG1 function approximation) 
Concentrations of the reagent blank and calibrators (STD) are measured. Two up to ten 
calibrators can be used. 

The calibration curve is calculated with the following formula. 

d
(Cx/b)1

da
 ABSCal. +

+
−

=  

Calculated ABS: Calculated absorbance of the measurement sample 

Cx: Concentration of the sample 

a, b, d: Factors automatically calculated by curve approximation in 
calibration. 

 
 

   STD5 
   STD4 
 
Cal.ABS 
 
   STD3 
 
   STD2 
  
   STD1 
    BLK 

Cal.ABS 

FV1    FV2   FV3   Cx     FV4     FV5 

Calibration 
curve 

 
 

Up to 10 calibrators are used to calculate factors a, b, and d by Gauss-Newton 
algorithm. In the above figure, the reagent blank and 5 calibrators are used. The 
number of calibrators must be at least three including the reagent blank. False power 
method is used to calculate Cx from the calculated ABS. 

Note: Do not define FV＝0 for any FV. 

The calculation to obtain the factors a, b, c, and d varies as follows depending on the 
presence or absence of the reagent blank. 

In the presence of the reagent blank, the calibration curve is obtained from the 
measurement results of the reagent blank and calibrators so that it should pass the 
origin (0, 0, or the blank point). 

In the absence of the reagent blank, the curve does not necessarily pass the origin 
because it is obtained from the measurement results of calibrators only. 
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6.1.2k Multipoint calibration (LOGIT-LOG2 function approximation) 
Concentrations of the reagent blank and calibrators (STD) are measured. Three up to 
ten calibrators can be used. 

The calibration curve is calculated with the following formula. 

dc(Cx/b)1

d-a
Cal.ABS +

+
=  

 

Calculated ABS: Calculated absorbance of the measurement sample 

Cx: Concentration of the sample 

a, b, c, d: Factors automatically calculated by curve approximation in 
calibration 

 

 

 
    STD5 
    STD4  
 Cal.ABS 
 
 
    STD3 
 
    STD2 
 
    STD1 
     BLK 

Cal. ABS 

FV1    FV2  FV3    Cx    FV4   FV5 

Calibration 
curve 

Conc. 
 

 

See the description under the graph in Section 6.1.2j for how to obtain the factors a, b, 
c, and d. The number of calibrators must be at least four including the reagent blank. 
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6.1.2l Multipoint calibration (LOGIT-LOG3 function approximation) 
Concentrations of the reagent blank and calibrators (STD) are measured. Four up to ten 
calibrators can be used. 

The calibration curve is calculated with the following formula. 

d
Cx)exp(ec(Cx/b)1

da
 ABSCal. +

××+
−

=  

 

Calculated ABS: Calculated absorbance of the measurement sample 

Cx: Concentration of the sample 

a, b, c, d, e: Factors automatically calculated by curve approximation in 
calibration 

 

 

    STD5 
    STD4 

 Cal. ABS 
 
 
    STD3 
 
    STD2 
 
    STD1 
     BLK 

Cal.ABS 

FV1    FV2  FV3    Cx    FV4  FV5 

Calibration 
curve 

Conc. 
 

 

See the description under the graph in Section 6.1.2j for how to obtain the factors a, b, 
c, and d. The number of calibrators must be at least five including the reagent blank. 

6.1.2m Simplified calibration 
In multipoint calibration, the origin and sensitivity can be corrected by simplified 
calibration data using the reagent blank and a calibrator. The simplified calibration can 
be selected in the [Start Conditions] window. By this function, the multipoint 
calibration curve is optimized without performing another multipoint calibration 
measurement that is time consuming. To effectuate this simplified calibration, the 
original multipoint calibration curve must be stored and maintained and the reagent 
blank must be used. 

The following formula is used for obtaining "U1" and "U2" described below. The 
original curve is represented by Calculated ABS= f (Cx), reagent blank by BLK, and a 
measurement value of a calibrator (FV) by STD. 
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MBLKf(FV)

BLKSTD
U2

−

−
=  

U1＝BLK－U2×MBLK 

U1 and U2 are further corrected by the formula below. 

U1f(Cx)U2Cal.ABS +×=  
 

Calculated ABS: Calculated absorbance of the measurement sample 

Cx: Concentration of the sample 

U1: Reagent blank for correction 

U2: Proportional component for correction 

FV: Concentration of the calibrator used for simplified calibration 

STD: Calculated absorbance of calibrator used for simplified calibration 

BLK: Reagent blank value obtained by simplified calibration 

f(FV): Calculated absorbance obtained by approximation from the 
absorbance of the calibrator of the same FV in the original 
multipoint calibration 

MBLK: Reagent blank measured in the original multipoint calibration 

 
 

  STD 
 
 
 
 f(FV) 
 
 
 
 
 
 MBLK 
  BLK 

Cal.ABS 

FV                 Conc. 

Original 
curve 

Corrected 
curve 

 
 

After a new multipoint calibration curve is obtained, the values are reset to U1＝0 and 
U2＝1. 
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6.1.3 Data checking functions 
The steps to check the measurement values manually are described in Section 5.2 in 
Chapter 5 of the Manual. Here are described various data checking functions that the 
application performs automatically. The measurement values that are highly suspected 
abnormal are checked and then automatically skipped from the calculation or marked 
with a flag. 

6.1.3a Check for the reaction cuvettes 
The cuvettes are checked as follows during the data processing. 

 The reaction cuvette is measured after washing. When the difference between the 
measured value and the cuvette blank check value is larger than the set range, the 
cuvette is not used for measurement (auto skip). 

 The reaction cuvette is measured twice after the cuvette wash. When the difference 
between two measured values is larger than the set range, sample measurement values 
obtained using the cuvette is flagged with "N". 

6.1.3b Check with the reaction process 
The absorbance at each point is checked for abnormality. 

When the variance times 100 is over the limit value defined for each checking range, 
the flag is posted. 

Abnormality may be caused by a defective photometry lamp, a defective detector, 
inadequate mixing, accidental addition of the sample, reagent, or washing solution in 
the cuvette, air bubbles, improper installation of the cuvette, etc.  

Values of the main wavelength and sub wavelength can be both checked. 

The checking range is automatically defined depending on the number of reagents. 

Note this function may not work properly in combination with the prolonged round or 
delay time functions. 

 Check for the range selected automatically 

In measurement with the one-part reagent, all points are checked from the dispensing 
of the reagent up to the last point except for the one immediately after mixing. 

In measurement with two-part reagent, all points from the dispensing of the reagent 1 
up to the dispensing of the reagent 2 are checked for the reagent 1, and all points from 
the dispensing of the reagent 2 up to the last point are checked for the reagent 2. For 
both sections, the point immediately after mixing is excluded. 

In measurement of three-part reagent, all points from the dispensing of the reagent 1 up 
to the dispensing of the reagent 2e are checked for the reagent 1, all points from the 
dispensing of the reagent 2e up to the dispensing of the reagent 2 are checked for the 
reagent 2e, and all points from the dispensing of the reagent 2 to the last point are 
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checked for the reagent 2. For either section, the point immediately after mixing is 
excluded. 

Take an example in case of measurement with two-part reagent. Following two 
combinations are possible. 

1) Sample + Reagent 1 + Reagent 2e 

2) Sample + Reagent 1 + Reagent 2 

 Judgment of abnormality 

When the variance times 100 is over the limit value defined for [Setting Allowance] 
window in the [Analytical Parameters (Chemistry)] window, the value is flagged with 
"V", "v", "W", "w", "X" or "x" for each section. 

Here, the variance is the difference in absorbance between two neighboring 
measurement points. 

 100
n－1

points） gneighborin  twoof  value in e（differenc
100

2

×
∑

=×Variance  

For the variance times 100, the value for each section is displayed in the [Realtime 
Monitor] and [Reaction Monitor] windows under the item name "S". Define the limit 
value on the basis of the values displayed in the windows. 

The abnormal wave form can be detected by setting appropriate positive numbers as 
variance times 100 for the main or sub wavelength. The default value is "0" meaning 
no detection is applied. 

6.1.3c Check with calculated ABS 
Calculated ABS is obtained from the reaction ABS in the M-DET.P range according to 
the assay method. If the S-DET.P is designated, the calculation formula is as follows 
except for CRA. 

 DET.P)(S  ABSCal.KDET.P)(M  ABSCal. ABSCal. -- ×−=  

 K: Volume correction factor. 

The checking parameters are defined in the [Analytical Parameters (Chemistry)] 
window. 

 Checking absorbance of the reaction process with the main 
wavelength in the M-DET.P range.  

 When measuring the reagent blank 

ABS with the main wavelength in the M-DET.P range is checked using blanks (u) and 
(d) to verify validity of the reagent. 
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 When blank (u) < ABS with main wavelength, the value is flagged with "U". 

 When blank (d) < ABS with main wavelength, the value is flagged with "D". 

 Judgment of valid data and moving points forward 

In the assay methods of RRA, 2PA, CRA, and IMA, the absorbance in the reaction 
process is checked in the M-DET.P range, using the ABS with the main wavelength. 

In the judgment, the point where the value exceeds the limit absorbance due to the 
measurement of high concentration sample is excluded from calculation for the 
calculated ABS (M-DET.P) in the tests that use the variance of absorbance (e.g. GOT, 
GPT).  This exclusion aims to avoid having an abnormally low calculated ABS which 
might result from including the measurement point where the value exceeds the limit 
absorbance. 

 The limit absorbance is the threshold value. The measurement value 
exceeding that value is judged abnormal. 

 

 E2 CORRECTION or check D.P. correction  
If "Do" is selected for [E2 CORRECTION], the sample measurement value over the 
limit absorbance (u, d) is corrected in the assay methods except IMA.  
"E2 CORRECTION" is used for correcting the limit absorbance change due to 
turbidity in serum.  The correction is applied for the points 4 to 6 in case turbidity is 
measured.  
However, the correction is not applied with (E2 value minus RBE value) < 0. 

tmeasuremen blank at  valueE2  valueE2 valuecorrection E2 −=  
 valueE2Kd)(u,d)(u, sample Correction ×+= Sample   

K:  Volume correction factor (K = total volume at E2 point divided by total volume 
at M-DET.P) 

E2: E2 point measurement value of each sample 

E2 blank value: The stored value at the reagent blank measurement. Correction is not 
applied with E2 value < 0. 

With IMA, E2 CORRECTION is always applied even if "Not do" is defined. 

D.P.Kd)(u, Sample d)(u, sample Correction ckValueatChe×+=   

K:  Volume correction factor (K = total volume at E2 point divided by total volume 
at M-DET.P) 
Note that no correction is applied with check D.P. point value = 0. 

In the decreasing reaction, points except those where the correction sample (d) > ABS 
with main wavelength are excluded.  
In the increasing reaction, points except those where the correction sample (u) < ABS 
with main wavelength are excluded. 
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When the measurement values at some points are judged invalid by the method 
described above and excluded, and consequently the number of points becomes smaller 
than the defined number, the range for M-DET.P is expanded by moving the points 
consecutively forward from "1" to "n". This adjustment is applied when the fewer 
points are defined for "l" than "m". With this adjustment, the measurement range is 
significantly expanded. However, the points are not moved forward in CRA. 

When the number of points becomes 3 or smaller, the value is flagged with "d" in the 
decreasing reaction and "u" in the increasing reaction. 

 Checking by least squares 

In RRA and IMA, the variance in absorbance per minute is calculated from the time 
and absorbance of the points by least squares. 

The values judged to have a large discrepancy from the calculated line are excluded, 
and the least squares calculation is repeated until the defined repeat times (Cycle) are 
over or until there is no value to exclude. 

 Usually "1" to "3" is defined for the Cycle. 

 When the discrepancy is larger than the standard deviation of the Factor times 
discrepancy, it is judged to be large and the value at the point is excluded from 
calculation. Usually "2" or "3" is defined for the Factor. 

 When the number of points is three or smaller, "n" is flagged. 

 Checking by the M-DET.P range 

For the assay methods RRA, 2PA, CRA, or IMA, 

 With the absorbance of correction sample (u) < ABS with the main wavelength in 
the decreasing reaction, the value is flagged with "U". 

 With the absorbance of correction sample (u) > ABS with the main wavelength in 
the increasing reaction, the value is flagged with "D". 

 Checking with the Check D.P. 

The Check D.P. point is set before or immediately after the addition of the trigger 
reagent to check if the reagent is consumed by some substance in the sample (e.g. 
pyruvic acid in GPT test). 

For the assay methods RRA, "PA, CRA, and IMA, the ABS with the main wavelength 
is checked at the Check D.P. point  

In the decreasing reaction, 

 Blank (u) < ABS with main wavelength, the value is flagged with "U". 

 Blank (d) > ABS with main wavelength, the value is flagged with "d". 

In the increasing reaction, 

 Blank (u) < ABS with main wavelength, the value is flagged with "u". 

 Blank (d) > ABS with main wavelength, the value is flagged with "D". 
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 Check for variance 

 The variance in the valid data in the M-DET.P range is checked. 

 When the variance of the calculated ABS is larger than the value defined for 
[Variance] in the [Analytical Parameters (Chemistry)] window, the calculated ABS is 
flagged with "*". 

 Variance calculation varies by assay method. 

In EPA, 

 BS｜100/｜Cal.A ABS)Min. ABS(Max Variance ×−=  

In CRA with p=0, 

 BS｜100/｜Cal.A2)-/(ndifference the of sum SquareVariance ×=  

In assay methods other than the above two, 

 
.ABS｜range/｜Cal 100/time2)/(ndifference the of sum Square Variance ×−=

 

 Prozone judge 

 The judgment is applied to all the assay methods. Prozone judge checks the values in 
the reaction process. 

 The variance of absorbance or rate of the variance between two ranges (M-DET 
range and S-DET range) is compared with the preset prozone limit value for prozone 
judgment 

 The parameters below can be defined in the [Analytical Parameters (Chemistry)] 
window. 

  Prozone form 

None Prozone judge is not performed 

RATE method ・ Define the points 
The ranges of M-DET.P (m, n) and S-DET.P (p, r) must be defined 
respectively, where m ≠ 0, n ≠ 0, m < n, and p ≠ 0, r ≠ 0,  p < r. 

 Unless the above conditions are met, or any one point is set as "0", 
calculation fails, and not only Prozone judge is not performed but also the 
concentration is not calculated. 

 ・ The ranges of absorbance variances ⊿Amn[M-DET.P (m, n) and ⊿
Apr[S-DET.P (p, r) are calculated respectively from the two ranges of  
prozone check points M-DET.P (m, n) and S-DET.P (p, r) by least 
squares. Then, the Prozone value is calculated using the following formula. 

△Amn/△Apr valueProzone =  

 ・ IF the absolute value of ⊿Apr is smaller than the [Judge limit] value, 
prozone judge is not performed.  The value range for [Judge limit] is 0 to 
9.999.  
When the normal value is near "0", that is ⊿Apr is small, "P" flag can be 
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posted to the value. This problem can be avoided by setting an appropriate 
Judge limit value. 

Prozone formula 

 ・ Define the points 
The M-DET.P (m, n)  range must be defined. The S-DET.P (p, r) range 
must be defined to perform a Prozone check for antigen re-addition 
method.. Here,  m  ≠ 0, n ≠ 0, m  < n, and p ≠ 0, r ≠ 0,  or p < r. 

 Unless the above conditions are met, calculation fails, and not only the 
prozone judge is not performed but also the concentration is not calculated. 

 ・ The ranges of absorbance variances ⊿Amn[M-DET.P (m, n) and ⊿
Apr[S-DET.P (p, r) are calculated respectively by averaging the values 
except the largest and smallest absorbance of the two ranges of Prozone 
check points M-DET.P (m, n) and S-DET.P (p, r). Then, Prozone value is 
calculated using the following formula. 

When S-DET.P (p, r) is defined: 
AprK-AmnP ×=erozonevalu        K: volume correction factor 

When the range of S-DET.P 8p, r) is defined as "0": 
 AmnP =erozonevalu  

 This function only regulates the data processing method, and therefore is 
not limited to the reagents based on a specific measurement principle. Also, 
RATE method can be used successfully for Prozone judge in the antigen 
re-addition method. 

 By the Prozone judge, the value is flagged with "P", if 

 Prozone value > Prozone limit value (upper limit) 

 Prozone value < Prozone limit value (lower limit) 

 Check for the reagent with the reagent blank measurement 

The validity of the reagent is checked on the basis of the absorbance of the reagent 
blank during the reagent blank measurement. 
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 In Multi-Standard (MSTD) 

 "H" is flagged in case of calculated ABS > Upper limit of the multi-standard reagent 
blank (BLK STD-H). 

 "L" is flagged in case of calculated ABS < Lower limit of the multi-standard reagent 
blank (BLK STD-L). 

 In measurement of other than MSTD (ABS, STD, and simplified 
calibration) 

 "H" is flagged in case of calculated ABS > Upper limit of reagent blank (Standard 
value set BLK-H) 

 "L" is flagged in case of calculated ABS < Lower limit of reagent blank (Standard 
value set BLK-L) 

6.1.3d Check with reaction ABS 
Reaction ABS is absorbance that depends on the concentration of the reaction solution. 
It is calculated by subtracting reagent blank from calculated ABS. 

blank ReagentKt ABSCal. ABSReaction ×−=  

 Kt (volume correction factor)＝Total volume of reaction solution／total 
volume at reagent blank measurement  

The checking parameters are defined in the [Analytical Parameters (Chemistry)] 
window. 

 Check with calibrator 

Calibrators and reagents are checked with the reaction ABS of calibrators. 

 In Multi-Standard (MSTD) 

 "H" is flagged in case of reaction ABS > Upper limit of the multi-point calibrator (n 
STD-H).  Here "n" stands for the multi-point calibrator number. 

 "L" is flagged in case of reaction ABS < Lower limit of the multi-point calibrator (n 
STD-L). 

 In measurement other than MSTD (ABS, STD, and simplified 
calibration) 

 "H" is flagged in case of reaction ABS > Upper limit of the calibrator (Standard 
value set STD-H). 

 "L" is flagged in case of reaction ABS < Lower limit of the calibrator (Standard 
value set STD-L). 

 Check with absorbance at rerun 

The reaction ABS is checked if the value is outside the dynamic range of reagent. 
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Calibrators, patient, and QC samples are checked as below: 

 In EPA, 

Reaction ABS is compared with the absorbance at rerun (Re.absorb). 

 "u" is flagged in case the reaction ABS > Re.absorb (u). 

 "d" is flagged in case the reaction ABS < Re.absorb (d). 

 In the other methods, 

Reaction ABS is not used for checking. Samples (u) and (d), and Check D.P. are used 
for checking the dynamic range of reagent. 

6.1.3e Check by concentration and unit 
The concentration and unit are calculated from the reaction ABS by the defined 
calibration. 

 When the concentration cannot be obtained 

"C" flag is posted when the concentration cannot be obtained due to calibration error. 

 Check for the normal range  

 For patient samples 

The values outside the normal range are checked. The normal range is defined by sex, 
age, and sample type in the [Normal Value Set] window accessed from the [Analytical 
Parameters (Chemistry)] window. 

 "l" flag is posted in case the concentration or unit < value set for Normal Value 
Setting (l). 

 "h" flag is posted in case the concentration or unit > value set for Normal Value 
Setting (h). 

 For QC samples 

The fluctuation of QC sample measurement values is checked. The average and 
standard deviation (SD) are registered for each QC sample for management in the 
[Control Data Registration] window. 
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 "l" flag is posted in case of QC sample measurement value < Registered average 
minus 2 x SD. 

 "h" flag is posted in case of QC sample measurement value > Registered average 
minus 2 x SD. 

 Check for the abnormal range 

 For patient samples 

The values in the abnormal range are checked. The abnormal range is defined by 
sample type in the [Abnormal Value Set] window accessed from the [Analytical 
Parameters (Chemistry)] window. 

 "L" flag is posted in case the concentration or unit < value set for Abnormal Value 
(L). 

 "H" flag is posted in case the concentration or unit > value set for Abnormal Value 
(H). 

 For QC samples 

The fluctuation of QC sample measurement values is checked. The average and 
standard deviation (SD) are registered for each QC sample for management in the 
[Control Data Registration] window. 

 "L" flag is posted in case of QC sample measurement value < Registered average 
minus 3 x SD. 

 "H" flag is posted in case of QC sample measurement value > Registered average 
minus +3 x SD. 

6.1.3f Check for the calibration value compared with the previous value 
The variance between the calculated calibrator ABS obtained this time and that of last 
measurement is checked whether it falls within the allowance (%). 

The variance is calculated with the formula:｜previous calibration value－current 
calibration value｜/ previous calibration value ×100 (％) . If this rate is higher than the 
allowance range, the value is judged as abnormal and flag "Z" is posted with the value. 
The new calibration value will not be used and the stored value is not updated. 

Define value for [Error judge rate (vs.previous data)] window in the [Analytical 
Parameters (Chemistry)] window. 
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6.2 Principle of the Ion Selective 
Electrode (ISE) test 

6.2.1 Measurement operation 

 Overview 

 The usual measurement order is: pre-test wash > pre-test measurement of the base 
potential > measurement of the sample potential > washing > post-test measurement 
of the base potential. 

 If the interval from the previous post-test measurement of the base potential is 15 
seconds or longer, the pre-test wash is performed twice. 

 Workflow of the serum measurement  

 Single measurement 

 

9 seconds 18 sec. 9 sec. E 

Time 

Pre-test wash Pre-test measurement of 
the base potential 

Sample potential measurement 

Post-test wash Post-test easurement of 
the base potential 

Averaging 

 
1 Pre-test wash  

If the interval from the previous post-test measurement of the base 
potential is 15 seconds or longer, the pre-test wash is performed twice. 

2 Pre-test measurement of the base potential 
3 Measurement of the sample potential 
4 Post-test wash  

Post-test wash is performed to prevent the sample carryover. 
 For urine samples, the post-test wash lasts 9 seconds longer. 

5 Post-test measurement of the base potential  
If there is no further order of measurement, the post-test base potential is 
measured, and then the operation is terminated. 

 The average of the pre-test and post-test base potentials is used as the 
base potential used in calculating concentration. 

 Continuous measurement 

The post-test base potential of a measurement is used as the pre-test base potential. 
This way, measurement continues at a rate of 18 seconds per sample. 
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6.2.2 Calibration 

 Process 

 In calibration, two kinds of calibrator are used: high-density standard (H-STD) and 
low-density standard (L-STD). First the H-STD is measured. The value obtained in 
the first measurement is excluded, and the measurement is repeated up to 8 ti mes 
until the variance between two successive measurement values falls in the calibration 
allowance range. The average of the last two values is stored as calibration value.  
If the value fails to fall in the allowance range even after 8 measurement times, it will 
be "Calibration LOW (HIGH) STD error."  
When the potential variance (sample potential minus buffer potential) fails to fall in 
the range, it will be "ISE Calibration range error." 

 

Standard 
Solution  

Na: K Cl 

L-STD for serum  -50 to -20  -50 to -20 5 to 35 
H-STD for serum  5 to 35 80 to 110 -40 to -10 
L-STD for urine  -280 to -220 170 to 270 40 to 100 
H-STD for urine 50 to 110 725 to 825 –95 to –35  

Default range 

 Principle 

In the ISE measurement, the variance in potential is measured between the reference 
(Ref.) electrode and corresponding ion selective electrode caused as reaction to the 
sample. 

a
ZF
RTEE log)303.2(0 ×±=   ····· 

E: Potential of the ion selective electrode (mV) 

 Nerst equation (1) 

E0: Potential of the reference electrode (mV) or reference potential 

R: Gas constant 

Z: Ionic valency 

F: Faraday constant  

a: Ionic activity 

T: Absolute temperature (K) 

2.303×RT/ZF in the formula (1) is the theoretical slope of potentials, generally called 
"slope (S)". For the ion with 1 valency in 25℃, the potential of the ion selective 
electrode is 59.16 mV (-59.16 mV for Cl electrode).  

Also, the following correlation is found among the following three parameters: 

cra ×=  

a: Ionic activity (mol/l) 
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r: Activity factor 

c: Ionic concentration 

The Nernst equation (1) becomes as follows: 

)log(0 crSEE ××±=  

  )loglog(0 cSrSE ×+×±=   ····  (2)

When the solution is diluted with the ion strength adjustment buffer to have a 
homogeneous ion strength, the activity factor becomes constant and the equation (2) 
becomes as follows: 

  

cSEE log'0 ×±=   ·········  (3) 

Also, if the internal standard solution of a known concentration is measured with each 
measurement, the potential of the internal solution (Eb) will be calculated using the 
equation (3) as follows: 

bb cSEE log'0 ×±=   ·········  (3a)

When deducting the equation (3a) from the equation (3), the reference potential 
disappears because it virtually does not change in a short time. The equation becomes 
as follows: 

  

)log(log bb ccSEE −±=−  

       )log(
bc
cS±=   ········ 

Therefore, if the correlation between ion concentration and potential variance is 
calculated using the standard solution, the target ion concentration can be measured. 

 (4) 

In BM6010/C, the sample is diluted with buffer solution. 

When a sample of concentration (cs)  is diluted by the dilution factor (t), the 
concentration of the diluted sample (ct

t
cc s

t =

) will be as follows: 

  ·············· 

Substitute (c) in the equation (4) with (c

 (5) 

t

)log(
b

s
b tc

cSEE ×=−

) to obtain the following equation. 

  ········  (6)

The slope and dilution factor of the equation (6) can be obtained by measurement L-
STD and H-STD calibrators of known concentration. 

  

 The potentials of the Na and K electrodes are displayed 10 times larger and that of 
the Cl electrode are 5 times larger of the measurement value during calibration.   
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7.1 Maintenance Items 
The maintenance items, including periodic checks and replacements, are summarized 
here separately for the chemistry analysis unit and for the ion selective electrode (ISE) 
unit. Refer to these lists for your regular or as-needed maintenance. Insufficient 
maintenance may cause inaccurate measurement results as well as system malfunction. 

Some maintenance services require first unlocking and opening the top cover.   

Refer to Section 1.8.2j for how to open the top cover.    

7.1.1 Maintenance items for the chemistry analysis unit and the 
workstation) 

Maintenance frequencies indicated in the table blow are based on usages of 50,000 
chemistry measurements per month. Lighter usages still should be maintained at the 
frequencies indicated. If the usage is heavier, perform the services more frequently. 

Item 
D

aily 

W
eekly 

M
onthly 

Every 3 m
onths 

Every 4 m
onths 

A
s required 

Remarks 
Refere

nce 

Check water quality supplied 
from the pure water supply unit ○       7.3.1a 

Check the probes for impurities ○       7.3.1b 
Check the mixing rods for 
impurities ○       7.3.1c 

Check the nozzles of the 
reaction carousel wash (WUD) 
unit for impurities 

○      
 7.3.1d 

Check the wash ports of probes 
and mixing rods for impurities ○       7.3.1e 

Check the splash cover for 
impurities ○       7.3.1f 

Check for potential leakage 
from pumps ○      

Replace the seal 
when leakage is 
detected. 

7.3.1g 

Examine the remaining volume 
of the lamp coolant ○       7.3.1h 

Check the lamp energy  ○      7.4.1a 
Cuvette blank measurement  ○      7.4.1b 
WASH2 with Reagent probe 
wash-S  ○      

7.4.1c 

Shutdown the workstation  ○      7.4.3a 
Soak and wash the mixing rods   ○     7.5.1a 
Clean the sample setting areas 
in the Sample and  
refrigerated trays (STT and 
CTT) and  the refrigerated 
reagent compartment in the 
reagent trays (RTTs) 

  ○    

 

7.5.1b 
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Item 

D
aily 

W
eekly 

M
onthly 

Every 3 m
onths 

Every 4 m
onths 

A
s required 

Remarks 
Refere

nce 

Clean the chiller filter   ○     7.5.1c 

Clean the line filter of the large 
water supply pump (LWP)    ○     

7.5.1d 

Clean the waste fluid lines of 
probe and mixing rod wash 
ports 

  ○    
 

7.5.1e 

Clean the exterior panels of the 
analyzer   ○     

7.5.1f 

Clean the vent fans and grids   ○     7.5.1g 
Clean the cuvette wash 
solution bottle and the 
conditioner bottle 

   ○   
 7.6.1a 

Clean the filters in the cuvette 
wash solution bottle and the 
conditioner bottle 

   ○   
The frequency 
depends on the 
quality of water. 

7.6.1b 

Clean the aspiration lines of the 
reaction carousel wash unit 
(WUD) 

   ○   
 7.6.1c 

Replace the spectrophotometer 
lamp    ○   

Replacement is 
suggested every 
2000 hours of 
accumulated usage. 

7.7.1a 

Replace the reaction cuvettes 

    ○  

The frequency 
depends on the 
usage. 
Replacement is 
suggested every 
10,000 whole blood 
samples analyzed 
for HbA1c. 

7.7.1b 

Disk defragmentation of the 
Windows XP-based workstation      ○ Semiannually 7.7.2a 

Replace probes      ○  7.8.1a 

Replace the seal of the pumps      ○  7.8.1b 

Remove clogs from the 
reaction carousel wash unit 
(WUD) nozzles 

     ○ 
 7.8.1c 

Replace the mixing rods      ○  7.8.1d 

System backup to DVD      ○ When the system 
setting is updated 

7.8.3a 

When the pure water bottle 
becomes empty      ○  7.9.1 

Degas the cuvette wash 
solution and conditioner lines      ○  7.9.2 
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Item 

D
aily 

W
eekly 

M
onthly 

Every 3 m
onths 

Every 4 m
onths 

A
s required 

Remarks 
Refere

nce 

In case of power outage      ○  7.9.3 

In case of a long-term 
suspension of operation      ○ 

When the operation 
is suspended for 4 or 
more days 

7.9.4 

7.1.2 Maintenance items for the ISE unit 

The ISE unit integrated into the analyzer requires specific maintenance services as 
described below. Maintenance frequencies indicated are based on usages of 
approximately 1,000 ISE measurements per month. Lighter usages still should be 
maintained at the frequencies indicated. If the usage is heavier, perform the services 
more frequently. 

 

Item D
aily 

W
eekly 

M
onthly 

E
very 3 

m
onths 

A
s 

required 

Remarks Section to 
refer to 

Check the 
remaining volume 
of the ISE buffer 
solution 

○  

 

  

Replenish the 
buffer when the 
level is low.  
Replenishment is 
allowed only once. 

7.3.2a 

Check the 
internal standard 
(IS) solution 

○  
 

  
Replenishment is 
not allowed for IS 
solution. 

7.3.2b 

Wash the 
electrodes ○  

 
   7.3.2c 

Wash the ISE 
dilution Bowl ○  

 
   7.3.2d 

Wash the 
electrode lines 

The frequency of washing 
the electrode lines 
depends on the number 
of dialysis samples 
measured, suggested as 
follows:  
 
Every three days for 500 or 
more dialysis samples per 
month 
Weekly for 100 to 499 
dialysis samples per month 
Biweekly for up to 100 
dialysis samples per month 

  

 7.4.2a 

Clean the ISE 
waste-drain 
nozzle 

  
 ○ 

 
  

Every time when a 
plasma sample is 
measured 

7.5.2a 
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Item D
aily 

W
eekly 

M
onthly 

E
very 3 

m
onths 

A
s 

required 

Remarks Section to 
refer to 

Condition the Na 
and K electrodes 

  

 

 ○ 
Perform on the day 
before the new 
electrodes are 
used. 

7.8.2a 

Replace the 
electrodes   

 ○ Every 3 months or 
every 30,000 
samples measured 

7.8.2b 

Post-
maintenance 
restoration of the 
ISE unit 

  

 

 ○ 
 7.8.2c 

Store the 
electrodes 

  
 

 ○  7.8.2d 
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7.2 Consumables and Spare Parts for 
Maintenance 
The spare parts listed below should be available at all times for proper maintenance and 
normal operation of the analyzer.  

7.2.1 List of consumables 

Name Specification  Applicable unit / 
Quantity 

Package 
Unit 

Parts No. 

Lamp Coolant-C No dilution type  400 mL １ 780656661 
Cuvette Wash Solution-
7 

 2 L  780656644 

Reagent Probe Wash-K  500 mL  780654056 
Cuvette Conditioner-EX  2 L  780656652 
Reaction carousel 
(RRV) Bath Oil 

Incubation Bath Oil 5 kg  * 

Reagent Probe Wash-S  500 mL １ 780654064 
Halogen lamp, New  Spectrophotometer １ 335008844 
RRV cuvettes  RRV cuvettes １ 844559351 
Filter 10R Super screen 

10 mm D 
For detergent and 
washing water 

１ 810371227 

Filter set, large water 
supply pump (LWP) 

PIS N02F-E80 For LWP line １set 490029027 

Filter holder for 10R 
filters 

CA01609 Filter 10, holder for 
filter PE 

１ 644000988 

Sample probe #6 
sample probe (SPP) 

SPP-BM6010 For sampling  １ 780607414 

Sample probe #6 
RPP 

 For dispensing 
reagent 

１ 810610043 

Rod (Mixing rod ＃24) Titanium Mixing unit １ 780656415 
1 mm depth L-ring 1 mm depth with O-

ring 
SPP  2 406017808 

5mm depth L-ring 5 mm depth with O-
ring 

RPP 2 811254780 

OMNISEAL 14ｍｍ  Sampling and 
reagent wash pump 
(SRWP) 

2 780655729 

Reagent Probe Wash 1  250 mL  780654072 
Reagent Probe Wash 2  250 mL  780654081 
ISE Detergent Solution  ISE unit 100 mL  

× 2pc 
780654099 

ISE Buffer  ISE unit 2L × 1 pc 780654102 
Internal  Standard  ISE unit 200mL  

× 1pc 
780609735 

ISE serum standard set  ISE unit 100 ml  
× 1 set 
(H,L) 

780654111 
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Name Specification  Applicable unit / 
Quantity 

Package 
Unit 

Parts No. 

ISE urine standard set  ISE unit 100 ml  
× 1 set 
(H,L) 

780654129 

Electrode-Na  ISE unit 1 pc 780654137 
Electrode-K  ISE unit 1 pc 780654145 
Electrode-Cl  ISE unit 1 pc 780654153 
Electrode-Ref  ISE unit 1 pc 780654161 
Selectivity-check 
solution  

No.213303 ISE unit  50mL 
×2pc 

475011520 

Reagent bottle 70 mL  For RTT  424011573 
Reagent bottle 40 mL  For RTT  780640241 
Sample cup  For sample (Jcup)  640057292 
Tube  10 mL  424012383 
Orange-G    780654048 
Cooling circulator 
(C.C.) coolant 

 For C.C.  780654030 

* Use JEOL specified incubation bath oil. Contact your local distributor for details. 
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7.2.2 Parts 

Name Specification Applicable unit / Quantity 
Package 

Unit 
Part 

number 

Guide (Sample cup 
holder) 

 Adaptor for Jcup  811279758 

Tray (guide)  Guide for reagent bottle 
(20 mL) 

 780642945 

Filter Strainer 06F-PE140-00 1 490029159 
Wide nozzle (L) WV NOZZLE

（72.5mm）WUD 
Wide nozzle for 
aspirating cuvette wash 
solution 

1 844354376 

Nozzle (WUD1 and 
5) 

WUD nozzle lines 
1 and 5 

RRV wash pipe, set of 3 1 780640101 

Nozzle (WUD2) WUD nozzle line 2 RRV wash pipe, set of 3 1 780640110 
Nozzle (WUD3) WUD nozzle line 3 RRV wash pipe, set of 3 1 780640128 
Nozzle (WUD4) WUD nozzle line 4 RRV wash pipe, set of 3 1 780656687 
Nozzle (WUD6) WUD nozzle line 6 RRV wash pipe, set of 1 1 780640136 
Cylinder 1mmD-D PUMP V-S (D1) SPP 1 811339521 
Holder L-ring 
1mmD-D 

PUMP V-D (D1), 
with O-ring 

SPP 1 780656075 

Plunger 1mmD PUMP V-D (D1) SPP 1 812469461 
Cylinder 5mmD PUMP (D5) RPP 1 812230761 
Holder L-ring 5 mm 
 

PUMP (D5) RPP 1 811238644 

Cyｌinder 
ASSY1mmD-S 

For assembling 
PUMP V-S (D5) ,  
plunger not 
included 

RPP 1 844354279 

Plunger 5mmD PUMP (D5) Ceramic plunger for RPP 1 812325451 
Cylinder ASSY 14D For assembling 

PUMP V-S (D14) ,  
plunger and wash 
port not included 

Sampling and reagent 
wash pump (SRWP) 

1 780633989 

Holder L-ring 14mm PUMP (D14D) Sampling and reagent 
wash pump (SRWP) 

1 812232542 

Plunger 14mmD PUMP (D14D) Ceramic plunger for 
SRWP 

1 812325494 

Medical silicon tube 
1/3 

1D×3D  1m 405002459 

Silicon tube 1.5/3 1.5D×3D  1m 405007680 
Teflon tube 1/2 
(PTFE) 

1D×2D  1m 405001291 

Teflon tube 0.5/2 
(PTFE) 

0.5D×2D  10m 405002530 

Teflon tube 1.4/2 
(PTFE) 

1.4D×2D  10m 405006063 

Teflon tube 2/3 2D×3D  10m 405000677 
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Name Specification Applicable unit / Quantity 
Package 

Unit 
Part 

number 

(PTFE) 
Pipe fitting (M6 
resin) 

CB17286 Pipe (outer diameter 2 
mm) 

20 810167816 

Pipe fitting (M6SUS) CB15092  10 640057594 
Tube fitting washer CB15093 Pipe (outer diameter 2 

mm) 
20 640057861 

Tube fitting washer  Pipe (outer diameter 
3mm) 

20 780607015 

Pipe fitting  for probe connection 10 811380548 
Pump FP  Reaction bath oil supply 1 780633652 
Thermistor No.04 709579 ISE unit １pc 780607791 
Thumbscrew 721085 ISE unit, for tightening 

the electrode 
１pc 780607856 

Dummy electrode 
with an O-ring 

17399 ISE unit １pc 780607805 
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7.2.3 Utensils 

Name Standard User unit / Purpose 
Pack
age 
Unit 

Part 
number 

Flange roller #2  For processing Teflon 
pipes 

1 set 420028056 

Tube cutter SMC/TK-3 For processing Teflon 
pipes 

1 set 780634951 

Wire   10 m 423202472 
Jig for replacing the 
seals 

G059  1 
pair 

780628314 
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7.3 Daily Maintenance  
7.3.1 Chemistry analysis unit 

7.3.1a Check water quality supplied from the pure water supply unit 
Degraded water quality may affect measurements and cause erroneous results. 

Check the pure water quality every day. The electrical conductivity of the water must 
be 1.0 μS/cm or lower. To improve the water quality, replace the ion exchange resin or 
take another appropriate measure as described in the instruction manual for the pure 
water supply unit. 

 The water quality can be checked only when the unit is actively purifying 
water. It cannot be checked even when the unit is turned on but not 
purifying water. 

 This section describes the water quality checking with the pure water supply 
unit, independent from the analyzer. 

 

Required tools N/A 
Required time 
(estimated) 

2 min 

Frequency of service Daily 
System mode at 
service 

- 

Workflow 1. Turn the faucet on. 
2. Turn on the power switch of the pure water 

supply unit. 
3. Check the water quality. 

 

 

 

 

7.3.1b Check the probes for impurities 
Impurities on the inner or outer parts of the probe can form clogs and affect 
measurement accuracy. Visually inspect the probes daily for impurities. 

 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

WAIT or READY 

Task Check the tip of the probe for impurities. 
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 How to clean the probe 

Clean the probe when it has impurities. 
 

Required tools Clean gauze (lint-free), pure water 
Required time 
(estimated) 

5 min 

Frequency of service As required 
System mode at 
service 

Analyzer’s power is off. 

Workflow 1. Remove the covers of sample trays (STT/CTT) 
and reagent trays (RTTs). 

2. Clean the probe tips. 
3. Return the STT/CTT and RTT covers. 

 

The probe will rarely become clogged if daily and weekly “washes” are performed. 

If clogging occurs, see “Section 7.8.1a Replacing the probe” for instructions regarding 
probe replacement. 

 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn the Operate/Standby switch to the  
  “Off” position 

before starting to clean the probe. If you clean the probe 
with the switch in the “PC CONTROL” or “On” positions, 
the probe may move, causing damage to the probe or 
bodily injury. 

 

1) Obtain a piece of gauze and a bottle of pure water. 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to   

 
 (OFF). 

 

 
CAUTION  

 

When the power is off, the probes may droop under by their own weight. The probes 
must be manually stabilized and monitored carefully. 
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4) Remove the tray covers. 
1 STT/CTT covers 

(a) Open the CTT cover first. 
(b) Lift it to remove. 

 
② 

① 

 
Removing the STT/CTT covers 

2 RTT cover 
(a) Open the RTT cover. 
(b) Slide the lever to the front side. 
(c) Grip the handle and lift it to remove. 

 

Lever 

Handle 

② 

① 

③ 

 
 

5) Move each probe to the position indicated below for cleaning. 

Sample probe (SPP): Above STT 

Reagent probes (RPP1, RPP2): Above RTT 
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6) Clean the probe tip with gauze dampened with pure water. 
 

 
CAUTION 
 

 
• Be careful not to jostle the probe tip with your hands or with the analyzer. 

• During cleaning, position the probe such that cleaning materials do not fall into the 
samples or reagent bottles. 

• Do not apply strong force to the probe. 

 
Cleaning SPP 

 
Cleaning RPP 

 

7) When the cleaning is completed, move the probe manually into the wash 
port.  

 
CAUTION 

 
 

 

Be careful not to hit the probe tip anywhere. Avoid placing it just above the outlet of 
the wash solution (V block). 
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8) Return the removed tray covers. 
9) Turn the Operate/Standby switch to “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

10) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.”  

11) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
 

 

7.3.1c Check the mixing rods for impurities 
Impurities on the mixing rod of the mixer unit (MIX1, MIX2) may cause cross 
contamination. Check the mixing rods for impurities every day. 

 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

WAIT or READY 

Task Check the mixing rod for impurities. 
 

 How to clean the mixing rod 

Clean the mixing rod when it has impurities. 
 

Required tools Clean gauze (lint-free), pure water, cotton swab 
Required time 
(estimated) 

5 min 

Frequency of service As required 
System mode at 
service 

Analyzer’s power is off. 

Task Clean the mixing rod. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 
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• Turn the Operate/Standby switch to the “Off” position 
before starting to clean the mixing rods. If you clean the 
mixing rods with the switch in the “PC CONTROL” or 
“On” positions, the mixing rods may move, causing 
damage to the mixing rods or bodily injury. 

 

Follow the steps below to clean the mixing rod when it has impurities. 

1) Obtain clean gauze, cotton swab, and pure water. 
2) Confirm the system mode is “READY.” 
3) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
4) Turn the Operate/Standby switch to   

 
 (OFF). 

5) Clean the mixing rod with gauze dampened with pure water. 
 

 
CAUTION  

 

Do not wipe the tip because it may become bent. 
 

 

Leak sensor 

 
Cleaning the mixing rod 

6) After the cleaning is completed, turn the Operate/Standby switch to  “PC 
CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

7) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 
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8) Perform “INITIALIZE” and confirm the system mode turns to “READY.” 

 
ALARM Button 

 
 

 

7.3.1d Check the nozzles of the reaction carousel wash (WUD) unit for 
impurities 
Detergent or washing solution remaining in the nozzles or lines of the WUD unit may 
cause clogs. If the lines connected to the nozzles deteriorate, they may leak. Check the 
nozzles of WUD unit daily for impurities. 

 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

WAIT or READY 

Task Check the nozzles for impurities 
 

 How to clean the WUD nozzles 

Follow the steps below to clean the WUD nozzles when they have impurities. 
 

Required tools Clean gauze (lint-free), pure water, 4mm Allen 
wrench 

Required time 
(estimated) 

5 min 

Frequency of service As required 
System mode at 
service 

Analyzer's power is off. 

Workflow 1. Take out WUD. 
2. Clean the nozzle tips. 
3. Place back WUD. 
4. Check the nozzle positions. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 
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CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn the Operate/Standby switch to the “Off” position 
before starting to clean the WUD. If you clean the WUD 
with the switch in the “PC CONTROL” or “On” positions, 
the WUD may move, causing damage to the unit or bodily 
injury. 

 

1) Obtain a piece of gauze dampened with pure water. 
2) Confirm the system mode is “READY.” 
3) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
4) Turn the Operate/Standby switch to   

 
 (OFF). 

5) Loosen the fixing screw with 4 ㎜Allen wrench to take WUD out. 

 
Taking out WUD 

 

6) While securely holding the WUD unit, clean the nozzles with gauze 
dampened with pure water. 

 Prevent debris from falling into the reaction carousel by covering the 
carousel with gauze. 

 Be careful not to detach the lines connected to the nozzles. 
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Cleaning the nozzles 

 

7) After the cleaning is completed, place back WUD. 
1 Fix WUD in the correct position using the positioning pins on both sides of 

the fixing screw.  
Confirm there is no space between WUD and the fixing location. 

2 Check that each nozzle is positioned just above a cuvette. 
3 Check that the lines are securely connected to the nozzles. 

 

8) Turn the Operate/Standby switch to  “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

9) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.”  

10) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
11) Check the WUD position 

1 Select [Maint.] > [Manual Operation], and double click [23.WUD] to display 
[WUD] window. Click the [Move] button in the window. 

WUD lowers a little. 

2 In the lowered position, check each nozzle is correctly in the midpoint of the 
cuvette. 

3 Click the [Int.] button in the [WUD] window. 

WUD returns to the home position. 

4 Click [Exit] in the [WUD] window. 

The [WUD] window is closed. 

12) Perform “INITIALIZE” and confirm the system mode turns to “READY.” 
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7.3.1e Check the wash ports of probes and mixing rods for impurities 
When impurities deposit inside the wash ports of the probes, the mixing rods, and/or 
around the wash solution outlet (V block), the probes and mixing rods cannot be 
washed properly, and samples, reagents, or contaminated wash solutions may remain 
on the tips of the probes and mixing rods. 

Check the wash ports for impurities daily. 
 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

WAIT or READY 

Task Check the wash ports for impurities. 
 

 How to clean the probe wash port and the V block 

When impurities deposit inside the wash port or on V block, follow the steps below for 
cleaning. 

 

Required tools Cotton swab, pure water 
Required time 
(estimated) 

5 min 

Frequency of service As required 
System mode at 
service 

Analyzer's power is off 

Task Clean the inside of the wash port and the V 
block. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn the Operate/Standby switch to the “Off” position 
before starting to clean the wash port and V block. If you 
clean them with the switch in the “PC CONTROL” or “On” 
positions, the probe may shift, causing damage to the probe 
or bodily injury. 
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1) Obtain a piece of gauze, cotton swabs, and a bottle of pure water. 
2) Confirm the system mode is “READY.” 
3) Select [Maint.] > [User Maintenance]. Click the [Start] button for [Position 

Probes for Routine Cleaning] in the window. 

All probes move to the dispensing position over the reaction carousel cuvettes.  The 
Operation Panel displays “WAIT” as the system mode. 

4) Exit the workstation system and display the “BioMajesty” startup window 
on the monitor. 

5) Turn the Operate/Standby switch to   
 

 (OFF). 
6) Pour pure water inside the wash port and on the V block from the bottle, 

and clean them with a cotton swab and gauze. 
 

 

 
CAUTION  

 

Do not use strong force on the overflow sensor because it can easily become deformed. 
 

 

V block 

Overflow sensor 

 
Cleaning the inside of the probe wash port and the V block 

7) After the cleaning is completed, turn the Operate/Standby switch to  “PC 
CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

8) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

 

 

 

 

 



 

 

ICABM6010/C-4  7-21 

C
hapter 7 

M
aintenance 

 

9) Perform “INITIALIZE” and confirm the system mode turns to “READY.” 

 
ALARM Button 

 

 How to clean the inside of the mixer wash port  

When impurities deposit inside the wash port, follow the steps below for cleaning. 
 

Required tools Clean gauze (lint-free), pure water, cotton swab 
Required time 
(estimated) 

5 min 

Frequency of service As required 
System mode at 
service 

Analyzer's power is off. 

Task Clean the inside of the wash port. 
 
 

Warning 

 

• Read the sections of “Safety Precautions” and “Precautions 
For Use” before starting the task. 

 

CAUTION 

 

• Wear protective glasses, mask, and gloves when you 
perform the service. 

 

• Turn the Operate/Standby switch to the   
  “Off” position 

before starting to clean the mixer wash port. 

 

1) Obtain a piece of gauze, cotton swabs, and a bottle of pure water. 
2) Confirm the system mode is “READY.” 

1 Exit the workstation system and display the “BioMajesty” startup window on 
the monitor. 

3) Turn the Operate/Standby switch to   
 

 (OFF). 
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4) Pour pure water inside the wash port from the bottle, and clean it with 
gauze. Be careful not to hit or bend the mixing rod. 

 

 
CAUTION  

 

Ensure that the overflow sensor may not be deformed. 
 

 

Overflow sensor 

 
Cleaning the mixer wash port 

 

5) Turn the Operate/Standby switch to “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

6) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

7) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 

7.3.1f Check the splash cover for impurities 
The splash cover protects the analyzer portion over which the probes move. The cover 
prevents water or reagents from splashing into the reaction cuvettes. 

Check the splash cover for impurities every week. 
 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

WAIT or READY 

Task Check the splash cover for impurities. 
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 How to clean the splash cover 

When the splash cover has impurities, follow the steps below for cleaning. 
 

Required tools Clean gauze (lint-free), pure water 
Required time 
(estimated) 

5 min 

Frequency of service As required 
System mode at 
service 

Analyzer's power is off. 

Task Clean the splash cover. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn the Operate/Standby switch to the  
  “Off” position 

before starting to clean the splash cover 

 

1) Obtain a piece of gauze dampened with pure water. 
2) Confirm the system mode is “READY.” 
3) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
4) Turn the Operate/Standby switch to   

 
 (OFF). 

5) Clean off the impurities on the splash cover with gauze dampened with 
pure water. 

 Do not touch the probes. 
 Ensure that no debris may enter the cuvettes. 

 
Cleaning the splash cover 
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6) After the cleaning is completed, turn the Operate/Standby switch to  “PC 
CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

7) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

8) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 

When the impurity level is high, loosen the screws to remove the splash cover for 
washing. 

 Screw 

 

Splash cover for the sample probe (SPP) Splash cover for the reagent probes (RPP) 
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7.3.1g Check for potential leakage from pumps 
If the seal surrounding the pump deteriorates, liquids may leak from the seal site. 

Leakage decreases the flow rate and introduces air bubbles. 

The steps for examining the sampling pump (SP) are different from those for the 
sampling and reagent wash pump (SRWP) and for reagent pumps 1 and 2 (RP1 and 
RP2). 

 Pump locations 

 

SP SRWP RP1 RP2 

 
Pump locations 

 How to check the liquid leakage and trapped air in SP 

Check the following points for SP 
 

Required tools N/A 
Required time 
(estimated) 

3 min 

Frequency of service Daily 
System mode at 
service 

WASH or Processing 

Task Check there is no liquid leakage or trapped air in SP. 
 

1) Perform “WASH” to check if the piston in the cylinder is moving up and 
down. 

The SP can also be visually checked for leakage while the system is in Processing 
mode.  

2) Check visually if no leakage is observed at the seal site. 
3) Check visually if no leakage is observed around the lever. 
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4) Check visually if no air is trapped in the cylinder. 

     

 

Lever 

Seal 

Cylinder 

 
Sites to check visually 

 

5) If leakage is observed, follow the steps described in Section 7.8.1b to 
replace the seal. 

 If air is found trapped in the cylinder, its source or point of entry must be 
determined. 

 How to check the liquid leakage and trapped air in RP1/RP2/SRWP 

Check the following points in RP1/RP2/SRWP. 
 

Required tools Gauze as required  
Required time 
(estimated) 

3 min 

Frequency of service Daily 
System mode at 
service 

WASH or Processing 

Task Check there is no liquid leakage or trapped air in the 
pump. 

 

1) Perform “WASH” to verify that the piston is moving vertically in the 
cylinder. 

The RP1/RP2/SRWP can also be visually checked for leakage while the system is in 
Processing mode.  
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2) Check visually or dab with gauze to rule out leaks in the sealing site, at the 
connection joints, at the joint between the holder and the cylinder, or at the 
joint between the nut and the cylinder. 

 

 
Cylinder 

RP SRWP 

Joint 

Holder 

Nut 

Sail Part 

 
 

3) Check visually if no air is trapped in the cylinder. 
4) If leakage is observed, follow the steps described in Section 7.8.1b to 

replace the seal. 
 If air is found trapped in the cylinder, its source or point of entry must be 
determined. 

7.3.1h Examine the remaining volume of the lamp coolant 
The spectrophotometer lamp is cooled by circulating coolant. If the coolant volume 
decreases and air bubbles form in the lamp coolant pump (CLP), the circulation will 
stop, and the temperature inside the lamp holder will rise. This process triggers an 
alarm signaling a lamp thermostat abnormality and turns off the lamp automatically.  

Check the remaining volume of the coolant every day. 
 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

READY 

Task Check the remaining volume of the lamp coolant. 
 

 
CAUTION  

 
 

Follow the steps below to determine the volume of lamp coolant. 
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1) Confirm the system mode is “READY.” 
2) Remove the cover over the lamp coolant tank to observe the coolant 

volume. 

Two lines inside the tank indicate the 5-cm and 9-cm heights from the tank bottom. If 
the coolant level is between the two lines, there is no need for replenishment. When the 
level dips below the 5-cm line, follow the steps listed to replenish the coolant. 

3) Close the cover over the lamp coolant tank. 

 How to replenish the lamp coolant 

Follow the steps below to replenish the lamp coolant. 
 

Required tools Lamp coolant 
Required time 
(estimated) 

1 min 

Frequency of service As required 
System mode at 
service 

READY 

Task Replenish the lamp coolant. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

1) Obtain the lamp coolant. 
 The lamp coolant should not be diluted before use. 

2) Manually turn the cover over the lamp coolant tank counterclockwise to 
remove it. 
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3) Pour the lamp coolant in a wash bottle or a beaker, and replenish the tank 

with lamp coolant to the 9-cm level. 

Be careful not to spill the coolant when replenishing the tank. 

 

Replenishing the lamp coolant 

 

Line at 9 cm level 

Line at 5 cm level 

 

Level lines 
 

4) Return the cover onto the lamp coolant tank. 

 How to replenish the coolant after the alarm sound 

If the thermostat abnormality alarm sounds, check the coolant level. If the level is low, 
replenish the coolant, and then verify that the coolant in the tank is circulating. Click 
the [ALARM] button on the Operation Panel to release the alarm message. If no error 
is reported, wait 10 minutes to resume measurement.  

If the coolant does not circulate, the lamp coolant pump (CLP) is not functioning, most 
likely because of air bubble formation. Contact your local distributor for service. 
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7.3.2 Ion selective electrode (ISE) unit 

7.3.2a Check the remaining volume of the ISE buffer solution 
Verify sufficient buffer solution volume before taking measurements. When the buffer 
volume becomes too low, the flag “r” will be posted to the test result. When the flag 
“r” is posted, the system mode shifts automatically to “Processing” to allow the buffer 
solution bottle to be replaced. Data collected when the “r” flag is posted can be 
considered accurate. However, if the buffer solution is not replenished and more 
measurements are taken, the flow rate will become insufficient and the level of buffer 
in the ISE dilution bowl lowers. Ultimately, measurements will be compulsorily 
suspended to ensure safety.  

 Keep the panel above the bottle compartment closed when running samples.  
Otherwise, the vibration of the bottles may influence the ISE test results. 

 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

READY 

Task Check the volume of buffer solution  

 

Buffer-solution bottle 

 
 

If the volume is insufficient, follow the steps below to replace the bottle. 
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 Replacing the buffer solution bottle 

Required tools A buffer solution bottle for replacement 
Required time 
(estimated) 

5 min (time for calibration is not included) 

Frequency of service As required 
System mode at 
service 

READY 

Workflow 1. Remove the buffer solution bottle. 
2. Set a new buffer solution bottle. 
3. Perform priming. 
4. Perform calibration. 

 

 Follow the steps below to replace the bottle. 
 

1) Remove the existing bottle. 
1 Lift the panel above the bottle compartment, and pull out the tray containing 

the bottles. 
 Be careful not to damage the tubing when pulling the tray. 

1 Remove the bottle connector including a float switch. 
2) Set out a new bottle. 

1 Place the new buffer bottle in the tray. Uncap it and insert the bottle 
connector. Screw the connector to close the bottle.  

 

Bottle 
connector 

 
 

2 Push the tray back in the compartment. 

3) Perform priming from the [ISE Operation] window. ( Section 7.10) 

Set “15” for [Times] for the buffer solution to reach the ISE dilution bowl.  Keep 
priming until no air bubbles come out.  If air bubbles persist, check for any leakage or 
loose connection especially at the joints. 

4) Perform calibration following priming.  
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7.3.2b Check the internal standard (IS) solution 
Verify sufficient IS solution volume before starting calibration. When the volume 
becomes too low, the flag “r” will be posted to the test result. When the volume level is 
further down, the system automatically suspends measurement to ensure safety. 

The remaining volume of IS solution is displayed in the [ISE Operation] window. 
( Section 7.10) 

 Keep the panel above the bottle compartment closed when running samples.  
Otherwise, the vibration of the bottles may influence the ISE test results. 

 

Required tools N/A 
Required time 
(estimated) 

1 min 

Frequency of service Daily 
System mode at 
service 

READY 

Task Check the level of the IS solution. 
 

If the volume is insufficient, follow the steps below to replace the pack. 

 Replacing the IS solution pack 

Follow the steps below to replace the pack. 
 

Required tools An IS solution pack for replacement 
Required time 
(estimated) 

5 min (time for calibration is not included) 

Frequency of service As required 
System mode at 
service 

READY 

Workflow 1. Remove the IS solution pack. 
2. Set out a new IS solution pack. 
3. Perform line priming for IS. 
4. Perform calibration. 

 

1) Click the [Change] button beside [IS Remain Vol.] in the [ISE Operation] 
window. 

The [ISE IS solution replacement] window is displayed. 

 
[ISE IS solution replacement] window 
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 The scheduled “WASH” is not performed when this window is displayed. 
 Replace the IS solution pack when the system mode is “READY” or “WAIT”. 
A dialog box is displayed to notify the user that the IS solution pack cannot 
be replaced when a scheduled ISE Wash is going on. Wait until the 
replacement becomes possible. 

 
2) Remove the existing bottle. 

1 Open the front door of the analyzer to remove the IS solution pack. 
2 Detach the bottle connector. 

3) Set out a new bottle. 
1 Uncap the new IS solution pack and insert the bottle connector. 
2 Place the new IS solution pack inside the analyzer. 

4) Click the [Reset Remain Vol.] button in the [ISE IS solution replacement] 
window. 

Confirm the remaining volume of IS solution is now reset. 

5) Perform IS line priming from the [ISE Operation] window. ( Section 7.10) 

Define “10” for [Times] for the IS solution to reach the degasser. 

Keep priming until no air bubbles come out. If air bubbles persist, check any leakage or 
loose connection especially at the joints. 

6) Perform calibration following IS line priming. 

7.3.2c Wash the electrodes 
The electrodes are washed automatically with “WASH2” performed upon initiating the 
shutdown sequence at the end of the day. 

 Electrode wash is a default setting.  You can change the option for 
[Prime/Electrode Wash/Final] in the [ISE Parameters of Setting] window. 

 

Required tools ISE Detergent Solution, dropper 
Required time 
(estimated) 

5 min 

Frequency of service Daily 
System mode at 
service 

READY 

Task Wash the electrodes. 
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Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

If the system is not automatically shut down at the end of the day or if the measurement 
data are unstable, wash the electrodes independently of the [WASH] operations, as 
follows: 

1) In the [ISE Operation] window, enter a position number for [Detergent 
posi.] and select “Sample cup (JCUP/Adp)” for [Container] in the [Wash 
Electrode] area. 

 
2) Put 100μL of ISE Detergent Solution in the JCUP and place it on the 

defined position. 
3) Click the [Execute] button. 

 
 

Electrode wash begins. 

 ISE Detergent Solution is dispensed twice. Do not touch the refrigerated 
sample tray (CTT) or ISE unit until the electrode wash is complete.  
Otherwise, your hand may be injured. 

 The display area of the [ISE Operation] window displays “Wash electrode 
running” and the remaining time in the [remain] field.  You cannot suspend 
the electrode wash. If you want to stop it urgently, use the [SYSTEM STOP] 
button on the power panel of the analyzer. 
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7.3.2d Wash the ISE dilution bowl 
Wash the ISE dilution bowl daily, either before or after running samples. If the buffer 
overflows for any reason, it must be washed separately from the daily wash. 

 

Required tools Pure water, cotton swab 
Required time 
(estimated) 

10 min 

Frequency of service Daily 
System mode at 
service 

READY 

Workflow 1. Fill the dilution bowl with pure water. 
2. Drain the dilution bowl. 
3. Wipe to dry the remaining water.  
4. Perform priming. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Be sure to change the status into [ISE-WASH-OFF] before 
performing the task.  If you perform the task in the [ISE-
WASH-ON] status, the scheduled wash is automatically 
activated, resulting in a serious accident or trouble.  

 

1) Click the [ISE-WASH-ON] button on the Operation Panel to change the 
display to “ISE-WASH-OFF.” 

2) Remove the cover over the ISE sampling position. 

Loosen 2 screws to remove the cover. 

3) Loosen the screw that locks the stainless steel cover over the ISE unit, and 
slide the cover off. 

4) Click [Execute] in the [Final Operation] area in the [ISE Operation] window 
to perform the “final operation” and fill the unit with water (Section 7.10).  
Or, drop 1 mL of pure water in the ISE dilution bowl with a dropper. 

5) Wait 5 minutes. 

Allow the system to idle for approximately 5 minutes to dissolve the impurities around 
the buffer outlet and nozzle. 
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6) Click [Execute] in the [Dil Bowl drain] area in the [ISE Operation] window.  

The water in the ISE dilution bowl is drained. 

7) Clean the remaining water or impurities around the nozzle with a cotton 
swab. 

 
Upper tray 

Solution 
supplying nozzle 

Cotton swab 

 
 Cleaning the nozzle 

 

 Wipe the nozzle gently. A deformed or damaged nozzle may result in less 
accurate data. 

8) Enter “3” for [Times] in the [Prime] area in the [ISE Operation] window, 
Click [Execute]. 

Priming begins.  

7.3.2e Post-maintenance restoration of the ISE unit 
After performing daily maintenance, restore the unit to measurement-ready status by 
doing the following: 

1) Return the stainless cover to the unit and replace the screws. 

Be careful not to damage the lines or dilution bowl when replacing the cover. Ensure 
that the cover is securely positioned in the gutters. 

2) Attach the cover on the ISE sampling position with screws. 
3) Click the [ISE-WASH-OFF] button on the Operation Panel to change the 

display to “ISE-WASH-ON.” 
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7.4 Weekly Maintenance 
7.4.1 Chemistry analysis unit 

7.4.1a Check the lamp energy 
Check the spectrophotometer lamp energy when the cuvettes are washed weekly in 
“WASH2.” Measure the cuvette blank at this time. 

In addition, the lamp energy and the cuvette blank should be measured upon replacing 
the lamp or cuvettes.  

 How to check the lamp energy 

The lamp deteriorates over time.  Check the lamp energy every week. 
 

Required tools Pure water 
Required time 
(estimated) 

5 min (WASH2 is not included) 

Frequency of service Weekly or every time after the lamp or cuvettes 
are replaced. 

System mode at 
service 

READY 

Workflow 1. Set a pure water bottle on the reaction tray 1 
(RTT1). 

2. Check the lamp energy in the [Lamp Energy 
Monitor] window. 

 

Follow the steps below for checking. 

1) Perform “INITIALIZE” and shift the analyzer mode to “READY”. 
2) Select [Maint.] > [Lamp Energy Monitor]. 

The [Lamp Energy Monitor] window is displayed. 

 
[Lamp Energy Monitor] window 
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3) Place a bottle of pure water on the position #45 of RTT1. 
4) Click the [Check Energy] button. 

The [Check Energy] window is displayed. 

 
 

5) Enter “45” for [RTT1 water posi.], and click the [Start] button. 

Once entered, the number is retained for the subsequent measurement. 

The reagent probe aspirates pure water from the bottle on RTT1 and dispenses it in the 
reaction cuvette #1.  The reaction carousel (RRV) then rotates to position the cuvette 
for measurement. At this time, the analyzer will enter “WAIT” mode. 

6) Enter “1000” for [Meas.times] and “100” for [Meas.cycle] in the [Lamp 
every check] column. 

Once entered, the number is retained for the subsequent measurement. 

7) Click the [Meas.Energy] button. 

A pop-up window is displayed to ask “Execute the lamp energy check?”  

 
 

8) Click [OK]. 

The measurement takes no more than one second. 
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9) Click the [Collect Data] button. 

The result of the lamp energy measurement is displayed. 

 

Result of the lamp energy measurement 
 

10) Select “340 nm” and “AD” in the section above the graph space. Also 
select “Auto” for [Scale]. Check the AD value of 340 nm in the graph. 

The lamp energy values are plotted in the graph. The AD values at a wavelength of 340 
nm are plotted on the Y axis. The lamp energy is regarded as normal when the 
difference between the largest and smallest values is 100 or less. The table to the left of 
the graph displays the lamp energies (AD values) at wavelengths of 340 nm to 884 nm. 
The lamp energy is considered normal if the values are between 10,000 and 30,000. 

Under the [Intensity] header, the attenuation in intensity since the previous lamp or 
cuvette replacement is depicted. The value indicates the integrated intensities of the 
lamp energy and the cuvette #1.   
If the values are not in the reference ranges, refer to “Section 8.4 Typical Error 
Messages and Countermeasures” and perform the countermeasures described for Error 
Message No. 0903 and 0904.   

11) When you check the lamp energy in this window after replacing the lamp or 
cuvettes, click the [Regist Data] button. 

A pop-up window is displayed to ask confirmation. Click [OK] in the window. The new 
data are registered for the reference value to calculate the attenuated intensity for future. 

12) The system mode is still “WAIT”, Perform “INITIALIZE” to shift it to the 
“READY” mode. 
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7.4.1b Cuvette blank measurement 
The reaction cuvette accumulates impurities over time and the absorbance will change 
accordingly.  Measure the cuvette blank every week together with the lamp energy to 
check the changes. 

 

Required tools N/A 
Required time 
(estimated) 

17 min (WASH2 is not included) 

Frequency of service Weekly or every time after the lamp or cuvette 
replacement 

System mode at 
service 

READY 

Task Perform the cuvette blank measurement from the 
[User Maintenance] window. 

 

Follow the steps below to measure the cuvette blank. 

1) Confirm the system mode is “READY.” 
2) Select [Maint.] > [User Maintenance]. 

The [User Maintenance] window is displayed. 

 
 

3) Click the [Start] for [Cuvette blank meas. check]. 

The cuvette blank measurement begins.  Select [Request] > [Realtime Monitor] to 
check the measurement value in realtime.  

4) Check the result. 

The cuvette blank measurement is completed in approximately 17 minutes.  Select 
[Request] > [RealTime Monitor] to review the statistical data of the 231 cuvettes for 
abnormality. 



 

 

ICABM6010/C-4  7-41 

C
hapter 7 

M
aintenance 

 

 To print the result, select [Current run] for [Data type], and select [Statistic] 
and [Abnormal cuvette] for [Print] in the [Cuvette Blank Batch Print] column 
in the lower middle part of the [User Maintenance] window. 

 
Example of the result data 

 

5) Register the data. 

When the measurement is completed, a window is displayed where you can select 
whether or not to register the data.  Click [Yes] to register the cuvette blanks. 

 If you click [No] in this window, the cuvette blank values are not registered 
and the window is closed. If you want to register the values afterwards, 
select [Maint.] > [User Maintenance] > [Cuvette blank meas. check], and 
click [Yes] for [Save current run?].  

6) Check the abnormal cuvettes. 

Select [Request] > [RealTime Monitor] and refer to [Abnormal cuvettes] to see if there 
were any abnormal cuvettes. If a flag such as “H” or “L” is posted for a cuvette, 
remove the cuvette holder that includes the abnormal cuvette according to the steps 
described in “Section 7.7.1b Replace the reaction cuvettes,” and inspect for 
abnormalities. 

If no abnormality is visually detected, return the cuvette set to the carousel. 

If a cuvette triggers an “L” or “H” flag indicating abnormal cuvette blank, it 
will be skipped and not used for measurement. Occasionally, impurities can 
be washed away during operation. If the cuvette blank is judged normal at 
the next blank measurement, it will automatically be used for the next 
sample measurement. 

  File the print outs of “Statistic” and “Abnormal cell” results to use for 
monitoring the cuvette status for management. 
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7.4.1c WASH2 with Reagent probe wash-S 
Reagent probe wash-K (20%) is used in the daily “WASH2” before shutting down the 
system at the end of the day, while Reagent probe wash-S (5%) is used in the weekly 
“WASH2” to clean the reaction cuvettes. 

The cleaning steps are as follows: 

1) Place Reagent probe wash-S at the position #49 on the reagent trays 1 and 
2 (RTT1 and RTT2) and pure water bottle at the position #50 on both of the 
trays. 

2) Click the [WASH] button in the Operation Panel. 

The [WASH Set] window is displayed. 

 
 

3) Select “WASH2” and click the [Execute] button. 

“WASH2” begins and finishes in approximately 40 minutes. 
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7.4.2 Ion selective electrode (ISE) unit 

7.4.2a Wash the electrode lines 
Impurities deposited in the electrode lines may prevent proper drainage, consequently 
affecting measurement. Impurities accumulate faster as the number of sample 
measurements increases. Frequency of the electrode line wash should be based on the 
number of dialysis sample run as follows:   

• Once in 3 days for 500 or more dialysis samples/month 

• Weekly for 101-499 dialysis samples/month 

• Biweekly for up to 100 dialysis samples/month 
 

Required tools Dummy electrode with O-ring and cap, ISE 
Detergent Solution, dropper 

Required time 
(estimated) 

25 min (time for calibration is not included) 

Frequency of service Depends on the number of samples measured 
System mode at 
service 

READY 

Workflow 1. Remove the electrodes and set the dummy 
electrode. 

2. Perform “STEP-1” of the line wash. 
3. Perform “STEP-2” of the line wash. 
4. Return the electrodes in place. 
5. Perform calibration. 

 
 

Warning 

 

• Read the sections of “Safety Precautions” and “Precautions 
For Use” before starting the task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Be sure to change the status into [ISE-WASH-OFF] before 
performing the task.  If you perform the task in the [ISE-
WASH-ON] status, the scheduled wash is automatically 
activated, resulting in a serious accident or trouble.  
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 How to wash 

The line wash consists of the following two steps. Perform them successively. 

 Perform STEP-1 of the line wash. 

1) Click the [ISE-WASH-ON] button on the Operation Panel to change the 
display to “ISE-WASH-OFF.” 

2) Remove the cover over the ISE sampling position. 

Loosen 2 screws to remove the cover. 

3) Loosen the screw that locks the stainless steel cover over the ISE unit to 
slide it off. 

4) Remove the Na, K, Cl, and Ref. electrodes. ( See “Section 7.8.2b ) 
5) Place the dummy electrode instead.  
6) Uncap the dummy electrode. 

 

 

Dummy electrode  
Dummy electrode 

 

7) Drop approximately 5 mL of ISE Detergent Solution with a dropper in the 
dummy electrode. 

 

Warning 

ISE Detergent Solution contains sodium hypochlorite. Avoid contact with skin and eyes. If 
contact occurs, wash the site thoroughly with water and consult a physician. 

 Dropper 

 
Dropping the ISE Detergent Solution 
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8) Close the cap of the dummy electrode tightly. 
 

 
CAUTION  

 

Be sure to close the cap tightly.  
The detergent solution is introduced to the ISE dilution bowl for washing. If the cap is 
damaged or not tightly closed, the detergent solution may leak and damage the device. 

 

9) Click [Execute (STEP-1)] button in the [ISE line wash] area in the [ISE 
Operation] window. ( See Section 7.10) 

 
10) Click [Yes] in the pop-up window. 

 ISE line wash begins. The status “ISE line wash 1 Running” and the 
remaining time are displayed in the window. You cannot suspend the 
electrode wash. If you want to stop it urgently, use the [SYSTEM STOP] 
button on the power panel of the analyzer. 

 Perform STEP-2 of the line wash. 

1) After the STEP-1 is completed, replace the dummy electrode with Na, K, Cl, 
and Ref electrodes. ( See “4.10 Setting the Electrode.”) 

 

Ref，Na，K，Cl electrodes 
 

 Placing back the electrodes 

2) Click [Execute (STEP-2)] button in the [ISE line wash] area in the [ISE 
Operation] window. ( See Section 7.10) 

3) Click [Yes] in the pop-up window. 

The wash begins and priming is repeated for 10 times. The status “ISE line wash 2 
Running” and the remaining time are displayed in the window. You cannot suspend the 
procedure. If you want to stop it urgently, use the [SYSTEM STOP] button on the 
power panel of the analyzer. 

4) Click the [ISE-WASH-OFF] button on the Operation Panel to change the 
display to “ISE-WASH-ON.” 

5) Perform calibration.  
 The environment around the electrodes has changed after the line wash. Be 
sure to perform calibration before starting measurement. 
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7.4.2b Post-maintenance restoration of the ISE unit 
After the weekly maintenance service, restore the unit to be ready for measurement. 
See Section 7.3.2e for procedure. 
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7.4.3 Workstation 

7.4.3a Shutdown 
Shut down the computer once a week to ensure the stable operation of the application. 

 

Required tools N/A 
Required time 
(estimated) 

5 min 

Frequency of service Weekly 
System mode at 
service 

- 

Workflow 1. Shut down the computer. 
2. Start up the computer. 

 

CAUTION 

 

• Ensure that the system mode is “READY” when you shut 
down the computer. 

1) Click [System (S)] command on the top bar of the Menu Panel and select 
“Exit” in the drop-down menu. The system is closed and the “BioMajesty” 
startup window is displayed. 

 
2) Click the [Shutdown] button. 

When the system is shut down, the computer and the analyzer are both turned off. 

3) Wait approximately 10 seconds to turn on the computer. 
4) When the startup window is displayed, select [Re-start] for startup. 

The analyzer is turned on. Wait for tens of seconds and confirm the Operation Panel 
shows the system mode “WAIT.” 

 
 

Perform “INITIALIZE” and confirm the system mode turns to “READY.” 
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7.5 Monthly Maintenance 
7.5.1 Chemistry analysis unit 

7.5.1a Soak and wash the mixing rods 
Impurities on the mixing rods can cause measurement errors. Inspect the mixing rods 
daily for impurities, and clean them accordingly. In addition, soak and wash the mixing 
rods once monthly as follows: 

 
 

Required tools Reagent probe wash-K, dropper 
Required time 
(estimated) 

15 min (WASH3 is not included) 

Frequency of service Monthly 
System mode at 
service 

READY 

Workflow 1. Fill Reagent probe wash-K in the mixer wash 
port. 

2. Perform “WASH.” 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

 How to clean the mixing rod 

1) Confirm that the system mode is “READY” and the mixing rods are in the 
raised position. 

2) Aspirate the remaining water in the wash ports with a dropper. 
 Ensure that the dropper does not jostle the mixing rod. 
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3) Fill the undiluted Reagent probe wash-K with a dropper in the wash ports 
(Approximately 1 mL). 

 

4) Wash the mixing rods. 
1 Select [Maint.] > [Manual Operation]. 

  
Manual Operation window 

 

2 Double click [44.MUD1]. The [MUD1] window is displayed where you can 
control the vertical motion of the mixer 1. 
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3 Click the [Init.] button. 

The mixer 1 (MIX1) lowers in the wash port. 

 
 

4 Double click [56.MUD2] to display the [MIX2] window where you can control 
the vertical motion of the mixer 2. Click the [Init.] button. 

The mixer 2 (MIX2) lowers in the wash port. 

5 Leave as is for approximately 10 minutes for soaking. 
6 Double click [40.MIXR1] to display the [MIXR1] window where you can 

control the rotational movement of MIX1. 
7 Click [Move] to rotate MIX1 once before stopping. Repeat it for 5 to 10 

times. 
 Error occurs when you click the button while the mixer is still rotating. Wait 
for the mixer to stop before clicking again. 

8 Double click [52.MIXR2] to display the [MIX2] window where you can 
control the vertical motion of the mixer 2. Click the [Move] button. 

9 Rotate MIX2 in the same way as described in Step 7 to wash the impurities 
away. 

10 Perform “INITIALIZE” and shift the system mode to “READY.” 
11 Perform “WASH3” to wash away the detergent. 
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7.5.1b Clean the sample setting areas in the sample and refrigerated 
trays (STT/CTT) and the refrigerated reagent compartment in the 
reagent trays (RTTs) 
The sample setting areas in STT/CTT and the refrigerated reagent compartment area in 
RTT become filthy with samples, reagents, and dusts. Clean the areas every month. 

 How to clean the sample setting areas in STT/CTT 
 

Required tools Clean gauze (lint-free) 
Required time 
(estimated) 

3 min 

Frequency of service Monthly 
System mode at 
service 

Analyzer's power is off. 

Workflow 1. Remove the STT/CTT covers. 
2. Remove the STT/CTT loaders. 
3. Clean the areas where the loaders are set. 
4. Return the STT/CTT loaders. 
5. Return the STT/CTT covers. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn the Operate/Standby switch to the  
  “Off” position 

before starting to clean the sample setting areas. 

 

Follow the steps below for cleaning. 

1) Confirm the system mode is “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to  

 
(OFF). 

4) Remove the STT/CTT covers. 
 See “Section 7.3.1b Check probes for impurities” for how to remove the 
covers. 
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5) Pull up two latches each on the STT/CTT to take out the loaders. 

 

 
Pull upward 

 
 

6) Clean the interior part with gauze. 
 

 

Cleaning the sample setting area in STT/CTT 
 

7) Return the STT/CTT loaders. 
8) Reattach the STT/CTT covers 
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9) After the cleaning is complete, turn the Operate/Standby switch to  “PC 
CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

10) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 
11) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 

 How to clean the RTT refrigerated reagent compartment 
 

Required tools Clean gauze (lint-free) 
Required time 
(estimated) 

10 min 

Frequency of service Monthly 
System mode at 
service 

Analyzer’s power is off. 

Workflow 1. Remove the RTT cover. 
2. Remove the RTT loader. 
3. Clean the areas where the loaders are set. 
4. Clean the barcode reading window. 
4. Return the RTT loaders. 
5. Return the RTT cover. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn the Operate/Standby switch to the  
  “Off” position 

before starting to clean the refrigerated reagent 
compartment. 

 

Follow the steps below for cleaning. 

1) Confirm the system mode is “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to   

 
 (OFF). 

4) Remove the RTT cover. 
 See “Section 7.3.1b Check probes for impurities” for how to remove the 
cover. 
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5) Turn the central handle counterclockwise to loosen and pull it upward to 
take out the loader. Repeat this for the other loader. 

 

6) Clean the water and impurities inside the compartment. 

 
Cleaning the refrigerated reagent compartment 

7) Clean the barcode reading window with dry gauze. 

 
Cleaning the barcode reading window 
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8) Return the RTT loaders. 

Place the loader at the position where the ▲ ma rk on the loader meets the pin. 

When the loader is placed in the right position, turn the handle clockwise to tighten and 
fix. 

9) Return the RTT cover. 

See “Section 7.3.1b Check probes for impurities” for how to reattach the cover. 

10) After the cleaning is complete, turn the Operate/Standby switch to  “PC 
CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

11) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

12) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 

7.5.1c Clean the chiller filter 
A filter is attached on the radiator of the coolant circulator (chiller).  When this filter 
becomes dirty with dusts, heat radiation may be insufficient. Follow the steps below to 
clean the filter once a month. 

 

Required tools Vacuum cleaner 
Required time 
(estimated) 

3 min 

Frequency of service Monthly 
System mode at 
service 

Analyzer's power is off. 

Workflow 1. Take out the filter. 
2. Clean the filter with a vacuum cleaner. 
3. Place the filter back in place. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 



  

 

7-56  ICABM6010/C-4 

C
hapter 7 

M
aintenance 

 

• Turn the Operate/Standby switch to the  
  “Off” position 

before starting to clean the chiller filter. 

 

 How to clean the chiller filter 

1) Confirm the system mode is “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to   

 
(OFF). 

4) Lift the panel above the bottle compartment located at the lower front side 
of the analyzer. Remove the ISE buffer bottle to access the left side. 

Look inside and find the filter on the left side of the refrigeration unit in the back. 

 

 

Side of the refrigeration unit 

Incubation 
bath oil 

Cuvette 
wash 

Cuvette 
conditioner 

 
 

5) Pull the filter outward and upward. 

The filter is detached. 

6) Use a vacuum to clean dust from the filter. 

 
Cleaning the filter 
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7) Attach the filter in the original position and place the ISE buffer bottle back 
in position. 

8) After the cleaning is complete, turn the Operate/Standby switch to  “PC 
CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

9) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

10) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 

7.5.1d Clean the line filter of the large water supply pump (LWP) 
Pressurized circulating water is supplied from the LWP line for washing mixing rods 
and probes. The pressure is set to 72 kPa to maintain a constant flow rate of cleaning 
water. 

Debris in the LWP line may clog the probe or trigger a malfunction of the solenoid 
valves used for washing. The LWP line contains a filter to avoid these problems. If the 
filter becomes clogged, the washing water volume will become unstable, and an 
“abnormal LWP gauge error” will be displayed. Therefore, clean the filter monthly. 

 

Required tools Cloth (towel), brush (tooth brush is OK) 
Required time 
(estimated) 

10 min 

Frequency of service Monthly 
System mode at 
service 

Analyzer's power is off. 

Workflow 1. Open the filter case and take out the filter. 
2. Clean the filter with the brush. 
3. Place the filter back in place. 
4. Regulate the flow rate. 

 
 

Warning 

 

• Read the sections of “Safety Precautions” and “Precautions 
for Use” before starting the task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 
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• Turn the Operate/Standby switch to the  
  “Off” position 

before starting to clean the LWP line filter. 

 

 How to clean the LWP line filter 

1) Confirm the system mode is “WAIT” or “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to   

 
 (OFF). 

4) The filter case is fixed by turning clockwise. Therefore, turn it 
counterclockwise for detachment. 

Water drops from the filter case when it is detached. Protect the floor underneath it 
with cloth. 

 
 

5) Take out the mesh filter from the case. 

 

Filter Case Mesh Filter 
 

 

6) Immerse the filter in a container of water, and clean it using a brush. Rinse 
with pure water. 

If the impurity level is high, soak the filter in a 1:20 dilution of Reagent probe wash-S 
for approximately 10 minutes, and rinse thoroughly 

7) After the cleaning is complete, place the filter in the case and attach the 
case back in place. 
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8) Turn the Operate/Standby switch to  “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

9) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

10) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
11) Select [Maint.] > [Manual Operation], and click [71.LWP] in the window. 

Then press the [Enter] key on the keyboard to activate LWP. Check that no 
water leaks from the filter case. 

If water leaks from the case, press [Enter] to stop LWP. Take the filter case out again, 
disassemble, reassemble it, and reattach. Press [Enter] again to activate LWP to check 
that no water leaks this time. 

12) Turn the LWP regulator valve to regulate the LWP pressure gauge reads 70 
- 72 kPa. 

 

Pressure gauge Flow rate adjustment valve  
 

 

13) Press [Enter] to stop LWP. 
14) Close the [Manual Operation] window. 
15) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
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7.5.1e Clean the waste fluid lines of probe and mixing rod wash ports 
Serum, reagents, and other liquids flow through the waste fluid lines of the probe and 
mixing rod wash ports. Over time, waste residue may clog the lines, blocking further 
waste liquid drainage. To prevent clogging, flush the waste fluid lines once monthly 
with Reagent probe wash-S. 

 

Required tools Reagent probe wash-S, pure water,  syringe 
with tube 4x6 

Required time 
(estimated) 

10 min (WASH3 is not included) 

Frequency of service Monthly 
System mode at 
service 

Analyzer's power is off. 

Workflow 1. Inject Reagent probe wash-S in the wash 
port. 

2. Flush the port with pure water. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn off the analyzer when washing the waste fluid lines of 
probe and mixing rod wash ports. 

 

 How to clean the waste fluid lines of probe and mixing rod wash ports 

1) Exit the workstation system and display the “BioMajesty” startup window 
on the monitor. 

2) Turn the Operate/Standby switch to   
 

 (OFF). 
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3) Set approximately 20 mL of Reagent probe wash-S in the injector with tube 
4×6 mm, and inject it in the wash port. 

Repeat this step for all the wash ports. 

 

Injector with 
tube 4 x 6 mm 

Reagent probe 
WASH-S 

Wash port 

 
 

4) Wait for more than 5 minutes. 
5) Set 20 mL of pure water in the injector, and inject it in the wash port. Check 

if it is drained smoothly. 

Repeat this step for all the wash ports. 

6) Turn the Operate/Standby switch to  “PC CONTROL.” 
7) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 
8) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
9) Click the [WASH] button, select “WASH3” in the [WASH set] window, and 

click [Execute].  

Check that the liquid in the wash port is drained smoothly. 

7.5.1f Clean the exterior panels of the analyzer 
Clean the top cover, side cover, front panel and back panel of the analyzer once a 
month.  Wring excess water from dampened gauze and wipe the surfaces of the covers 
and panels.  

 

Required tools Clean gauze (lint-free), pure water 
Required time 
(estimated) 

8 min 

Frequency of service Weekly 
System mode at 
service 

Analyzer's power is off. 

Task Clean the covers and panels of the analyzer. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 
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CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn the Operate/Standby switch to the  
  “Off” position 

before starting to clean the covers and panels. If you clean 
the covers and panels with the switch in the “PC 
CONTROL” or “On” positions, the gauze may be caught in 
the fan resulting in bodily injury. Wear insulating gloves 
while cleaning. 

 

• Only use water for cleaning.  Cleaning with solvents such 
as alcohol may strip the paint. 

 

 How to clean the exterior panels of the analyzer 

1) Exit the workstation system and display the “BioMajesty” startup window 
on the monitor. 

2) Turn the Operate/Standby switch to   
 

 (OFF). 
3) Wring excess water from dampened gauze and wipe the surfaces of the 

covers and panels. 
4) After the cleaning is complete, turn the Operate/Standby switch to  “PC 

CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

5) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

6) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
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7.5.1g Clean the vent fans and grids 
Fans and grids for the heat vent are located on the rear of the analyzer. If they are 
coated with dust, the heat cannot be vented sufficiently. This may obstruct proper 
temperature control in the analyzer. 

Two vent fans are located on the rear panel.  Clean them every month. 
 

Required tools Vacuum cleaner 
Required time 
(estimated) 

10 min 

Frequency of service Monthly 
System mode at 
service 

Turn the main power off. 

Task Vacuum clean the vent fan and grids. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Be sure to turn off the main power switch located at the 
rear of the analyzer. If you clean the area with the power 
on, you may receive an electrical shock or be injured by 
the fan. 

 

 How to clean the fans 

1) Exit the workstation system and display the “BioMajesty” startup window 
on the monitor. 

2) Turn the Operate/Standby switch to   
 

 (OFF). 
3) Turn off the main power switch at the rear of the analyzer. 

 Main power switch 
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4) Use a vacuum to clean the fan on the rear panel. 

 
Cleaning the panel fan 

5) Clean the vent grids on the right front and rear sides of the analyzer. 
6) After the cleaning is complete, turn on the main power switch at the rear of 

the analyzer. 
7) Turn the Operate/Standby switch to  “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

8) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

9) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
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7.5.2 Ion selective electrode (ISE) unit 

7.5.2a Clean the ISE waste-drain nozzle 
Impurities attached to the ISE waste-drain nozzle may block drainage, which affects 
measurement. Clean the ISE waste-drain nozzle when impurities are found. 

 

Required tools Clean gauze (lint-free) or Kimwipe 
Required time 
(estimated) 

5 min 

Frequency of service Monthly 
System mode at 
service 

READY 

Workflow 1. Detach the ISE waste-drain nozzle. 
2. Clean the ISE waste-drain nozzle. 
3. Perform priming. 
4. Attach the ISE waste-drain nozzle. 

 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Be sure to change the status into [ISE-WASH-OFF] before 
performing the task.  If you perform the task in the [ISE-
WASH-ON] status, the scheduled wash is automatically 
activated, resulting in a serious accident or trouble.  

 

1) Click the [ISE-WASH-ON] button on the Operation Panel to change the 
display to “ISE-WASH-OFF”. 

2) Remove the cover over the ISE sampling position. 

Loosen the screw that locks the stainless steel cover over the ISE unit to slide it off.  

3) Take the thumb screw off and take out the ISE waste-drain nozzle with the 
line kept attached. Clean the nozzle with gauze or a Kimwipe. 

 Be careful not to break the nozzle while cleaning. 
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4) If crystal is built up on the ISE waste fluid trap side, remove it with a cotton 
swab dampened with pure water. 

 ScrewWaste-drain 
nozzle

 

 

ISE waste 
fluid trap 

Wash block

 
Taking out the ISE waste-drain nozzle 

5) Insert the waste-drain nozzle in the ISE waste fluid trap, paying attention 
not to break the line. Fit the wash block into the dented part of the ISE 
waste fluid trap and fix it with the screw. 
  The dented part serves to fix the nozzle in the center of the waste fluid trap. 

6) Enter “5” for [Times] in the [Prime] area in the [ISE Operation] window, 
Click [Execute]. 

Check no solution remains in the waste fluid trap during priming to confirm no 
impurities has been accumulated or no screw has dropped in the waste fluid trap to 
block drainage. 
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7.5.2b Post-maintenance restoration of the ISE unit 
After the monthly maintenance service, restore the unit to be ready for measurement. 
See Section 7.3.2e for procedure. 
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7.6 Maintenance to Perform Every 
Three Months 

7.6.1 Chemistry analysis unit 

7.6.1a Clean the cuvette wash solution bottle and the conditioner bottle 
Impurities adhered to the inner walls of the cuvette wash solution bottle or the 
conditioner bottle may affect measurement values. Wash the bottles once every 3 
months to ensure measurement accuracy. Follow the steps below for cleaning. 

 

Required tools Clean gauze (lint-free), Cuvette wash solution 7, 
Cuvette conditioner 

Required time 
(estimated) 

15 min 

Frequency of service Once in three months 
System mode at 
service 

READY 

Workflow 1. Take the bottle out of the compartment. 
2. Clean the bottle. 
3. Place the bottle back in the compartment. 
4. Perform priming 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Do not use pure water to wash the reaction bath oil bottle.    
The reaction bath oil and water are immiscible. 
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 How to clean the cuvette wash solution bottle and the conditioner bottle 

1) Confirm the system mode is “READY.” 

 

Reaction 
bath oil 

Cuvette wash Cuvette 
conditioner 

 
 

2) Uncap the cuvette conditioner bottle and remove the line. 

Using gauze, wipe away any conditioner remaining on the line and/or filter. 

3) Turn the nut connecting the volume level sensor to the bottle 
counterclockwise, and pull the connector out. 

 
Removing the connector 

4) Remove the bottle. 
5) Remove the volume level sensor from the bottle. 
6) Discard the remaining cuvette conditioner from the bottle. Wash the inside 

of the bottle with pure water and then dry sufficiently.   
 Be careful not to spill water on the connector of the volume level sensor. 

7) Pour new cuvette conditioner in the bottle, and attach the sensor to the 
bottle. Return the bottle with sensor in the compartment. 
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8) Insert the sensor connector, and turn the nut counterclockwise to fix. 

Check the filter for impurities and clean it if it is not clean. 

Check the filter holder reaches the bottom of the bottle. 

 See “Section 7.6.1b Clean the filter in the cuvette wash solution bottle and 
conditioner bottle” for the cleaning steps. 

9) Clean the Cuvette wash solution bottle in the same way. 
 Be careful to set each bottle and connector in the right place. 

10) After setting back the two bottles, perform [PRIME2] or [PRIME3] for 10 
cycles for degassing the lines. 

7.6.1b Clean the filters in the cuvette wash solution bottle and the 
conditioner bottle 
Filters are present in the aspiration lines of each bottle in the detergent compartment 
(except for the reaction bath oil bottle). 

If a filter becomes clogged, the required flow rate may not be met and/or air bubbles 
may be generated. Either of these issues can induce measurement errors. Clean them 
once every three month. 

 

Required tools Small brush (e.g. tooth brush) 
Required time 
(estimated) 

10 min 

Frequency of service Once in three months 
System mode at 
service 

READY 

Workflow 1. Take out the line from the bottle and detach the 
filter. 

2. Clean the filter with the brush. 
3. Attach the filter. 
4.  Perform priming. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 
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 How to clean the filters in the cuvette wash solution bottle and the conditioner bottle 

1) Confirm the system mode is “READY.” 
2) Turn the bottle cap counterclockwise to remove it, and take the line out of 

the bottle. 
3) Turn and remove the tip of the filter holder to take out the filter. 

 
Taking out the filter 

4) Brush the filter with a small brush to remove impurities. Then wash it with 
pure water. 

 
 

5) Insert and attach the cleaned filter on the tip of the holder.  
 Be careful to place the filter in the right position. It is very thin and easily 
displaced. 

After completion, place the line with the filter back in the bottle. 

6) Perform [PRIME2] or [PRIME3], setting “10” for [Cycle]. 

During priming, check no bubble is generated in the line. 
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7.6.1c Clean the aspiration lines of the reaction carousel wash unit 
(WUD) 
When WUD cleans the cuvettes, the blue-marked nozzles aspirate the reaction solution 
from the cuvette. Then the red-marked nozzles introduce wash solution into the cuvette. 
The yellow-marked nozzle continuously drains the wash solution to prevent overflow. 

Crystallized serum or reagent may accumulate in the aspiration lines over time. This 
can lead to insufficient aspiration and potentially cause the cuvette to overflow. To 
avoid this, the aspiration lines must be cleaned regularly. 

The aspiration line may become clogged if it aspirates dust or debris from the cuvette. 
If this occurs, prepare a nozzle cleaning wire and follow the steps described in “Section 
7.8.1c Clean the clogging in the WUD nozzle” to remove clogs. 

 

Required tools 4-mm Allen wrench, silicone line and container, or 
container to immerse the nozzle, hypochlorite 
solution diluted to 2.5-3%, or 1N NaOH solution, 
towel, plastic sheet. 

Required time 
(estimated) 

15 min (WASH3 is not included) 

Frequency of service Once in three months 
System mode at 
service 

READY 

Workflow 1. Take out WUD. 
2. Connect detergent to nozzle. 
3. Start washing from the [User Maintenance] 

window. 
4. Return WUD back. 
5. Check the nozzle positions. 
6. Perform “WASH.” 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 
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dispensing

 

 How to clean the aspiration lines of WUD 

1) Confirm the system mode is “READY.” Cover the work space with towels 
and plastic sheets. 

2) Loosen the fixing screws with a 4-mm wrench to remove WUD. 
3) Check beneath the nozzles for impurities or clogs. 
4) Attach the silicon lines onto the tips of the blue-marked and yellow-marked 

nozzles. 

 

Fixing screw 
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5) Place the ends of the tubes into a container containing 150 mL of either 
50% hypochlorite solution or 1 N NaOH solution. (Do not use foamy 
detergent for cleaning, and never add more than 150 mL to the container.) 

 Most nozzles can be immersed directly into the solution, but do not 
immerse the apparatus beyond the nozzles. The wide nozzle cannot be 
immersed in the solution. 

 

Lowest limit Do not soak the wide nozzle 

 
 

6) Select [Maint.] > [User Maintenance]. 
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7) In the [User Maintenance] window, click [Start] in the [Cuvette Detergent 
Aspirate Line Wash] column, and Click [Yes] in the pop-up window. 

The detergent is aspirated from the nozzles for one minute for cleaning. 

 
 

8) When the aspiration is complete, the following message is displayed. Wait 
for 4-5 minutes. Then place the tubes in a container filled with 150 mL of 
pure water, and click [OK] in the window below. 

The nozzles aspirate the pure water. 

 
 

9) When the aspiration is complete, the window below is displayed. Click 
[OK] to close the window. 

 
 

10) Detach the silicone tubes from the nozzle tips. 
11) Wipe the nozzle tips with gauze, remove the towels and plastic sheets, and 

place WUD back. 
12) Check no gap is between WUD and the fixing plate, and then fix the screw 

with the Allen wrench. 
13) Perform “INITIALIZE.” 
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14) After “INITIALIZE” is complete, follow the steps below to check the 
position. 
1 Select [Maint.] > [Manual Operation]. 
2 Double click [23.WUD] to display the [WUD] window. Click [Move]. 

WUD lowers a little. Check each nozzle is rightly lowered in the midpoint of the cuvette. 

3 Click the [Init.] button to return WUD in the home position. 
4 Click [Exit] to close the [WUD] window, and close the [Manual Operation] 

window. 
 

 
 

15) Check no leakage is found at the joints of the lines. 
16) Perform [WASH3] to check the solution does not overflow from the 

cuvettes. 
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7.7 Maintenance at 3-Month or Longer 
Intervals 

7.7.1 Chemistry analysis unit 

7.7.1a Replace the spectrophotometer lamp 
A degraded lamp generates more noise and may induce measurement instabilities. 

The following issues suggest that the lamp has degraded. 

• Significant variations in measurement values. 

• The lamp energy assessed using the [Check Energy] feature ([Lamp Energy 
Monitor]) returns variable results. 

• The lamp has been used for more than 3 months. 

• The lamp has been used for more than 2,000 hours. (This is comparable to 1 month 
of 24-hour continuous use.) 

If lamp replacement is necessary, perform the following steps: 
 

Required tools Lamp for replacement 
Required time 
(estimated) 

70 min 

Frequency of service One of the incidents described above. 
System mode at service Analyzer's power is off. 
Workflow 1. Remove the lamp cover. 

2. Detach the lamp lead wires. 
3. Take the lamp from the lamp house. 
4. Place a new lamp. 
5. Check the lamp energy and measure the 

cuvette blank. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Be sure to turn off the analyzer when replacing the lamp. If 
you replace the lamp with the analyzer's power on, you 
may get a shock. 
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 How to replace the spectrophotometer lamp 

1) Confirm the system mode is “WAIT” or “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to   

 
 (OFF). 

4) Remove the lamp cover. 

 
Lamp cover 

 
 

Warning 

The lamp is extremely hot. Turn off the analyzer and allow the lamp to cool for at least 10 
minutes before initiating the lamp replacement steps. Otherwise, serious burns may result. 

 

5) Manually loosen the screws fixing the lamp lead wires to detach them from 
the terminals. 

 

 

Lead wires 

Screws fixing the wires 

 
Loosening the screws fixing the lead wires 
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6) Manually loosen the screws fixing the lamp and take the lamp out of the 
house. 

 

Lamp holder hole 

Lead wires Lamp fixing 
screws 

 
Inside of the lamp cover 

7) Set a new lamp in the lamp holder and place a new lamp in the house. Turn 
the fixing screws manually to fix the lamp. 

Align the locating pin to the lamp holder hole to set the lamp correctly in the lamp 
house.  

 

 
CAUTION  

 

Clean the lamp surface with ethanol-soaked gauze if required, and never touch it with 
your bare fingers. 

 

8) Attach the lamp lead wires to the terminals. 
9) When the replacement is complete, place the lamp cover back. 

10) Turn the Operate/Standby switch to  “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

11) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

12) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
13) Allow the system to idle for 30-40 minutes in the “READY” mode to ensure 

the stable function of the lamp. 
14) Check the lamp energy in the [Lamp Energy Monitor] window, and measure 

the cuvette blank. 

See Sections 7.4.1a and 7.4.1b in this chapter. 
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7.7.1b Replace the reaction cuvettes 
Impurities can accumulate in the reaction cuvette and may affect measurement 
accuracy. The reaction cuvettes must be replaced every 4 months, as described below. 

• Cuvettes used for HbA1c analysis should be replaced every 10,000 measurements.  

• Certain combinations of reagents may require more frequent cuvette replacement 
 

Required tools New reaction cuvettes (11 cuvette holders 
containing 21 cuvettes in each holder, total of 231 
cuvettes), Reagent probe wash-S 

Required time 
(estimated) 

30 min (WASH2 is not included) 

Frequency of service Every four months, or as required for the above 
conditions 

System mode at 
service 

Analyzer's power is off. 

Workflow 1. Remove the reaction cuvettes. 
2. Set new cuvettes. 
3. Perform “WASH.” 
4. Check the lamp energy and measure the 

cuvette blank. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Before replacing the reaction cuvettes, turn off the analyzer 
and workstation to prevent injury. 

• Do not attach or detach the cuvette holder in the region 
through which the lamp light passes. Doing so could 
damage the spectrophotometer because the space between 
the detector and the cuvette is extremely narrow. Slowly 
rotate the reaction carousel by hand to move the cuvette 
holder away from this site, and then proceed with 
attachment/detachment. 

• When attaching/detaching the cuvette holder, be careful not 
to drop the fixing screws into the reaction bath or any other 
compartment within the analyzer.  
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• When attaching new cuvettes, never touch the surface 
through which the lamp light passes. 

• Handle the cuvettes very carefully.  Never wipe the inner 
or outer surface of the cuvette with materials such as 
gauze, because these may scratch the surface of the 
cuvette. 

 

 How to replace the reaction cuvettes 

The 11 cuvette holders (containing 21 cuvettes in each holder, total of 231 cuvettes) 
should be replaced all at once. 

Follow the steps below for replacement. 

1) Exit the workstation system and display the “BioMajesty” startup window 
on the monitor. 

2) Turn the Operate/Standby switch to   
 

 (OFF). 
3) Manually loosen the fixing screws for the cuvette holder, and remove the 

holder. Continue removing all 11 cuvette holders on the reaction carousel. 

Rotate the reaction carousel by hand when detaching and attaching each holder to avoid 
damaging the spectrophotometer site. 

 

 
CAUTION  

 

Do not remove the cuvette holder near the spectrophotometer site. 
 

 
Detaching the cuvette holder 

 

 

 

 

 



  

 

7-82  ICABM6010/C-4 

C
hapter 7 

M
aintenance 

4) Attach new cuvette holders on the reaction carousel. 
 Firmly tighten the fixing screws of the cuvette holders. 

 

 
CAUTION 

 
 

 

Be careful not to damage the cuvettes when taking out a new cuvette holder from the 
packaging. Also, be careful not to hit the light passing side of the cuvette against the 
wall of the reaction bath unit. 

 

5) Turn on the analyzer. 
6) Turn the Operate/Standby switch to  “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

7) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

8) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
9) Perform “WASH2” with Reagent probe wash-S diluted to 5%. 

Replace the Reagent probe wash-K bottles placed on the #44 positions of the reagent 
trays 1 and 2 with the bottles with Reagent probe wash-S diluted to 5%. 

Check the nozzles of the reaction carousel wash unit (WUD) will not hit the cuvettes 
during washing. 

10) When the washing is completed, check the lamp energy and measure the 
cuvette blank (See Section 7.4.1b) and register the cuvette blank values. 
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7.7.2 Workstation 

7.7.2a Disk defragmentation of the Windows XP-based workstation 
The files stored in the hard disk drive of the workstation will fragment over time, 
which will negatively affect processing speed. Ultimately, this can lead to error 
messages such as “acquisition error.” As a countermeasure, regularly execute the “disc 
defragmenter” to optimize file storage. 

 

Required tools N/A 
Required time 
(estimated) 

Depend on the computer performance 

Frequency of service Semiannually 
System mode at 
service 

Analyzer’s power is off. 

Task Perform “disk defragmenter.” 

 How to defragment the disk 

1) Exit the workstation system and click the [Cancel] button in the 
“BioMajesty” startup window. 

The “BioMajesty” startup window is closed. 

 
 

2) Click the [Start] button in the bottom left corner of the Windows display. 

Windows menu is displayed. 

3) Select [Program] > [Accessories] > [System Tools] > [Disk Defragmenter]. 

The [Disk Defragmenter] window is displayed. 

 Double click the [Disk Defragmenter] icon on your desktop if available. 
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4) Click and highlight “(C:)” under the header “Volume,” and click the 
[Defragment] button. 

Disk defragmentation begins. 

 
 

5) When the [Disk defragmentation completed] window is displayed, close all 
the windows. 

6) Click the [Start] button in the bottom left corner of the window. 

Windows menu is displayed. 

7) Click “Shutdown” to exit Windows and turn the power off. 

The analyzer is turned off simultaneously by the “PC CONTROL” function. 

8) 10 seconds later, turn the computer on. 
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9) In the [BioMajesty] window, select “Re-Start” on the same date to startup 
the system. 

 
Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

10) Perform “INITIALIZE” and confirm the system mode turns to “READY.” 
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7.8 Maintenance Performed as 
Required 

7.8.1 Chemistry analysis unit 

7.8.1a Replace probes 
Replace the probe if it becomes clogged with foreign matter or if it is deformed or 
broken. 

Using a defective probe can cause wash solution to disperse during washing. A 
damaged probe also may damage a separate unit by accidental contact. 

 

Required tools Probe (for sample or reagent accordingly) , 
Phillips screwdriver, flat-bladed screwdriver, 
needle nose pliers, gauze 

Required time 
(estimated) 

10 min 

Frequency of service As required 
System mode at 
service 

Analyzer's power is off. 

Task 1. Remove the probe. 
2. Attach a new probe. 
3. Check the position of the probe tip. 
4. Perform “WASH.” 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

Two kinds of probe are used in the analyzer. 

• Sample probe (SPP) 

• Reagent probe (RPP) 

 SPP has an integrated liquid level sensor and a “crash sensor,” which 
protects the probe from bumping into foreign matter while it is being 
lowered.   
RPP also has an integrated liquid-level sensor. 

Follow the steps below for replacement. Be sure to check the position after replacement. 
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 How to replace SPP 

1) Confirm the system mode is “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to   

 
 (OFF). 

 

 
CAUTION 

 
 

 

When the power is off, the SPP arm can be moved freely. However, if you push the arm 
downward, it may lower and be damaged upon contact with another object. Carefully 
steady the arm from below when replacing the probe. 

 

4) Loosen the two fixing screws of the probe arm cover and lift the cover. 

Perform this service at the wash port position. 

 Do not remove the screws completely. 
  After lifting the cover, return the two screws to the probe arm. Once the 
probe is replaced, perform “WASH3” without the cover on. 

 

 

 

Fixing screw 

Probe arm cover 

Fixing screw 

Probe arm cover 



  

 

7-88  ICABM6010/C-4 

C
hapter 7 

M
aintenance 

 

5) Loosen the Terminal 2 fixing screw with a Phillips screwdriver, and detach 
Terminal 2.  Using pliers, hold the post steady, and loosen the Terminal 1 
fixing screw to detach Terminal 1. 

  Loosen the screws, but do not remove them completely. 

 

Terminal fixing screw1 

Terminal fixing screw2 
 

Terminal 2 

Terminal 1 

Post 

 

 

 
How to detach the terminal  
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The positions of the sensor board and the spring are shown in the figure below. 

 

Sensor board 

Spring 

 

6) Holding the block-shaped joint steady with your fingers, loosen the pipe 
fitting by turning it counterclockwise with pliers. Using your fingers, pull 
the screw out completely. 

 

 

Block shaped joint 

Pipefitting 

 
 

7) Pinch the tip of the spring with pliers, and lift to detach it from the probe. 

 

Spring 
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8) Rotate the sensor board with the U-cutting while lifting the washer. 

 

Sensor board 

Washer 

 
 

9) Using a flat-bladed driver, lift and remove the block-shaped joint. 

The block-shaped joint is located between the guide arms. 

The joint is wider than the guide. Therefore, lift the protruding part from underneath 
using a flat-bladed driver. 

 

Block shaped joint 

Guide 

 
 

10) Lift the probe slowly, and use your fingers to remove it. 

The probe cannot be removed if its tip is warped. Straighten it using pliers or cut the 
warped part. 

 

11) Insert a new probe into the holder. Press the block-shaped joint straight 
down by hand to position it into the guide. 

 

 
CAUTION 

 
 

 

Carefully steady the arm from below when replacing the probe. 
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12) Lift the lower washer and rotate the sensor board so that the U-cutting fits 
around the washer. 

 

Washer 

Sensor board 

 
 

13) Pinch the tip of the spring with pliers and lift to attach it on the probe. 

 
 

14) Insert Terminals 1 and 2 respectively into fixing screws 1 and 2. Tighten 
the screws using a Phillips screwdriver, 

Tighten Terminal 1 while holding the post steady with the pliers to prevent it from 
rotating. 

 

Spring 

Terminal post 2 

Terminal post 1 

Terminal fixing screw 2 

Terminal fixing screw 1 
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15) While holding the block-shaped joint steady, manually turn the pipe fitting 
clockwise, and tighten it securely. 

Be careful not to deform the threads of the male screw. The first 2 or 3 rounds should 
be easy to turn. 

16) Tighten approximately 30 degrees further using pliers. 

 
 

17) Lift the probe arm with your fingers and turn it carefully. Verify that the 
probe tip passes safely through the midpoint of the wash port. 

18) Turn the Operate/Standby switch to  “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

19) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

20) Perform “INITIALIZE” and check the probe moves normally and no leakage 
is observed at the block shaped joint. 

During initialization, check that the probe moves normally and that no leakage is 
observed at the block-shaped joint. 

21) Check the position of the probe tip above the cuvette. 
1 Click [Maint.] > [User Maintenance] to display the [User Maintenance] 

window. 
2 Click the [Start] button in the [Position Probes for Routine Cleaning] column. 

After some time, the probe moves over to the cuvette. 

Check the probe tip is in the midpoint of the cuvette. 
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 Sensor  
Sample probe 

Cuvette 

Cuvette midpoint 
 

Slightly shifted from the 
cuvette midpoint 

Largely shifted from 
the cuvette midpoint 

 
 

 If it is a little shifted from the midpoint, bent the probe slightly for adjustment. 
 If it is greatly shifted from the midpoint, repeat the steps of detaching and 
re-attaching the probe. 

 

22) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
23) Perform “WASH3” and confirm the probe moves properly. 

Check no leakage is observed at the joint. 

If a “liquid level sensor error” occurs, repeat the steps of detaching and re-attaching the 
probe. 

24) When the operation is complete and the system enters in the “READY” 
mode, attach the probe cover. 

 Replacing the reagent probes 1 and 2 (RPP1/RPP2) 

1) Confirm the system mode is “WAIT” or “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to  

 
(OFF). 

 

 
CAUTION 

 
 

 

When the power is off, the RPP arm can be moved freely. Carefully steady the arm 
from below when replacing the probe. 

 

4) Using gauze or a Kimwipe, block the openings underneath to prevent 
screws from dropping into the cuvette or the wash port. 
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5)  Loosen the two fixing screws of the probe arm cover and lift the cover. 

Perform this service at the wash port position. 

 Do not remove the screws completely. 
 After lifting the cover, return the two screws to the probe arm. Once the 
probe is replaced, perform “WASH3” without the cover on. 

 Cover 

Reagent probe 

Gauze 

 
 

6) Holding the block-shaped joint steady with your fingers, loosen the pipe 
fitting by turning it counterclockwise with pliers. Using your fingers, pull 
the screw out completely 

 
Needle nose pliers 

Square shape joint 

Pipefitting 

Guide 
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7) Loosen the probe fixing screws A, B, C, and D with a Phillips screwdriver. 
 Do not remove the screws completely. 

 

Screw D 

Holder 

Reagent probe 

Screw A 

Screw C 

Screw B 

Pipefitting 

 
 

8) Using your fingers, lift the probe slowly to remove it. 

 Pipefitting 

Screw D 

Holder 

Reagent probe 

Screw A 

Screw C 

Screw B 
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9) Insert a new probe into the holder until the stopper contacts Terminal 1. 

 

Pipefitting 

Guide 

Holder 

Square shape joint 

Terminal 2 

New reagent probe 

Terminal 1 

Stopper 

Stopper 

Terminal 1 

 
 

10) When the new probe is set successfully in Terminal 2, tighten Screw A 
while pressing the probe into Terminal 1 with your fingers. 

 Pipefitting 

Screwdriver 

New reagent probe 

Screw A 

Clamp 

Terminal 1 

Terminal 2 

Stopper 

 

Fits 

completely 
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11) Lift at Position A to verify that the probe is fixed securely. 

 Pipefitting 

Screw D 
Position A 

New reagent probe 

Screw A 

Clump 

Stopper 

Terminal 2 

Terminal 1 

 
 

12) While pressing the block-shaped joint, securely tighten Screws B and C, 
and then lightly tighten Screw D. 

 Pipefitting 

Screw D 

New reagent probe 

Screw B 
Guide 

Clump 

Terminal 2 

Screw C 

Square shape joint 

Screwdriver 

 
 

13) While holding the block-shaped joint steady, manually turn the pipe fitting 
clockwise, and tighten it securely. 

 Be careful not to deform the threads of the male screw. The first 2 or 3 
rounds should be easy to turn. 
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14) Tighten approximately 30 degrees further using the pliers. 

 
Square shape joint 

Pipefitting 

Needle nose pliers 

New reagent probe 

 
 

15) Remove the gauze or Kimwipe spread over the openings. 
16) Lift the probe arm with your fingers and move it carefully. Verify that the 

probe tip passes safely through the center of the wash port. 
17) Turn the Operate/Standby switch to  “PC CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

18) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT”. 

19) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 

Ｃheck the probe moves normally and no leakage is observed at the joint. 
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20) Check the position of the probe tip above the cuvette. 
1 Click [Maint.] > [User Maintenance] to display the [User Maintenance] 

window. 
2 Click the [Start] button in the [Position Probes for Routine Cleaning] column. 

After some time, the probe moves over to the cuvette. 

㉑ Check the probe tip is in the midpoint of the cuvette. 

 Sensor  
Probe 

Cuvette 

Center of cuvette 
 

Slight shift from the 
cuvette center 

Large shift from the 
cuvette center 

 
 

 If it is a little shifted from the midpoint, bent the probe slightly for adjustment. 
 If it is widely shifted from the midpoint, start the assembly from the 
beginning again. 

㉒ Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
㉓ Perform “WASH3” and confirm the probe moves properly. 

 Check no leakage is observed at the joint. 
 If a “liquid level sensor error” occurs, repeat the steps of detaching and re-
attaching the probe.  

㉔ When the operation is completed and the system enters in the “READY” 
mode, attach the probe cover. 

6 Cover 

Wash port 

Fixing SCREW 
  M3×6（2） 
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7.8.1b Replace the seal of the pumps 
If the pump seals deteriorate, measurement values may become inconsistent. Follow the 
steps described in “Section 7.3.1g Check for potential leakage from pumps” to assess 
any leak. If leakage is observed, replace the seal. 

 

Required tools Clean gauze (lint-free), towel, pen, pliers, Phillips 
screwdriver, towel, Allen wrench, L-ring removal 
jig, L-ring fitting jig 
Sampling pump (SP): 1-mm seal - 1 pc 
Reagent pump (RP): 5-mm seal - 1 pc 
Sampling and reagent wash pump (SRWP); 14-
mm seal - 2 pcs 

Required time 
(estimated) 

15 min 

Frequency of service As required 
System mode at 
service 

Analyzer's power is off. 

Task 1. Take out the pump. 
2. Disassemble the pump. 
3. Replace the seal. 
4. Assemble the pump. 
5. Place the pump back. 
6. Perform “WASH.” 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Turn off the analyzer and workstation before removing or 
replacing the pump. Otherwise, the analyzer may operate, 
causing electrical shock or bodily injury. 

 

How to take the pump out 

1) Confirm the system mode is “WAIT” or “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Turn the Operate/Standby switch to   

 
 (OFF). 
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4) Open the front panel door. 

 

SP SRWP RP1 RP2 

 
Pump location 

 The following steps describe removal of the sampling and reagent wash 
pump (SRWP). These steps also apply to removal of other pumps. 

 

5) Using pliers, loosen the joint on the top of the cylinder, and remove it by 
hand.  

 When the joint is loose, the liquid inside will leak.  Wipe it with gauze or a 
Kimwipe. 

 Each joint has its own location. Before removing it, mark the joint position to 
facilitate replacement. 

 

Removing the joint on the top of the cylinder Removing the joint on the front side of the 
cylinder 
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6) Using pliers, loosen the joint on the front side of the cylinder, and remove 
it by hand. . 

 When the joint is loose, the liquid inside will leak.  Wipe it with gauze or a 
Kimwipe. 

 Each joint has its own location. Before removing it, mark the joint position to 
facilitate replacement. 

7) Using a Phillips screwdriver, remove the two screws that hold the pump in 
place. Pull the pump to remove. 

    

Removing the fixing screws of the pump Pulling the pump forward 
 

8) Pull the pump forward and remove the two connectors. 

Press the lock release button lightly, and detach the connectors by pulling them in 
directions B and C. 

 

 
Lock Lock 

B 

C 

B 

C 
Connector Connector  

 

9) Place the pump on a flat surface cushioned with a towel or similar 
absorbent material while replacing the seal. 
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 How to replace the 1-mm seal for the Sampling pump (SP) 

1) Obtain a 1-mm L ring. 
2) Remove the two fixing screws, and then remove the cover. 

 Each cover has its own direction for reattachment. Mark the direction to 
facilitate reassembly. 

 

Cover 

Cylinder 

Screw 

 
 

3) Move the drive lever slowly in the arrow direction until it contacts the end. 

 

Block 

Cylinder 

Drive lever 
 

 

4) Remove the two hex socket bolts, then remove the washer, the cylinder, 
and the holder. 

 

Holder 

Plunger 

Cylinder 

Hex socket  
bolt  
M3×25 

Drive lever 

Block 

NOTE： 
Do not remove these 
two screws completely.  

Washer 

 
 

 
CAUTION  

 

Be careful not to bend the plunger when removing the holder. 
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5) Remove the L-ring attached to the holder. 

 

O-Ring 

Holder 

 
 

6) Place a new L-ring using the L-ring fitting jig. 
 Do not set an L-ring on the back side. 

 

Holder 

O-Ring 
New L-Ring Set 

 
 

7) Insert the holder, the washer, and the cylinder through the plunger. Align 
the screw holes, and hold them in place using the hex socket bolts. 

Tighten the bolts with the longer arm of an Allen wrench, alternating bolts to gradually 
bring them to the same tightness. Using the shorter arm of an Allen wrench, tighten 
each bolt 30 degrees further. 

 Place the holder such that the O-ring faces upward. 
 Set the cylinder with the connector hole facing the front of the pump. 

 

Hex 
socket 
bolt  

Connector Hole 

Holder 

Drive lever 

Block 
Cylinder 

Washer 
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8) After attaching the cylinder, manually move the driver lever up and down to 
verify that it moves smoothly. 

9) Attach the cover. 
 Be careful to place it in the correct direction. 

 Replace the 5-mm seal for Reagent pumps 1 and 2 (RP1/RP2) 

1) Obtain two 5-mm L-rings for each pump. 
2) Mark the alignment direction of the cylinder block. 

 
Piston 

Cylinder Block 

 
 

3) Remove the two hex socket bolts and slide the cylinder block outward to 
remove.  

 

 
CAUTION  

 

Pull in direction A to slide the cylinder block out. Do not wiggle the block while 
removing. 

 Piston 
Spacer 

Hex socket bolt 

Cylinder 
Block 
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4) Before disassembling the cylinder block, mark the orientations of the 
holder and cylinder to facilitate reattachment. 

 Spacer Holder 

Cylinder 

 
 

5) To disassemble the cylinder block, first remove the hex socket bolts 
holding the cylinder in place. 

 

Spacer 

Hex socket bolt 

Holder 

Cylinder 

 
Disassembly scheme 

6) Using the L-ring removal jig, take the L-ring out of the holder as follows. 
1 Insert the removal jig approximately 5 mm into the L-ring. 
2 Slightly angle the removal jig. 
3 Lift at an angle to remove the L-ring. 

 

L-Ring removal jig 

New L-Ring Set 

Holder 
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7) Using the L-Ring fitting jig, place the new L-ring into the holder as follows. 
1 Insert a new L-ring into the L-ring fitting jig. 
2 Plunge the fitting jig straight into the holder to attach the L-ring. 
3 Slowly pull the fitting jig out. 

 

L-Ring fitting jig 

New L-Ring  
New L-Ring  

Holder 
 

Attaching the new L-ring 
 

8) Align the marks to reassemble the cylinder block. 

 Cylinder 

Holder 

Spacer 

Align the marks 

 
Assembling the Cylinder Block １ 

 

9) Assemble the parts of the block and lightly tighten the three fixing screws 
evenly.  

 

OK NG 

Screw Bolt 

Spacer 

Holder 

Cylinder 

Gap 

 
Assembling the Cylinder Block 2  



  

 

7-108  ICABM6010/C-4 

C
hapter 7 

M
aintenance 

 

10) Slowly insert the L-Ring removal jig into the cylinder block, and firmly 
tighten the three hex socket bolts. 

Using the longer arm of an Allen wrench, tighten the bolts gradually and alternately to 
the same tightness. 

Using the shorter arm of an Allen wrench, tighten the bolts 30 degrees further. 

 
L-ring 

Removal jig 

Allen wrench 

Hex socket bolt 

Cylinder 

 
Assembling the Cylinder Block 3 

 

11) Remove the L-ring removal jig slowly. 
 

12) Slowly insert the cylinder block into the piston and secure it to the pump 
unit using the two hex socket bolts.   

 Set the cylinder with the connector hole facing the front.       

 

Pump Unit 

Hex socket bolt 

 
Align the marks. 

Cylinder 

Piston 
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 How to replace the 14-mm OMNISEAL of the Sampling and reagent wash pump (SRWP) 

1) Obtain two pieces of pump seal (OMNISEAL 14 mm). 
2) Turn the nut counterclockwise to disassemble the cylinder block. 

 Nut Piston 

Spacer 

Cylinder 

Nut 

  

Disassembling the cylinder block 

3) Using the removal jig, take the OMNISEALs out of the spacer and cylinder. 
1 Insert the removal jig approximately 5 mm into the OMNISEAL. 
2 Slightly angle the removal jig. 
3 Lift at an angle to remove the OMNISEAL. 

 Removal jig OMNISEAL 

 
Removing the OMNISEAL from the spacer 

 
Removing the OMNISEAL from the cylinder 
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4) Using the fitting jig, place the new OMNISEALs in the spacer and cylinder. 
1 Insert a new OMNISEAL into the L-ring fitting jig. 
2 Plunge the fitting jig straight into the spacer and cylinder to attach the 

OMNISEAL. 
3 Slowly pull the fitting jig out. 

 Fitting jig 

New OMNISEAL Spacer 

New OMNISEAL 

a b c 

 
 

5) Assemble the cylinder block as follows. 
 In the SRWP, locate the pins on the holder and top of the spacer and the 
fitting holes on the bottom (where the OMNISEAL is attached) of the spacer 
and the cylinder. Assemble the unit with the pins and fitting holes aligned. 

 

Pin on the holder Fitting hole on the spacer 
 

  

Pin on the spacer Fitting hole on the cylinder 
 

1 Insert the spacer straight into the piston with the bottom side (where the 
OMNISEAL is attached) facing the holder. 

 Attach the spacer with the pin facing front, and ease the pin of the holder 
into the hole of the spacer. 
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2 Manually turn the spacer right and left to check the fitting. 
If the spacer does not turn, the pin of the holder is positioned correctly in the hole 
of the spacer (See Figure.1). 

 
Holder 

Pin of the spacer Spacer 

Fig.1 
 

Checking the fitting 

3 Insert the cylinder straight through the piston 
 

 Attach the cylinder with the hole facing front, and ease the pin of the spacer 
into the hole of the cylinder. 

4 Manually turn the cylinder right and left to check the fitting 

If the cylinder does not turn, the pin of the spacer is positioned correctly in the hole of 
the cylinder (See Figure 2). 

 
Fitting Hole  

Fig. 2 
 

Checking the fitting 
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5 Place the nut around the cylinder and turn clockwise until it is finger-tight. 
Align the marks on the nut and the cylinder. 

 Cylinder  

Nut  

 
Assembling the Cylinder Block 

 How to replace the pump and assess its motion 

 The following steps describe the installation of SRWP. The same steps 
apply to other pumps. 

1) Join the two connectors. 

Interlock them in the correct direction. 

ポンプ本体の切り欠き部 

Connector Connector 
  

Connecting the connectors 

2) Position the pump and hold it in place using the two fixing screws. 

  
Placing and fixing the pump 
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3) Attach the line joint to the top and front of the cylinder. Tighten the joint by 
turning it clockwise manually. Using pliers, tighten the joint approximately 
45 degrees further. 

 Each joint is associated with a specific position. Reattach the joints 
according to the identification marks you made when detaching the joints. 

 

 
CAUTION 
 

 
 

The screw threads can be damaged if the joint is angled during reattachment. Hold the 
joint parallel to the receiver when attaching. 

The joint should turn easily by hand. 

 

Attaching the joint on the top of the 
cylinder 

Attaching the joint on the front side of the 
cylinder 

 

4) Check the motion 
1 Turn the Operate/Standby switch to  “PC CONTROL.” 
2 Select “Re-start” in the “BioMajesty” startup window to re-start the system. 
3 Perform “INITIALIZE” and confirm the system mode turns to “READY.” 
4 Perform “WASH3.” 
5 Check that no leakage is observed around the joint and pump seal, and that 

no air bubbles are trapped in the cylinder. 
 After the service, return the Operate/Standby switch on the power panel to 
the “PC CONTROL” position. If  

  (Off) or     (On) is selected, the 
analyzer does not turn on/off together with the workstation. 
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7.8.1c Remove clogs from the reaction carousel wash unit (WUD) 
nozzles 

The nozzles will rarely become clogged if daily and weekly “WASH2” cycles are 
performed as recommended. However, if a drain nozzle aspirates dust or debris from a 
cuvette, the nozzle may clog, leading to improper aspiration.   

If improper aspiration by the WUD results in overflow of wash solution from the 
cuvette, take the following measures. 

 

Required tools Clean gauze (lint-free), wire (fishing wire), 4-mm 
Allen wrench, Kimwipe, 2 pliers, 

Required time 
(estimated) 

10 min (WASH2 is not included) 

Frequency of service As required 
System mode at 
service 

Analyzer’s power if off. 

Task 1. Take out WUD. 
2. Clean the nozzles. 
3. Return WUD back. 
4. Check the nozzle positions. 
5. Perform “WASH.” 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• When cleaning the WUD nozzles, be sure to turn off the 
analyzer and workstation. 

 

 How to remove clogs from the WUD nozzles 

1) Obtain gauze and wire. 
 

2) Confirm the system mode is “WAIT” or “READY.” 
 

3) Exit the workstation system and display the “BioMajesty” startup window 
on the monitor. 

 

4) Turn the Operate/Standby switch to   
 

 (OFF). 
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5) To remove the WUD, loosen the fixing screws using a 4-mm Allen wrench. 
 

 Protect the cuvettes from debris by covering them with gauze or Kimwipes. 

WUD fixing screw 

 
 
 

6) Detach the clogged nozzle and associated line of the port. 
 When the nozzle is detached from the line, liquid will drip from the nozzle 
tip. Use gauze to absorb the liquid. 

 If two or more nozzles must be detached from the lines, mark the number of 
the line on each nozzle to avoid confusion when reassembling. 

 

 
CAUTION 

 
 

 

Do not detach the red-marked lines. 
 

There are two types of connections: 1) a Silicon line, and 2) a joint  
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1) To remove a silicone line, pinch the line with your fingertips, lift upward, and pull out. 

 
 

2) Use two pairs of pliers to remove a joint connection. Holding the metal joint on the nozzle 
side steady with one pliers, loosen the resin joint with the other, then continue to turn it 
manually to remove. 

 
 

7) Insert a wire into the nozzle, and remove the clog. 
 

 Repeat for any additional clogged nozzles in the port. 
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8) Once the clog is removed, reconnect the nozzle to the line. 

Ensure that nozzles are reconnected to the correct lines according to the markings made 
in Step 6. 

1)  For the silicone connection, wipe the nozzle thoroughly with gauze and carefully insert it 
into the tube. 

2) For the joint connection, first twist the resin joint into the metal joint. Holding the metal 
joint with pliers, turn the resin joint manually to tighten. Using pliers, tighten the resin 
joint approximately 45 degrees further 

9) Return WUD to its operating position. 
1 Secure the WUD using the positioning pins on either side of the fixing screw 

hole. 

Confirm that there is no space between WUD and the fixing location. 

2 Verify that each nozzle is aligned above each cuvette. 
3 Ensure that all lines are securely connected to their respective nozzles. 

10) Remove the gauze or Kimwipe used in Step 5 to protect the cuvettes. 
11) After the cleaning is complete, turn the Operate/Standby switch to  “PC 

CONTROL.” 

If  
  (Off) or     (On) is selected, the analyzer does not turn on/off together with the 

workstation. 

12) Select “Re-start” in the “BioMajesty” startup window to re-start the system. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.”  

13) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
14) Check the WUD position 

1 Select [Maint.] > [Manual Operation]. The [Manual Operation] window is 
displayed. 

2 Double click [23.WUD] to open the [WUD] window. Click the [Move] button. 

WUD lowers a little. 

3 In the lowered position, check each nozzle is correctly in the midpoint of the 
cuvette. 

4 Click the [Init.] button. 

WUD returns to the home position. 

5 Click the [Exit] button to close the [WUD] window. 
6 Click the [Exit] button to close the [Manual Operation] window. 

15) Perform [INITIALIZE] and check no leakage is observed around the line 
joints. Also, confirm the system mode shifts successfully to “READY.”  

16) Perform the routine [WASH2] to verify that the wash process functions 
normally in the port where the clogging occurred. 
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7.8.1d Replace the mixing rod 
Impurities on the mixing rod of the mixer unit (MIX1, MIX2) may cause cross 
contamination.  Replace the mixing rod when it is noticeably soiled, deformed, or 
broken. 

 

Required tools Clean gauze (lint-free), a new mixing rod for 
replacement 

Required time 
(estimated) 

3 min (WASH3 is not included) 

Frequency of service As required 
System mode at 
service 

READY 

Workflow 1. Remove the mixing rod. 
2. Attach a new mixing rod. 
3. Clean the mixing rod. 
4. Check the position of the mixing rod. 
5. Perform “WASH.” 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 
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 How to replace the mixing rod 

1) Cover the cuvettes with gauze to protect them from debris or small parts 
entry. 

 

Mixing rod 
fixing plate 

 
 

2) Turn the resin fixing plate of the mixing rod clockwise (viewed from above). 
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3) Pull the mixing rod downward and outward as directed in the figure below. 

 
 

4) Insert a new mixing rod into the upper motor axis via the tip of the mixing 
rod’s silicone line.  

 Be careful not to exert pressure on the tip of the mixing rod. 
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5) Reinsert the mixing rod by pushing it upward, and rotate it 
counterclockwise (viewed from above) to reattach. 

 
  

6) Using gauze, gently clean the mixing rod 

Wipe the finger-touched sites with gauze. 

 Be careful not to exert pressure on mixing rod while cleaning. 
 

 
CAUTION 

 
 

 

Do not wipe the twisted part on the tip. 
 

 

Gauze  
 

7) Remove the gauze spread out for protection. 
8) Perform “INITIALIZE.” 

 

9) Verify the position of the mixing rod 
1 Select [Maint.] > [Manual Operation]. The [Manual Operation] window is 

displayed. 
2 Double click [44．MUD1] for the mixer 1 and [56．MUD2] for the mixer 2 to 

open the respective window. 
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3 Click the [Init.] button. 

The mixing rod returns to the wash port. 

4 Click the [Move] button twice. 

The mixing rod lowers in the cuvette. 

5 Click the [Exit] button. 

The [MUD1] or [MUD2] window is closed. 

6 Double click [45．MIX1] or [57．MIX2] several times at some interval. 

Check the mixing rod moves back/forth and right/left in the midpoint of the cuvette. 

7 Close the [Manual Operation] window. 

 

Cuvette 

Roller 

Arm 

Cuvette 

Mixing rod 

Mixing rod 

Cuvette midpoint 
 

 

 

 

Cuvette 

Mixing rod 
OK 

NG 

Mixing rod 

Mixing rod Cuvette 

Cuvette 

Cuvette midpoint 

Shifted from the midpoint 

 
 

10) Perform “INITIALIZE” and confirm the system mode turns to “READY.” 
11) Perform “WASH3.” 

Verify that the mixing rod does not touch the cuvette when it moves back and forth. 
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7.8.2 Ion selective electrode (ISE) unit 

7.8.2a Condition the Na and K electrodes 
New Na and K electrodes may produce variable results during the first few 
measurement cycles due to their characteristics. To avoid this instability, follow the 
steps below to condition the electrode on the day before they are replaced. 

 

Required tools New electrode, pool serum, buffer solution, clean 
gauze (lint-free) 

Required time 
(estimated) 

15 min 

Frequency of service At the electrode replacement 
System mode at 
service 

READY 

Workflow 1. Pour pool serum in the electrode. 
2. Immerse the electrode in the buffer solution 

for one night. 
3. Install the electrode in place and perform 

calibration. 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

1) Take the ion-selective electrode from its packaging. 
2) Remove the sponge from the package, and return the electrode in the 

package. 

Do not remove the cap attached to the electrode terminal. 
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3) Pour 0.5 mL of the pool serum into the flow pass that goes through the 
electrode.  

 Ensure that the pooled serum penetrates the flow pass. 

 
 

Warning 

Be sure to use non-antigenic serum to avoid the chance of viral infection.  
 

4) Add the ISE buffer solution to cover the whole electrode. 
5) Leave it as is overnight in the room temperature. 
6) Take the conditioned electrode from the packaging, wash it under running 

water, and dry it with gauze. 

Remove the cap attached to the electrode terminal for cleaning. 
 

Warning 

Wear gloves when removing the electrode to avoid direct contact with serum. Serum 
possesses a risk of viral infection. 

 

After completing the electrode conditioning as above, replace the electrode as indicated 
in the next section. 
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7.8.2b Replace the electrodes 
The electrode is expendable. A degraded electrode can induce measurement instability. 
To avoid this, replace the electrode as required.  

 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

• Be sure to change the status into [ISE-WASH-OFF] before 
performing the task.  If you perform the task in the [ISE-
WASH-ON] status, the scheduled wash is automatically 
activated, resulting in a serious accident or trouble.  

 
 

Required tools Electrode for replacement 
Required time 
(estimated) 

20 min (time for calibration is not included) 

Frequency of service Every three months or every 30,000 samples 
measured 

System mode at 
service 

READY 

Workflow 1. Remove the old electrode. 
2. Place a new electrode. 
3. Perform calibration 

 

 Condition the new electrode before use. Without conditioning, the new 
electrode may take time before stable results are obtained. 

 Before every use, wash the reference electrode with water, and dry it 
thoroughly. If residual preservative solution remains on the electrode while 
it is being used, the connector area may rust and produce inaccurate 
measurement values. 

 Parts required for replacement 

• Na，K，Cl，and Ref. electrodes (with O-ring) 
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 How to replace the electrodes 

 Preparatory step 

♦ Click the [ISE-WASH-ON] button on the Operation Panel to change the display to “ISE-WASH-

OFF.” 

 Remove the electrodes. 

1) Loosen the two screws to remove the cover over the ISE sampling position. 
2) Loosen the screw that affixes the stainless steel cover to the ISE unit, and 

slide the cover off. 
3) Prepare new electrodes. 

The Cl and reference electrodes will be wet upon removal from their packaging. Dry 
the Cl electrode thoroughly by wiping. Wash the reference electrode with water, and 
wipe thoroughly before use. 

Use conditioned Na and K electrodes. 

4) Remove the fixing screw that holds the electrodes in place. 
 

 Fixing screw 

 
Removing the fixing screw 

Release the fixing plate. This will also release the electrode assembly.  

 

Fixing plate 

 
Removing the fixing plate 

5) Detach the connectors from the electrodes. 
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6) Remove the electrodes manually. 

 
Removing the electrode 

 Insert the new electrodes 

New electrodes must be stored in the case until replacement. Follow the instruction 
below for installing the new electrodes.  

1) Place the electrodes in their indicated positions. 

Ensure that no gaps exist between the electrodes. 

Interlock the depressions and protrusions of each successive electrode in the assembly. 
 

 
CAUTION 
 

 
 

An electrode without an O-ring will leak liquid. 
 

2) Tighten the fixing screw by hand while pressing the fixing plate onto the 
electrode assembly.   

3) Insert the electrode connectors. 

 

Electrode color code 
 Yellow： Na 
 Red： K 
 Blue： Cl 
 Black： Ref 

 
Inserting the connectors 

 

 If a gap is present between the electrodes, the fixing plate will not fit in 
place. Shift each electrode slightly to correct the interlocking. Never force 
the fixing plate in place; this may cause damage to the plate. Tighten the 
fixing screw sufficiently. A loose assembly can be released during 
measurement, causing liquid leakage and malfunction. 
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 Perform “INITIALIZE.” 

♦ Click the [Execute] button to “Initialize” in the [ISE Operation] window. ( See Section 

7.10) 

Verify that liquid drains smoothly from the ISE dilution bowl during priming. 

 If liquid accumulates, press the “SYSTEM STOP” button to halt the analyzer. 

Next, replace the electrodes with the dummy electrode, and perform the “INITIALIZE” 
function. If liquid drainage becomes normal, a clogged electrode caused the drainage 
failure. 

Contact your local distributor in this case. 

7.8.2c Post-maintenance restoration of the ISE unit 

Following the maintenance procedure, perform the steps below to restore the unit for 
measurement. 

1) Slide the stainless cover over the unit and secure it with screws. 

Be careful not to damage the tubes or dilution bowl. Ensure that the cover is securely 
set in the gutters. 

2) Attach the cover over the ISE sampling position. 
3) After completing the above steps, wash the electrodes as shown in 

“Section 7.3.2c.” 
4) Perform calibration 

 Be sure to perform calibration after electrode replacement. 
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7.8.2d Store the electrodes 

Store the unopened electrodes in the case provided in the dark at room temperature. 

Wash the electrodes before removing them from the unit. 

Once-used electrode is left out of the unit for more than 30 minutes, follow the steps 
below for storage. 

 
 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, mask, and gloves when you 
perform the service. 
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How to store the electrodes 

Item Na: K Cl Ref 

Storage 
place 

Refrigerator Room 
temperature 

Management Place the electrode in the provided case as follows 
In the case Buffer solution to cover the 

electrode 
Buffer solution 
to cover the 
electrode 

Pure water 
soaked sponge 

Notes   Activity will be 
lost if the Cl-
selective 
molybdenum 
oxide film dries 
out. The film 
exposed to the 
inner side of 
the flow pass is 
invisible from 
the outside.  
Immerse it in 
the ISE buffer 
solution when 
not in use. 

The inner 
structure will 
shrink when 
dried. 
The life of the 
electrode will 
be shorter 
when it is in 
contact with a 
large amount 
of pure water. 
Never immerse 
in NaCl 
solution, as it 
generates a 
liquid-junction 
potential that 
interferes with 
measurement 
accuracy. 

Precautions 
for use 

Be sure to wash the connector with water before use to avoid rust 
formation. Bring the refrigerated electrode to room temperature to avoid 
data drift. 

 

Silver-lined part of the electrode may accumulate rust during long-term storage. To 
avoid rust formation, store the electrode with the cap that was originally attached to the 
electrode terminal. 
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7.8.3 Workstation 

7.8.3a System backup to DVD 

The BM6010/C application is based on the Windows XP Operating System. It consists 
of the analyzer’s operation software, data processing software, and user-specific 
settings and data files. Because each user is associated with different settings, perform 
backup after modifying your settings. 

We recommend that the user create a duplicated DVD backup copy of the application. 

 Backup to DVD 
 

Required tools DVD disk (2 disks recommended) 
Required time 
(estimated) 

10 min 

Frequency of service After the settings have been modified, or before 
the hard disk is defragmented. 

System mode at 
service 

“BioMajesty” startup window 

Workflow 1. Insert a DVD disk in the disk drive of the 
workstation computer. 

2. Begin backup from the startup window. 
 

DVD+RW or DVD+R disks are used for backup. Normally, when the system settings 
are saved to a DVD, a folder of the current date is generated, and the settings are 
copied there. A folder with the backup date also is added to the disk for every backup. 
Backup folders cannot be deleted from the DVD+R disk but can be deleted from the 
DVD+RW disk. Initiate the backup from the “BioMajesty” startup window. 

 

1) Confirm the system mode is “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Prepare a DVD disk and insert it in the DVD drive. 
4) Click the [Back-up] button in the lower right of the “BioMajesty” startup 

window to display the [Backup Tool] window. 
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5) Confirm that “Make a Backup Copy” is selected in the [Backup Tool] 
window. 

6) Select “System Files” for [Target Files]. 

Deselect “Data Files.” Confirm that the “Total size” is smaller than the “Space 
Available.” If not, use a new disk. 

7) Select “DVD drive” for [Destination Folder]. 

To select, use the [Browse...] button. 
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8) Click the [Execute] button. 

A confirmation window will be displayed, asking <Do you want to make a backup copy 
to “D:/..."?> (the DVD drive is represented as "D:¥”). Click [OK] to begin Backup. 

 
 

A new folder of the current date will be created in the DVD（D:¥）disk, shown as 
20090203 in the above window. The settings are backed up in this folder. 

9) When backup is completed, a confirmation window is displayed. Click [OK]. 

The window will close, and a [Backup Tool] window will be displayed. 
 

10) Click the [Exit] button to return to the “BioMajesty” Startup window. 
 

11) Take out the DVD disk, and mark it with the date/version prior to storage. 
 

12) Duplicate this DVD for safety. 

Alternately, the steps above can be repeated to create another backup disk directly. 

 When two or more analyzers are used, backup the system settings for each. 

7.8.3b System restore using the backup disk 

If system malfunction occurs, contact your local distributor before using the backup 
disk to restore your BM6010/C system application. 
The system specifications and settings will be restored to the state that was last backed-
up to the disk. Confirm that the current version of the application used in the system is 
the same as that stored in the disk. 

1) Confirm the system mode is “WAIT” or “READY.” 
2) Exit the workstation system and display the “BioMajesty” startup window 

on the monitor. 
3) Insert the DVD disk created above in the disk drive. 
4) Wait for a while and click the [Back-up] button in the lower right of the 

“BioMajesty” startup window to display the [Backup Tool] window. 
5) Select “Restore a Backup Copy” in the window. 
6) Click the [Browse] button for the [Source Folder] field to browse the DVD 

drive (indicated above as “D:￥”), Click and highlight the file of the date 
that you want to use for recovery. Click [OK]. 

7) The file name is displayed in the [Source Folder] field. Click [Execute] to 
begin restoration. 
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8) When the restoration is complete, the confirmation pop-up window is 
displayed. Click [OK] to close the window and return to the [Backup Tool] 
window. 

9) Click [Exit] and return to the “BioMajesty” startup window. 
10) Take out the DVD disk. 
11) Start the system in the “New Start” mode. 

Check and modify the settings if required before use. 

 Cuvette blank, calibration, and QC data are not restored. You need to 
obtain the new data. 



 

 

ICABM6010/C-4  7-135 

C
hapter 7 

M
aintenance 

 

7.9 Specific Cases 
7.9.1 When the pure water bottle becomes empty 

If you perform measurements with an insufficient supply of pure water, the “Pure tank 
supply Time Over-1” alarm will sound. If you continue to collect data during this status, 
the “Pure water tank float sensor LOW” alarm will sound. At this point, the analyzer 
will enter the “Processing” mode, and sample analysis will be suspended.  

The large water pump (LWP) gauge will indicate an abnormality, and air bubbles will 
start to form in the LWP that supplies water to wash the outer wall of sample probe 
(outer wall) and mixing rod. Air bubbles also will form in the sampling and reagent 
wash pump (SRWP) that supplies wash water to the sample probe (inner wall).  

When the “Pure water tank float sensor LOW” alarm sounds, press the [SYSTEM 
STOP] button, and put the system into “WAIT” mode. Then, follow the steps below. 

 

Required tools Gauze or Kimwipe 
Required time 
(estimated) 

20 min (WASH is not included) 

Frequency of service As required 
System mode at 
service 

WAIT 

Workflow 1. Check the pure water supply unit. 
2. Degas the pure water lines. 
3. Perform “WASH” to degas the pumps. 

 
 

Warning 

 

• Read the “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

 Steps to take after the pure water tank becomes empty 

1) Press the [SYSTEM STOP] button on the power panel of the analyzer to put 
the system in the “WAIT” mode. 

 Do not perform “INITIALIZE.” 

2) Select [Maint.] > [Manual Operation] to display the [Manual Operation] 
window. 
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3) If the pure water supply unit has a problem, eliminate it and restore the 
unit to the normal status. 

4) Wait for the pure water bottle to be filled. 

When the bottle becomes full, [72.WEV] switches to “OFF” in the [Manual Operation] 
window. 

5) Degas the LWP. 
1 Double click [59.VP] in the [Manual Operation] window to turn VP “ON.” 

Double click [61.VDP] in the [Manual Operation] window to turn VDP “ON.” 

2 Remove the fixing screw that secures the manual cock.  
3 Open the manual cock for 3 seconds, then close it. 

Do not keep opening the manual cock for more than 5 seconds a time. 

 

Manual cock 

  
Close 

（usually） 
Open 

Manual cock 

Fixing screw 

 
 

4 Double click [61.VDP] to turn VDP “OFF.” 
5 Double click [59.VP] to turn VP “OFF.” 

6) Adjust the flow rate for LWP 
1 Double click [71.VWP] in the [Manual Operation] window to turn it “ON.” 
2 Turn the LWP regulator valve counterclockwise to the limit to open, and 

leave it in the open status for approximately 3 seconds. 

In response, the alarm for abnormal LWP gauge should sound.  Click the [BUZZER] 
button in the Operation Panel to stop the alarm.  

3 Turn the LWP regulator valve clockwise to its limit to close it. Check the 
LWP pressure gauge reading. 

 Degassing is successful when the gauge reads > 100 kPa. If the pressure 
does not reach this level, air may be still trapped in the line. Repeat the 
opening/closing sequence with the LWP regulator valve 3–4 times at 20-
second intervals, or click [71.LWP] to turn on and off for 3-4 times at 20 
second intervals. If the pressure is still low, repeat the steps from 5 onwards. 
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 Flow rate adjustment valve 

Pressure gauge 
 

 

4 When the pressure comes in the normal range, slowly turn the LWP 
regulator valve counterclockwise to regulate the pressure at 70 - 72 kPa. 

Click the [ALARM] button in the Operation Panel to delete the error message. 

7) Degas the probe wash port lines. 
1 Confirm the pressure is in the range of 70 - 72 kPa. 
2 Cover the sample probe (SPP) wash port with gauze or Kimwipe sheets. 

This is for avoiding splash of water solution in case the wash solution may shoot out. 

 
Covering the SPP wash port with 4-5 sheets of Kimwipe 

 

3 Click [21.SPEV2] in the [Manual Operation] window. 
 Do not double click [21.SPEV2]. If you double click it, the solenoid valve 2 
(SPEV2) for the sampling pump opens immediately to supply the wash 
solution. 

4 Press the Enter key on the computer keyboard. 

SPEV2 opens. If air is trapped, the sound of air purging will be heard for a few seconds. 
After this, no air bubbles will be evident.  

5 Press the Enter key when no air bubble is evident. 

SPEV2 closes and water supply stops. 

 If the sound of air purging is heard for more than 5 seconds, press the 
Enter key to close [SPEV2]. Press the Enter key again in a few seconds to 
open SPEV2. Confirm the purging sound is no longer heard. 

 Before you repeat the steps for confirmation, replace Kimwipe sheets. 
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6 Remove the gauze or Kimwipe sheets, and press the Enter key. 

SPEV2 opens. Check if the wash solution comes out properly in the wash port. 

7 After checking the proper supply of wash solution, press the Enter key 
again. 

SPEV2 closes. 

8 Repeat Steps 1 - 7 for the other probes and mixing rods respectively. 

The following units require degassing. 
 

Probe Unit 

SPP 21.SPEV2 
RPP1 42.RPEV2-1 
RPP2 54.RPEV2-2 
MIX1 46.MWEV1 
MIX2 58.MWEV2 

 

8) After completing degassing the lines of all probe and mixer wash ports, 
close the [Manual Operation] window, 

9) Perform “INITIALIZE” and confirm the system mode shifts to “READY.” 
10) Check that no liquid leakage is observed in the analyzer. 
11) Degas other lines. 

1 Perform “PRIME2” or “PRIME3.” Set “10” for “Times” for all the three 
primings.  

2 Perform “WASH3.” 
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7.9.2 Degas the cuvette wash solution and cuvette conditioner lines 

If the nozzles aspirate air from empty detergent or cuvette conditioner bottles, follow 
the steps below to degas the lines. 

When a large amount of air is trapped in the cuvette wash solution and conditioner 
lines, wash solution will drip from the R2 or R4 nozzles of WUD. If this occurs, stop 
the analyzer immediately. 

 

Required tools Clean gauze (lint-free) or Kimwipe 
Required time 
(estimated) 

10 min 

Frequency of service As required 
System mode at 
service 

WAIT 

Workflow 1. Degas. 
2. Perform “WASH3.” 

 
 

Warning 

 

• Read “Safety Precautions” and “Usage Notes” before 
starting this task. 

 
 

CAUTION 

 

• Wear protective glasses, a mask, and gloves when you 
perform this service. 

 

 How to degas the cuvette wash solution line 

The analyzer is in the “WAIT” mode. 

1) Verify that the line joint is tightly connected to the cuvette wash solution 
bottle cap. 

2) Confirm that there are no impurities on the mesh filter attached to the 
aspiration nozzle in the bottle. 

3) Select [Maint.] > [Manual Operation] to display the [Manual Operation] 
window. 

4) Double click [59.VP] to turn the VP “ON.” 
5) Double click [24.AEV1] and [62.VEV1] to turn the solenoid valves “ON.” 
6) Wait for 10 seconds and then perform “INITIALIZE” and confirm the system 

mode turns to “READY” 
7) Perform “WASH3,” and confirm that solution does not drip from the R2 

nozzle in the WUD. Confirm also that air does not intrude from the line 
joint attached to the solution bottle cap. 
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 How to degas the cuvette conditioner line 

1) Verify that the line joint is tightly connected to the cuvette wash solution 
bottle cap. 

2) Confirm that there are no impurities on the mesh filter attached to the 
aspiration nozzle in the bottle. 

3) Select [Maint.] > [Manual Operation]. The [Manual Operation] window is 
displayed. 

4) Double click [59.VP] to turn the VP “ON.” 
5) Double click [34.DCEV] and [63.VEV2] to turn the solenoid valves “ON.” 
6) Wait for 10 seconds and then perform "INITIALIZE" and confirm the system 

mode turns to “READY.” 
7) Perform “WASH3,” and confirm that solution does not drip from the R4 

nozzle in the WUD. Confirm also that air does not intrude from the line 
joint attached to the solution bottle cap. 

7.9.3 Power outage 

When a power outage is planned, turn off the power to the workstation and analyzer in 
advance. When the power is restored, startup the system as normal. If the power outage 
lasts for several hours, store the reagents in the refrigerator. 

In case of an unexpected power outage, follow the steps below to restart the system. 

 If the system does not start normally after performing the following steps, 
the application may be broken.  Contact your local distributor. 

 When the power is not restored after a power outage 

1) Confirm the Operate/Standby switch is in the “PC CONTROL” position. If 
the workstation has a power switch, set it in the off state.  

Follow the steps below after the power is restored. 

2) Turn on the analyzer. 

Turn on the work station if the workstation power does not turn on automatically with 
the analyzer. 

3) In the “BioMajesty” startup window, select “Re-Start” and press [OK]. 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.”  

4) Perform “INITIALIZE.” 

Confirm the system mode enters the “READY” mode. 

5) Check if the data before power outage have been saved. 
6) If the reagents have already been dispensed in the cuvettes, wash the 

cuvettes, 

Perform “WASH3” to wash the cuvettes. 
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If they are left for over 30 minutes, perform “WASH2” with Reagent probe wash S (5% 
dilution). 

 When the power is restored soon after the power outage 

If the workstation is on after the power restoration, follow the steps below. 

1) If the “BioMajesty” startup window is displayed, click the [Shutdown] 
button to shut down the system as usual. 

2) Turn off the workstation, and wait for approximately 20 seconds. 
3) Turn on the workstation. 

The “BioMajesty” startup window is displayed. 

4) Select “Re-Start” and click [OK] 

Wait for several seconds and confirm the Operation Panel shows the system mode 
“WAIT.” 

5) Perform “INITIALIZE.” 

Confirm the system mode enters the “READY” mode.  

6) Check if the data before power outage have been saved. 
7) If the reagents have already been dispensed in the cuvettes, wash the 

cuvettes, 

Perform “WASH3” to wash the cuvettes. 

If they are left for over 30 minutes, perform “WASH2” with Reagent probe wash S (5% 
dilution). 
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7.9.4 Long-term suspension of operation 

If the analyzer is not used for 4 days or longer, the wash lines of the reaction carousel 
wash unit (WUD) may become dried and clogged. Follow the steps below before and 
after a long-term suspension of operation. 

 Before a long-term suspension of operation 

1) Perform “WASH2.” 

Perform “WASH2” after the day's operation as usual. 

2) Fill the Cuvette conditioner and wash solution lines with pure water. 
1 Remove the aspiration lines from the Cuvette conditioner and Cuvette wash 

solution bottles, rinse them, and place them in a beaker with approximately 
500 mL of pure water. 

 Cover the bottles to protect them from dust and debris. 
 

 
CAUTION 

 
 

 

 Leave the reaction bath oil (ACUR30) as is.

 

 (This is IMPORTANT.) 

2 Perform “WASH3.” 

Fill the Cuvette conditioner and wash solution lines with pure water. 

3) Fill the ISE drain line with pure water. 
1 Replace the Na, K, Cl, and Ref. electrodes with the dummy electrode. 
2 Fill the ISE dilution bowl with water using a dropper. 
3 Select [Maint.] > [ISE Operation]. Enter “5” for [Times] in the [Dil Bowl drain] 

area, and click [Excute]. 

The ISE drain line is filled with pure water. 

 In case the system is not used for one month or longer, replace the buffer 
bottle with a water-filled container. Perform “Prime” after entering “50” for 
[Times] to fill all lines with water. Store the electrodes as instructed in the 
section 7.8.2d. 

4) Store the reagents. 

Cover the detergent and reagent bottles on the reagent tray (RTT) with parafilm. 

 Be sure to remove the cover before starting up the system next time. 
 

5) Discard the detergent in the refrigerated sample tray (CTT). 
 

6) End and shut down the system. 
 

 Deselect “Auto Startup” if it has been selected. 
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 After a long-term suspension of operation 

1) Check that crystals have not formed on the tips of the metal nozzles of the 
WUD. 

• Port 2 (Red 2): Cuvette wash solution 

• Port 4 (Red 4): Cuvette conditioner 

 If crystal formation or clogging is suspected, take out the WUD unit and 
remove the crystal or clog by inserting a wire through the nozzle. (Do not 
disconnect the joint. See Section 7.8.1c) 

2) Return the aspiration tubes to their respective bottles in the detergent 
compartment. 

Remove the cuvette conditioner and wash solution lines that had been stored in pure 
water. Wipe them dry, and place them back in the bottle. 

3) Start up the system. 
4) Remove the dummy electrode and place the Na, K, Cl, and Ref. electrodes 

back. 
5) Place the wash solutions on the refrigerated sample tray (CTT), 
6) Return the reagents to the positions as before. 

Remove the parafilms that cover the wash solutions and reagents on the reagent tray 
(RTT). 

7) Perform “PRIME1.” 
8) Perform “WASH3.” 

 After “WASH” begins, observe the movement of the WUD unit to ensure that 
the silicone lines do not disconnect, and that leakage does not occur. 

9) Start the routine measurement. 
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7.10 ISE Operation Window 
You can operate the ISE unit alone from the [ISE Operation] window. This section 
describes the operations of ISE unit available from this window, including those used 
for maintenance. Select [Maint.] > [ISE Operation] to display the [ISE Operation] 
window. 

 

Operation 
area 

Display 
area 

 

[ISE Operation] window 

• The [ISE Operation] window consists of the display area and the operation area. The 
display area shows the operational status, operation time, and regular wash type. The 
operations are possible in the system modes of “WAIT” and “READY.” 

• However, when the system mode is “WAIT,” only the functions “Initialize,” “Prime,” 
and “Manual operation” are available. 

• Operations made from the [ISE Operation] window can be performed if the system 
mode is “READY,” and no other messages are displayed. 

• When the following ISE operations are being performed, the system mode window in 
the Operation Panel shows “ISE only” or “ISE wash.” The display area in the [ISE 
Operation] shows the on-going ISE operation. 

- Calibration 
- Electrode wash 
- CV check 
- Interval check 
- Selectivity check 
- Final 
- ISE line wash 
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• The settings made in the [ISE Operation] window are only valid when the order is 
submitted using the [Execute] button in this window.  The settings entered in this 
window do not affect the default settings. 

 

 When priming, electrode wash, or calibration is performed from the [PRIME], 
[WASH], or [START] button, the settings made in the [ISE Parameter 
Settings] window are used. 

 [Prime]  

 
 

1) Enter 1 - 99 for [Times]. 
2) Click the [Execute] button. 

The display area shows “Prime Running” with the approximate time until the end of 
priming. 

3) Click [Cancel] to abort the operation. 

 [IS Line]  

 

1) Enter 1 - 10 for [Times]. 
2) Click the [Execute] button. 

The display area shows “IS line prime Running” with the approximate time until the 
end of the line priming. 

At the end of operation, priming is automatically performed for 4 times. 

3) Click the [Stop] button to abort the operation. 

 [Calibration] 

 
 

1) Select “Serum” or “Urine” for the calibration type. 

Check for “Do” to select. Both of [Serum] and [Urine] can be selected. 

2) Enter the positions of the low-concentration standard (L-STD) and the 
high-concentration standard (H-STD) on the refrigerated sample tray (CTT) 
for the selected calibration type. 

3) Select a container type in the [Container] field. 
4) Position L-STD and H-STD in the selected container respectively and set 

them on the designated position. 

Mix the solution well by inversion, and pour 500 μL into the sample container. 
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5) Click the [Execute] button. 

Calibration begins and the display area shows “Calibration Running” with the 
remaining time until completion. 

6) Click the [Cancel] button to abort the operation. 
 If the operation is canceled, the calibration values will not be updated. Wait 
for the system mode to display “READY” to restart the calibration. 

 [Wash Electrode] 

 
 

1) Enter the CTT position # in the [Detergent posi.] field and select a 
container type. 

2) Pour 100μL of the ISE Detergent Solution in the selected container and 
place it on the CTT position # designated in Step１. 

3) Click the [Execute] button. 

The display area shows “Wash Electrode running” with the approximate time until 
completion. 

 [CV check] 

 
 

After completing the above maintenance services of the ISE unit, perform “CV 
(coefficient of variance) check” to assess the reproducibility of measurement values 
and the proper operation. 

1) Select a sample type from serum and urine for [Samp.type]. 
2) Enter [CTT posi.] and select a container type for [Container] for the sample. 
3) Set the sample in the selected container and place it on the designated 

CTT position #. 
4) Enter 1 - 99 for [Times]. 

Approximately 30 μL of the sample is required for one check. 

5) Enter comment as required in the [Comment] field. 

The entered comment is displayed in the report. Use this function as required for data 
organization. 

6) Click the [Execute] button. 

The display area shows “CV check Running” with the approximate time until 
completion. 

If the CV is measured for twice or more, the results will be processed statistically. 
When the measurement is performed only once, an alert is displayed to indicate that the 
measurement time is insufficient for statistical processing. 

7) Click the [Cancel] button to abort the operation. 
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 [Interval check] 

 
 

The “Interval check” is performed at intervals to measure the data reproducibility and 
confirm the operation. 

Two interval types are available. Type A is performed at intervals of 18–72 seconds, 
and type B is performed every 360 seconds. 

 

1) Select a sample type from serum and urine for [Samp.type]. 
2) Enter the CTT position # in the [CTT posi.] field and select “Tube” for 

[Container]. 

The measurement takes 40 - 60 minutes. Take the evaporation into consideration in 
selecting a tube capacity. 

3) Set the sample in the selected container and place it on the designated 
CTT position #. 

The required sample volume is 1.5 mL or more. 

4) Select a check type from A or B for the [Mea.typ] field. 
5) Enter comment as required in the [Comment] field. 

The entered comment is displayed in the report.  Use this function as required for data 
organization. 

6) Click the [Execute] button. 

The check begins and the display area shows “Interval check Running” with the 
approximate time until completion. 

7) Click the [Cancel] button to abort the operation. 

 [Selectivity check] 

 
 

Check the selectivity of the electrodes using the selectivity check solution. 

Different selectivity check solution is available respectively for Na and K electrodes. 

1) Select “Na” or “K”. 

You can also select both. 

2) Enter the CTT position # and select a container type for the check solution 
corresponding to the selected electrode. 

3) Put the selectively check solution in the selected container and place it on 
the designated CTT position #. 

4) Enter comment as required in the [Comment] field. 

The entered comment is displayed in the report.  Use this function as required for data 
organization. 
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5) Click the [Execute] button for the selectivity check. 

The check begins and the display area shows “Selectivity check Running” with the 
approximate time until completion. 

The measurement is repeated three times and the second and third measurement values 
are averaged. When the value exceeds the upper limit of selectivity defined in the [ISE 
Parameter Settings] window, the third measurement value is flagged with a “u.” The 
measurement values are displayed with the date in the [ISE Monitor] window. 

6) Click the [Cancel] button to abort the operation. 
 When aborted, the data are not statistically processed. 

 [Final operation] 

 
 

The “Final operation” is performed before shutting down the system at the end of the day. 
The ISE dilution bowl is filled with water, and the regular wash is automatically 
canceled, preventing buffer solution from being used. 

1) Click the [Execute] button for the “Final operation.” 

When the “Final operation” begins, “Final operation Running” is displayed along with 
the approximate time until completion. “Period wash OFF” also is displayed at this 
time. Pure water is dispensed into the dilution bowl five times, filling it with 
approximately 950 μL of water in total. This operation cannot be suspended. 

 To resume the sample run after the “Final operation,” select “INITIALIZE” 
from the Operation Panel or from the “ISE Operation” window. Perform a 
calibration to obtain the calibration values before running samples.  

 [Manual operation] 

 
 

Use this area to operate each part of the ISE unit for maintenance or for assessing 
proper operation. 

The manual operations are possible when the ISE unit is in the operable state, even if 
the system is in “WAIT” mode according to the Operation Panel. 

Manual operation of ISE unit parts triggers a display of “Manual operation running.” 
The scheduled ISE wash then is automatically canceled. 

 When “Manual operation running” is displayed, only “Manual operation” and 
“INITIALIZE” can be performed.  After completing the “Manual operation,” 
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be sure to click [Exit] in the “Manual operation” area, or click [Execute] for 
[Initialize] in the [Manual Operation] window. Confirm the display of “Final 
operation Running” disappears. Also, click the [ISE-WASH-OFF] button to 
turn to [ISE-WASH-ON] in the Operation Panel. 

 Double click the abbreviated name of the part to operate. 

Once the part name is clicked, an associated window will be displayed for operation. 
To operate another part, close this window. 

Name of the part and operation 

Abbrevi
ation 

Full name Function  Operation 

BP Buffer pump DOWN/U
P 

Click the [Toggle] button in the pop-up 
window. 

Initialize Click the [Init.] button in the pop-up 
window. 

BPEV Buffer pump 
solenoid valve 

OFF/ON Double click [2.BPEV] or press [Enter] 
key on the keyboard. 

DPEV Drain pump 
solenoid valve 

OFF/ON Double click [4.DPEV] or press [Enter] 
key on the keyboard. 

MIXER Mixer OFF/ON Click the [Toggle] button in the pop-up 
window. 

 Initialize Click the [INIT.] button in the pop-up 
window. 

ISPEV Internal 
Standard 
solution 
solenoid valve  

OFF/ON Double click [7.ISPEV] or press [Enter] 
key on the keyboard. 

 

 To measure the electrode potentials, click the [AD execute] button. 

The potentials of Na, K, and Cl electrodes as well as Thermister1 and Thermister2 are 
displayed. 

 [ISE line wash] 

 
 

In “STEP-1,” ISE Detergent Solution is introduced in the dummy electrode. The 
detergent solution backs up in the ISE dilution bowl and remains there for 1 minute.  
The detergent solution then fills the lines and remains there for another minute, 
cleaning the bowl and the lines. 

In “STEP-2,” priming is repeated 10 times to restore the unit to a measurement-ready 
status. 
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When dialysis samples are run often, perform the line wash. See the maintenance table 
on page 5 for wash frequency. 

 Be sure to replace the electrodes with the dummy electrode when 
performing the line wash. 

1) Click the [ISE-WASH-ON] button in the Operation Panel to turn it to [ISE-
WASH-OFF]. 

2) Remove the Na, K, Cl, and Ref. electrodes in the ISE unit, and place the 
dummy electrode. 

3) Uncap the dummy electrode, and add 5 mL of ISE Detergent Solution 
using a dropper. 

4) Tighten the cap of the dummy electrode. 
5) Click the [Execute (STEP-1)] button in the [ISE line wash] area. 

The wash begins, and the display shows “ISE line wash1 Running.” This function lasts 
approximately 16 minutes. 

6) Once “STEP-1” is completed, replace the dummy electrode with the actual 
electrodes. 

The wash is completed when the “ISE line wash1 Running” display disappears. 

7) Click the [Execute (STEP-2)] button in the [ISE line wash] area. 

This will initiate the wash, and the display will show “ISE line wash2 Running.” 
Priming is automatically performed. This function lasts approximately 1 minute. 

8) Click the [ISE-WASH-OFF] button in the Operation Panel to turn it to [ISE-
WASH-ON]. 

 [Dil Bowl drain] 

 
 

Use this operation to drain the pure water and buffer solution remaining in the dilution 
bowl after washing. 

1) Enter 1 - 99 for [Times]. 

Enter “5” for [Dil Bowl drain]. 

2) Click the [Execute] button in the [Dil Bowl drain] area. 

Draining begins, and the display area shows “Dil Bowl drain Running” with the 
approximate time until completion. 
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 [Initialize] 

 
 

Use this operation after the manual operation of the parts of the ISE unit or 
troubleshooting. 

 Click the [Execute] button. 

Initialization begins and the display area shows “Initialize Running.” No remaining 
time is shown. 

After the initialization is completed, the display of “Dilution Bowl drain” disappears. 

 If there is no problem remaining, each part of the ISE unit should be in the 
correct position. 

 [Batch print] 

 
 

You can print the most recent data of “CV check,” “Interval check A” and “Interval 
check B.” 

 Click the button to print the relevant data. 

A pop-up window is displayed. Click [YES]. The display area shows “Printing” and the 
data are printed. 

 [IS Remain vol.] 

 
Use this area to check the remaining volume of the Internal Standard (IS) solution. 

When you replace the IS bottle, click the [Change] button and follow the instruction 
displayed in the window. 

See “Section 7.3.2b Check the remaining volume of IS solution” for the steps to replace 
the IS solution pack. 
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 Setting button 

Click this button to display the [ISE IS solution setting] window. 

 
 

Define the alarm settings for the remaining volume. If the remaining volume becomes 
insufficient for the number of tests entered for [# for Remaining tests], the bar 
representing the volume will be displayed in yellow. Select “Yes” for [Warning sound] 
to sound an alarm when the volume becomes insufficient for the defined number of 
tests. 

Select “ml” or “# of tests” under [Display by] as the parameter for the graphic display. 
The display of the [ISE IS solution remaining volume] window in the [Operation mode 
details] will follow the selected setting. 

“# of tests” is calculated by dividing the remaining volume by the consumption volume 
per test. The test is assumed to be performed intermittently on serum, which consumes 
the maximum volume. Therefore, the calculated and actual remaining “Times” may 
differ. The “ml” reading indicates the accurate volume based on the system’s record of 
the actual consumed volume in total. 

Click the [Clear] button to reset to the default setting. 

Click [Cancel] to quit the window without saving the setting. 

Click [OK] to save the setting and close the window. 
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7.11 Maintenance List 
Use the list below to record the routine maintenance items. 

Print or copy the list. 

• Monthly list 

• Annual list 
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Monthly Maintenance List 

Daily Maintenance 

Month:             

Date 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 

Check water quality                                 

Check the probes for impurities                                

Check the mixing rod for impurities                                

Check the nozzles of the WUD 
unit for impurities                                

Check the wash ports of probes 
and mixing rods for impurities                                

Check the splash cover for 
impurities                                

Check for potential leakage from 
pumps                                

Check the remaining volume of the 
lamp coolant                                

Check the level of the ISE Buffer                                

Check the level of the ISE Internal 
Standard solution                                

Wash the electrodes                                

Wash the ISE dilution bowl                                 

Wash the electrode lines (*)                                

                                

                                

                                

 
 

Weekly Maintenance 
 Week 1 

Date: 
Week 2 
Date: 

Week 3 
Date: 

Week 4 
Date:  

Week 5 
Date: 

Check the lamp energy      

Cuvette blank 
measurement      

WASH-2 with Reagent 
probe wash-S      

Wash the electrode lines 
(*)      

Shut down the 
workstation      

      

      

      
 

The optimal maintenance frequency depends on the usage for items with (*). Read the relevant chapter 
carefully to set the frequency. 
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Annual Maintenance List 

Maintenance service performed at intervals of 1 - 6 months 

Year:             

Date / / / / / / / / / / / / 

Soak and wash the mixing rods             

Clean the sample setting areas in the STT/ CTT,  
and  the refrigerated reagent compartment in RTTs 

            

Clean the chiller filter             

Clean the line filter of the LWP              

Clean the waste fluid lines of probe and mixing rod 
wash ports 

            

Clean the exterior panels of the analyzer             

Clean the vent fans and grids             

Clean the ISE waste drain nozzle             

Clean the cuvette wash solution and conditioner 
bottles 

            

Clean the filters in the cuvette wash solution and 
conditioner bottles 

            

Clean the aspiration lines of the reaction carousel 
wash unit (WUD) 

            

Disk defragmentation of the Windows XP-based 
workstation 

            

             
 

Parts Replacement / Irregular Maintenance Service 
 Date / Unit 
Regular replacement 
Replace the 
spectrophotometer lamp (*) 

            

Replace the reaction 
cuvettes (*) 

            

As required 
Replace probes 
(SPP, RPP1, RPP2) 
 

 
 

           

Replace the seal of the 
pumps 
(SP,RP1,RP2,SRWP) 

            

Replace the mixing rods 
(MIX1,MIX2) 

            

Replace the electrodes of 
the ISE unit 
(Ref,Na,K,Cl) 

            

Backup the system data on 
DVD 

            

             

The optimal maintenance frequency depends on the usage for items with (*). Read the relevant chapter 
carefully to set the frequency. 
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8.1 Emergency stop and steps to 
resume operation 

1) If it is necessary to stop the analysis during operation, press the [SYSTEM 
STOP] button on the power panel. 

The analyzer will stop operation immediately. 
 

2) Restart the analyzer to the "READY" mode. 

If reagents were being dispensed into the cuvettes at the emergency stop, the cuvettes 
will need to be washed. Perform the normal or weekly [WASH2] procedure as 
described in the chapters 4 and 7. 
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8.2 Resuming operation after manually 
turning off the analyzer 

 
If you have started up the workstation without using the PC control function and 
turned off the analyzer manually, follow the steps below to resume operation with 
the PC control function. 

 
1) Turn the operate/standby switch to the "OFF" position once and then to 

the "PC CONTROL" position. 
 

2) Shut down the workstation once and restart. 
1 Click the [System (S)] command button on the top bar in the Menu Panel and 

select "Exit (X)" in the drop-down menu. 

A window is displayed to ask for confirmation. 

2 Click [Yes]. 

Another window is displayed to ask for confirmation. 

3 Click [Yes]. 

Approximately 15 seconds later, BioMagesty startup window is displayed.  
 

3) Start up the workstation. 
1 Select "Restart" as the start-up mode. 
2 Click [OK] 

Workstation is started and the Menu Panel and Operation Panel are displayed. 

The system mode displayed in the Operation Panel changes into "WAIT" from "SYSTEM 
INIT." 

 

3 Restart the analyzer to the [READY] mode. 

If reagents were being dispensed into the cuvettes at the emergency stop, the cuvettes will 
need to be washed. Perform the normal or weekly [WASH2] procedure. 
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8.3 Alarm handling 
Checking the alarm 

When the system detects an error in analyzer function, an error message is displayed in 
the lower left space in the Operation Panel.  Or the buzzer (alarm) sounds. 

 
 Click the [BUZZER] button to stop the sound. 

 

Checking the error details 

1) Click the [ALARM] button in the Operation Panel. 

Or select [Maint.] in the Menu Panel and then [Error Report]. 

The [Error Report] window is displayed. 

 
In this window, the error information is displayed in reverse chronological order (from 
latest to earliest). 

 

2) Double-click the line of the event you would like to check. 

The [Error Report Details] window shown below opens to display details of the error.  
Follow the instructions listed under "ACTION". 
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Types of alarms 

Alarms sound both during operation and when the analyzer halts.  

There are three ways the analyzer may respond after the alarm sounds: 

• An alarm sounds and an error message is displayed while the operation continues. 

• After the alarm sounds, sample dispensing stops, and the analyzer pauses in the 
"WAIT" mode after completing the ongoing measurements. 

• After the alarm sounds, all operations immediately stop, and the analyzer pauses in 
the “WAIT” mode. 

 

When the analyzer suspends in the “WAIT” mode after the alarm sound, it indicates a 
problem in the  system that makes it unsafe to continue to use the analyzer.  Do not 
restart the analyzer before fixing the problem.  
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8.4 Typical alarms and 
countermeasures 

 

Alarm # Error message / site Cause / countermeasure 

0903 Cuvette blank calculation 
error 

【Cause】 
1. A possible cause is an improper lamp 

function. The lamp function may be 
unstable immediately after replacement. 

2. A possible cause is the degradation or 
insufficient washing of the reaction 
cuvette. 

3. A possible cause is the shortage or 
waving of the reaction bath oil. 

 

【Countermeasure】 
1. Check the lamp energy. (Print the current 

[Lamp Energy Monitor] window for later 
comparison.) 

 Change the lamp if the AD, voltage, or 
intensity value is abnormal. 

 If the lamp has just been changed, leave 
it for approximately 30 minutes before 
checking the energy again. 

2. Check the volume of reaction cuvette 
wash solution and c heck if the wash 
solution overflows. 

3. Check the amount and f low rate of the 
reaction bath oil. 

 If it is abnormal, replenish or regulate it. 
4. Change the reaction cuvette. 
5. If the above measures do not  work, 

contact your local distributor. 

0904 Cuvette blank calculation 
error 
Cuvette #1, flag #2 - The 
cuvette blank measurement 
results show the absorbance 
of the cuvette #1 is out of the 
±0.04 range from the median 
cuvette blank value, therefore 
it is flagged with #2 (N,  L, or 
H). 

1401 
- 
1411 

System error or sample log 
(file) error 

【Cause】 
A possible cause is an i mproper PC data 
processing. 
【Countermeasure】 
If this error happens frequently, contact your 
local distributor. 

2000 
- 
2199 
 
2200 
- 
2220 

Analytical condition error 
 
 
An error in sample / order 
data is detected. 

【Cause】 
A possible cause is an i mproper parameter, 
operation, or measurement. 
【Countermeasure】 
Check the error report details for the problem 
in the relevant sample data and analytical 
conditions, and perform corrective measures. 
If the error repeats, contact your local 
distributor. 
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Alarm # Error message / site Cause / countermeasure 

2400 
- 
2428 

Calculation error 【Cause】 
Measurement / setting errors has caused an 
improper PC data processing. 
【Countermeasure】 
Check the error report details and the 
relevant settings. If the error repeats, contact 
your local distributor. 

3001 LIS (Host) communication 
time-out 

【Cause】 
The workstation did not receive any signal 
from LIS within the defined time frame. 
【Countermeasure】 
Check if LIS is engaged in another 
processing. Select [Maint.] > [Communication 
Monitor] to check the values defined for time-
out. 

4201 
- 
4203 
 

ISE communication errors 【Cause】 
A possible cause is communication failure 
between the analyzer and the ISE unit. 
【Countermeasure】 
1. Exit and s hut down the system, then 

reboot. 
2. If the problem is not solved, contact your 

local distributor. 
4306 ISE Thermister error 【Cause】 

A possible cause is failure or disconnection of 
the thermister, or di sconnection of the 
connector. 
【Countermeasure】 
Reconnect the connector. 

4312 
- 
4319 

ISE pump-related error 【Cause】 
Functional failure of the pump 
【Countermeasure】 
1. "INITIALIZE" the system. 
2. Perform "Priming" several times. 
3. Power OFF and then ON the analyzer. 
4. If the problem is not solved, contact your 

local distributor. 
4327 
- 
4329 

ISE calibration related error 【Cause】 
The calibration result values are out of the 
reference range. 
【Countermeasure】 
1. Check the calibrator. 
2. Perform calibration again. 
3. If the problem is not solved, contact your 

local distributor. 
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Alarm # Error message / site Cause / countermeasure 

6000 
- 
6002 
 

Internal system error 【Cause】 
Analyzer's internal communication or 
communication between analyzer and 
workstation fails. 
【Countermeasure】 
Exit the system and t hen reboot. If the 
problem is not solved, contact your local 
distributor. 
 

6140 Diluent shortage in #1   
Bottle position #2 

【Cause】 
The diluent level has reached the judgment 
level. The special diluents on the refrigerated 
tray (CTT) may be short. 
【Countermeasure】 
Check the remaining amount in the bottle and 
replenish as required. 

6202 
- 
6203 

RPP1 sensor full stroke error 
(detergent position) 
RPP2 sensor full stroke error 
(detergent position) 

【Cause】 Reagent probe wash, pure water, 
or detergent may be short. (Reagent Tray 
(RTT) 1 or 2) 
【Countermeasure】 
Check the remaining amount in the bottle and 
replenish as required. 

6208 
 

WUD nozzle sensor error 【Cause】 
The wide nozzle of the reaction carousel 
wash unit’s (WUD) may be in contact with the 
cuvette and prevented to reach the bottom. 
【Countermeasure】 
1. Check the fixture and function as below. 

In case of trouble, follow the relevant 
steps described in Chapter 7: 
Maintenance. 

a) Check if the movement of WUD nozzles 
is blocked.  

b) Check if the WUD nozzles are fixed in 
the proper position. 

c) Check the fixture of the reaction cuvette. 
d) Check the fixture of the splash cover. 
e) Check if some foreign matter is blocking 

the reaction carousel movement. 
2. Perform "INITIALIZE" several times and 

then perform "WASH" to check the 
movement.  

3. If "INITIALIZE" fails or the error repeats, 
shut down and reboot the system. 

4. If the problem is not solved, contact your 
local distributor. 
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Alarm # Error message / site Cause / countermeasure 

6238 
 
6240 
 
6239 
 
 
6241 

MIX1 abnormal rotation speed  
 
MIX2 abnormal rotation speed 
 
MIXR1 abnormal rotation 
speed 
 
MIXR2 abnormal rotation 
speed 

【Cause】 
The number of the back and forth rotation 
movement of Mixer 1 or 2 (MIX1 or 2) may be 
out of the defined range. 
【Countermeasure】 
1. Remove the mixing rod and check the 

movement. If the movement is abnormal 
follow the steps to change the rod as 
described in Chapter 7: Maintenance.  

2. Perform "INITIALIZE" and then select 
[Maint.] > [Manual Operation] and check 
the position of the mixing rod using, 
40.MIXR1, 45.MIX1, 52.MIXR2, 57.MIX2. 
If the mixing rod is curved or misaligned, 
change or reattach it. 

3. Perform "INITIALIZE" and "PRIME" 
several times. It they complete 
successfully, start the measurement 
while checking the status of the analyzer 
from time to time. 

4. If "INITIALIZE" or "PRIME" fails and the 
error repeats, shut down the system and 
reboot. 

5. If the problem is not solved, contact your 
local distributor. 
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Alarm # Error message / site Cause / countermeasure 

6255 
- 
6289 
 

Clot A related errors 
Abnormality detected when 
checking if the air pressure 
inside the probe returns to 
atmospheric after washing the 
inside of the probe in the 
carousel wash unit (WUD) 
with pressure from the pump 

【Cause】 
1. A possible 

cause is clot 
due to debris. 

2. A possible 
cause is air 
trapped in the 
sample pump 
(SP) line or 
sampling and 
reagent wash 
pump (SRWP) 
line. 

3. A possible 
cause is a 
defect in clot 
sensor. 

【Countermeasure】 
Check the followings. In 
case of trouble, follow 
the relevant steps 
described in Chapter 7: 
Maintenance. 
1. [Common with 

Clots A - D] Check 
if air is trapped in 
the SP or SRWP 
lines, 

 If trapped, follow 
the steps to 
degassing the 
Large Water Pump 
(LWP) described in 
Chapter 7: 
Maintenance. 

2. [Clot A] Follow the 
steps to clean or 
change the sample 
probe (SPP) tube 
described in 
Chapter 7: 
Maintenance. 

 
 

Clot B related errors 
Abnormality detected at the 
pressure check just before 
sample aspiration 

【Cause】 
1. A possible 

cause is air 
trapped in the 
SP or SRWP 
line. 

2. A possible 
cause is a 
defect in clot 
sensor. 

 
 
 

Clot C related errors 
Abnormality detected at the 
pressure check when 
washing the inside of the 
probe with pressure from the 
pump 
Clot E related errors 
Abnormality detected when 
checking if the sensor is 
working properly just after 
starting operation from the 
[READY] mode 
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Alarm # Error message / site Cause / countermeasure 

6255 
- 
6289 
 

Clot D related errors 
Abnormality detected by the 
pressure check at sample 
aspiration When this error 
message was once displayed 
for a sample but not for the 
next sample, the clot has 
been removed by probe wash 
with pressure from the pump. 

【Cause】 
1. A possible 

cause is fibrin 
deposed in the 
sample 

2. A possible 
cause is the 
nozzle 
touching the 
bottom of the 
sample 
container due 
to the small 
sample 
volume. 

 This error can 
occur when a 
small quantity 
is entered for 
"Sample Vol.” 
in the 
[Analytical 
Parameters 
(Chemistry)] 
window and 
the nozzle 
touches the 
bottom of the 
sample 
container. The 
manufacturing 
variables of 
the container 
may contribute 
to this error. 

 

3. [Clots B, C, and E] 
Perform 
"INITIALIZE" and 
"PRIME" several 
times. It they are 
completed 
successfully, start 
the measurement 
while checking the 
status of the 
analyzer from time 
to time.  

4. [Clot D] Check the 
status of the 
sample. 

5. If some foreign 
matter such as 
fibrin is found, take 
corrective 
measures, 

6. If the error repeats, 
shut down the 
system and reboot. 

7. If the problem is 
not solved, contact 
your local 
distributor. 
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Alarm # Error message / site Cause / countermeasure 

9002 LWP gauge related errors 【Cause】 
A possible cause is abnormal flow rate of the 
circulating water in the analyzer. 
【Countermeasure】 
1. Air may be trapped in the pure water 

circulation line. 
2. Perform "INITAILIZE" and check the 

pressure gauge for the water circulation 
pump (LWP). If the pressure is 68 kPa or 
lower, degass the line. 

3. Water supply may be improper. 
 Check the status of the main valve of the 

water supply and the power status of the 
pure water supply unit. 

9007 Leak under the pump 
compartment 

【Cause】 
Water leak is detected by the leak sensor 
placed in the lower back part of the pump 
compartment. 
【Countermeasure】 
Check the site and take an appropriate 
measure. 

9010 Reaction bath (RRB) oil level 
is low. 

【Cause】 
The content of the RRB oil bottle may be 
insufficient. 
【Countermeasure】 
1. Remove the holder of reaction cuvettes to 

check the level of the RRB oil.  
2. If the level is low, check the followings:  

a) Check the volume contained in the 
RRB oil bottle. Replenish it if it is 
insufficient. 

b) Check that the bottle and line are 
tightly connected and that the tube tip 
is securely inside of the RRB oil. 

3. If the level of the oil is sufficiently high, 
check the followings: 
a) The liquid surface may be in motion 

so that the sensor detects the level 
incorrectly. 

b) Let the analyzer rest for 
approximately 5 minutes and see if 
the error repeats. 

4. If the error persists, shut down, wait 5 
minutes, then reboot. 

5. If the problem is not solved, contact your 
local distributor. 
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Alarm # Error message / site Cause / countermeasure 

9012 RRB oil level sensor 
judgment logic failure  

【Cause】 
There are two 
sensors for the RRB 
level. One is for low 
level and the other 
for high. This error 
means a conflict that 
occurs between the 
values of the two 
sensors. 

【Countermeasure】 
1. The liquid surface 

may still be in 
motion after 
replenishment so 
that the sensor 
detects the level 
incorrectly. Let the 
analyzer rest for 
approximately 5 
minutes and see if 
the error repeats. 

2. If the error persists, 
shut down, wait 
five minutes, then 
reboot.. 

3. If the problem is 
not solved, contact 
your local 
distributor. 
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9.1 Overview 
The system can save and display the measurement results in two types of format. This 
chapter describes the procedure for saving results and how to read the output data. 

 The text file cannot be saved in the C:¥BIOMJ directory or its subdirectories. 
The data to be saved and displayed are the test results of the current day or 
those saved in the workstation regarding the routine samples including 
priority samples, STAT samples, and control samples.  

 Please be s ure there is sufficient free space available in your chosen file 
destination before attempting to save the text file, or the text file may not be 
successfully saved due to diskspace shortage.  
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9.2 Saving the Test Results  
The [User Maintenance] window is used to save the test results as text file. 

 

1) Select [Maint.] > [User Maintenance] 

The [User Maintenance] window is displayed. In the [Save to Text File] column in the 
upper right side of the [User Maintenance] window, define the conditions to create a 
text file. 

 

 

 
 
 

2) Select a [Sample type] 

Select either "Patient Sample," "STAT Sample," or "Control Sample." 
 

3) Select a [Date] 
The default is "Today." When "Control Sample" is selected, enter the starting and 
ending dates from the last 60 days. 

4) Select an [Output form] 

Designate either "Sequential File" or "CSV File." 

 See “Section 9.3 Sequential File Display Format” and “Section 9.4 CSV File 
Display Format” for details on output formats. 

5) Designate the range of data to be saved in the [Save Range] column. 

Select one of the three designation methods below: 
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• Designation by "Order No." 

• Designation by "Position No." 

 First, select "TT" or "RACK" and then enter the range. 

• Designation by "Sample No." 
 

6) Click the [Save] button 

The [Save of Text File] window is displayed. 

 
 

The default saving destination is "D:¥".  The default extension is ".TXT" for sequential 
file and ".CSV" for CSV file. 

 

7) Select the destination directory in the [Save in:] field, enter a fi le name in 
the [File name:] field, and then click the [Save] button. 

The entered designations are saved. Close the [Save of Text File] window to return to 
the [User Maintenance] window. 
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9.3 Sequential File Display Format  
Display format 

[Sample Information]<CR><LF> 

<Key word><TAB><data><CR><LF> 

： 

［ITEM #］<CR><LF> 

<Item Process Sequence No. ><TAB><Test item name><TAB><data> 

<TAB><Mark><TAB><User code><CR><LF> 

： 

 [Sample Information]<CR><LF> 

<Key word><TAB><data><CR><LF> 

： 

［ITEM #］<CR><LF> 

<Item Process Sequence No. ><TAB><Test item name><TAB><data> 

<TAB><Mark><TAB><User code><CR><LF> 
 

 

Data for a single sample comprises the "Sample Information" section and the "ITEM #" 
section. The latter section contains the test results. "TAB" is used to separate the 
abbreviation of the test, its value, and the values in the "ITEM #" section. The 
abbreviation of the test in the "Sample Information" section is displayed whether or not 
there is a corresponding result; however, the test result is displayed only when the test 
is ordered.  

 

Details of data display format for one sample 

 Sample Information section 

      1  2  3  4  5  6  7  8  9  10 11 12 13 14 15 16 17 18 19 20  21 22 

[ S a m p l e  I n f o r m a t i o n ] CR LF 

 

○ Sample ID 

       1  2  3   4   5  5+n1 6+n1     n1： byte count of the value in 1* 

P I D TAB 1* CR LF 

The field "1*" (the 5th byte) contains the sample ID (maximum size: 13 bytes). 

The size varies by sample type. 

IDs from PA001 to PZ200 are used for control samples, where PA - PZ indicate the 
control sample types and 001 - 200 indicate the number of measurement times for each 
sample type. 
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IDs in the format of “Cttnn” or “Mttnn” such as C0101 or M98010 are used for 
calibrators, where “tt” indicates the position number and “nn” the number of 
measurement times. 

 

○ Position number 

       1  2  3   4   5  5+n2 6+n2     n2： byte count of the value in 2* 

P O S TAB 2* CR LF 

The field "2*" contains the position number (maximum size: 11 bytes).   

When using the sample or refrigerated trays (TTs), the value will be TT# (1 - 97) - Cup 
No. (1 - 84). 

When an optional rack is used, the value will be the rack number (00000001- 
99999999) - the position number (1 - 10). 

When a barcode is used, the value will not be displayed (0 byte). 

 

○ Dilution factor 

      1   2  3  4  5  6   7   8  8+n3 9+n3     n3： byte count of the value in 3* 

F A C T O R TAB 3* CR LF 

The field "3*" contains the dilution factor (maximum size: 4 bytes including 1 digit 
after the decimal point). 

Dilution factor 10 is displayed as 10.0. 

 

○ Container type 

      1   2  3  4  5  6  7  8   9   10   11  12 

C U P  T Y P E TAB 4* CR LF 

The field "4*" shows the container type (maximum size: 1 byte).  

The value is 1 - 9. 

 

○ Sample type 

      1   2  3  4  5  6  7  8  9  10 11  12   13  14  15 

S A M P L E  T Y P E TAB 5* CR LF 

The field "5*" shows the sample type (maximum size: 1 byte).  

The value "1" indicates serum and "2" urine. 

 

○ Comment 1 

      1   2  3  4  5  6  7  8   9   10 10+n6 11+n6     n6: byte count of the value in 6*. 

C O M M E N T 1 TAB 6* CR LF 

The field "6*" contains the comment #1 (maximum size: 16 bytes.) 

When no value is entered, nothing will be displayed (0 byte). 
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○ Comment 2 

      1   2  3  4  5  6  7  8   9   10 10+n7 11+n7     n7: byte count of the value in 7*. 

C O M M E N T 2 TAB 7* CR LF 

The field "7*" contains the comment #2 (maximum size: 16 bytes). 

When no value is entered, nothing will be displayed (0 byte). 

 

○ Age 

      1   2  3   4   5  5+n8 6+n8     n8: byte count of the value in 8*. 

A G E TAB 8* CR LF 

The field "8*" contains the patient's age (maximum size: 3 bytes.) 

When no value is entered, nothing will be displayed (0 byte). 

 

○ Sex 

      1  2  3   4   5    6   7 

S E X TAB 9* CR LF 

The field "9*" shows the patient's sex (maximum size: 1 byte.)  

The value "1" represents male, "2" female, and "3" unknown. 

 
○ The number of ordered tests 

      1   2  3  4  5  6  7    8   8+n10 9+n10    n10: byte counts for the value in 10* 

I T

 

E M  # TAB 10* CR LF 

The field "10*" contains the number of ordered tests 

(maximum size: 3 bytes).  

 

 Test results section 

○ Test results 

      1   2  3  4  5  6  7  8   9  10  

[ I T E M  # ] CR LF 

 

11* TAB 12* TAB 13* TAB 14* TAB 15* CR LF 

| 
11* TAB 12* TAB 13* TAB 14* TAB 15* CR LF 

 

The field "11*" contains the Process Sequence number ranging from 1 to 326 
(maximum size: 3 bytes).  

 

The field "12*" contains the Test Name (maximum size: 10 bytes).  

The number of results 
displayed is as defined in 
10* above. 
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The field "13*" contains the measurement value. 

The measurement value of concentration is right aligned with the total size of 9 bytes. 
The result value of qualification has a variable size with maximum of 6 bytes. When 
the test is not performed, no value is displayed (0 byte). For concentration, the number 
of digits after the decimal point varies according to the analytical conditions defined 
for each test. When the result is manually edited, an "E" mark is displayed at the top 
field and ｔhe total size is 10 bytes. 

 

The field 14* contains the flag corresponding to the abnormality detected by the data 
check function (maximum size: 10 bytes).  

When the test is not performed, no value is displayed (0 byte). 

The results of a general test have 10 bytes and are displayed as below:  
 A general test is a chemical test, ratio test, or ISE test. 

 

Chemical test 

The first character (1st byte) in this field is the flag character H, L, h, or l as 
detected by data check.  
The flag characters "S", "s", "r", "t", "A", "M", "Q", "G", "F", "c", "u", "d", "U", 
"D", "P", "*", "n","N", "R", "/", "V", "v", "W", "w", "X", "x", "C", "J", "O", "Z", 
"f", "q", "a", and "z" are shown left aligned from the second to tenth bytes when 
applicable. The flag characters exceeding the space limit are not shown. 

 

Ratio test 

The first character (1st byte) in this field is the flag character H, L, h, or l as 
detected by data check.  
Two flag characters "R" and "/" are used for ratio tests. Two or more flag 
characters are displayed left aligned from the second byte onwards in the order 
of "R" and "/". 

 

ISE test 

The first character (1st byte) in this field is the flag character H, L, h, or l as 
detected by data check.  
The flag characters "s", "S", "u", "*", "B", "r", "C", "T", "I", "d", "/", "R", "A", 
"Q", "G", "O", and "c" are shown left aligned from the second to tenth bytes 
when applicable. 

 

For the flag display in all the test results above, if the number of flag characters is 
smaller than 10, a one-byte space (20H in the ASCII code) will be inserted in each 
empty space. 

The serum test is not a general test, therefore, a 10-byte space will be inserted. 
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The 15* field contains the User Code (maximum size: 4 bytes). 

Example of display format 

[ITEM #] 

1 AST_______ ___999.99 HsR_______ USR 

2 ALT_______ ___999.99 _sR_______ USR 

3 TP________ E___999.99 HsR_______ USR 

4 HDL-C_____ ___999.99 __________ USR 

(" _ " indicates space) 
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9.4 CSV File Display Format 
Display format 

Sample Information section 

1* , 2* , 3* , 4* , 5* , 6* , 7* , 8* , 9* , 10* ,  

Test result section 

11* , 12* , 13* , 14* , 15* , … 11* , 12* , 13* , 14* , 15* , CR LF 

         1st test                                     10th test 
： 

Sample Information section 

1* , 2* , *3 , 4* , 5* , 6* , 7* , 8* , 9* , 10* ,  

Test result section 

11* , 12* , 13* , 14* , 15* , … 11* , 12* , 13* , 14* , 15* , CR LF 

 

Data for a single sample comprises the "Sample Information" section and the "ITEM #" 
section. The latter section contains the test results. Each value is in double quotation 
marks and a comma is inserted to separate the values. “CR” and “LF” mark the end of 
the sample result. Undefined values are not displayed, but the separator commas are. 
As many test results as ordered are displayed. 
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Details of data display format for one sample 

 Sample Information section 

○ Field "1*" 

The field "1*" contains the sample ID (maximum size: 13 bytes).  
The ID varies by sample type. 

IDs from PA001 to PZ200 are used for control samples, where PA – PZ indicate 
the control sample types and 011 – 200 indicate the number of measurement 
times for each sample type. 
IDs in the format of “Cttnn” or “Mttnn” such as C0101 or M98010 are used for 
calibrators, where “tt” indicates the position number and “nn” the number of 
measurement times. 

 

○ Field "2*" 

The field "2*" contains the position number (maximum size: 11 bytes).  
When the sample or refrigerated trays (TTs) are used, the value will be TT# (1 - 
97) - Cup No. (1 - 84).  
When an optional rack is used, the value will be the rack number (00000001- 
99999999) - the position number (1 - 10).  
When the barcode is used, the value will not be displayed (0 character). 

 

○ Field "3*" 

The field "3*" contains the dilution factor (maximum size: 4 byt es including 1 
digit after the decimal point). 
The dilution factor 10 is displayed as 10.0. 

 

○ Field "4*" 

The field "4*" shows the container type (maximum size: 1 byte).  
The value ranges 1 - 9, showing the container type. 

 

○ Field "5*" 

The field "5*" shows the sample type (maximum size: 1 byte).  
The value is "1" for serum or "2" for urine. 

 

○ Field "6*" 

The field "6*" contains the comment #1 (maximum size: 16 bytes).  
When no value is entered, nothing will be displayed (0 byte). 

 

○ Field "7*" 

The field "7*" contains the comment #2 (maximum size: 16 bytes).  
When no value is entered, nothing will be displayed (0 byte). 
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○ Field "8*" 

The field "8*" contains the patient's age (maximum size: 3 bytes).  
When no value is entered, nothing will be displayed (0 byte). 

 

○ Field "9*" 

The field "9*" contains the patient's sex  (maximum size: 1 byte).  
The value "1" represents male, "2" female, and "3" unknown. 

 

○ Field "10*" 

The field "10*" contains the number of ordered tests (maximum size: 3 bytes). 

 

 Test result section 

○ Field "11*" 

The field "11*" contains the Process Sequence number (maximum size: 3 bytes.)  
The value ranges from 1 to 326. 

○ Field "12*" 

The field "12*" contains the Test Name (maximum size: 10 bytes.) 
 

○ Field "13*" 

The field "13*" shows the test result.  
The result value of concentration has fixed size of 9 bytes in total and is 
displayed right aligned. The result value of qualification has a variable size with 
maximum 6 by tes. When the test was not performed, no value is displayed (0 
byte). For concentration, the number of digits after the decimal point varies 
according to the analytical conditions defined for each test. 

 

○ Field "14*" 

The field 14* contains flag characters (maximum size: 11 bytes).  
When no abnormality was detected, no value is displayed (0 byte).  
The flag space for a general test has 11 bytes. 

 A general test is a chemical test, ratio test, or ISE test, and the flags 
are dispayed in the following manner. 
 

Chemical test 

The first character (1st byte) in this field is the flag character H, L, h, or l as 
detected by data check.  
The flag characters "S", "s", "r", "t", "A", "M", "Q", "G", "F", "c", "u", "d", "U", 
"D", "P", "*", "n","N", "R", "/", "V", "v", "W", "w", "X", "x", "C", "J", "O", "Z", 
"f", "q", "a", and "z" are shown left aligned from the second to tenth bytes when 
applicable. The flag characters that are exceeting the space limit are not shown. 
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Ratio test 

The first character (1st byte) in this field is the flag character H, L, h, or l as 
detected by data check.  
Two flag characters "R" and "/" are used for ratio tests. Two or more flag 
characters are displayed left aligned from the second byte onwards in the order 
of "R" and "/". 

 

ISE 

The first character (1st byte) in this field is the flag character H, L, h, or l as 
detected by data check. 

The flag characters "s", "S", "u", "*", "B", "r", "C", "T", "I", "d", "/", "R", "A", 
"Q", "G", "O", and "c" are shown left aligned as the second to tenth bytes when 
applicable. 

 

For the flag display in all the test results above, if the number of flag characters is 
smaller than 11, a one-byte space (20H in the ASCII code) will be inserted in the 
empty space. 

When the manual editing mark "E" is displayed as the first byte, either "H", "L", "h", 
or "l" will be the second byte, and then, the above characters will be shown left-aligned 
in the indicated order as the third to eleventh bytes if applicable. 

In case of serum test, 10-byte space is displayed. 
 

The field “15*” contains the User Code (maximum size: 4 bytes). 
 

Example of display format of the test result section 
,"1","AST_______","___999.99","HsR________","USR_","2","ALT_______","___
999.99","_sR________","USR_","3","TP________","___999.99","EHsR_______","
USR_","4","HDL-C_____","___999.99","___________","USR_", 

(" _ " indicates space) 
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10.1 Overview 
This chapter describes the specific operation of the BM6010/C analyzer system in 
combination with a laboratory automation system (LAS).  

Handle the LAS according to the instructions given in the LAS manual.  

 Refer to “Section 1.5 Instructions for Installation and Connection 
Specifications of the BM6010/C System.” 

 

10.1.1 Operational types of the system connected with a LAS 

The BM6010/C system is generally on-line with a LAS or a laboratory information 
system (LIS) to use samples that are externally delivered. 

The operational type is thus different according to the functions of the LAS or LIS. 

The table below summarizes the principal operational types. 

Principal operational types of the analyzer system connected with a LAS/LIS 

 

Sample  

Identifica-
tion 

Sample 
supplier 

Test 
registra-

tion  

with LIS 

Operational type 

1) Barcode LAS Real-time Patient sample is delivered externally. 
2) Barcode LAS Batch Same as above, when automatic on-line 

communication is not available. 
3) Barcode LAS N/A Same as above, when the order has 

been placed in advance via workstation. 
4) Barcode Sample 

tray 
(STT) 

Automatic Used when samples are more efficiently 
measured using STT as in the case of 
priority and rerun samples. 

5) Barcode STT Batch Same as above, when automatic on-line 
communication is not available. 

6) Barcode STT N/A Same as above, when the order has 
been placed in advance via workstation. 

7) TT-CUP STT Automatic Used to measure the samples for which 
barcode cannot be applied. 

8) TT-CUP STT Batch Same as above, when automatic on-line 
communication is not available. 

9) TT-CUP STT N/A Same as above, when the order has 
been placed in advance via workstation. 
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10.1.2 On-line communication during operation with a LAS 

The table below summarizes the on-line communication flow for a sample between the 
analyzer and a LAS/LIS. 

 

 More details are available in "BM6010 Laboratory Information System On-
Line Signal Specification" and " JCA-BM6010/C Laboratory Automation 
System Connection Specification." 

 

On-line communication flow 

Direction Action Remarks 

LAS/LIS → BM Notifies that LAS/LIS is ready. At start  
LAS/LIS ← BM Notifies that BM is ready. At start 
LAS/LIS → BM Notifies BM of the sample ID before the sample 

arrives at the sampling position. 
 

LAS/LIS ← BM Inquires which tests are ordered for the sample.  
LAS/LIS → BM Indicates which tests are ordered for the sample.  
LAS/LIS → BM Requests BM to start sampling.   
LAS/LIS ← BM Requests the sample ID to LAS/LIS for 

reconfirmation. 
 

LAS/LIS → BM Sends the sample ID.  
BM Aspirates and dispenses the sample.  
LAS/LIS ← BM Indicates the end of sampling.  
LAS/LIS ← BM Transfers the result at the completion of 

measurement. 
 

 

 

10.1.3 Use of the sample tray (STT) when the system is connected 
with a LAS/LIS 

The sample tray (STT) is used exclusively for priority samples when the system is 
operating in the LAS/LIS mode (connected with a LAS/LIS). 

Any samples that cannot be handled with the LAS/LIS are handled with the STT. 
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10.2 Setting the External Sample 
Delivery  
This section describes the settings that require modification depending on the delivery 
method. 

Double-check these settings when you have changed the sample delivery method. 
 

The following windows are used for modifying the settings: 

• [System Specification Set] window 

• [Online Settings] window as required 

• [System Monitor] window 

• [Setting System Parameters] window as required 
 

After setting the parameters, shut down the system once and then reboot. Select "New 
start" after changing a parameter, or otherwise, select "Restart" to reboot. 

 

10.2.1 [System Specification Set] window 

Use the [System Specification Set] window to use the analyzer with a LAS/LIS. 

Select [Setup] > [System Specification Set] to open the window. 

 

[System Specification Set] window 

Define the following parameters in this window. 

In the [System Basic Configuration] column, select "LAS" for [Sample delivery]. 
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In the [Sample Container Specifications] column, define the types of container used in 
the LAS. 

 Steps to define the container types 

When the sample is delivered via the LAS, the container type should be correctly 
defined so that the BM6010/C system can behave accordingly. 

 

 
Warning  

Be sure to specify the correct container type. Otherwise: 

• The probe may not be lower appropriately into the container which will cause 
erroneous results or,  

• The probe may break if it lowers too far into the container. 

 

The container type can be defined by in one of three places: 

• In the [Order Entry] window in the workstation 

• Via the LIS  

• Via the LAS 

 If different values are ent ered in the above places, the definition via the 
LAS has the priority. 

The container type is identified by a sample container number which is predefined by 
the LAS/LIS. The same sample container will have a different number when used with 
the LAS/LIS than when used with the sample tray (STT). Generally, a common number 
is defined for the LAS and LIS, but the number used with the STT is the same that is 
defined in the [Cup/Tube Assign] window. The table below shows an example of set 
values. 

 

Example of settings 

Sample Container # Type Remarks 

[Sample container 1] 10 mL sample tube For STT 
[Sample container 2] JCUP B For STT 
[Sample container 3]   
[Sample container 4]   
[Sample container 5] STAT sample container For STT 
[Sample container 6] STAT urine sample container For STT 
[Sample container 7]   
[Sample container 8]   
[Sample container 9] LAS sample container For LAS/LIS 
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In the example above, 

• when the container information is obtained via the LIS, all the containers will be 
“Sample container 9” for the LAS, 

• otherwise, or when any of the other containers is used, designate the type for the 
[Container type] field in the [Order Entry] window. 

 

 The sample container for the LAS is already entered as "Sample container 
9." If you wish to change it, the new number should be the same for the 
BM6010/C, the LAS, and the LIS settings. On the other hand, there is no 
restriction in adding or editing containers to be used only in the sample tray 
(STT).    
When the LAS accepts two or m ore types of containers, they should be 
entered separately. If the LIS has a feature to designate the container type 
for each sample on the LAS sample delivery line, then “Sample Container 
#0(Priority Requested)” can be s elected in the LAS to signify that the 
container type will be d esignated by the order. In this case, the container 
type is selected for each sample by the LIS. 

 

10.2.2 [Online Settings] window 

Online settings related to the LAS can be modified if necessary. 

 See “Section 5.8.2 Online Settings” for details about the [On-line Settings] 
window. 

 

10.2.3 [System Monitor] window 

In order to use the LAS, select "Operate" for [LAS] in the [Pre-operation set] column 
in the [System Monitor] window. To access the [System Monitor] window, select 
[Maint.] > [System Monitor]. 

 

 

Selecting operation with a LAS in the [Pre-operation set] column in the [System Monitor] window 

 



  

 

10-6  ICABM6010/C-4 

C
hapter 10 

Appendix 2: U
sing a Laboratory Autom

ation System
 (LAS) 

10.2.4 [Setting System Parameters] window 

The window is used to modify LAS related parameters if required. 

Select [Setup] > [Setting System Parameters] to open the window. 

 

 The default values are selected. Edit the values only when a modification is 
required for reasons such as a change in the LAS specification. 

 Refer to “Section 5.9 Parameters in the [Setting System Parameters] 
Window” for details on the [Setting System Parameters] window. 

 

The LAS-related parameters and the default values are as follows: 

[LAS First sample waiting time] 30 seconds 

This is the time from the start of the analyzer by the LAS to the arrival of the 
first sample. If the sample is not delivered during this period, the analyzer 
enters into the [WAIT] mode. 

 

[LAS Next sample waiting time] 30 seconds 

This is the time from sending out the dispensed sample to the arrival of the next 
sample. If the next sample is not delivered during this period, the analyzer 
enters into the [WAIT] mode. 

 

[LAS Max dummy cycle] 20 cycles 

This is the maximum waiting time after the LAS sends a signal to the analyzer 
that the next sample is coming until the sample actually arrives at the sampling 
position.  If the sample is not delivered during this period, the analyzer judges 
it as sample non-arrival error and enters into the [STOP] mode from which the 
operation cannot be resumed.   
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10.3 Analyzer Operation While Using a 
LAS 
This section describes the typical steps of the analysis operation connected with a 
LIS/LAS. 

 

10.3.1 Beginning analyzer operation 

1) Start the LIS. 
2) Start the LAS. 
3) Start the pure water supply unit. 
4) Start BM6010/C. 

 See “Section 4.2 Getting Started” for starting BM6010/C. 

5) Prepare the LAS for connection with the analyzer as required. 
6) Begin operation of the BM6010/C connected with the LAS. 

 When you start the LIS after starting the analyzer, inappropriate 
communication may occur. If so, delete these communication data before 
starting operation by clicking the [HOST ON] button on the Operation Panel 
to turn it to [HOST OFF], and then clicking it again to turn it back to [HOST 
ON]. 

 

10.3.2 Ending analyzer operation 

1) Change the analyzer to the READY mode. 

When the analyzer connected with the LAS has completed a measurement run, it enters 
into the [WATCH] mode instead of the [READY] mode.  

Operation Panel showing the [WATCH] mode 

 

Click the [STOP] button in t he Operation Panel and wait for the mode window to 
indicate a change from [WATCH] to [READY] before ending analyzer operation. 

 

 

 

Operation mode display 
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2) Perform the routine ending operation. 
 See “Section 4.13 System End・Shutdown” for instructions for ending 

operation of the BM6010/C. 

3) Perform the ending operation of the water supply unit. 
4) Shut down the LAS. 
5) Shut down the LIS. 

 

10.3.3 Measurement of priority and rerun samples during operation 
with the LAS 

Priority and rerun samples can be dispensed from the sample tray instead of the LAS 
external sample delivery system. Samples with an ID but no readable barcode label can 
be dispensed in the same way. 

 

1) Enter the order information. 

If the LIS has the relevant order information, the order is placed automatically online. 

Otherwise, follow the steps below to enter the order information at the workstation. 

1 Select [Request] > [Order Entry].  

The [Order Entry] window is displayed. 

 

Figure 7. [Order Entry] window 
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2 Enter the sample ID in the [Samp.no.] field. 

When the sample has no ID, enter a sample number (up to 13-digit arbitrary but unique 
number) for ordering. 

3 Define a container type for the [Container type] field. 

Skip this step if it has been already defined in the [Cup/Tube Assign] window. 
 

2) Click the [PAUSE] button in the Operation Panel when the analyzer is in 
the [START] or [WAIT] mode during the operation with the LAS. 

3) Wait until the "SMP LOAD OK (Append)" message is displayed under the 
[PAUSE] mode display. 

   

Operation Panel showing the [PAUSE] mode and "SMP LOAD OK" notification. 

 

 Warning 
Be sure to perform the following steps after confirming the analyzer is in the [PAUSE] mode 
and the panel shows "SMP LOAD OK (Append)." Otherwise, the probes move when the 
sample arrives via the LAS. Therefore, the operator risks injury by contact with the probe 
and possible infection via contact with the serum. Furthermore, the probes or trays may be 
damaged. 

 
 

4) Place the sample in the sample tray. 

Place the sample in a position assigned to the correct container, if it has been already 
defined in the [Cup/Tube Assign] window. 

 

5) Click [START] in the Operation Panel. 

The [Start Conditions] window is displayed. 
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Figure 9. [Start Conditions] window 

 

6) Define the container type. 

Skip this step if it has been already defined in the [Cup/Tube Assign] window. 

7) Define [Patient Sample] as shown in Figure 9. 

For [Analysis mode], select "Barcode" 
For [Routine samp.], select "Analyze", then enter [1] - [84] (sample tray (STT) 
positions). 
For [Routine samp.] under [External analyze], select "Analyze"  
Using these settings, the analyzer will complete the measurement of the samples 
dispensed from STT, then enter into the [WAIT] mode for the sample arrival via the 
LAS.  

8) Click [START]. 

The analyzer will begin reading the barcode of the samples in the STT.  
After reading the barcode, a confirmation window is displayed. The barcode can be 
edited here if required. If the barcode is not able to be read, enter the sample ID here. 

9) Click [OK]. 

The analyzer starts measurement. 
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 Do not click the [HOST ON] button during operation with the LAS. If you 
click the button, the connection with the LIS will be cut off. 

 The analyzer will complete reading the sample barcode and send a request 
to the LIS for an order on the sample ID. 
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10.3.4 Stand-alone operation of BM6010/C 

In stand-alone operation, the analyzer is not connected to the LAS/LIS. It operates 
independently when the LAS and LIS are not in operation. The operational steps are as 
follows: 

 

i. Select "Detach" for the LAS in the [System Monitor] window. 

 In “Detach” status, the analyzer does not respond to the LAS. Note that an 
error may occur on the LAS if the LAS is in operation. 

 

ii. Click the [HOST ON] button on the Operational Panel to toggle it to 
[HOST OFF]. 

In [HOST OFF] status, the analyzer does not receive order information from the LIS 
nor will the measurement results be sent to the LIS. 

iii. Follow the steps below to enter order information at the workstation. 

1) Select [Request] > [Order Entry]. 

The [Order Entry] window is displayed. 

2) Enter the sample ID in the [Samp.no.] field. 

When the sample does not have a barcode, enter an arbitrary but unique ID for ordering. 

3) Define the container type. 

Skip this step if you define it during measurement or if it has been already allocated to 
the sample tray (STT) position in the [Cup/Tube Assign] window. 

4) Place the sample in the STT. 
5) Click [START] in the Operation Panel. 

The [Start Conditions] window is displayed. 

6) Define the container type. 

Skip this step if it was defined in step 3 or if it has been already allocated to the STT 
position in the [Cup/Tube Assign] window. 

7) Select "Barcode" for [Analysis mode]. 
8) Click [START]. 

The analyzer starts reading the barcode of the sample in the STT. 

After reading the barcode, a confirmation window is displayed. The barcode can be 
edited here if required. If the barcode could not be read, enter the sample ID here. 

9) Click [OK]. 

The analyzer starts measurement. 
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10.4 Resuming Operation after a Trouble 
10.4.1 Steps for resuming operation when a trouble occurs with the 

LAS 

1) The analyzer automatically stops. 
 When a trouble occurs on a sample on the LAS during sampling, the 
analyzer stops automatically. 

 The measurement continues for the dispensed samples. 

2) Remove the samples from the LAS. 
3) Troubleshoot the problem with the LAS. 

 See the instructions in the LAS manual for troubleshooting and how to 
remove the samples from the LAS. 

4) Wait until the analyzer enters in the [READY] mode. 
 It may take some time before the analyzer enters in the [READY] mode 
because procedures such as a rerun order utilizing the sample tray (STT) or 
cuvette washing to eliminate contamination must be completed.  

5) Prepare the LAS for operation. 
6) Perform [INITIALIZE] of the analyzer to start the next measurement. 

 

 

10.4.2 Steps for resuming operation when a trouble occurs with the 
analyzer 

Cases in which the operation can be resumed 

When the [STOP] button on the Operation Panel is pressed for some trouble, the mode 
will change in the following order: STOP shift - STOP - END - READY. In this case, 
the operation can be resumed as follows depending on the system mode of the analyzer. 

 

• In the [STOP shift] or [STOP] mode: 
The analyzer can be restarted to continue measurement. 

• In the [END] mode:  
Wait until the mode becomes [READY]. 

• In the [READY] mode:  
The analyzer can be restarted to continue measurement. 

 When the [STOP] button on t he Operation Panel is pressed during 
measurement and t he mode is forced to be [READY], the sample whose 
first barcode reading has already been finished will be skipped because the 
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order for the further barcode reading is canceled. A new measurement 
order should be placed for this sample. 

 

Cases in which the operation cannot be resumed 

When an accident occurs (e.g. the probe has hit something), the analyzer automatically 
stops and the mode shifts to [STOP]. When this occurs, the [PAUSE], [STOP] and 
[START] buttons on the Operation Panel are grayed out and cannot be used. In this 
case, please follow the steps below to resume the operation.  

1) Wait until the analyzer enters in the [WAIT] mode. 
 It may take some time before the analyzer will enter in the [WAIT] mode 
because procedures such as a rerun order utilizing the sample tray (STT) or 
cuvette washing to eliminate contamination must be completed.  

2) Remove the samples from the LAS. 
3) Eliminate the cause of the trouble. 

 Check the error message and act accordingly. 

4) Perform the [WASH] procedure as required. 
 When the analyzer stops with the reagent dispensed in the reaction 
cuvettes, cuvette contamination may occur when measurement is resumed. 

5) Prepare the LAS for operation. 
6) Perform [INITIALZE] of the analyzer to start. 

 Check the last sample that was measured properly and resume the 
measurement of the next sample and onwards. 

 

Emergency Stop 

When the [SYSTEM STOP] button on the analyzer is used, or when the operation 
cannot continue due to some problem in a unit, the analyzer makes an emergency stop. 
In this case, the analyzer enters into the [WAIT] mode. 

1) Remove the samples from the LAS. 
2) Eliminate the cause of the trouble. 
3) Perform the [WASH] procedure as required. 

When the analyzer stops with the reagent dispensed in the reaction cuvettes, 
cuvette contamination may occur when measurement is resumed. 

4) Prepare the LAS for operation. 
5) Perform [INITIALZE] of the analyzer to start. 
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This appendix 3 describes various flags with the required countermeasures to take. 
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11.1 Flagging Function 
The BM6010/C system checks the measurement values for abnormality, and a data with 
high possibility of abnormality is posted with the flag corresponding to the type of 
abnormality. This function is called flagging. 

11.1.1 Flags used for the chemistry tests 

Flags posting and rerun triggered by a flag can be setup in the [Analytical Parameters 
(Chemistry)] window. 

List of flags 

Flag Incidence type Judgment 

S  System abnormality  
S Sample shortage  
t Diluent shortage  
r Reagent shortage  
N Cuvette blank abnormality 6.1.3a Check for the reaction 

cuvettes  
u, U  Over the higher absorbance limit 6.1.3c Check with calculated 

absorbance (ABS) 
6.1.3d Check with reaction 
ABS 

d, D Below the lower absorbance limit 6.1.3c Check with calculated 
ABS 
6.1.3d Check with reaction 
ABS 

* Variance abnormality 6.1.3c Check with calculated 
ABS 

n Abnormality in the number of effective points  ( Ef-
fevt.nbr.o.pnts) 

6.1.3c Check with calculated 
ABS 

P Prozone abnormality 6.1.3c Check with calculated 
ABS 

h, l Normal value limit 6.1.3e Check by concentration 
and unit 

H, L Abnormal value limit 6.1.3c Check with calculated 
ABS 
6.1.3d Check with reaction 
ABS 
6.1.3e Check by concentration 
and unit 

R Rerun data  
C Calibration failure  6.1.3e Check by concentration 

and unit 
V, v Abnormal value with main wavelength in the 

section of reagent 1(V), Abnormal value with main 
wavelength in the section of reagent 1(v) 
R1 main waveform error (V), R1 sub waveform 
error (v) 

6.1.3b Check with the reaction 
process 

W, w Abnormal value with main wavelength in the 6.1.3b Check with the reaction 
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Flag Incidence type Judgment 

section of reagent 2e (W), Abnormal value with 
main wavelength in the section of reagent 2e (w) 
R2e main waveform error (W), R2e sub waveform 
error (w)  

process 

X, x  Abnormal value with main wavelength in the 
section of reagent 2 (X), Abnormal value with main 
wavelength in the section of reagent 2(x) 
R2 main waveform error (X), R2 sub waveform 
error (x)  

6.1.3b Check with the reaction 
process 

A Clot detection  
M Mixer (Mix) error  
Q Liquid level sensor error  
G Probe hits something (Crash)  
F Abnormal temperature (outside the range of 

37℃±0.3) in the reaction bath (Temperance error) 
 

c Calibration mismatch  
f Multiple normal data error (Plural normal data)  
q Borderline data  
a No normal data  
z Invalid data (Bad data)  
Z Abnormal calibration data 6.1.3f  Check with the previous 

STD value  
///////  Overflow  
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11.1.2 Flags used for the ISE tests 

Flags posting and rerun triggered by a flag can be setup in the [Rerun Condition Set] 
window. Click the [Rerun cond.] button in each column in the ISE Parameter Setting] 
window to display the window. 

List of flags 

Flag Incidence type Judgment 

S Safety  
S Sample shortage  
r Buffer shortage  
T Thermistor abnormality  
u Abnormal selectivity   
C Abnormal range 6.2.2 Calibration 
* H-STD error or L-STD error  
d Abnormal dilution factor 6.2.2 Calibration 
B Abnormal liquid volume in the dilution bowl  
h，l Normal value limit 6.2.2 Calibration 
H，L Normal value limit 6.2.2 Calibration 
I ID error  
R Rerun data  
A Clot  
G Probe hits something (Crash)  
Q Liquid level sensor error  
/////// Overflow  



  

 

11-4  ICABM6010/C-4 

C
hapter 11 

Appendix 3: Flags  

11.2 Countermeasures for Flags in 
Chemistry Tests 

11.2.1 S: System abnormality 

An abnormality has occurred in the system, which might affect the measurement value. 

 Cause 

Causes of the error can be identified by the error message displayed when the 
abnormality occurred. 

 Countermeasure 

Click the [Alarm] button in the Operation Panel to display the [Error Report] window. 
Search the ID of the sample whose data is flagged with “S.”  

Click the corresponding line to show the [Error Report Details] window to see the 
content. 

11.2.2 s: Sample shortage 

The sensor in the sample probe judges the sample volume is short. 

 Cause 

The sample volume is small. 

A container different from the designated one is used. 

The type of container is not correctly selected. 

Impurities on the probe 

 Countermeasure 

Check that sufficient volume of sample is in the container judged short of sample. 

Check that the correct container type is selected in the [Order Entry] window. 

Follow the steps to clean the probes described in “Section 7.3.1b Check the probes for 
impurities” in Chapter 7 of the manual.  

11.2.3 t: Diluent shortage 

The sensor in the sample probe judges the volume of the diluent on CTT is short. 

 Cause 

The diluent volume is small. 

Impurities on the probe 
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 Countermeasure 

Check that sufficient volume of diluent is in the container, and measure again. 

Follow the steps to clean the probes described in “Section 7.3.1b Check the probes for 
impurities” in Chapter 7 of the manual.  

11.2.4 r: Reagent shortage 

The sensor in the reagent probe judges the reagent volume is short. 

 Cause 

The reagent volume is small. 

A container different from the designated one is used. 

Impurities on the probe 

 Countermeasure 

Check if the reagent container has sufficient volume of reagent, and if the volume is 
short, replenish it and measure the sample again. 

Follow the steps to clean the probes described in “Section 7.3.1b Check the probes for 
impurities” in Chapter 7 of the manual. 

11.2.5 N: Cuvette blank abnormality 

The cuvette blank value is abnormal. 

 Judgment 

The difference of pre-test cuvette blank values (CB1 and CB2) measured with 14 
wavelengths is greater than the defined threshold value. 

 Cause 

Foreign matter is attached to the nozzle(s) of the reaction carousel wash unit (WUD) or 
the nozzle(s) is (are) clogged, which prevents normal washing. 

The reaction cuvette has accumulated impurities and the absorbance has changed 
accordingly. 

The spectrophotometry lamp has deteriorated and the lamp energy has changed. 

 Countermeasure 

Rerun with the same sample to check for abnormality. 

Check if the WUD nozzles are free from foreign matter attached or clogged, if no liquid 
dripping from the nozzle, or if the wash solution overflows the cuvettes. See Section 
7.3.1d Check the nozzles for the reaction carousel wash (WUD) unit for impurities 
for the steps to clean the nozzle, and Section 7.8.1c Remove the clogs in the WUD 
nozzles for how to remove the clogs of the WUD nozzles. 
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Check the lamp energy in the [Lamp Energy Monitor] window. Replace the lamp if the 
lamp energy is abnormal. 

If it is  normal, measure the cuvette blank values and check them again. If the cuvette 
blank values are abnormal, replace the cuvettes. 

 See “Section 7.4.1a Check the lamp energy” and “Section 7.4.1b Cuvette 
blank measurement of this chapter for checking the lamp energy and 
cuvette blank respectively.  

11.2.6 u, U: Beyond the upper absorbance limit 

The measurement value is beyond the upper limit of the parameter for abnormality 
detection during the reaction process. 

 Judgment 

The relevant measurement value exceeds the upper absorbance limit defined as “blank 
(u)” and “sample (u)” in the [Analytical Parameters (Chemistry)] window, “absorbance 
limit (u)” in the [Rerun conditions Set] window, and “corrected sample (u)” calculated 
from “sample (u)” and E2 data (see Chapter 6). 

Limit values can be defined in the [Analytical Parameters (Chemistry)] window and 
the [Rerun conditions Set] window accessed by clicking the corresponding button in 
the former window. 

 See “Section 6.1.1 Assay Method,” “Section 6.1.3c Check with calculated 
ABS” and “Section 6.1.3d Check with reaction ABS” for details. 

 In the assay methods RRA, 2PA, CRA, and IMA 

 Main Wavelength ABS is the value of “ABS1” displayed in the [RealTime 
Monitor] and [Reaction Monitor] windows.  

When measuring the reagent blank 

Flag “U” is posted when Main Wavelength ABS > blank (u). 
 

When measuring patient samples or calibrators  

- In decreasing reaction  
Flag “U” is posted when Main Wavelength ABS > corrected sample (u).  

- In increasing reaction  
When Main Wavelength ABS > corrected sample (u), data points after the relevant 
point will be excluded.   
Flag “u” is posted when the number of remaining effective points is smaller than the 
number of points required for judgment.  

 

When “Check D.P.” is defined.  
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- In decreasing reaction  
Flag “U” is posted when Main Wavelength ABS > blank (u) at the point defined as 
“Check D.P.” 

- In increasing reaction  
Flag “u” is posted when Main Wavelength ABS > blank (u) at the point defined as 
“Check D.P.” 

 In the assay method EPA  

When measuring patient samples or calibrators 

Flag “u” is posted when Reaction ABS > Rerun absorbance (u)  

 Cause 

The reagent may be handled inappropriately. See “Section 3.4 Preparing the reagents” in 
Chapter 3 of the Manual. 

The sample may be handled inappropriately. See “Section 3.2 Preparing the sample” in 
Chapter 3 of the Manual. 

Incorrect sample was used in the reagent blank measurement. 

When measuring patient samples or calibrators  

- The sample's lipemia, hemolysis, or icterus level is high 
- The concentration of the sample is extremely high. 

 Countermeasure 

First of all, check the following: 

Reaction waveform in the [Reaction Monitor] window. 

Whether the same flag is posted on the measurement value(s) of the other sample(s). In 
that case, see “Section 11.2.30 Multiple flags are posted simultaneously” in this 
Chapter. 

Check the levels of lipemia, hemolysis, and icterus. 

Verify if the sample is properly handled. 

Verify if the reagent is properly handled. 

 In case the reaction waveform is abnormal 

When abnormal spike noises or disturbance are observed in the waveform, perform 
rerun. 

Verify the abnormality is reproduced with the rerun sample. 
If the abnormality is not reproduced, possible causes are as follows: 

The spectrophotometry lamp was the source of the spike noise. 

Some foreign matter might possibly transverse the reaction carousel. 

If the abnormality is reproduced, 
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If the waveform is normal and the flag is not posted on the values of other samples, the 
sample may be the cause of the abnormality. 

Rerun the sample using different dilution factor. 

11.2.7 d, D: Below the lower absorbance limit 

The measurement value is outside the parameter range set for abnormality detection 
during the reaction process. 

 Judgment 

The relevant measurement value falls below the lower absorbance limit defined as 
“blank (d)”, “sample (d)”, “absorbance limit (u)” at rerun, and “corrected sample (u)” 
calculated from sample (u) and E2 data. 

Limit values can be defined in the [Analytical Parameters (Chemistry)] window and 
the Rerun conditions Set] window accessed by clicking the corresponding button in the 
former window. 

 See “Section 6.1.3c Check with calculated ABS” and “Section 6.1.3d Check 
with reaction ABS” of Chapter 6 of the Manual for details. 

 In assay methods RRA, 2PA, CRA, and IMA 

When measuring the reagent blank  
Flag “D” is posted when Main Wavelength ABS < blank (d).  

When measuring patient samples or calibrators  

- In decreasing reaction  
When Main Wavelength ABS < corrected sample (d), data points after the relevant 
point will be excluded.   
Flag “d” is posted when the number of remaining effective points is smaller than the 
number of points required for judgment.  

- In increasing reaction  
Flag “D” is posted when Main Wavelength ABS < corrected sample (d).  

 

When “Check D.P.” is defined. 

- In decreasing reaction  
Flag “d” is posted when Main Wavelength ABS < blank (d) at the point defined as 
“Check D.P.” 

- In increasing reaction  
Flag “D” is posted when Main Wavelength ABS < blank (d) at the point defined as 
“Check D.P.” 

 In assay method EPA  

 Reaction ABS is the value of “ABS” displayed in the [RealTime Monitor] and 
[Reaction Monitor] windows. 
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When measuring patient samples or calibrators 

Flag “u” is posted when Reaction ABS > Rerun absorbance (u) 

 Cause 

Possible causes are the same as those described in “Section 11.2.6. u, U: Beyond the 
upper absorbance limit.” Refer to the section. 

 Countermeasure 

Possible causes are the same as those described in “Section 11.2.6. u, U: Beyond the 
upper absorbance limit.” Refer to the section. 

11.2.8 *: Variance abnormality 

The measurement value is over the upper limit of the parameter set for abnormality 
detection during the reaction process. 

 Judgment 

The variance of measurement values in a zone of the reaction process exceeds the set 
value. 

The value can be defined in the [Analytical Parameters (Chemistry] window. 

See “Section 6.1.3c Check with calculated ABS” in Chapter 6 of the Manual. 

 Cause 

The reagent may be handled inappropriately. See “Section 3.4 Preparing the reagents” in 
Chapter 3 of the Manual. 

The sample may be handled inappropriately. See “Section 3.2 Preparing the sample” in 
Chapter 3 of the Manual. 

The sample's lipemia, hemolysis, or icterus level may be high 

Impurities may adhere to the mixing rod. 

The spectrophotometry lamp may be degraded. 

 Countermeasure 

First of all, perform the following: 

Check the reaction waveform in the [Reaction Monitor] window. 

Check whether the same flag is posted on the measurement value(s) of the other 
sample(s). In that case, see “Section 11.2.30 Multiple flags are posted 
simultaneously.” 

Check the levels of lipemia, hemolysis, and icterus. 

Verify if the sample is properly handled or not. 

Verify if the reagent is properly handled or not. 
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Verify the mixing rods for impurities. If impurities are observed, clean the rods. See 
Section 7.5.1a for procedure. 

 In case the reaction waveform is abnormal 

When abnormal spike noises or disturbance are observed in the waveform, perform 
rerun. 

If the abnormality is not reproduced, possible causes are as follows: 

The spectrophotometry lamp was the source of the spike noise. 

Some foreign matter might possibly transverse the reaction carousel. 

If the abnormality is reproduced, 

If the waveform is normal and the flag is not posted on the value from another sample, the 
sample may be the cause of the abnormality. 
Rerun the sample using different dilution condition. 

11.2.9 n: Number of effective points shortage 

The number of points in the reaction process used for calculation falls short of the 
effective number. 

 Judgment 

This flag is posted on the data in the assay methods of RRA. 2PA, CRA, and IMA 
when the number of effective points used in calculation is short. 

See “Section 6.1.3c Check with calculated ABS” in Chapter 6 of the Manual for the 
details of calculation. 

 Cause 

The measured values of the performed test may be abnormally high so that the points 
are moved forward. Consequently, the number of effective points falls short. 

 Countermeasure 

Check the reaction waveform in the [Reaction Monitor] window to determine if the 
sample has produced abnormally high values. In that case, dilute and rerun the sample. 

11.2.10 P: Prozone 

Prozone error is detected from the reaction process data. 

 Judgment 

The prozone value of the reaction process exceeds the prozone limit value. 

Prozone limit value can be defined in the [Analytical Parameters (Chemistry)] window. 

See “Section 6.1.3c Check with calculated ABS” in Chapter 6 of the Manual for the 
details of calculation and setting. 
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 Cause 

The sample may have produced abnormally high values. (“Prozone sample”) 

Other possible causes are the same as those described in “Section 11.2.8 *: Variance 
abnormality.” Refer to the section. 

 Countermeasure 

Check the reaction waveform in the [Reaction Monitor] window to determine if the 
sample has produced abnormally high values. In that case, dilute and rerun the sample. 

11.2.11 h, l: Normal value limit 

Flags “h” and “l” are posted to the patient and control sample data that are out of the 
defined normal range. They are also applied to the values of cuvette blank measured as 
user maintenance.  

11.2.11a Patient sample 

 Judgment 

The measurement value is out of the user defined normal value range. 

h: Measurement value＞ Upper normal value limit 
l: Measurement value < Lower normal value limit 

Normal limit values can be defined in the [Analytical Parameters (Chemistry)] window. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.2.11b Control (QC) sample 

 Judgment 

The measurement value is out of the control value range. The flags are posted in the 
following cases. 

h: Measurement value＞ Mean＋2×SD 
l: Measurement value＞ Mean - 2×SD 

Select [QC] > [Control Data Registration] to define the mean value and SD in the 
[Control Data Registration] window. 

 Countermeasure 

Follow the procedure specified in the user institution. 
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11.2.11c Cuvette blank measurement 

 Judgment 

The measurement values of cuvette blank are judged for each of the 14 wavelengths by 
the condition below and the cuvette that meets the condition even for a wavelength is 
listed with the corresponding flag. 

h: Cuvette blank－median cuvette blank of 231 cuvettes > 3 × SD 
l: Cuvette blank－median cuvette blank of 231 cuvettes < 3 × SD  

SD = standard deviation of the cuvette blank values stored in the system 

 Cause 

The cuvette has impurities. 

 Countermeasure 

These flags do not affect the measurement values. 

If numerous cuvettes are listed with flag, perform “WASH2” with 1:20 diluted Reagent 
probe wash S. 

If the situation does not improve, replace the cuvettes. See “Section 7.7.1b Replace the 
reaction cuvettes" in Chapter 7 of the Manual. 

Remeasure the cuvette blank after replacement. 

11.2.12 H, L: Abnormal value limit 

Flags “H” and “L” are posted to the patient/control sample and calibration data that are 
beyond the defined upper limit value or below the defined lower limit value. They are 
also applied to the cuvette blank and water blank values measured as user maintenance 
that are in the define abnormal range.  

11.2.12a Patient sample 

 Judgment 

The measurement value is in the defined abnormal value range. 

H: Measurement value > Upper abnormal value limit (H) 
L: Measurement value < Lower abnormal value limit (L) 

Abnormal limit values can be defined in the [Analytical Parameters (Chemistry)] 
window. 

 Countermeasure 

Follow the procedure specified in the user institution. 
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11.2.12b Control (QC) sample 

 Judgment 

The measurement value is out of the control value range. The flags are posted in the 
following cases. 

H: Measurement value > Mean + 3 × SD 
L: Measurement value > Mean + 3 × SD 

Select [QC] > [Control Data Registration] to define the mean value and SD in the 
[Control Data Registration] window. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.2.12c   Calibrator    

 Judgment 

The judgment varies according to the sample type as follows. 

The threshold values can be defined in the [Analytical Parameters (Chemistry)] 
window. 

Reagent blank (including simplified calibration) 

H: Measurement value > BLK H 
L: Measurement value < BLK L 

Calibrator (including simplified calibration) 

H: Measurement value > STD H 
L: Measurement value < STD L 

Multi-point calibrator (MSTD) 

H: Measurement value > BLK and STD-H for corresponding STD 1-5 
L: Measurement value < BLK and STD-L for corresponding STD 1-5 

 Cause 

The reagent may be handled inappropriately. See “Section 3.4 Preparing the reagent” in 
Chapter 3 of the Manual. 

The sample may be handled inappropriately. See “Section 3.2 Preparing the sample” in 
Chapter 3 of the Manual. 

 Countermeasure 

Verify if the reagent is properly handled. 

Verify if the sample is properly handled. 
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11.2.12d Cuvette blank measurement 

 Judgment 

The cuvette blank values are judged for each of the 14 wavelengths according to the 
condition below, and the cuvette that meets the condition even for one wavelength is 
listed with the corresponding flag. 

H: Cuvette blank - median cuvette blank of 231 cuvettes > + cuvette reference value 
L: Cuvette blank - median cuvette blank of 231 cuvettes < - cuvette reference value 

 Cause 

The cuvette may have impurities, scratches, or foreign matter. 

 Countermeasure 

Remove the flagged cuvette and check for impurities, scratches, and foreign matter. If it 
has scratches or irremovable impurities, replace the cuvettes. See “Section 7.7.1b 
Replace the reaction cuvettes” in Chapter 7 of the Manual. 

11.2.13 R: Rerun data 

The flag “R” is listed with the rerun data. It indicates the value is a rerun result. 

11.2.14 C: Calibration error 

The concentration cannot be obtained from the calibration curve. 

 Cause 

Calibration was not performed, or failed. 

 Countermeasure 

Perform calibration and confirm that a valid calibration curve is obtained. Then, start 
measurement again. 

11.2.15 V, v: Abnormal value with main wavelength in the Reagent 1 
zone (V), Abnormal value with sub wavelength in the Reagent 
1 zone (v) 

The measurement value is over the allowance set for abnormality detection during the 
reaction process. 

 Judgment 

The variance of the points with main (V) or sub (v) wavelength in the zone (period) 
from Reagent 1 dispensing until Reagent 2e or 2 dispensing is over the defined 
allowance. 

The allowance can be defined in the [Analytical Parameters (Chemistry)] window. 
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See “Section 6.1.3b Check with the reaction process” in Chapter 6 of the Manual for 
the details of calculation. 

 Cause 

Possible causes are the same as those described in “Section 11.2.8 *：Variance 
abnormality.” Refer to the section. 

 Countermeasure 

Take the same measures described in “Section 11.2.8 *：Abnormal variance” in this 
chapter. 

11.2.16 W, w: Abnormal value with main wavelength in the Reagent 2e 
zone(W), Abnormal value with sub wavelength in the Reagent 
2e zone(w) 

The measurement value is over the allowance of the parameter set for abnormality 
detection during the reaction process. 

 Judgment 

The variance of the points with main (W) or sub (w) wavelength in the zone (period) 
from Reagent 2e dispensing until Reagent 2 dispensing is over the defined allowance. 

The allowance can be defined in the [Analytical Parameters (Chemistry] window. 

See “Section 6.1.3b Check with the reaction process” in Chapter 6 of the Manual for 
the details of calculation. 

 Cause 

Possible causes are the same as those described in “Section 11.2.8 *:Variance 
abnormality.” Refer to the section. 

 Countermeasure 

Take the same measures described in “Section 11.2.8 *:Abnormal variance” in this 
chapter. 

11.2.17 X, x: Abnormal value with main wavelength in the reagent 2 
zone (X), Abnormal value with sub wavelength in the reagent 2 
zone (x) 

The measurement value is over the allowance of the parameter for abnormality 
detection during the reaction process. 

 Judgment 

The variance of the points with main (X) or sub (x) wavelength in the zone (period) 
after Reagent 2 dispensing is over the defined allowance. 
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The allowance can be defined in the [Analytical Parameters (Chemistry] window. 

See “Section 6.1.3b Check with the reaction process” in Chapter 6 of the Manual for 
the details of calculation. 

 Cause 

Possible causes are the same as those described in “Section 11.2.8 *Variance 
abnormality.” Refer to the section. 

 Countermeasure 

Take the same measures described in “Section 11.2.8 *Abnormal variance” in this 
chapter. 

11.2.18 A: Clot error 

The clot sensor in the sample probe (SPP) detects clot during sample aspiration. 

 Cause 

The sample is highly viscous. 

Fibrin or foreign matter is on the surface of the sample. 

Serum separator is on the surface of the sample 

The clog in SPP is not removed. 

 Countermeasure 

Check the other measurement results with the sample flagged for clot error. 

Check if some substance as fibrin is found on the sample surface, and remove if any. 
Perform rerun as required. 

If the clot error persists with normal samples, replace SPP. See Section 7.8.1a Replace 
probes in Chapter 7 of the Manual. 

11.2.19 M: Mixer error 

The number of rotations or reciprocal movements of the mixing rod falls short of the 
defined number. 

 Cause 

 The mixing rod has impurities in the bearing area. 

 The mixing rod is broken. 

 The mixing rod is not attached properly. 

The mixing motor malfunctions. 
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 Countermeasure 

Remove the rod and check if impurities adhere to the bearing area. If they do, clean the 
area. 

Check if the mixing rod is broken. If it is, replace it. See “Section 7.8.1d Replace the 
mixing rod” in Chapter 7 of the Manual. 

Check if the mixing rod is properly attached. 

Check if the mixing rod fits in the midpoint of the cuvette. If it does not, contact your 
local distributor. 

If the problem persists even after replacement, contact your local distributor. 

11.2.20 Q: Liquid level sensor error 

The sample probe (SPP) may have aspirated air during sample aspiration. 

 Cause 

The sample has air bubbles. 

Impurities adheres to SPP 

 Countermeasure 

Check if air bubbles are observed in the sample, and remove them if any. Note that the 
air bubbles may have gone when checking. 

Clean SPP if it has impurities. Follow the steps described in “Section 7.3.1b Check the 
probes for impurities” in Chapter 7 of the Manual. 

11.2.21 G: Crash  

The probe hits something during operation. 

Crash can occur when SPP is aspirating the sample and when the reagent probes 
(RPP1/RPP2) are aspirating the reagents. 

 Cause 

The sample container is covered. 

The sample container is incorrectly selected. 

The sample container is placed improperly in the sample tray (STT)/ 

The STT cover is not in the correct position. 

The cover of the ISE unit is not in the correct position. 

The splash cover is not in the correct position. 

The reagent bottle is covered. 

The reagent bottle is placed improperly in the reagent tray (RTT). 

The RTT cover is not in the correct position. 
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 Countermeasure 

Display the error report and identify the probe that had the “crash.” (SPP, RPP2 or 
RPP2) 

Confirm against what the probe “crashed.”  

Based on the above information, identify and eliminate the cause of the “crash.” 

Check if the probe is broken or bent. If it is, replace it. See “Section 7.8.1a Replace 
probes” in Chapter 7 of the Manual. 

If it is not, check if the probe is attached properly. It may be displaced by the shock. 
Perform rerun. If the probe has some problem, replace it. 

Check that the probe no longer “crashes” and the measurement value is normal. 

11.2.22 F: Temperature error (outside the range of 37℃±0.3) of the 
reaction bath  

The temperature of the reaction bath is outside the defined range. 

 Judgment 

The temperature of the reaction bath is outside the range of 37℃±0.3. 

 Cause 

The temperature of the reaction bath has not reached stability because the measurement 
was performed immediately after the startup of the system. 

The temperature of the reaction bath cannot be controlled due to the extremely high or 
low ambient temperature. 

 Countermeasure 

Wait until “OK” is displayed for [RRV Bath Temp.] and [RRV Bath Control] in the 
[System Monitor] window. After confirming that “OK” is displayed, start the 
measurement. 

Operate the system in a n environment that conforms to the installation requirement. 
(See “Section 1.6 Installation” in Chapter 1 of the Manual) 

11.2.23 c: Calibration error 

The combination of the reagent(s) and the calibration curve used for calculation is 
invalid. 

 Judgment 

When the multiple bottles of a reagent are set on the reagent tray and the new 
calibration date is obtained after a bottle switch, the measurement value of the sample 
to which the reagent was dispensed from the new bottle is judged as calibration error 
until the new calibration becomes effective.  
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 Countermeasure 

Follow the procedure specified in the user institution. 

11.2.24 f: Multiple normal data 

The measurement value is outside the parameter range defined for abnormality 
detection. 

 Judgment 

When a patient sample is measured simultaneously with the dilution conditions, M, D1, 
D2, D3, and D4 defined in the [Report data select] column in the [Abnormal value 
setting] window accessed from the [Analytical Parameters (Chemistry)], the result 
includes two or more measurement values that have neither the abnormal limit value 
flag “L” nor “H.” This is judged to be the “multiple normal data” error. 

In the [Reporting data select], either “Low dilute data” or “High dilute data” can be 
selected in the [Data selection for data comment] column. 

The value can be entered in the [Abnormal value setting] window displayed by clicking 
the [Abnormal value setting] button in the [Analytical Parameters (Chemistry)] 
window. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.2.25 q: Borderline data 

The measurement value is outside the parameter range defined for abnormality 
detection. 

 Judgment 

When a patient sample is measured simultaneously with the dilution conditions, M, D1, 
D2, D3, and D4 defined in the [Report data select] column in the [Abnormal value 
setting] window accessed from the [Analytical Parameters (Chemistry)], all the 
measurement values have the abnormal limit value flag “L” or “H”, where a value with 
a lower dilution condition is posted with H and that with a step-higher dilution 
condition is posted with L. A Borderline result is considered to exist between the two 
dilution conditions. In this case, the two measurement values are considered to be 
borderline data defined for “q: Borderline data” in the [Data selection for data 
comment] column in the [Abnormal value setting] window. 

In the [Reporting data select], either “Low dilute data” or “High dilute data” can be 
selected in the [Data selection for data comment] column. 

The value can be entered in the [Abnormal value setting] window displayed by clicking 
the [Abnormal value setting] button in the [Analytical Parameters (Chemistry)] 
window. 
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 Countermeasure 

Follow the procedure specified in the user institution. 

11.2.26 a: No normal data 

The measurement value is outside the parameter range defined for abnormality 
detection. 

 Judgment 

When a patient sample is measured simultaneously with the dilution conditions, M, D1, 
D2, D3, and D4 defined in the [Report data select] column in the [Abnormal value 
setting] window accessed from the [Analytical Parameters (Chemistry)], all the 
measurement values have the abnormal limit value flag “L” or “H”, where no 
borderline data exist. 

The value can be entered in the [Abnormal value setting] window displayed by clicking 
the [Abnormal value setting] button in the [Analytical Parameters (Chemistry)] 
window. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.2.27 z: Incorrect data, prozone  

The measurement value is outside the parameter range defined for abnormality 
detection. 

 Judgment 

When a patient sample is measured simultaneously with the dilution conditions, M, D1, 
D2, D3, and D4 defined in the [Report data select] column in the [Abnormal value 
setting] window accessed from the [Analytical Parameters (Chemistry)], the 
measurement values show conflicting “L” and “H” flags. 

Example: A measurement value with a dilution condition is normal or posted with “L”, 
while a value with a higher dilution condition is posted with “H.” 

The validity of the set values is judged by the user or the manufacturer of the reagent. 
The value can be entered in the [Abnormal value setting] window displayed by clicking 
the [Abnormal value setting] button in the [Analytical Parameters (Chemistry)] 
window. 

 Countermeasure 

Follow the procedure specified in the user institution. 
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11.2.28 Z: Calibration data abnormality 

The result of calibration is abnormal. 

 Judgment 

The reaction ABS of the currently obtained calibration data is beyond the allowance. 

Allowance (%) < | Calculated ABS from the previous calibration - Calculated ABS of 
the current calibration | / Calculated ABS of the previous 
calibration x 100 (%) 

Allowance can be defined in the [Analytical Parameters (Chemistry)] window. 

 Cause 

The reagent may be handled inappropriately. See “Section 3.4 Preparing the reagents” in 
Chapter 3 of the Manual. 

The sample may be handled inappropriately. See “Section 3.2 Preparing the sample” in 
Chapter 3 of the Manual. 

 Countermeasure 

Verify that the reagent is handled properly. 

Verify that the sample is handled properly. 

Perform calibration again. 

11.2.29  / : Overflow 

The calculated concentration is beyond the range of the values that can be displayed. 

In this case, “/////” is displayed for concentration.  

 Countermeasure 

Check the calibration curve for abnormality. 

The calculation formula may be erroneous when ratio parameter or realtime correction 
is used. Check the formula. 

11.2.30 Multiple flags are posted simultaneously 

Multiple types of flags below are posted for multiple tests and samples, Follow the 
steps below. 

 Flags that require attention   

U, u, D, d, *, n, P, H, h, L, l, V, v, W, w, X, x   

 If the flags are posted for multiple tests and samples  

The analyzer may have some problem. 
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The quality of water supplied from the pure water supply unit may be degraded. Check 
the water quality.  

Check if the mixing rod has impurities. If it does, clean it. See Section 7.5.1a for 
procedure. If the impurities persist, replace the mixing rod. 

Check if the mixing rod is broken. If it is, replace it. See Section 7.8.1d for procedure. 

Check if the nozzles of the reaction carousel wash unit (WUD) are free from foreign 
matter attached or clogged, if the wash solution is improperly provided from the 
nozzles, or if the wash solution overflows the cuvettes. See “Section 7.3.1d Check the 
nozzles for the reaction carousel wash (WUD) unit for impurities” for the steps to 
clean the nozzle, and “Section 7.8.1c Remove the clogs in the WUD nozzles” for how 
to remove the clogs of the WUD nozzles. 

Check if the sample probe and reagent probes are attached properly. If they are not, 
attach them properly. 

Check if the sample probe and reagent probes have impurities. If they do, clean them. 
See Section 7.3.1b for the procedure to clean the probes. 

Check if the sample probe and reagent probes are bent or clogged. If bent, broken, or 
clogged, replace the probe. See Section 7.8.1a for replacement. 

Check the pumps for liquid leakage and air bubbles. Follow the steps described in 
“Section 7.3.1g Check for potential leakage from pumps” in Chapter 7 of the Manual. 

Foreign matter such as solid substance or substance immiscible with the reaction bath 
oil may mix in the reaction bath oil. Remove the reaction cuvette holder to check if 
there is some foreign matter inside the reaction bath. If there is, contact your local 
distributor. 

The reaction cuvette may have impurities. Measure the cuvette blank, and if the blank 
value is abnormal or the cuvettes are not replaced for a long period, perform 
“WASH2.” If the problem persists, replace the cuvettes. See “Section 7.7.1b Replace 
the reaction cuvettes” in Chapter 7 of the Manual. 

Check the lamp energy in the [Lamp Energy Monitor] window. Replace the lamp if the 
lamp energy is abnormal. See “Section 7.4.1a Check the lamp energy” in Chapter 7 
for checking the lamp energy.  

 If the flags are posted for multiple samples 

When flags are posted for multiple samples for a single test, the reagent may be 
causing the problem. Check the following. 

Whether the reagents are placed in the correct positions. 

The reagent's expiration date. Do not use expired reagents. 

Whether foreign matters or air bottles are observed in the reagent. Remove them, if any. 
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11.3 Countermeasures for Flags in ISE 
Tests 

11.3.1 S: Safety 

Refer to Section 11.2.1. 

11.3.2 s: Sample shortage 

Refer to Section 11.2.2. 

11.3.3 r: Buffer shortage, Internal Standard (IS) solution shortage 

This flag is posted in one of the following cases. 

The buffer level has lowered below the specified range. 

The calculated volume of remaining IS solution becomes zero. 

 Cause 

The remaining buffer volume is small. 

The level sensor is out of place. 

The IS solution is used up based on the calculation. 

 Countermeasure 

Check the buffer line and IS solution line for air bubbles. If air bubbles are observed, 
they may have affected the measurement values.  

Replace the buffer or IS solution. See Section 7.3.2a and 7.3.2b of Chapter 7 of  the 
Manual for the replacement steps of each bottle.  Perform calibration after 
replacement. 

Check the bottle sensor is in the correct position. 

Perform measurement again. 

11.3.4 T: Thermistor abnormality 

The thermistor reading is abnormal. 

 Cause 

The thermistor has some problem such as disconnection. 

 Countermeasure 

Replace the thermistor. 
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11.3.5 u: Abnormal selectivity 

The ion selectivity is beyond the defined upper limit of selectivity check.  

 Cause 

The ion selectivity of the electrode has lowered. 

 Countermeasure 

Replace the electrode. 

11.3.6 C: Calibration error 

When the calibrator is measured, the potential is abnormal. 

 Judgment 

The difference in potential between the sample and base is outside the set range.  

See 6.2.2 Calibration for the range. 

 Cause 

The buffer is not flowing normally due to clogs, air bubbles in the flow line, etc. 

The buffer has some problem such as water or foreign matters mixed in. 

The IS solution is not flowing normally due to clogs, air bubbles in the flow line, etc. 

The IS solution has some problem such as water or foreign matters mixed in. 

The ISE standard solutions (H and L) are not placed in the correct positions. 

The ISE serum standard solutions (H and L) are mistakenly used for urine measurement, 
and vice versa. 

The ISE solution is degraded. 

The electrodes are placed improperly in position. 

The electrodes are degraded. 

The sample probe (SPP) is not attached properly. 

The sample pump (SP) has leakage. Air is trapped in the line. 

 Countermeasure 

Dispense the ISE standard solutions again and perform calibration. At that time, verify 
the solutions are correctly set in the respective positions. 

If the error repeats, follow the steps below and perform calibration again. 

If the buffer and IS solution bottles have just been replaced, replace them again and 
perform buffer priming. Refer to Sections 7.3.2a and 7.3.2b. 

Check if leakage is observed around the electrodes. If it is, remove the electrodes and 
verify the O-rings are certainly between the electrodes. If no problem is found, place 
the electrodes back and perform buffer priming. 
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Check the buffer and IS solution are drained in the ISE dilution bowl. If not, the line is 
clogged somewhere. Check the line. 

Check the buffer line and IS solution line for air bubbles. If air bubbles are found, 
perform buffer priming. 

Check if SPP is attached properly. See Section 7.8.1a of Chapter 7 for proper 
attachment. 

Check if leakage or air bottles are observed in the sampling pump. Follow the steps 
described in “Section 7.3.1g Check for potential leakage from pumps” in Chapter 7 of 
the Manual. 

Replace the electrodes. See Section 7.8.2b for replacement. 

11.3.7 *: H-STD error or L-STD error (Variance) 

The potentials measured during calibration vary substantially. 

 Judgment 

When the difference of the consecutively measured sample and base potentials in 
calibration falls outside the defined range, the measurement is repeated up to 8 times.  

If the difference is still outside the range even after 8 repeated times of measurement, 
this flag is posted. 

The error is called L-STD error in L-STD measurement, and H-STD error in H-STD 
measurement. 

 Cause 

Air is trapped in the buffer line. 

Air is trapped in the IS solution line. 

The electrodes are degraded. 

SPP is not attached properly. 

SP has leakage. Air is trapped in the line. 

 Countermeasure 

Dispense the ISE standard solutions again and perform calibration. 

If the error repeats, follow the steps below and perform calibration again. 

Check the buffer line and IS solution line for air bubbles. If air bubbles are found, 
perform buffer priming. 

Check if SPP is attached properly. See Section 7.8.1a of Chapter 7 for proper 
attachment. 

Check if leakage or air bubbles are observed in SP. Follow the steps described in 
“Section 7.3.1g Check for potential leakage from pumps” in Chapter 7 of the Manual. 
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Wash the electrodes and electrode lines. See “Section 7.3.2c Wash the electrodes” and 
“Section 7.4.2a Wash the electrode lines” in Chapter 7 of the Manual. 

Replace the electrodes. See Section 7.8.2b Replace the electrodes in Chapter 7 of  the 
Manual. 

11.3.8 d: dilution factor abnormality, Ref: Reference electrode 
abnormality 

These errors occur at calibration. The indication and condition vary according to the 
electrode. 

11.3.8a Na, K, and Cl electrodes 
The dilution factor is outside the set range of 25 to 60. 

 Cause 

Possible causes are the same as for the calibration range error. See “Section 11.3.6 C: 
Calibration error.” 

 Countermeasure 

Take the same measures as for the calibration error. See “Section 11.3.6 C: Calibration 
error.” 

11.3.8b Ref: Reference electrode 
Control potential obtained by the reference electrode calibration is lower than the set 
value of 350. 

 Cause 

The reference electrode is degraded. 

 Countermeasure 

Replace the reference electrode. 

11.3.9 B: Abnormal liquid volume in the dilution bowl 

The liquid level of the dilution bowl is abnormal. 

 Judgment 

The error is detected for too high or too low buffer level in the dilution bowl when the 
sample is dispensed in the ISE unit. 

 Cause 

 In case the level is too high 

The buffer is overflowing. The electrode is clogged or improperly attached. 
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Air bubbles are generated in the dilution bowl. 

 SPP has impurities at the tip or it is not attached properly. 

 In case the level is too low 

The buffer is not dispensed. The line is clogged. 

The buffer leaks around the electrodes. 

Air is trapped in the buffer line. 

SPP has impurities at the tip or it is not attached properly. 

 Countermeasure 

When the buffer solution is overflowing from the dilution bowl, the electrodes may not 
be placed properly, or they may be clogged. Remove the electrodes to check for clogs. 
If no problem is observed, place them back properly. Wipe the inside of the dilution 
bowl completely. Perform buffer priming and confirm that no b uffer solution 
overflows. 

Remove bubbles in the dilution bowl if any. 

Wipe and dry the inside of the dilution bowl completely. 

If the buffer solution is not dispensed in the dilution bowl, the line is clogged 
somewhere. Check the line. 

If air bubbles are observed in the buffer line, check the joint of the buffer bottle for 
looseness. 

If leakage is observed around the electrodes, remove them once, and then place them 
back. Wipe the surroundings of the electrodes completely. Perform buffer priming and 
check for any leakage. 

Clean the probe tip. Follow the steps described in “Section 7.3.1b Check the probes for 
impurities” in Chapter 7 of the Manual. 

Reattach the probe. See “Section 7.8.1a Replace probes” in Chapter 7 of the Manual. 

11.3.10 h, l: Normal value limit 

The flags “h” and “l” are posted to the measurement value outside a set range for 
patient/control/calibration measurement. 

11.3.10a Patient sample 

 Judgment 

The concentration is over the range of normal value defined in the [Normal Value Set] 
window accessed from the [ISE Parameter Settings] window. 

Flag “h” is posted when Concentration > Upper limit of normal value range for 
corresponding age and sample type categories. 
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Flag “l” is posted when Concentration < Upper limit of normal value range for 
corresponding age and sample type categories. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.3.10b Calibration 

 Judgment 

The slope is outside the slope range specified in the [Standard value set] column in the 
[ISE Parameter Settings] window. It is time to replace the electrodes. 

Flag “h” is posted when the value is over the [Slope upper limit h]. 

Flag “l” is posted when the value is below the [Slope lower limit l]. 

 The slope for Cl is negative, which is converted to positive in judgment. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.3.10c Control 

 Judgment 

The measurement value is out of the control value range. The flags are posted in the 
following cases. 

h: Measurement value＞ Mean＋2×SD 
l: Measurement value < Mean＋2×SD 

Select [QC] > [Control Data Registration] to define the mean value and SD in the 
[Control Data Registration] window. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.3.11 H, L: Abnormal value limit 

The flags “H” and “L” are posted to the measurement value outside a set range for 
patient/control/calibration measurement. 

11.3.11a Patient sample 

 Judgment 

The concentration is over the range of abnormal value defined in the [Abnormal Value 
Set] window accessed from the [ISE Parameter Settings] window. 

Flag “H” is posted when Concentration > Upper limit of abnormal value range for the 
corresponding sample type.  
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Flag “L” is posted when Concentration < Lower limit of abnormal value range for the 
corresponding sample type. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.3.11b Calibrator 

 Judgment 

The slope is outside the specified slope range between 38 and 65. 

 Cause 

The electrodes are degraded. 

 Countermeasure 

Perform calibration again. 

If the problem persists, replace the electrodes. 

11.3.11c Control sample 

 Judgment 

The measurement value is out of the control value range. The flags are posted in the 
following cases. 

H: Measurement value＞ Mean + 3 × SD 
L: Measurement value < Mean + 3 × SD 

Select [QC] > [Control Data Registration] to define the mean value and SD in the 
[Control Data Registration] window. 

 Countermeasure 

Follow the procedure specified in the user institution. 

11.3.12 I: ID error 

The sample ID measured does not correspond to the sample ID ordered. 

The sample measured may be different from the sample ordered for some reason. 

 Countermeasure 

Perform measurement again. 

11.3.13 R: Rerun data 

  See “Section 11.2.13  R: Rerun data” in the “Countermeasures for Flags in 
Chemistry Tests” in this Chapter. 
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11.3.14 A: Clot error 

  See “Section 11.2.18  A: Clot error” in the “Countermeasures for Flags in 
Chemistry Tests” in this Chapter. 

11.3.15 G: Crash 

  See “Section 11.2.21  G: Clash” in the “Countermeasures for Flags in Chemistry 
Tests” in this Chapter.   

11.3.16 Q: Liquid level sensor error 

 See “Section 11.2.20 Q: Liquid level sensor error” in the “Countermeasures for 
Flags in Chemistry Tests” in this Chapter.    
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